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Welcome Welcome

Welcome

This Help provides in-depth information on how to use the SignalVu-PC Vector Signal Analysis Software.

Using the signal analysis engine of the RSA5100 and RSA6100 Series real-time signal analyzer, this vector
signal analysis software helps you move your analysis of acquisitions off the instrument.

SignalVu-PC allows you to connect to the RSA306B, RSA500A series, RSA600A series, and RSA7100A
spectrum analyzers. With Option CON installed, you can also connect to a MDO4000B/C series
oscilloscope to acquire live data. Several features and settings become available in SignalVU-PC once
connected to one of these instruments. These are noted where appropriate throughout this Help document.

NOTE. Some of the screen illustrations in this document are taken from the vector signal analysis software
version that runs on the RSA5100 Series Real-time Signal Analyzers. These instruments support additional
hardware-based functionality and buttons that are not present in the SignalVu™ or SignalVu-PC
application.
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Software and documentation How to install product software

How to install product software

The SignalVu-PC product software is made up of the base software and any additionally purchased
applications software (licensed optional software). The base software provides access to the standard
SignalVu-PC applications. It is available for download, free of charge, from the Tektronix Web site
at www.Tek.com\downloads. Once you have the base version, you can purchase licenses for optional
SignalVu-PC applications or choose to activate 30-day free trials of those applications.

Tektronix is working to make it easier for you to manage the options you purchase for SignalVu-PC. If
you purchase an optional license after December 4, 2015, you will set up a product license account that
allows you to manage your product licenses. However, you can still activate or reactivate any options you
have already purchased using the same option keys in the same way.

NOTE. Options purchased prior to December 4, 2015 are referred to as legacy options.

You will find the information you need to activate currently held legacy option licenses, newly purchased
option licenses, and free trial licenses in the Help topics below:

How to activate and purchase new application licenses (options) (see page 3)

How to activate legacy options (application licenses) (see page 7)

How to activate options in free trial evaluation mode (see page 9)

How to manage legacy option licenses (see page 10)

List of available application options (see page 10)

How to activate and purchase new application licenses (options)

To purchase optional application licenses, contact your local Tektronix Account Manager. After
purchasing a license, you will receive an email with a list of the applications purchased and the URL to
the Tektronix Product License Web page, where you will create an account and can then manage your
licenses: http://www.Tek.com/products/product-license.

The product license page provides an inventory of the license(s) in your account. It enables you to check
out or check in a license and view the history of licenses.

Optional applications are enabled by one of the following license types.

License type Description

Node locked item (NL) This license is permanently assigned to a specific host id.

Floating License item (FL) This license can be moved between different host ids.

xxx

You can view a list of the currently installed application licenses and options in your product as follows:
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Select Tools > Licenses >Manage from the application’s main toolbar.

Select Help > About Tektronix Real Time Signal Analyzer to view a list of the installed options.

How to install a license

Before installing a purchased application license, you must first have purchased one through your local
Tektronix Account Manager, created an account on the Tektronix Product License Web page, and
downloaded the license to your PC or a portable memory device.

(See List of available application options.)

(See http://www.Tek.com/products/product-license.)

1. Select Tools > Licenses >Manage to open the Manage Licenses window.

2. In theManage Licenses window, click Install License. An Explorer window will open.

3. Navigate to the location of the license file (*.lic) you downloaded from your Tektronix Product
License account page.

4. Click Open.

5. A notification will appear stating that the license has been successfully installed. Click OK

6. The new license should now appear in the Installed Licenses list.
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Software and documentation How to activate and purchase new application licenses (options)

7. Click Close.

8. Restart the SignalVu-PC application after you have finished installing all of the desired options.

How to return a license

You can return (uninstall) a license from a particular PC as follows:

1. Select Tools > Licenses >Manage to open the Manage Licenses window.

2. In theManage Licenses window, select the license you want to return.

3. Click Return License. The following window will appear.
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4. Click Yes to uninstall the license. You will then be prompted to save an exit license file. This is the file
you will check into (return to) your Tektronix Product License account.

5. Save the exit license file to the desired location.

6. Click Close.

7. Navigate to your Tektronix Product License account page and check in the saved exit license file.

How to move a license to a different host

You can return a purchased license and then reassign it to a different host, as indicated below. See the
Available application options topic for a list of available application licenses.

Node locked license (NL): This license type can be reassigned no more than two times. This allows
you to reassign the license in the case of an upgrade to a new Windows platform, for example.

Floating license (FL): This license type can be reassigned an unlimited number of times.

When assigning a floating license, you need to specify the host id and the duration the feature is to
be enabled on the host. After the license expires, the feature is automatically disabled on that host
and the license in then available to be assigned to a different host.

Free trial license (FT): This license type expires after 30 days.

See also:

http://www.tek.com/products/product-license
How to install a license.
How to return a license.
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How to activate legacy options (application licenses)

Activating options requires internet access. However, you can activate options on a PC that does not have
internet access by using a second PC that does have internet access to contact the license server and use it
to download a license file. The license file can then be transferred to the PC on which the option is to
be activated. In order to use any options you have purchased for SignalVu-PC, you must activate each
option individually one of the following two ways:

To activate an option with Internet access

1. Launch the SignalVu-PC application.

2. Select Tools > Licenses > Legacy > Activate... to view the Activate Legacy License dialog.

3. In the dialog, select Auto.

4. In the Enter Activation Key text box, enter the option activation key provided when you purchased
the option.

5. Click OK. SignalVu-PC will contact the license server and install a license file provided by the
license server.

6. Repeat the steps above to activate each option, using the activation key specific to each option.

To activate an option without Internet access

To activate options on a PC without internet access, you need use the Offline Activation Tool. The tool is
provided with SignalVu-PC as a separate installation file.
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1. Launch the SignalVu-PC application.

2. Select Tools > Licenses > Legacy > Activate... to view the Activate Legacy License dialog.

In the dialog, select Manual.

3. Write down the Host ID shown in your Activate Legacy License dialog, and then click Cancel to
close the window.

4. Install the Activation Assistant software on a PC that has internet access.

The Activation Assistant software is located at:

If you installed SignalVu-PC from a DVD or USB flash drive, navigate to the device, open the
Offline Activation Tool folder, and run the Setup file located there.

If you downloaded SignalVu-PC from the Web, navigate to the location you extracted the
installation files. Open the Offline Activation Tool folder and run the Setup file located there.

5. Launch the Activation Assistant application and follow the instructions to generate a license file.
Repeat this step for each option that you have purchased. You will also need the option activation
key you received.

Activation keys are specific to each option, therefore you must acquire a license file for each option
purchased.

6. Copy the license file (or files) to the following location the PC on which SignalVu-PC is to be activated:

C:\ProgramData\Tektronix\RSA\SignalVu-PC\License

7. Restart the SignalVu-PC application.
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How to activate options in free trial (evaluation) mode

If you don’t have a license for one (or any) SignalVu-PC options, you can activate each option in
evaluation mode for 30 days.

NOTE. Each option has its own evaluation period.

To activate an option in evaluation mode:

1. Launch SignalVu-PC.

2. Select Tools > Licenses > Legacy >Manage... to view the Manage Legacy License dialog.

3. Select the option you want to evaluate, and then select Start 30-day evaluation.

The Current Status box will change to display the number of days remaining for evaluation. Repeat
this procedure for each of the options you wish to evaluate.
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How to manage legacy option licenses

Options are licensed for use on a single PC. However, you can move SignalVu-PC and its options from
one PC to another PC by deactivating each option on the current installation and reactivating them on
another PC. Each activated option needs to be deactivated as follows:

1. Launch the application.

2. Select Tools > Licenses > Legacy >Manage... to view the Manage Legacy License dialog.

3. Use to the drop-down list under Option to select one of the options that is activated.

For example: OFDM Measurements (SignalVu-PC SVO).

4. Starting with each installed option, click Deactivate License. Continue selecting options and clicking
Deactivate License until all the options have been deactivated.

The SignalVu-PC options are now deactivated. You can now install the software on another PC
and activate the options in the new installation.

NOTE. You can view already installed and activated options from the Tools > Licenses > Legacy >
Manage... window.

Available application options

The following table shows available optional applications for SignalVu-PC.

Application description
Application
(option) License type

SVANL-SVPC Node LockedAM/FM/PM/Direct Audio Analysis

SVAFL-SVPC Floating
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Application description
Application
(option) License type

SVTNL-SVPC Node LockedSettling Time (frequency and phase) measurements

SVTFL-SVPC Floating

SVMNL-SVPC Node LockedGeneral Purpose Modulation Analysis to work with analyzer of acquisition
bandwidth ≤ 40 MHz and MDO SVMFL-SVPC Floating

SVMHNL-SVPC Node LockedGeneral Purpose Modulation Analysis to work with analyzer of any acquisition
bandwidth SVMHFL-SVPC Floating

B800NL-SVPC Node Locked800 MHz acquisition bandwidth

(RSA7100A only) B800FL-SVPC Floating

SVPNL-SVPC Node LockedPulse Analysis to work with analyzer of acquisition bandwidth ≤ 40 MHz and
MDO SVPFL-SVPC Floating

SVPHNL-SVPC Node LockedPulse Analysis to work with analyzer of any acquisition bandwidth

SVPHFL-SVPC Floating

TRIGHNL-SVPC Node LockedAdvanced triggers (Frequency Mask, Density) for the RSA7100A

(RSA7100A only) TRIGHFL-SVPC Floating

SVONL-SVPC Node LockedFlexible OFDM Analysis

SVOFL-SVPC Floating

SV23NL-SVPC Node LockedWLAN 802.11a/b/g/j/p measurement

SV23FL-SVPC Floating

SV24NL-SVPC Node LockedWLAN 802.11n measurement

(Requires SV23NL-SVPC or SV23FL-SVPC) SV24FL-SVPC Floating

SV25NL-SVPC Node LockedWLAN 802.11ac measurement to work with analyzer of acquisition bandwidth
≤ 40 MHz and MDO

(Requires SV23NL-SVPC or SV23FL-SVPC and SV24NL-SVPC or
SV24FL-SVPC)

SV25FL-SVPC Floating

SV26NL-SVPC Node LockedAPCO P25 measurement

SV26FL-SVPC Floating

SV27NL-SVPC Node LockedBluetooth measurement 1

SV27FL-SVPC Floating

MAPNL-SVPC Node LockedMapping

MAPFL-SVPC Floating

CONNL-SVPC Node LockedSignalVu-PC connection to the MDO4000B/C series oscilloscopes

CONFL-SVPC Floating

SV2CNL-SVPC Node LockedWLAN 802.11a/b/g/j/p/n/ac and option to connect to MDO4000B/C. Works with
analyzer of analyzer of acquisition bandwidth ≤ 40 MHz and MDO.

(This option bundles the following: SV23NL-SVPC or SV23FL-SVPC,
SV24NL-SVPC or SV24FL-SVPC, SV25NL-SVPC or SV25FL-SVPC, and
CONNL-SVPC or CONFL-SVPC)

SV2CFL-SVPC Floating

SignalVu-PC Printable Help 11



Software and documentation Available application options

Application description
Application
(option) License type

SV2CHNL-
SVPC

Node LockedWLAN 802.11a/b/g/j/p/n/ac and option to connect to MDO4000B/C. Works with
analyzer of any acquisition bandwidth.

(This option bundles the following: SV23NL-SVPC or SV23FL-SVPC,
SV24NL-SVPC or SV24FL-SVPC, SV25NL-SVPC or SV25FL-SVPC, and
CONNL-SVPC or CONFL-SVPC)

SV2CHFL-SVPC Floating

SV28NL-SVPC Node LockedLTE Downlink RF measurement 2

SV28FL-SVPC Floating

SV30NL-SVPC Node LockedWiGig 802.11ad measurements (only for offline analysis)

SV30FL-SVPC Floating

SV54NL-SVPC Node LockedSignal survey and classification

SV54FL-SVPC Floating

SV56NL-SVPC Node LockedPlayback of recorded files

(RSA500A series and RSA600A series only) SV56FL-SVPC Floating

SV60NL-SVPC Node LockedReturn loss, VSWR, cable loss, and distance to fault

(RSA500A series and RSA600A series only) SV60FL-SVPC Floating

Education-only version of all modules for SignalVu-PC EDUFL-SVPC Floating

xxx

1 Bluetooth is a registered trademark of Bluetooth SIG, Inc.
2 LTE is a trademark of ETSI.

TIP. See the Features by product (see page 13) topic for more information.
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Features by product

The following table lists a subset of features that may or may not be available for your analyzer when
connected to SignalVu-PC. An “√” means the feature is available with the specified product. Some of
these features require specific options be installed. You can view a list of options for SignalVu-PC here
(see page 10).

Feature
RSA300
Series

RSA500A
Series

RSA600A
Series RSA7100A

Audio demodulation (listening) √ √ √ 1

DPX Spectrogram (DPXogram) √ √ √ 1

Fast Frame 1

Frequency Mask Trigger √

DPX Density Trigger 1

Internal GPS √ √ 1

Playback of recorded files (Option SV56-SVPC) √ √ √

Playback of recorded files (external application) √ √ √ √

Tracking generator and return loss, VSWR,
cable loss, and distance to fault (Option 04 with
SV60-SVPC)

√ √

xxx

1 Planned for future release.

Available product documentation

In addition to the Help, the following documents are available. For the most up to date documentation,
visit the Tektronix Web site www.tektronix.com/manuals.

SignalVu-PC Quick Start User Manual (Tektronix part number 077-1024-XX). This PDF document
explains how to install and activate the SignalVu-PC software. The instructions also provide a
brief overview of the SignalVu-PC interface to get you started. It is available for download at
www.Tek.com/manuals and can also be accessed from the Help menu in the application.

SignalVu-PC Programmer Manual (077-0721-XX). This PDF document provides detailed
descriptions of the remote commands for the SignalVu-PC software and explains how to use the
programming interface for SignalVu-PC.

SignalVu-PC Printable Help Document (PDF) (077-0720-XX). A PDF file version of this Help that
can be printed.

If you are using an RSA306B, RSA500A Series, RSA600A Series, RS7100A, or MDO4000/B or
C Series instrument with SignalVu-PC, you can find more documents about those specific products
online at www.Tek.com/manuals.
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The most recent versions of the product documentation, in PDF format, can be downloaded from
www.Tek.com/manuals. You can find the manuals by searching on the product name and selecting the
Manuals filter.

Video tutorials

You can browse the Tektronix YouTube channel (www.youtube.com/user/tektronix ) to find video tutorials
about various topics related to your product. You can also subscribe to the Tektronix YouTube channel to
keep up with new postings.

Searching for topics

For example, you can watch a video tutorial about performing basic EMI testing with a spectrum analyzer,
or how to use WLAN presets and connect to an MDO4000B oscilloscope. To find a video on a topic, do
the following. The following image shows you what the Tektronix YouTube Channel looks like.

1. Click on the search icon located just above the video you see when the page first loads.

NOTE. This icon allows you to search the Tektronix YouTube channel specifically. The search icon located
at the top of the page allows you to search all of YouTube .

2. Type in the key phrase you are looking for in the search field. For example, “WLAN”.

3. Click the search icon to start the search.

4. Videos related to the topic will appear. Click a video to view it.
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Selecting Files for Analysis

The SignalVu-PC software can analyze waveform files saved by Tektronix oscilloscopes and real-time
signal analyzers. SignalVu-PC can open several file types, including .wfm, .tiq, .iqt and .mat files. For
more detailed information on opening the supported file types, see Recalling Waveforms with SignalVu-PC
(see page 686).

Right-Click Action Menu

You can change marker settings and how waveforms are displayed by using the right-click Actions menu.

To use the right-click Actions menu, right-click in the graph area.
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Icon Menu Description

Select Selects markers and adjusts their position.

Span Zoom Zooms the graph area about the selected point. Right-click in
the graph display at a point of interest and drag to increase or
decrease the span about the point of interest. Span Zoom adjusts
the span control.

CF Pan Adjusts the Center Frequency according to horizontal movement.

Zoom Adjusts horizontal and vertical scale of the graph. The first
direction with enough movement becomes the primary scale of
adjustment. Adjustment in the secondary direction does not occur
until a threshold of 30 pixels of movement is crossed.

Dragging to the left or down zooms out and displays a smaller
waveform (increases the scale value). Dragging to the right or up
zooms in and displays a larger waveform (decreases the scale
value).

Pan Adjusts horizontal and vertical position of the waveform. The first
direction with enough movement becomes the primary direction of
movement. Movement in the secondary direction does not occur
until a threshold of 30 pixels of movement is crossed.

- Reset Scale Returns the horizontal and vertical scale and position settings
to their default values.

- Marker to peak Moves the selected marker to the highest peak. If no marker is
turned on, this control automatically adds a marker.

- Add marker Defines a new marker located at the horizontal center of the graph.

- All markers off Removes all markers.

xxx

SignalVu-PC Markers Menu

The SignalVu-PC Markers menu appears when you right-click on a marker. The SignalVu-PC Markers
menu enables you to assign a marker to a different trace and pan the trace to place the marker at the
measurement frequency.

Icon Menu Description

- Pan to marker Adjusts horizontal position of the waveform to locate the selected
marker at the measurement frequency.

- Assign to trace Assigns the selected marker to Trace 1, Trace 2, Trace 3 or the
Math trace. A trace must be enabled to assign a marker to it.

xxx
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Elements of the Display

General application window areas. The main areas of the application window are shown in the following
figure.

NOTE. If values or buttons on the application UI become truncated or displaced, you may need to adjust
the Microsoft Windows display settings or custom DPI percentage setting.

Specific elements of the application display window. Specific elements of the display are shown in the
following figure. More detailed information is available in the Menus section.
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Ref
number

Setting Description

1 Recall Displays the Open window in order to recall setup files, acquisition data files,
or trace files.

2 Save Opens the Save As dialog in order to save setup files, pictures (screen
captures), acquisition data files, or export measurement settings.

3 Undo/Redo Undoes or redoes the previous edit to a display or measurement settings, a
preset, or a measurement change.

4 Displays Opens the Select Displays dialog box so that you can select measurement
displays.

5 Settings Opens the Settings control panel for the selected display. Each display has
its own control panel.

6 Trigger

(Only available when
connected to an RSA306,
RSA306B, RSA500A
series, and RSA600A
series, RSA7100A, or
MDO4000B/C.)

Opens the Trigger control panel so that you can define the instrument trigger
settings.
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Ref
number

Setting Description

7 Acquire Opens the Acquire control panel, which displays the Sample Rate and Record
length of the recalled waveform file.

8 Analysis Opens the Analysis control panel so that you can define the analysis settings
such as frequency, analysis time, and units.

9 Amplitude Opens the Amplitude control panel so that you can define the Reference Level,
configure internal attenuation, and specify external gain/loss corrections.

10 GNSS/Antenna Opens the GNSS/Antenna control panel so that you can configure and activate
an external GNSS receiver and antenna.

11 Audio Demodulation Opens the Audio control panel so that you can define the audio demodulation
settings for the RSA306, RSA306B, RSA500A series, RSA600A series, and
RSA7100A.

12 Recording Opens the Recording control panel so that you can record and configure
recording of signals. For detailed information, see the Setup Menu (see
page 708) topic.

13 Favorite User Presets Click to select from a list of custom favorite User presets and load the selected
preset. For more detailed information, see the Make a User preset a Favorite
preset (see page 24) topic.

14 Main menu bar Contains access to menus. For detailed information, see the Main Menu (see
page 698) topic.

15 Preset Recalls the Main preset.

16 Replay Runs a new measurement cycle on the existing acquisition data record using
any new settings. See the Replay menu topic for more details.
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Ref
number

Setting Description

17 Run

and

Run/Stop toolbar

(Only available when
connected to an RSA306,
RSA306B, RSA500A
series, and RSA600A
series, RSA7100A, or
MDO4000B/C.)

Run menu and Run/Stop toolbar

Starts and stops data acquisitions and specifies the run conditions. For
example, if you select Single in the Run/Stop toolbar (or Run Single in the
Run menu), a single measurement cycle is run. If you select Continuous
in the Run/Stop toolbar (or Run Continuous in the Run menu), the data
acquisition runs until stopped.

Run menu

The Run menu also includes Resume and Abort.

Resume restarts data acquisition, but does not reset accumulated results,
such as Average or MaxHold. This allows you to stop acquisitions
temporarily, then continue.

Abort immediately halts the current acquisition/measurement cycle.
In-process measurements and acquisitions are not allowed to complete.

See the Run menu topic for more details.

18 The Edit Favorites icon allows you access the below menu, which allows you to
edit the contents of the Favorites bar. For more information, see the Favorites
bar (see page 712) topic.

xxx
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Restoring Default Settings

To restore the software to its factory default settings:

1. Select Presets > Preset Options.

2. In the Presets tab of the Options control panel, click to the view the Preset type drop down menu
and select Main.

3. Click to the view the Presets drop down menu and select Original.

4. Click the red X icon in the top right corner of the Options control panel to close the panel.

5. Select Presets >Main from the menu bar to return the software to its original factory default settings.

NOTE. You can also click the Preset button on the right-hand side of the menu bar to load the Main preset.

Presets

Main menu bar: Presets

SignalVu-PC includes a set of standard configurations that are tailored to specific applications or types of
analysis. These configurations, referred to as Presets, open selected displays and load settings that are
optimized to address specific application requirements. You can also make your own User presets to
fit your application. Any User preset can be added to the Favorites bar, enabling one-button access to
your most used setups.

Preset Options

Select the Presets > Preset Options menu to open the Options control panel. Once you have chosen these
settings, you can access any preset or list of presets from Presets on the menu bar.

Preset type: Select the Preset type.

Presets: Select the specific preset you want to display for the selected preset type.

Preset action: Selecting a preset from the Preset drop down menu results in one of two actions
depending on which item you choose in the Preset action list: Recall selected preset will immediately
execute a preset when it is selected from the Presets menu. Show list will display a list of presets
subtypes from which you can then select the preset you want to recall.

Available Presets

Select Presets from the menu bar to access the presets shown in the following table. Preset subtypes are
managed in the Presets > Preset Options menu.
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Preset Description

Main

Current This Preset sets the analyzer to display a Spectrum display with settings appropriate for
typical spectrum analysis tasks.

Original This Preset is the original factory preset used with your original SignalVu-PC software.
This version of the factory preset is included to allow you to maintain compatibility with
existing remote control software.

DPX

(Only available when an RSA306, RSA306B, RSA500A series, RSA600A series, RSA7100A, or MDO4000B/C is connected.)

Open the DPX display The Open the DPX display opens the DPX display without closing existing displays.

Swept The DPX Swept Preset displays the DPX Spectrum display with the span set to maximum
and the center frequency set to 1/2 the span.

Real Time The DPX Real Time Preset displays the DPX Spectrum display with the center frequency
set to 1.5 GHz and the span set to the maximum available real-time bandwidth.

Standards

WLAN This preset sets the analyzer to display the WLAN Summary, WLAN Constellation, and
SEM displays. After you select the standards and bandwidth, the software configures
these displays to apply the parameters appropriate for typical WLAN analysis tasks.

APCO P25 This preset sets the analyzer to display the P25 MCPR, Summary, P25 Constellation,
and Time Overview displays. After you select the standard and modulation type, the
software configures these displays to apply the parameters appropriate for typical P25
analysis tasks.

Bluetooth This preset loads a set of Bluetooth displays and test setup to perform Bluetooth SIG RF
tests. The software configures these displays to apply the parameters appropriate for
Bluetooth analysis tasks.

LTE This preset loads a set of LTE displays and a test setup, frame structure, and channel
bandwidth to perform LTE tests. The software configures these displays to apply the
parameters appropriate for LTE analysis tasks.

802.11ad This preset loads a set of standards (Control PHY and Single carrier PHY) for 802.11ad
for offline analysis.

Application

Modulation Analysis The Modulation Analysis setup application preset provides you with the most common
displays used during modulation analysis. Only present when Option 21 is installed.

Pulse Analysis The Pulse Analysis application preset provides you with the most common displays
used during pulse analysis, and makes changes to the default parameters to settings
better optimized for pulsed signal analysis.

Time-Frequency Analysis The Time-Frequency preset configures the analyzer with settings suited to analyzing
signal behavior over time.

Spectrum Analysis The Spectrum Analysis application preset provide you with the settings commonly used
for general purpose spectrum analysis.

Spur Search Multi Zone
9k-1GHz

The Spur Search application preset sets the analyzer to display all spurs that exceed the
Threshold and Excursion values for the entire 9 kHz through 1 GHz range.

User (Favorites)
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User Preset 1 This preset sets the analyzer to show these displays: Frequency vs Time, Time
Overview, Spectrogram, and Spectrum. Settings commonly used for general purpose
analysis are loaded.

User Preset 2 This preset sets the analyzer to show the Spurious display. Settings commonly used for
spur analysis are loaded.

Interference Hunting This preset sets the analyzer to show the DPX and Signal Strength displays.

Other user presets User presets you create and save will appear in the Preset drop down menu of the
User Presets window. Any User preset that you have designated as a Favorite will be
marked with an *.

xxx

Recalling a Preset

To recall a preset, select Presets and then the desired preset type.

NOTE. You can set which presets to recall from the Presets > Preset Options control panel.

NOTE. You can also click the Preset button on the top right side of the menu bar to load the Main preset.

User (Favorites) Presets

Select the Presets > User (Favorites) menu to open the User Presets window. The Presets drop-down
list shows the three default user presets provided with the software.

User Preset 1: Sets up the Spectrum, Time Overview, Spectrogram, and Frequency vs Time displays.

User Preset 2: Sets up the Spurious display.

Interference Hunting: Sets up the DPX and Signal Strength displays.
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Make a User preset

You can add your own User presets to the list that appears in the User Presets dialog box as follows:

1. Select Save As from the File menu to open the Save As dialog box.

2. Select to save to C:\SignalVu-PC Files\User Presets.

3. Enter a file name. The name you give the file will appear in the User Presets dialog box list.

4. Select Setup file to save from the Save as type drop-down list.

5. Click Save.

Make a User preset a Favorite preset. You can place one or more User presets on the Favorites bar as a
Favorite preset for quick access. Do this as follows:

1. Select Presets > User to open the User Presets window.

2. Select the desired preset from the Presets drop-down list.

3. Click the Add Favorite button. The preset will now have an * next to it. You can do this for more
than one preset.

4. If desired, add a note for this preset in the Notes field and then click the Save button. Whenever you
recall this preset, this note will appear in a separate window, as shown below.
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5. Click the OK button in the User Presets window.

6. Click on the icon on the Favorites bar and you will see the recently added Favorite preset listed.

7. When you are ready to recall a Favorite preset, click and select the preset from the list that appears.

8. To remove a Favorite preset, select it from the User Presets window and click the Remove Favorite
button. The * should disappear from the list.

Standards Presets

The Standards presets allow you to recall preconfigured displays for the standards that you select. You
can select from the following standards groups.

WLAN: The IEEE wireless LAN (WLAN) standards specify the wireless interface between two
wireless clients or a wireless client and a base station. The WLAN presets allow you to access displays
preconfigured for the WLAN standards and bandwidths you select.

NOTE. More information is available about WLAN standards here. You can also watch a video tutorial
about WLAN Presets at www.youtube.com/user/tektronix. Click here for information about searching the
Tektronix YouTube channel for videos.

P25: The Project 25 (P25) TIA-102 standards specify the design of interoperable digital two-way
wireless communications products. The P25 presets allow you to access displays preconfigured for
the P25 standards you select. You can choose either the Phase 1 (FDMA) standard or the Phase
2 (TDMA) standard.
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NOTE. More information is available about P25 standards here (see page 387).

Bluetooth: The Bluetooth standards specify short range RF signals. The Bluetooth presets allow
you to access displays preconfigured for the specific Bluetooth standards you select: Basic Rate,
Low Energy, and Enhanced Data Rate (EDR).

NOTE. More information is available about Bluetooth standards here.

LTE: The LTE standards ensure that the RF signals meet 3GPP measurements specifications. The
LTE presets test setups load pre-configured displays and control setting as suggested by the selected
standard to accelerate the test setup of the analyzer.

NOTE. More information is available about LTE standards and test setups here.

Application Preset: Modulation Analysis

The Modulation Analysis application preset opens the following displays:

DPX display: Shows you a continuous spectrum monitoring of the specified carrier frequency.

Signal Quality: Shows a summary of modulation quality measurements (EVM, rho, Magnitude
Error, Phase Error, and others).

Constellation: Shows the I and Q information of the signal analyzed in an I vs Q format.

Symbol Table: Shows the demodulated symbols of the signal.

To use the Modulation Analysis preset (assuming the Preset action is set to Show list in the Presets tab
of the Options control panel):

1. Select Presets > Application. SelectModulation Analysis and then click OK.

2. Set the reference level so that the peak of your signal is about 10 dB below the top of the DPX display.

3. Set the modulation parameters for your signal. This includes the Modulation Type, Symbol Rate,
Measurement Filter, Reference Filter, and Filter Parameter. All of these settings are accessed by
selecting Tools > Settings.

For most modulated signals, the Modulation Analysis application preset should present a stable display of
modulation quality. Additional displays can be added by selecting Setup > Displays, and other settings
can be modified to better align with your signal requirements.

Application Preset: Pulse Analysis

The Pulse Analysis application preset opens the following displays:

DPX: The DPX display is opened with the maximum available span.

Time Overview: Shows amplitude vs. time over the analysis period.
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Pulse Table: This shows a full report for the user-selected pulse measurements.

Pulse Trace: Shows the trace of the selected pulse and a readout of the selected measurement from
the pulse table.

You can make a selected pulse and measurement appear in the Pulse Trace display by highlighting it in the
Pulse Measurement Table. Key pulse-related parameters that are set by the Pulse Analysis application
preset are:

Measurement Filter: No Filter-Max BW

Measurement Bandwidth: This is set to the maximum real-time bandwidth of the instrument.

NOTE. The label on the “Measurement Bandwidth” setting is just “Bandwidth”. Like the main instrument
Preset command and the other application presets, the Pulse Analysis application preset also sets most
other instrument controls to default values.

Power threshold to detect pulses: This is set to –10 dBc.

Minimum OFF time between pulses: This is set to 400.000 ns o ensure a good probability of catching
several pulses for typical signals.

Max number of pulses: Check this box to limit the number of pulses to measure.

To use the Pulse Analysis preset (assuming the Preset action is set to Show list in the Presets tab of the
Options control panel):

1. Select Presets > Application. Select Pulse Analysis and then click OK.

2. Set the Center Frequency control to the carrier frequency of your pulsed signal.

3. Set the Reference Level to place the peak of the pulse signal approximately 0-10 dB down from
the top of the Time Overview display.

You may need to trigger on the signal to get a more stable display. This is set up in the Trigger control
panel. (“Trig” button). Using the Power trigger type with the RF Input source works well for many
pulsed signals.

4. Set the Analysis Period to cover the number of pulses in your signal that you want to analyze. To do
this, click in the data entry field of the Time Overview window and set the analysis length as needed.

Application Preset: Spectrum Analysis

The Spectrum Analysis application preset opens a Spectrum display and sets several parameters. The
Spectrum Analysis preset sets the analyzer as follows.

Spectrum Analysis : Sets the frequency range to maximum for the analyzer, and sets the RF/IF
optimization toMinimize Sweep Time.

To use the Spectrum Analysis preset (assuming the Preset action is set to Show list in the Presets tab
of the Options control panel):
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1. Select Presets > Application. Select Spectrum Analysis and then click OK.

2. Set the measurement frequency using the front-panel knob or keypad.

3. Adjust the span to show the necessary detail.

Application Preset: Time-Frequency Analysis

The Time-Frequency Analysis application preset opens the following displays:

Time Overview: Shows a time-domain view of the analysis time ‘window’.

Spectrogram: Shows a three-dimensional view of the signal where the X-axis represents frequency,
the Y-axis represents time, and color represents amplitude.

Frequency vs. Time: This display's graph plots changes in frequency over time and allows you to
make marker measurements of settling times, frequency hops, and other frequency transients.

Spectrum: Shows a spectrum view of the signal. The only trace showing in the Spectrum graph
after selecting the Time-Frequency Analysis preset is the Spectrogram trace. This is the trace from
the Spectrogram display that is selected by the active marker. Stop acquisitions with the Run button
because its easier to work with stable results. In the Spectrogram display, move a marker up or down
to see the spectrum trace at various points in time.

The analysis period (scale) is set to 5 ms.

To use the Time-Frequency Analysis preset (assuming that Time-Frequency Analysis is the selected preset
on the list of Application Presets and Preset action is set to Recall selected preset):

1. Select Presets > Application. Select Time-Frequency Analysis and then click OK.

2. When the preset's displays and settings have all been recalled and acquisitions are running, adjust the
center frequency and span to capture the signal of interest.

3. Set the Reference Level to place the peak of the signal approximately 0-10 dB down from the top of
the Spectrum graph.

4. If the signal is transient in nature, you might need to set a trigger to capture it. Connect to an
MDO4000B/C series oscilloscope or and RSA306, RSA306B, RSA500A series, RSA600A series, or
RSA7100A spectrum analyzer and use its triggering functions to capture the signal. (Option CON is
required to connect to an MDO4000B/C.)

When the signal has been captured, the spectrogram shows an overview of frequency and amplitude
changes over time. To see frequency transients in greater detail, use the Frequency vs. Time display.

The Time-Frequency Analysis preset sets the analysis period to 5 ms. The Spectrum Span is 40 MHz. The
RBW automatically selected for this Span is 300 kHz. For a 300 kHz RBW, the amount of data needed for
a single spectrum transform is 7.46 μs. A 5 ms Analysis Length yields 671 individual spectrum transforms,
each one forming one trace for the Spectrogram to display as horizontal colored lines. This preset scales
the Spectrogram time axis (vertical axis) to -2, which means that the Spectrogram has done two levels of
time compression, resulting in one visible line for each four transforms. This results in 167 lines in the
Spectrogram for each acquisition, each covering 29.84 μs.
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Application Preset: Spur Search Multi Zone 9k-1GHz

The Spur Search Multi Zone 9k-1GHz application preset opens the Spurious display, which is set to
display all spurs that exceed the Threshold and Excursion values for the entire 9 k through 1 GHz range.

To use the Spur Search Multi Zone 9k-1GHz preset (assuming that Preset action is set to Recall selected
preset):

1. Select Presets > Application. Select Spur Search Multi Zone 9k-1GHz and then click OK.

2. Click Setup > Settings when the preset's display and settings have all been recalled and acquisitions
are running.

3. Select the Ranges and Limits tab in the Spurious Settings control panel to view the spur information.
You can click the Expand button to view the table in a separate window.

NOTE. You can read more about the Spurious display (see page 149) and its various parameters and
settings in the RF Measurements section.

Settings Options

Main menu bar: Tools > Options

There are several settings you can change that are not related to measurement functions. The Option
settings control panel is used to change these settings.

Settings tab Description

Presets Use this tab to configure Presets. You can select Presets and specify the action to
take when a preset is recalled.

Analysis Time Use this tab to specify the method used to automatically set the analysis and spectrum
offsets when the Time Zero Reference (see page 607) is set to Trigger.

Save and Export Use this tab to specify whether or not save files are named automatically and what
information is saved in acquisition data files.

Security Selecting the Hide Sensitive readouts check box causes the instrument to replace
measurement readouts with a string of asterisks.

Prefs Use this tab to select different color schemes for the measurement graphs and specify
how markers should react when dragged.

xxx
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Presets

The Presets tab in the Options control panel allows you to specify actions taken when you press the Preset
button. You can read more about this tab here (see page 21).

Analysis Time

The Analysis Time tab in the Options control panel is used to specify the method used to automatically set
the analysis and spectrum offsets when the Time Zero Reference (see page 607) is set to Trigger. The
available settings are:

Include trigger point – Selects an algorithm that uses the measurements to determine how far in
advance of the trigger to set the analysis offset. The analyzer tries to ensure that data about the trigger
point is included in the analyses.

Start at trigger point (legacy) – The method used by the instrument in prior versions, which sets the
Analysis Offset to zero when possible. The analyzer tries to ensure that data following the trigger
point is included in the analyses. Use this method if your measurements or procedures depend on past
behavior of the Auto Analysis Offset function.

Save and Export

The Save and Export tab allows you to specify whether or not files are saved with an automatically
generated name, and how much data is saved in an acquisition data file.

All files. The Automatically increment filename/number function can automatically name saved files by
appending a number to a base file name. Use this tab to enable/disable automatic naming of files. For
example, if Automatically Increment Filename Number is disabled, when you select Save from the File
menu, you will have to enter a name for the file.

Acquisition data files. This setting specifies whether saved data files include the entire acquisition record
or only the data for the analysis length (a subset of the acquisition record).

TIQ acquisition data files. Specifies which data records to save. You can choose from the following:

Current acquisition: Saves the current acquisition.

Current frame: If Fast Frame is enabled, saves only the current frame. The current frame is the
one most recently analyzed.

Selected frames: If Fast Frame is enabled, saves the specified frames.

All in history: Saves all acquisition records in the history.

Save TIQ file now: Invokes the Save As dialog box with the Save as type drop-down list set to TIQ.

Security

The Security tab enables you to hide sensitive readouts in displays with readouts, such as the OFDM
Summary display.
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Prefs

The Prefs tab enables you to set properties that apply to all displays.

Connectivity

The Connect menu allows you to connect your PC (with SignalVu-PC installed) to the following
instruments:

RSA306, RSA306B, RSA500A series, and RSA600A series spectrum analyzers via USB 3.0

RSA7100A spectrum analyzer to the CTRL7100A via PCIe port

MDO4000B/C Series instrument via USB, wireless, or LAN (Option CON required)

NOTE. Multiple instruments may be connected to the PC that runs SignalVu-PC, but only one instrument
at a time can be connected to SignalVu-PC.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

Connecting to a Spectrum Analyzer

USB3 connection. Establishing a connection to an RSA306, RSA306B, RSA500A series, and RSA600A
series is as simple as connecting the USB cable from the PC to the RSA, either before or after starting the
SignalVu-PC application. During the connection process, SignalVu-PC indicates that it is finding and
connecting to the instrument. Please wait for the connection process to complete before using the software.

NOTE. Your PC may notify you that it has found a new USB device and has loaded the device drivers. If
you see these notifications, wait until the drivers are loaded before continuing.

PCIe connection. Establishing a connection to an RSA7100A is as simple as connecting the PCIe cable
from the CTRL7100A to the RSA and then powering on the controller. The controller automatically turns
on the RSA and launches the SignalVu-PC application.

The SignalVu-PC application always monitors the ports. Anytime an RSA is discovered, a connection

is immediately established causing the Connect status indicator to turn green ( ). Disconnecting the
RSA from the PC also disconnects the SignalVu-PC application, causing the Connect status indicator

to turn red ( ).

If the SignalVu-PC application is already connected to another instrument (either USB, PCIe, or network),
an automated connection will not take place. In this situation, do the following:
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1. Select Disconnect From Instrument to end the existing connection.

2. Select Connect To Instrument. You should see the USB connected RSA in the instrument list.

3. Select the instrument.

NOTE. RSA306 devices require SignalVu-PC version 3.4.0253 or higher. RSA306B devices require
SignalVu-PC version 3.7.01xx or higher. The latest version of software is available from the Tektronix web
site www.Tek.com/downloads .

4. A Connect Status dialog box will appear to confirm the instrument is connected and SignalVu-PC can
receive live data from the instrument.

NOTE. You can quickly verify connection status by looking at the Connected indicator icon. It is green
( ) when an instrument is connected. It is red ( ) when it is not. You can also view the name of the
instrument that is connected by hovering the pointer over the connection icon.

5. When you want to connect to a different instrument, select Disconnect From Instrument to end
the current connection.

Connecting to an MDO4000B/C Series instrument

NOTE. You can watch a video tutorial about using Connect (Option CON) to connect to an MDO4000B/C
Series instrument and about WLAN Presets at www.youtube.com/user/tektronix. Learn more about the
Tektronix YouTube channel here (see page 14).

USB connection. To establish a connection using USB, perform the following procedures in the order
given.

1. Check that the MDO4000B/C is on.

2. Connect a USB cable to the MDO.

3. Connect the other end of that USB cable to the PC.

NOTE. Your PC may notify you that it has found a new USB device and has loaded the device drivers. If
you see these notifications, wait until the drivers are loaded before continuing.

4. Double click the SignalVu-PC icon on the Desktop to start the application.

5. Click Connect on the menu bar to view the drop down menu.

NOTE. See Elements of the Display (see page 17) for information about menus and toolbars.
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6. Select Connect To Instrument. You should see the USB connected MDO in the Connect To
Instrument list.

NOTE. If the PC is currently connected by LAN or USB to another instrument, that connection will
also show in the Connect To Instrument list. You must select Disconnect From Instrument to end that
connection before connecting to the newly found instrument.

7. If you do not see the USB MDO, click Search for Instrument. TekVISA is now searching for
instruments. A notification will briefly appear stating that the instrument was found. Check that the
newly found instrument now appears in the Connect To Instrument list.

8. Select the instrument.

9. A Connect Status dialog box will appear to confirm the instrument is connected and SignalVu-PC can
receive live data from the instrument.

NOTE. You can quickly verify connection status by looking at the Connected indicator square at the bottom
of the screen. It is green ( ) when an instrument is connected. It is red ( ) when it is not. You can also

view the name of the instrument that is connected by hovering the pointer over the .

10. Use SignalVu-PC to configure the MDO. Frequency, Amplitude, Span, Bandwidth, and Time Scaling
parameters for the RF channels can only be changed using SignalVu-PC.

NOTE. Press F1 on your keyboard to open the SignalVu-PC help for information about configuring
and using the application. You can also click on Help > User Manual in the SignalVu-PC menu bar
to open the help.

11. When you are ready to connect to a different instrument, select Disconnect From Instrument to first
end the current connection.

NOTE. For more search options using TekVISA, go to the Visa Resource Manager (double click in the
applications tray).
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LAN or wireless connection. To establish a connection using a LAN or wireless connection, perform the
following procedures in the order given.

1. Check that the PC has a working LAN or wireless network connection.

2. Use an Ethernet cable to connect the MDO to the network.

3. Check that the MDO is on and wait for the IP Address to display on the screen. Write down the IP
address to help you identify the MDO in the SignalVu-PC application.

4. Double click the SignalVu-PC icon on the Desktop to start the application.

5. Click Connect on the menu bar to view the drop down menu.

NOTE. See Elements of the Display (see page 17) for information about menus and toolbars.

6. Select Search For Instrument. TekVISA is now searching for instruments.

7. A notification will briefly appear stating that the instrument was found. Check that the newly found
instrument now appears in the Connect To Instrument list and then click on the instrument name
to connect.

NOTE. If the PC is currently connected by LAN/wireless or USB to another MDO4000B/C, that connection
will also show in the Connect To Instrument list. You must select Disconnect From Instrument to end that
connection before connecting to the newly found instrument.

8. If you do not see the LAN address of the MDO, clickManually Search for LAN Instrument. You
will then need to enter the IP address of the MDO into the IP Address dialog box and click Connect.

9. A Connect Status dialog box will appear to confirm the instrument is connected and SignalVu-PC can
receive live data from the instrument.

NOTE. You can quickly verify connection status by looking at the Connected indicator square at the bottom
of the screen. It is green ( ) when an instrument is connected. It is red ( ) when it is not. You can also

view the name of the instrument that is connected by hovering the pointer over the .

10. Use SignalVu-PC to configure the MDO. Frequency, Amplitude, Span, Bandwidth, and Time Scaling
parameters for the RF channels can only be changed using SignalVu-PC.

NOTE. Press F1 on your keyboard to open the SignalVu-PC help for information about configuring
and using the application. You can also click on Help > User Manual in the SignalVu-PC menu bar
to open the help.

11. When you are ready to connect to a different instrument, select Disconnect From Instrument to first
end the current connection.
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NOTE. For more search options using TekVISA, go to the Visa Resource Manager (double click in the
Windows applications tray).
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Selecting Displays

Main menu bar: Setup > Displays

Favorites toolbar:

Use the Select displays dialog to choose the displays that appear on the screen.

To select displays:

1. Select Setup > Displays or click the icon.

2. Select one of the choices underMeasurements. The measurement chosen determines the choices
available in Available displays.

3. Double-click the desired display in the Available displays box or select the desired display and
click Add.

4. Click OK.
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TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.
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Available Measurements

Available automatic measurements include RF power measurements, OFDM analysis, WLAN analysis,
APCO P25 analysis, Bluetooth analysis, LTE analysis, 802.11ad (for offline analysis only), audio analysis,
analog modulation measurements, digital modulation measurements, return loss, distance to fault, and
pulsed RF measurements.

See the specific measurement topic in this document for information about how to take a measurement.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

Power measurements

Measurement Description

Channel Power The total RF power in the selected channel (located in the Chan Pwr and ACPR display).

Adjacent Channel Power Ratio
(ACPR)

Measure of the signal power leaking from the main channel into adjacent channels.

Multi-Carrier Power Ratio
(MCPR)

The ratio of the signal power in the reference channel or group of channels to the power
in adjacent channels.

Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted
signal (located in the CCDF display).

CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much
time a signal spends at or above a given power level relative to the average power of
a measured signal.

xxx
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OFDM analysis

Measurement view Description

Channel Response Plots the channel response (magnitude or phase) versus the subcarrier or frequency.
Here, the channel refers to all sources of signal frequency response impairment up to
the analyzer input, including the transmitter itself, as well as any transmission medium
through which the signal travels between the transmitter and the analyzer.

Constellation Shows the WLAN signal modulation amplitude and phase in I (horizontal) versus Q
(vertical) form. For multicarrier WLAN OFDM signals, the points show all data symbol
subcarriers' modulation. For single-carrier 802.11b, each point corresponds to a single
modulated chip.

EVM The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Flatness Ratio of the peak power in the transmitted signal to the average power in the transmitted
signal

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Power shows the data symbols' individual subcarrier Power values versus symbol interval (time)
and subcarrier (frequency).

xxx

Tracking generator measurement

Measurement Description

Transmission Gain

(Requires Option 04)

Measure the gain/loss and response of filters, amplifiers, attenuators, and other such
devices.

xxx

Return loss measurements

Measurement Description

Cable loss Measure cable attenuation.

Return loss / VSWR Measure return loss and VSWR on filters and antennas.

Distance to fault (DTF) Measure distance to fault to find the fault.

xxx
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WLAN measurements

Measurement view Description

Channel Response Plots the channel response (magnitude or phase) versus the subcarrier or frequency.
Here, the channel refers to all sources of signal frequency response impairment up to
the analyzer input, including the transmitter itself, as well as any transmission medium
through which the signal travels between the transmitter and the analyzer.

Constellation Shows the WLAN signal modulation amplitude and phase in I (horizontal) versus Q
(vertical) form. For multicarrier WLAN OFDM signals, the points show all data symbol
subcarriers' modulation. For single-carrier 802.11b, each point corresponds to a single
modulated chip.

EVM The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Flatness Ratio of the peak power in the transmitted signal to the average power in the transmitted
signal

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Power vs Time The signal power amplitude versus time. For 802.11b signals, the packet Power-On and
Power-Down ramp times are also measured.

Summary Shows several measurements of WLAN signal quality.

Symbol Table Shows decoded data values for each data symbol in the analyzed signal packet. For
OFDM (non-802.11b) signals, results are presented with subcarrier (frequency) indices
in the horizontal dimension and symbol (time) intervals in the vertical dimension. For
802.11b signals, the Preamble, Header, and Data (PSDU) symbol values are presented
sequentially, with symbol indices in the left column.

xxx

802.11ad measurements

This option is available for offline analysis only.

xxx
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Digital Modulation measurements

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Measurements for OQPSK and SOQPSK modulation types

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q
samples. For EVM, I and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the I and Q
symbol decision points are time-aligned before collecting the I and Q samples. In this
case, one I and one Q sample is collected for each symbol (half as many samples as the
same number of symbols for (non-offset) EVM.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Measurements for nFSK modulation types

Measurement Description

Peak FSK err Peak value of the frequency deviation error at the symbol point.

RMS FSK Err RMS value of the frequency deviation error at the symbol point.

Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal
magnitude.

RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal
magnitude.

Freq Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Freq Deviation Frequency distance from the center frequency at the symbol point.

Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of
the analyzed signal.

Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and
the instrument calculates the error between the user entered value and the instrument
calculated value.

xxx

Measurements for C4FM modulation type

Measurement Description

RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.

Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.

Deviation Frequency distance from the center frequency at the symbol point.

Length Number of symbols in the analysis area.

xxx

Analog Modulation measurements

Measurements for AM modulation

Measurement Description

+AM Positive peak AM value.

-AM Negative peak AM value.

Total AM Total AM value, which is equal to the peak-peak AM value divided by 2.

xxx

Measurements for FM modulation

Measurement Description

+Pk Positive peak frequency deviation.

–Pk Negative peak frequency deviation.

RMS RMS value of the frequency deviation.

Pk-Pk/2 Peak-to-peak frequency deviation divided by 2.

Pk-Pk Peak-to-peak frequency deviation.

xxx
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Measurements for PM modulation

Measurement Description

+Pk Positive peak phase deviation.

–Pk Negative peak phase deviation.

RMS RMS value of the phase deviation.

Pk-Pk Peak-to-peak phase deviation.

xxx

APCO P25 measurements

Measurement Description

RF output power Measure of RF output power when the transmitter is connected to the standard load
during defined duty cycle.

Operating frequency accuracy Measure of the ability of the transmitter to operate on its assigned frequency.

Unwanted emissions (ACPR) Ratio of the total power of a transmitter under prescribed conditions and modulation to
that of the output power that falls within a prescribed bandwidth centered on the nominal
frequency of adjacent channels.

Frequency deviation Measurement of the amount of frequency deviation that results for a Low Deviation
and High Deviation test pattern.

Modulation fidelity Measures the degree of closeness to which the modulation follows the ideal theoretical
modulation determined by the rms difference between the actual deviation and the
expected deviation for the transmitted symbols.

Symbol rate accuracy Measures the ability of the transmitter to operate at the assigned symbol rate (4.8 kHz
for Phase 1, 6 kHz for Phase 2).

Transmitter power and
encoder attack time

Measures the time required for a transmitter to prepare and transmit information on the
radio channel after changing state from standby to transmit (applies to conventional
mode).

Transmitter power and
encoder attack time with
busy/idle operations

Measures the time required for a transmitter to prepare and transmit information on the
radio channel after the receiving channel changes state from busy to idle.

Transmitter throughput delay Measures the time it requires for audio changes in the microphone to be encoded and
transmitted over the air.

Transient frequency behavior Measures the difference of the actual transmitter frequency and assigned transmitter
frequency as a function of time when the RF output power is switched on or off.

HCPM transmitter logical
channel time alignment

Measures the ratio of total transmitter power under prescribed conditions and modulation
to the peak power that falls in a prescribed bandwidth centered on the nominal frequency
of the adjacent channel during the transmitter power ramping interval.

xxx

Bluetooth measurements

Measurement Description

Modulation characteristics Verifies that the modulation characteristics of the transmitted signal are correct. This
measurement can only be done if the payload has the bit pattern 10101010 or 11110000.

Carrier frequency offset and
drift

Verifies that the carrier frequency offset and carrier drift of the transmitted signal is within
the specified limits for the Basic Rate and Low Energy standards. This test can be done
only if the payload contains 10101010 bit pattern.
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Measurement Description

Output power Verifies the maximum peak and average power emitted from the EUT. The standard
recommends this test be done for a PRBS payload pattern.

In-band emission / ACPR Verifies that the in-band spectral emission is within limits. The standard document
recommends that this measurement be done with Hopping off, finding the integrated
power in 1 MHz band (with RBW 100 kHz) in 80 channels starting from 2401 MHz to 2481
MHz. The integrated power values calculated in the adjacent channels are compared
against recommended limits (except the three channels around transmitted frequency).
This measurement is referred to as ACPR in the Basic Rate standards document.

20 dB bandwidth Verifies if the emissions inside the operating frequency range are within limits. This
measurement is done with Hopping off. The difference between frequency points at
which the power level drops to 20 dB below the peak power of the emission is found as
20 dB bandwidth.

Frequency range These measurements verify if the emissions inside the operating frequency range are
within the limits.

Power density This measurement verifies the maximum RF output power density.

Out-of-band spurious emission This measurement can be done for FCC or ETSI masks using the Spurious display.

Relative power Verifies the relative power in the GFSK and PSK part of the Enhanced Data Rate signal.
This measurement is supported only when an Enhanced Data Rate signal is detected.

xxx

LTE measurements

Measurement Description

Cell ID detection The Cell ID is detected from the input LTE signal.

For TDD and FDD.

Adjacent Channel Leakage
Ratio (ACLR)

The Adjacent Channel integrated power is calculated and shown. The relative power
compared to the reference signal is also computed. The computed power is compared
against limits suggested by the selected standard and pass/fail is reported.

For TDD and FDD.

Channel Power The channel power is calculated in the channel bandwidth.

For TDD and FDD.

Occupied Bandwidth The Occupied bandwidth is calculated as bandwidth containing 99% of the total
integrated power in the selected span around the selected center frequency.

For TDD and FDD.

Operating Band Unwanted
Emission

The power in the offset regions is calculated and presented and compared against limits
set in the offset and limits table and pass/fail is reported.

For TDD and FDD.

TOFF The power in off-slot region is computed and compared against selected limits.

For TDD only.

xxx

Pulse measurements

Measurement Description

Average ON Power The average power transmitted during pulse on.

Peak Power Maximum power during pulse on.
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Measurement Description

Average Transmitted Power The average power transmitted, including both the time the pulse is on and the time
it is off, and all transition times.

Pulse Width The time from the rising edge to the falling edge at the –3 dB / –6 dB level (50%) of the
user selected 100% level. Level is user selectable for Volts or Watts.

Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user
selected 100% level.

Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user
selected 100% level.

Repetition Interval The time from a pulse rising edge to the next pulse rising edge.

Repetition Rate The inverse of repetition interval.

Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.

Duty Factor (Ratio) The ratio of the pulse width to the pulse period.

Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot,
overshoot, or undershoot. By default, the first 25% and the last 25% of the pulse top is
excluded from this measurement to eliminate distortions caused by these portions of
the pulse.

If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements
for the analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple
results will be in %Watts. The default for the general Units control is dBm, so the Ripple
results default is %Watts.

See also Ripple (see page 736).

Ripple dB The Ripple measurement expressed in dB.

Droop Droop is the power difference between the beginning and the end of the pulse On time. A
straight-line best fit is used to represent the top of the pulse. The result is a percentage
referenced to the Average ON Power.

Droop dB The Droop measurement expressed in dB.

Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units
are %Watts or %Volts.

Overshoot dB The Overshoot measurement expressed in dB.

Pulse-ref-Phase Difference The phase difference between the current pulse and the first pulse in the analysis
window. The instantaneous phase is measured at a user-adjustable time following the
rising edge of each pulse.

Pulse-ref Freq Difference The difference between the frequency of the current pulse and frequency of the previous
pulse. The instantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

RMS Freq Error The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time
trace, computed over the Measurement Time.

Max Freq Error The maximum frequency error is the difference between the measured carrier frequency
of the signal and the user-selected center frequency of the analyzer.

RMS Phase Error The RMS Phase Error measurement is the RMS average of the Phase vs Time trace,
computed over the Measurement Time.
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Measurement Description

Max Phase Error The phase is measured at each point during the pulse's ON time. The phase error for
each point is the difference between the measured phase value and the calculated ideal
phase value. After the phase error is calculated for all points in the acquisition record,
the largest error in the positive direction and the largest in the negative direction are
determined. Whichever of these two values has the greater absolute value is designated
the Max Phase Error.

Freq Deviation The Frequency Deviation measurement is the difference between the maximum and
minimum measured values of the signal frequency during the Measurement Time.

Phase Deviation The Phase Deviation is the difference between the maximum and minimum Phase values
measured during the ON time of a pulse.

Impulse Response Amplitude The difference in dB between the levels of the main lobe and highest side lobe.

Impulse Response Time The difference in time between the main lobe and highest side lobe.

Absolute Frequency The absolute pulse frequency measured at a point specified by the user. The
measurement includes carrier frequency as well. The measurement point should be
within the pulse width, starting from the 50% point.

Pulse-Pulse Frequency
Difference

The difference between the frequency of the current pulse and frequency of the previous
pulse. The instantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

Pulse-Pulse Phase Difference The phase difference between the selected pulse and the first pulse in the analysis
window. The instantaneous phase is measured at a user-adjustable time following the
rising edge of each pulse.

xxx
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Overview

The displays in General Signal Viewing (Displays > Measurements > General Signal Viewing) are:

Amplitude vs Time

DPX Spectrum

Frequency vs Time

Phase vs Time

RF I & Q vs Time

Spectrogram

Spectrum

Time Overview

These displays provide extensive time-correlated multi-domain views that connect problems in time,
frequency, phase and amplitude for enabling you to more quickly understand cause and effect when
troubleshooting.

TIP. See the Features by product (see page 13)topic for more information about which features are
available with which connected analyzers.

DPX Display Overview

The DPX display enables you to see how traces change over time and thus displays signal events that
cannot be seen on a swept spectrum analyzer. A DPX Spectrum indicates how traces change in two ways.
First, it uses color shading to show how consistent the shape of a trace is. Second, it uses persistence to
hold signals on the screen so you can see them longer.

Read more about the DPX display in the following topics:

DPX Display (see page 49)

DPX Settings (see page 55)

DPX Display

The DPX display works by using a two-dimensional array to represent points on the display. Each time a
trace writes to a point on the display, a counter in the array is incremented. A color is assigned to each point
in the display based on the value of its counter. Thus, as acquisitions occur over time, a colored waveform,
the Bitmap, develops on the display that shows how frequently each display point has been written to.
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An important feature of the DPX display is dot persistence. Dot persistence sets how long a point on the
display will be visible. You can set the Dot Persistence to be Variable or Infinite. In variable persistence
mode, you specify a decay period that limits how long a point will be displayed. In infinite persistence
mode, once a point in the display has been written to, it will remain visible indefinitely.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

The DPX display can plot the trace in the following views:

Spectrum – This view plots power on the vertical axis versus frequency on the horizontal axis. This
display is similar to a standard Spectrum display. In SignalVu-PC, this display appears as part of the
Split view. In the Split view, the only trace that can be displayed is the Ogram Line.

DPXogram (available when an RSA306, RSA306B, RSA500A series, or RSA600A series instrument
is connected) - This view is a spectrogram version (time plotted along the vertical axis versus
frequency on the horizontal axis) of the DPX Spectrum trace. DPX spectrogram (on the instrument
that created the DPX acquisition data) creates the spectrogram in real time, and does not require an
acquisition to be transferred into memory and analyzed. Because of this real time processing, there are
no gaps in the spectral lines, even for monitoring periods that can last for several days.

Split - This view consists of two DPX views. A DPXogram view appears on the top half of the display
and a DPX Spectrum view appears on the bottom half of the display.

To display a DPX view:

1. Recall a DPX waveform acquisition data file.

2. Select Frequency and set the measurement frequency.

3. Select the Displays icon or Setup > Displays. This displays the Select Displays dialog box.

4. From theMeasurements box, select General Signal Viewing.

5. Select DPX from the Available displays box.

6. Click the Add button. This will add the DPX icon to the Selected Displays box (and remove it from
the Available displays box).

7. Click the OK button. This displays the DPX Spectrum view.

SignalVu-PC will display the Split view of the recalled acquisition data.
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DPX Split View

Elements of the DPX Display

Item Display element Description

1 Vert Position Sets the top of graph value. This is only a visual control for panning the graph.
The Reference Level is adjusted in the Toolbar and the Ampl control panel. By
default, Vert Position = Ref Level.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its value is
italicized.

SignalVu-PC Printable Help 51



General Signal Viewing DPX Display

Item Display element Description

4 DPX view Selects the DPX view. Choices are Spectrum, Zero Span, Frequency, Phase,
DPXogram, and Split.

5 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on screen.

6 Pos/CF Spectrum: Center Frequency - Adjusts the analyzer center frequency. For Zero
Span, Frequency, or Phase the Position is in seconds.

7 Span/Scale, Sweep/Scale Spectrum display: Span - Adjusts frequency range of the measurement. Scale - If
Horizontal scale has been manually adjusted in Settings > Scale, then this control
adjusts the visual graph scaling without affecting the Span. Zero Span, Frequency,
Phase displays: Sweep - adjusts the trace duration in seconds. Scale - adjusts the
visual graph scaling without affecting the Sweep time.

8 Clear Erases the bitmap and traces in the graph and restarts multi-trace functions
(Avg, Hold).

9 Function Readout of the Detection and Function selections for the selected trace.

10 Show Controls whether the selected Trace is visible or not. When trace is Off, the box is
not checked.

11 Trace Selects a trace. Touching here pops up a context menu listing the available
traces, whether they are enabled or not. If user selects a trace that is not currently
enabled, it will be made enabled.

xxx

Additional Elements of the DPXogram Split Display

This display is only available when an RSA306, RSA306B, RSA500A series, or RSA600A series
instrument is connected.
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Item Display element Description

1 Spectrums/line Appears only when the display is stopped. Readout of the number of spectrum
lines represented by each line of the DPXOgram display. This value changes
when the Time/div or Time resolution settings are changed.

2 Color scale Legend at the right side of the DPX Spectrum display. This element illustrates the
relationship between the colors in the DPXogram plot and the amplitude axis of the
DPX Spectrum plot. This scale changes with Color (DPXogram) palette selection
and Max and Min settings on the Ampl Scale tab.

3 DPXogram trace The selected line in the DPXogram graph can be shown in the DPX Spectrum
graph of the Split view. The most recent DPXogram line, usually at the bottom
of the graph, is selected by default. If any markers are on, the selected marker
determines the selected line.

xxx

Time Resolution of DPXogram Display

Due to the large amount of data produced by the DPX hardware during acquisitions, a compressed version
of the plot is shown while running. This plot is limited to 500 lines, with each line having 267 points.
However, a much longer record, with higher frequency resolution is being collected. As soon as the
instrument is stopped, this underlying data is shown, replacing the temporary version. There are 50 lines
in each vertical division of the 2-D DPXogram plot, so the time resolution of the graph is Time/div
divided by 50. However, you can set the instrument to collect multiple spectra per line, allowing you to
zoom in later on this high-time-resolution data.

When the DPXogram display is stopped, the analyzer can display the full resolution of the captured data.
The Time Resolution readout applies only when the DPXogram is running.

Effects of Changing Time Resolution. The Time Resolution control affects acquisition parameters for the
DPX hardware. This means that if you change the Time Resolution value while the instrument is stopped,
the new value applies to the NEXT acquisition, and might not represent the results currently shown in
the display.

Time resolution can be changed either directly, by manually adjusting the Time Resolution control, or
automatically, by changing the Time/div control. Auto is the default, yielding one spectrum per line in the
display. When the Time Resolution is decreased below its auto value, multiple spectra are collected to
create each line in the DPXogram graph. Once you stop the instrument, you can decrease the Time/div
value or use Zoom to see increased time resolution.

If the time resolution is set to a very small number while the Time/div is set to a large value, you might
notice that there is a limit to the number of spectra that can be collected. This limit depends on the number
of trace points selected. For 801-point spectra, 60,000 underlying spectra can be collected. The number of
2401-point spectra collected is 20,000, and for 4001-point spectra the number is 12,000. When the limit is
reached, the oldest spectra are discarded as newer spectra are captured.
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Touchscreen Actions on Markers in the Graph Area

Action Description

Mouse click within 1/2 div. of
a marker

Selects the marker and updates the marker display to show the selected marker's values.

Click on a marker to select
and then use the arrow keys
to move the marker

Adjust the setting associated with the Marker.

Click and drag a marker Changes marker position to the "drop point". You can use Tools > Options > Prefs to
change whether markers jump from one peak to the next while dragging or move smoothly
along the trace.

xxx

Available Traces for Display in SignalVu-PC

The DPX display shows two types of displays, the DPXogram and Split display. The Split display consists
of a DPXogram display on the top half of the display and a DPX Spectrum display on the bottom half of
the display.

For the DPXogram display, only one trace is available – the DPXogram trace.

For the Split display, the DPX Spectrum display shows only the Ogram Line (the selected line in the
DPXogram display) on the bottom half of the display.

NOTE. The DPXogram display is only available when an RSA306, RSA306B, RSA500A series, or
RSA600A series instrument is connected.

Reference. Changing the DPX Spectrum Display Settings (see page 522)
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DPX Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The measurement settings for the DPX display are shown in the following table.

Settings tab Description

Freq & Span (see page 88) Sets frequency and span parameters for the DPX display. This tab appears for the
Spectrum and DPXogram displays.

BW (see page 92) Sets Resolution Bandwidth.

Traces Tab Allows you to select the number and types of traces to display and their functions.

Horiz & Vert Scale Tab (see
page 60)

Sets the vertical and horizontal scale parameters for all the DPX views.

Bitmap Scale Tab (see
page 61)

Sets the DPX Bitmap display parameters.

Prefs (see page 95) Specifies whether certain display elements are visible.

Density (see page 62) Specifies location and size for the DPX Density measurement box. (Spectrum display
only.)

xxx

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

Traces Tab - Bitmap

The Traces Tab allows you to set the display characteristics of displayed traces in the DPX display.
The Traces tab for the DPX display has two versions: one for the DPX Bitmap trace (described in this
topic) and one for line traces .

Traces tab – Bitmap trace
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NOTE. The DPXogram display is only available when an RSA306, RSA306B, RSA500A series, or
RSA600A series instrument is connected.

Traces tab settings for the bitmap trace

Setting Description

Trace Select Bitmap or DPXogram to set the parameters of the DPX Bitmap or DPXogram trace.

Show Specifies whether or not the selected trace is displayed.

Detection (DPXogram trace
only)

Sets the Detection method (see page 89) used for the trace. Available detection methods
are +Peak, -Peak, and Avg (VRMS).

Intensity (standard instrument
only)

Use Intensity to control the visibility of events. An increased intensity level allows a
single, short event to be seen. This also makes such an event subject to the persistence
controls. This allows you to see the effect of the Persistence controls on infrequent
events. Range is 1-100%. Resolution: 1.

Dot Persistence Allows a dot to remain visible if it is not updated with new data. Choices for this setting
are Variable and Infinite (not available for the DPXogram trace).

Variable The Variable dot persistence setting controls how long a point in the display is visible
before fading (not available for the DPXogram trace).

Range: 100 ms – 60 s. Resolution 0.1.

Infinite The Infinite dot persistence setting prevents a point in the display from fading (not
available for the DPXogram trace).

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show Recalled Trace Displays a saved trace instead of a live trace (not available for the DPXogram trace).

xxx

Dot Persistence

Dot Persistence is the characteristic of the DPX display that determines how long a pixel in the display
remains visible.

To set the Persistence:

1. Select Setup > Settings.

2. Select the Traces tab.

3. Select Dot Persistence.

4. Select either Infinite or Variable.

5. If you select Variable, enter a value in the text box. The Variable persistence value can be set from
0.05 to 100 seconds.

Saving Traces

To save a trace for later analysis:
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1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the location where you want to save the file.

3. Type a name for the saved trace and click Save.

Show Recalled Trace

You can recall a previously saved trace for comparison to a live trace. First, specify a trace for recall and
second, enable Show Recalled Trace.

To select a trace for recall:

1. Select the ... button to display the Open dialog box.

2. In the Open dialog, navigate to the location of the saved trace.

3. Select the desired trace file.

4. Select OK to complete your selection.

5. Select the Show recalled trace check box.

6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Traces Tab – DPX Ogram

The Traces Tab allows you to set the display characteristics of the DPXOgram and Ogram traces in
the DPX display when DPXOgram is selected.

NOTE. The DPXogram display is only available when an RSA306, RSA306B, RSA500A series, or
RSA600A series instrument is connected.
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Setting Description

Trace drop-down list Selects which trace to configure. In SignalVu-PC, the only configurable traces are
DPXogram and Ogram.

Show Specifies whether or not the trace shown in the Trace setting is displayed.

Freeze Halts updates to the selected trace.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak,
-Peak, and Avg (VRMS).

Save Trace As Saves the Ogram trace to a file for later recall and analysis.

xxx

Detection

Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

NOTE. The Detection setting does not affect the trace until the spectrum length is longer than the Auto
setting.

Saving Traces

To save an Ogram trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
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2. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for comparison to a live trace. First, specify a trace for recall and
second, enable Show Recalled Trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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Horiz & Vert Scale Tab

The Horiz & Vert Scale tab allows you to change the vertical scale settings used for the Bitmap trace.
Changing the scale settings changes how the trace appears on the display but does not change control
settings such as Measurement Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale.

Offset Adjusts the Reference Level away from the top of the trace display.

Reset Scale Sets Scale to its default value and Offset to zero. Disabled when Units (Setup > Analysis
> Units) is set to Watts or Volts.

Autoscale Resets the scale of the vertical axis to contain the complete trace. Disabled when Units
(Setup > Analysis > Units) is set to Watts or Volts.

Horizontal Controls the horizontal position and scale of the trace display.

Scale Changes the horizontal scale.

Position Adjusts the horizontal position of the signal. This does not change the center frequency.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

xxx
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Bitmap Scale Tab

The Bitmap Scale tab allows you to set the color scheme used for the Bitmap trace. Changing the DPX
bitmap Color, Max and Min scale settings changes how the trace appears on the display but does not
change control settings such as Measurement Frequency.

Setting Description

DPX Bitmap (Signal Density) Controls the appearance and scale of the DPX Bitmap trace.

Color Allows you to select the color palette used for the DPX Bitmap trace.

Max Sets the hit density represented by the top of the color scale. "Clipping" occurs for
densities greater than this value.

Range: 1p% - 100%; Default: 100%.

Min Sets the hit density represented by the bottom of the color range. Range: 0 - 80%;
Default: 0.

Curve Adjusts how colors are mapped to the signal density. The mapping can be linear (Curve
= 1), or it can be set to concentrate the resolution on the lower level of the range (Curve >
1) or the mapping can be set to show the best resolution on the upper range of density
or hit count (Curve < 1).

Auto Color Adjusts the Max and Min settings to display the broadest range of colors.

xxx
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Density Tab

The Density tab specifies the parameters of the measurement box used for measuring average signal
density of an area in the bitmap. The measurement box is also used by DPX Density triggering.

To measure the average signal density over a rectangular portion of the DPX bitmap, you can adjust the
size and location of the measurement area using these controls, or by dragging the measurement box in
the graph. You move the box by dragging the readout. You adjust the size of the box by dragging the
corners or edges.

Setting Description

Show Measurement Shows or hides the measurement box in the graph when Triggering is not set to DPX
Density. If Triggering is set to DPX Density, the measurement box is always visible.

Frequency Specifies the frequency at the center of the measurement box. The +/- value specifies
the width of the measurement box.

Amplitude Specifies the amplitude of the center of the measurement box. The +/- value specifies
the height of the measurement box.

xxx

62 SignalVu-PC Printable Help



General Signal Viewing Time Overview Display

Time Overview Display

The Time Overview display shows the entire acquisition record and shows you how the spectrum time and
analysis time fit within the acquisition record. This enables you to see how you can adjust the spectrum
time and analysis time to measure portions of the data.

You can specify the maximum number of trace points in the Time Overview display. You can set the
maximum number of trace points to 1K, 10K, 100K, 1M points or to Never decimate. If the Acquisition
Length includes more than 10,000 sample points (and Max trace points is not set to Never decimate), the
trace is decimated (using the +Peak method, similar to +Peak detection in a Spectrum display) to 10,000
points. This decimated trace is what is used for marker measurements.

The Time Overview window displays the Spectrum Length and Analysis Length. The Spectrum Length
is the period of time within the acquisition record over which the spectrum is calculated. The Analysis
Length is the period of time within the acquisition record over which all other measurements (such as
Amplitude vs. Time) are made. The Spectrum Length and Analysis Length can be locked together so
that the data used to produce the Spectrum display is also used for measurement displays; however, they
do not have to be tied together. They are by default specified separately and used to analyze different
parts of the acquisition record.

Elements of the Time Overview Display
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Item Element Description

1 Time Select the type of time analysis to be performed. You can select Analysis,
Spectrum, or Linked.

2 Offset Sets the offset of the selected analysis time control.

3 Length Sets the length of the selected analysis time control.

4 Position and Scale Adjusts the vertical scale and position.

5 Scale indicators Shows the vertical scale.

6 Autoscale button Resets the horizontal scale to display the entire acquisition record and the
vertical scale to show all trace points.

7 Horizontal offset Adjusts the horizontal offset.

8 Results Timeline This fuchsia line indicates the portion of the record actually used for
calculating the selected result. For example: if a pulse measurement is
selected, it shows the period of the specific pulse. For a constellation display,
it shows the points included in the demodulation.

9 Amplitude vs. Time graph The trace represents the entire acquisition record (at full horizontal scale).
The graph indicates the Analysis Length or Spectrum Length on the graph
with a darker background.

10 Horizontal Scale Adjusts the span of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the acquisition record by adjusting
the offset.

11 Spectrum Length and Offset
Indicator (red line, top of
graph)

This red line indicates the Spectrum Length and Offset. The longer the time,
the longer the bar. Adjusting the offset shifts the bar left or right.

12 Analysis Length and Offset
Indicator (blue line, top of
graph below red line)

The blue line indicates the Analysis Length and Offset. The longer the time,
the longer the bar. Adjusting the offset shifts the bar left or right.

xxx

NOTE. The area with black background (not gray) in the Amplitude vs. Time Graph highlights the control
selected in the Analysis Time Control drop-down list.

Changing the Time Overview Display Settings (see page 64)

Time Overview Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for Time Overview are shown in the following table.
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Settings tab Description

Scale (see page 94) Adjusts the vertical and horizontal scale and offset of the display.

Trace (see page 67) Allows you to select the types of trace to display and its function.

Prefs (see page 95) Specifies whether or not certain display elements are shown.

xxx
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Navigator View

The Time Overview Navigator View places the Time Overview display across the top of the application
screen. This allows you to adjust the area of interest in the Navigator View and see the results
simultaneously in the other displays. For example, in the following image, adjusting the mask in the
Navigator View moves the trace and markers in all of the other displays.

Show Navigator View

To show the Navigator View, select View > Navigator View. To remove the Navigator View, deselect
Navigator View in the View menu.
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Trace Tab

The Trace Tab allows you to set the display characteristics of displayed traces.

Setting Description

Show Shows / hides the selected trace.

Detection Sets the Detection method used for the trace. Not available for saved traces. Available
detection methods are +Peak, -Peak, +/-Peak, Avg (VRMS), and Sample. Not all
detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

(Number of Traces) Sets the number of traces averaged to generate the displayed trace. (Present only
when Function is set to Average.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

xxx

Detection

Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples
available to each trace point varies with both analysis length and trace length. For example, with Spectrum
Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one
IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the
available detection methods to differ in value because they have a larger set of samples for the various
detection methods to process.

The available detection methods (depending on the display) are:
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+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

+/-Peak – Selects the highest and lowest values of all the samples contained in two consecutive
acquisition intervals.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Sample – The result is calculated based on the first sample available in the set of IQ samples for
each trace point.

Trace Processing

Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace. There is one vertical
value for each underlying frequency data point. Once the specified number of traces have been
acquired and averaged to generate the displayed trace, each new trace takes the place of the oldest
trace in the calculation. The Number of Traces setting specifies how many traces averaged.

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces

To save a trace for later analysis:

1. Select the Save icon . This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.
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To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.

5. Check the Show Recalled Trace check box.

6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Spectrum Display

To display a spectrum:

1. Click the Displays button or select Setup > Displays.

2. From the Measurements box, select General Signal Viewing.

3. Double-click the Spectrum icon in the Available displays box. This adds the Spectrum icon to the
Selected displays box (and removes it from the Available displays box). Alternatively, you can click
the Spectrum icon and then click the Add button to select Spectrum for display.

4. Click the OK button.
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Elements of the Spectrum Display

Item Display element Description

1 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

2 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its
value is italicized.

3 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab
(see page 92).

4 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on
screen.

5 Position Default function is CF - center frequency (equivalent to the Freq setting).
If Horizontal scaling has been manually adjusted in Settings > Scale, then
Offset will replace CF as the setting at the bottom-left corner of the screen.

6 Span / Scale Default function is Span - frequency difference between the left edge of
the display and the right edge. If Horizontal scaling has been manually
adjusted in Settings > Scale, then Scale will replace Span as the setting at
the bottom-right corner of the screen.

7 Clear Restarts multi-trace functions (Avg, Hold).

8 Function Readout of the Detection and Function selections for the selected trace.

9 Show Controls whether the selected Trace is visible or not. When trace is Off, the
box is not checked.

10 Trace Selects a trace. Touching here pops up a context menu listing the available
traces, whether they are enabled or not. If user selects a trace that is not
currently enabled, it will be made enabled.

xxx
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Changing the Spectrum Display Settings (see page 71)

Spectrum Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Spectrum display are shown in the following table.

Settings tab Description

Freq & Span (see page 88) Sets frequency and span parameters for the Spectrum Analysis display.

BW (see page 92) Sets Resolution Bandwidth and windowing parameters.

Traces (see page 89) Sets Trace display parameters.

Traces (Math) (see page 92) Sets the traces used to create the Math trace.

Scale Tab (see page 72) Sets vertical and horizontal scale and position parameters.

Prefs Tab (see page 95) Specifies whether or not certain display elements are shown.

xxx
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Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical

Scale Changes the vertical scale.

Position Vertical Position adjusts the top of graph amplitude value. This control allows you to
move (“pan”) the traces up and down in the graph without changing the Reference Level.

Autoscale Resets the Offset so that the trace appears below the top of the graph.

Horizontal

Scale Allows you to change the range of frequencies shown in the graph without changing the
span or measurement frequency.

Position Allows you pan the graph.

Autoscale Resets Scale to the Span setting.

Reset Scale Resets all settings to their default values.

Log scale Resets the display to show the frequency axis in a logarithmic scale.

xxx

Spectrogram Display

The Spectrogram is a display with the vertical axis (time) composed of successive spectral displays, each
having the amplitude represented by color or intensity. The horizontal axis represents frequency. The most
recently acquired spectrum results are added to the bottom of the spectrogram. The addition of a new
spectrum can occur at the fastest rate that new spectra can be plotted, or, if you choose, new spectra can be
added at a timed rate. The spectrogram view is well-suited to displaying long-term trends of spectral data.
The maximum number of lines that can be displayed in a spectrogram is 125,000.

The spectrogram can also be displayed in a 3-D waterfall format. In the 3-D waterfall format, the
spectrogram displays the time axis along a simulated Z-axis.

NOTE. Spectrogram data is shared with the Spectrum display. There is no linkage between DPX and
Spectrogram.
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To display a Spectrogram:

1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.

2. From theMeasurements box, select General Signal Viewing.

3. Double-click the Spectrogram icon in the Available Displays box. This adds the Spectrogram icon
to the Selected displays box.

4. Click the OK button. This displays the spectrogram view.

5. To display a 3-D version of the spectrogram, select the 3-D checkbox.

Elements of the Spectrogram Display
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Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Spectrogram display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Time/div Sets the length of time represented by each vertical division. Divisions are
indicated by tick marks along the left edge of the graph.

3 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its
value is italicized.

4 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab
(see page 92).

5 3-D checkbox Enables and disables the 3-D view.

6 Selected records indicators Shows the positions of the start and stop records selected on the Select data
records tab. Drag the indicators to select which records will be played by
Replay All. Note that these are not visible while acquisitions are running; the
instrument must be stopped for the indicators to be visible.

7 T Trigger indicator. This icon indicates the trigger point within the current
acquisition.

8 Pos Position indicates the bottom line visible in graph. Changing this setting
scrolls the window up and down through the displayed acquisition records.

9 Autoscale Resets Vertical and Horizontal scale and Pos to default values.

10 CF Sets the Center Frequency.

11 Span Sets the span of the spectrogram display.

12 Current data record indicator A blue line indicates the current data record. When the analysis length is
short, the blue line appears as a thin line much like the selected indicator
line. When the analysis length is relatively long, the blue line appears more
like a blue bar.

13 Position scroll bar Changes the position of the trace in the window. Changing the position scroll
bar is the same as adjusting the Pos setting.

14 Selected indicator This inverse-colored line indicates the Spectrogram line that will appear in
the Spectrum display when the Spectrogram trace is enabled. This line is
attached to the selected marker.

15 Clear Clears the spectrogram display; however, data records in acquisition history
remain in memory and are available for replay. To clear memory, select File >
Acquisition Data Info > Delete All Data.

16 Marker indicators These icons indicate the position of markers in the spectrogram. You can
move markers by dragging the desired marker indicator.

17 Detection setting Displays the selected Detection method (see Settings > Trace (see page 76)
tab).
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Item Display element Description

18 Marker readout Marker readout for the selected marker. In the Spectrogram display, the
marker readout includes a date and timestamp. The time is displayed
in a 24-hour format. The timestamp readout can be shown or hidden
independently of the other marker readouts (see Settings > Prefs (see
page 95)).

19 Time Scale status readout Three readouts can appear here depending on settings: Time/update,
Spectrums/line, and Overlap. See Time Scale Status Readout (see page 75).

xxx

Time Scale Status Readout

Three types of readouts can appear in the display depending on settings:

Time/update – Displays minutes:seconds when Spectrum Monitor is selected in the Settings > Time
& Freq Scale tab in the Vertical (Time) section.

Spectrums/line – Displays an integer number when vertical scale is Normal and each line contains the
results from one or more frequency transforms (whether zoomed out or not).

Overlap – Displays the overlap percentage when vertical scale is Normal and each line's transform
shares some points with the transforms of lines before and after it (zoomed in). Overlap can only be
done when the Analysis Length > 2x RBW frame length.

The Spectrogram can show results from one or multiple acquisitions and it can show one or multiple
lines for each acquisition.

Changing the Spectrogram Display Settings (see page 75)

Spectrogram Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for the Spectrogram display are visible when Spectrogram is the selected display.

Settings tab Description

Freq & Span (see page 88) Sets frequency and span parameters for the Spectrogram display.

BW (see page 92) Sets Resolution Bandwidth and windowing parameters.

Trace (see page 76) Sets Trace display parameters.

Amplitude Scale (see page 77) Selects between 2-D and 3-D, sets height scale, position and orientation for 3-D display.
Sets color parameters for the spectrogram trace.

Time & Freq Scale (see
page 77)

Sets the vertical and horizontal scale parameters for the spectrogram trace. The
Spectrum Monitor controls are also on this tab.

Prefs (see page 95) Specifies whether or not certain display elements are shown.

xxx
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Trace Tab

The Spectrogram Trace tab controls let you specify the Detection method, save traces, and recall saved
traces for display. The Spectrogram Trace tab does not have all the controls that other Trace tabs contain,
however, it does have a unique display element, the Selected Line readout. For details on Detection,
Freeze, and saving and recalling traces, see the Traces Tab (see page 89).

Selected Line

Displays the time at the Selected Line. If Markers are enabled, the selected line is positioned by the
selected marker. If no markers are enabled, the selected line is the first line in the current analysis period.
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Amplitude Scale Tab

The Amplitude Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D
Waterfall display, and set the color scheme used for the spectrogram trace.

Setting Description

Height (3-D only)

Scale Changes the vertical scale for trace Amplitude in the graph (not the vertical scale for
Time).

Position Specifies the level displayed at the bottom edge of the graph. (Bottom front edge in
the 3-D view).

Autoscale Adjusts the vertical position and scale of the trace lines to bring them into the visible
portion of the graph.

3–D Waterfall Displays the spectrogram in a 3-D format.

Northeast Shifts the perspective of the 3-D graph so that the oldest traces move back and to the
right.

Northwest Shifts the perspective of the 3-D graph so that the oldest traces move back and to the left.

Reset Scale Resets the Height and Color settings to their default values.

Color (Power)

Color Displays a drop-down list that allows you to set the color scheme used for the
spectrogram trace.

Max Sets the maximum power level represented by the top of the color scale.

Min Sets the minimum power level represented by the bottom of the color scale.

xxx

Time & Freq Scale Tab

The Time and Freq Scale tab allows you to change the vertical and horizontal scale settings, enable the 3-D
Waterfall display, and set the color scheme used for the spectrogram trace.
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Setting Description

Vertical (Time)

Normal For most Spectrogram applications. Primary time scale control is Time/div. Time scale
can be zoomed in or out.

Spectrum Monitor For long-term signal monitoring applications. In spectrum monitor mode, each line in the
spectrogram represents the period of time specified by the Time/update parameter. Time
scale can be zoomed out, but not zoomed in (no overlap).

Time/update Sets the time, in minutes and seconds, represented by each line of the spectrogram.
Only available in Spectrum Monitor.

Reset Scale Resets the Time/div and Pos settings to their default values.

Autoscale Scales the vertical (time) axis to compress all existing trace lines into the visible area
of the graph. Resets the Position value to zero, placing the most recent spectrogram
line at the bottom of the spectrogram display. Only Position is affected by Autoscale
when Spectrum Monitor is selected.

Time/div Sets the time displayed per division.

Visible elapsed time Displays the length of time visible in the display. This does not represent the total time
available to view.

Position Adjusts vertical position of the trace within the graph area. Setting represents the offset,
in divisions, between the bottom of the graph and the bottom (most recent) line in the
results trace.

Time at position Displays the time of the spectrogram line shown at the bottom of the graph. This time is
relative to the Time Zero Reference of the current acquisition.

Horizontal (Frequency)

Scale Sets the frequency range of the graph without changing the Span value.

Position Sets the frequency displayed at the center of the graph. Changing this value does not
change the Freq setting.

Autoscale Sets the frequency scale to the Spectrogram Span value.

xxx

Spectrum Monitor

Spectrum Monitor performs long term monitoring. The monitor mode compresses time into each line
of the spectrogram, which enables you to monitor long periods of time (from 1 second per line up to
600 minutes per line). With extended memory (Option 53) installed in the instrument, you can capture up
to 125,000 lines. With standard memory installed in the instrument, the maximum number of lines you
can capture is 31,250.

During each line's collection period, spectrum transforms are computed for each acquisition taken by the
instrument. As each transform completes, it is incorporated into the current spectrogram line. How each

78 SignalVu-PC Printable Help



General Signal Viewing Amplitude Vs Time Display

line of the spectrogram is created in spectrum monitor mode depends on the detection setting (Settings >
Trace). For example, if Detection is set to +Peak, each spectrogram line is effectively a peak hold display
of all the spectral data captured since the prior line.

Amplitude Vs Time Display

The Amplitude vs. Time display plots the signal amplitude against time. The amplitude appears on the
vertical axis while time is plotted along the horizontal axis.

Note that the trace(s) in the Amplitude vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To show Amplitude vs. Time display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in theMeasurements box.

3. In the Available displays box, double-click the Amplitude vs. Time icon or select the icon and click
Add. The Amplitude vs. Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

4. Click OK.

Elements of the Display
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Item Display element Description

1 Vertical scale adjustment Adjusts the vertical scaling.

2 Span Adjust the bandwidth of the data to be analyzed. (Not the period of time
shown in the display.)

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Offset Adjust the horizontal offset.

5 Max and Min readouts Displays the maximum and minimum amplitudes, as well as when those
values occur.

6 Scale Sets the time spanned by the graph.

7 Clear button Restarts multi-trace functions (Avg, Hold).

8 Trace function Displays the current trace function setting (Settings > Trace tab > Function).

xxx

Reference. Changing Amplitude vs Time Display Settings (see page 80)

Amplitude Vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Amplitude vs. Time display are shown in the following table.

Settings tab Description

Freq & BW (see page 81) Sets the Bandwidth Method used for setting the measurement bandwidth.

Traces (see page 89) Allows you to select the type of trace to display and their functions.

Traces (Math) (see page 92) Sets the traces used to create the Math trace.

Scale (see page 94) Sets the vertical and horizontal scale parameters.

Prefs (see page 95) Specifies whether certain display elements are visible.

xxx
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Freq & BW Tab

The Freq & BW (Bandwidth) tab allows you to specify the bandwidth parameters used for setting
measurement bandwidth. This determines what Acq BW the measurement will request.

Settings
Description

xxx

Frequency Vs Time Display

The Frequency vs. Time Display shows how the signal frequency varies with time.

Note that the trace(s) in the Frequency vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To display the Frequency vs. Time Display:

1. Select the Displays button or Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in theMeasurements box.

3. In the Available displays box, double-click the Frequency vs. Time icon or select the icon and click
Add. The Frequency vs. Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

4. Click OK to display the Freq vs. Time display.
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Elements of the Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the frequency range displayed on the vertical axis.

2 Offset adjustment Adjusts the frequency shown at the center of the display.

3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the
best display.

4 Maximum and Minimum
frequency readouts

Displays the maximum and minimum values, as well as when those values
occur.

5 Horizontal Scale Sets the time spanned by the graph.

6 Clear button Restarts Average trace.

7 Trace function Displays the current trace function setting (Settings > Trace > Function).

xxx

Changing Frequency vs Time Display Settings (see page 82)

Frequency Vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for Frequency vs. Time are shown in the following table.
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Settings tab Description

Freq & BW (see page 87) Sets the frequency and bandwidth parameters.

Trace (see page 89) Sets the trace display parameters.

Scale (see page 94) Sets the Vertical and Horizontal scale and offset parameters.

Prefs (see page 95) Specifies whether certain display elements are visible.

xxx

Phase Vs Time Display

The Phase vs. Time display plots the signal phase against time. The phase appears on the vertical axis
while time is plotted along the horizontal axis.

Note that the trace(s) in the Phase vs. Time display can be set to a maximum of 100,000 points (however,
the actual number of trace points can extend up to 1,000,000 points if Max trace points is set to Never
Decimate). If the Analysis Length includes more than the selected Max trace points value, the trace is
decimated (using the method specified with the Detection control) to be equal to or less than the Max trace
points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export. You can set the Max trace points
on the Settings > Prefs tab.

To display Phase vs. Time:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in theMeasurements box.

3. In the Available displays box, double-click the Phase vs. Time icon or select the icon and click
Add. The Phase vs. Time icon will appear in the Selected displays box and will no longer appear
under Available displays.

4. Click OK to show the Phase vs. Time display.
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Elements of the Display

Item Display element Description

1 Top of graph adjustment Adjusts the vertical scale. Use the knob to adjust the value of the top of the
graph.

2 Vertical offset adjustment Adjusts the phase error shown at the vertical center of the display.

3 Autoscale button Adjusts the vertical and horizontal settings so that the entire trace fits in the
view.

4 Horizontal Offset Adjusts the horizontal position of the trace.

5 Max and Min readouts Displays the maximum and minimum value of the phase error within the
analysis times and the times at which they occurred.

6 Horizontal Scale Sets the time spanned by the graph.

7 Clear button Restarts multi-trace functions (Avg, Hold).

8 Trace function Shows the trace function as set on the Settings > Trace tab.

xxx

Changing the Phase vs Time Display Settings (see page 84)

Phase Vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Phase vs. Time display are shown in the following table.
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Settings tab Description

Freq & BW (see page 87) Sets the frequency and bandwidth parameters.

Trace (see page 89) Sets the trace display parameters.

Scale (see page 94) Sets the Vertical and Horizontal scale and offset parameters.

Prefs (see page 95) Specifies whether certain display elements are visible.

xxx

RF I & Q vs Time Display

This is a plot of the baseband In-Phase (I) and Quadrature (Q) components of a modulated carrier. The plot
is in the time domain, with I and/or Q values the Y-axis.

Note that the trace(s) in the RF I & Q vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To display an RF I & Q vs. Time display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From theMeasurements box, select General Signal Viewing.

3. Double-click the RF I&Q vs. Time icon in the Available Displays box. This adds the RF I & Q vs.
Time icon to the Selected displays box.

4. Click the OK button.
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Elements of the Display

Item Display element Description

1 Top of Graph adjustment Use the knob to adjust the vertical scaling.

2 Vertical offset adjustment Adjusts the level shown at the center of the display.

3 Autoscale button Adjusts the offset and scale for both vertical and horizontal to provide the
best display.

4 Maximum and Minimum level
readouts

Displays the maximum and minimum values, within the Analysis Time, as well
as the times at which they occurred.

5 Scale Sets the time spanned by the graph.

6 Clear button Restarts multi-trace functions (Avg, Hold).

7 Trace function Displays the current trace function setting (Settings > Trace > Function). If the
traces are averaged, the number of averages is displayed.

8 Trace Control Selects which trace is displayed (using the drop-down list) and which trace is
active (click on the trace name to display a menu).

xxx

Changing the RF I & Q vs Time Display Settings (see page 86)

RF I & Q vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for RF I&Q vs. Time are shown in the following table.
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Settings tab Description

Freq & BW (see page 87) Sets the frequency and bandwidth parameters.

Trace (see page 89) Sets the trace display parameters.

Scale (see page 94) Sets the Vertical and Horizontal scale and offset parameters.

Prefs (see page 95) Specifies whether certain display elements are visible.

xxx

General Signal Viewing Shared Measurement Settings

The control panel tabs in this section are identical or very similar for each of the displays in the General
Signal Viewing folder (Setup > Displays). Some tabs are shared by all the displays, some tabs are shared
by only a couple of displays.

For some tabs, the control values are shared across all the General Signal Viewing displays. For other
control values, each display has unique values for the controls. Details are provided for the specific tabs.

Common controls for general signal viewing displays

Settings tab Description

Freq & Span (see page 88) Sets the frequency and span parameters.

Trace (see page 89) Sets the trace display parameters.

Traces – Math (see page 92) Sets the traces used to create the Math trace.

BW (see page 92) Sets the Bandwidth Method used for setting the measurement bandwidth.

Scale (see page 94) Sets the Vertical and Horizontal scale and offset parameters.

Prefs (see page 95) Specifies whether certain display elements are visible.

xxx

Freq & BW Tab — Freq vsTime, Phase vs Time, RF I & Q vs Time Display

The Freq & BW tab provides access to settings that control frequency settings for the Freq vs Time, Phase
vs Time, RF I & Q vs Time display.

SignalVu-PC Printable Help 87



General Signal Viewing Freq & Span Tab

Setting Description

Measurement Freq The frequency at the which measurements are made. This value is the same as the
setting for Frequency in the Application bar.

Measurement BW This control limits the bandwidth of measurements. You use the measurement bandwidth
setting to improve the signal-to-noise ratio of the measurement, resulting in lower
measurement uncertainty. However, if the measurement bandwidth is set too low,
resulting in fewer samples per second, it can reduce the number of points within the
measurement length below the 256 stable samples required, thus causing the analysis
to fail.

Link to Span When enabled, the measurement bandwidth of the RF I & Q display is determined by
the span of the analyzer. When unchecked, the measurement bandwidth is specified by
the user, and no additional filter is applied.

Set to max BW Sets the measurement bandwidth to the maximum acquisition bandwidth of the
instrument.

xxx

Freq & Span Tab

The Freq & Span tab provides access to settings that control frequency settings for the trace display. The
control values set in this tab are shared by all the General Signal Viewing displays.

Setting Description

Center The frequency at the center of the selected Span.

Start The lowest frequency in the span.

Stop The highest frequency in the span.

Step Size Sets the increment/decrement size for Center, Start and Stop values.

Span The difference between the start and stop frequencies. This is the measurement
bandwidth for the general signal viewing displays.

Max Span Sets the Span to the maximum value.

xxx

Center, Start, Stop, and Span Frequencies Are Correlated

Changing the values for Center frequency, Start frequency, Stop frequency or Span will change the values
for the other settings, depending on which setting you change. For example, if you change the Center
frequency, the Start and Stop frequencies will be adjusted automatically to maintain the same Span.

Note however that if the Start and Stop frequencies are changed so that they are closer than the minimum
span setting, the Start and Stop frequencies will be adjusted to maintain the minimum Span setting.

Setting Changed Manually Settings Changed Automatically As
a Result

Setting Not Automatically Changed

Start Center, Span Stop

Stop Center, Span Start

Center Start, Stop Span

Span Start, Stop Center

xxx
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Traces Tab

The Traces Tab allows you to set the display characteristics of displayed traces.

Setting Description

Trace Selects a trace. (This setting is not present for every display.)

Show Shows / hides the selected trace.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

Count Sets the number of traces averaged to generate the displayed trace. (Present only when
Function is set to Average, Min Hold, or Max Hold.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

xxx

Trace

Available traces for Spectrum are: Trace 1, Trace 2, Trace 3, Math, and Spectrogram. Other displays
support fewer traces. Traces 1-3 are based on the input signal and enable you to display the input signal
using different processing. For example, you could display Trace 1 with Function set to Normal, Trace 2
with Function set to Max Hold and Trace 3 with Function set to Min Hold.

The Math trace is the result of subtracting one trace from another.

The Spectrogram trace applies only to the Spectrum display and is available only if the Spectrogram
display is shown. The Spectrogram trace shows the trace selected in the Spectrogram as a spectrum trace.

Detection

Trace Detection is used to reduce the results of a measurement to the desired number of trace points. For
example, if the maximum number of trace points is 100,000, and a measurement over the selected analysis
length yields 200,000 points, the measurement must decimate these 200,000 trace points by 2 to prevent
exceeding the 100,000 trace point limit. Since only one value can be represented for each trace point, an
algorithm must be used to select (detect) the appropriate value to use.

The results array from an analysis can be detected (or “decimated”) in a variety of ways. The number
of results points produced for each trace point varies with both analysis length and trace length. For
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example, the frequency transform used for the Spectrum display produces just one output value for each
desired trace point. In this case, the detection method chosen has no effect, as no decimation is required.
Increasing the Analysis Length (or for the Spectrum display, the Spectrum Length), causes the available
detection method's output traces to differ from each other because they have a larger set of samples for the
various detection methods to process.

The available detection methods (depending on the display) are:

+Peak – The highest value is selected from the results to be compressed into a trace point.

-Peak – The lowest value is selected from the results to be compressed into a trace point.

+/-Peak – Both the highest and lowest values are selected from the results to be compressed into a
trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the results values it includes. When displayed in either linear (Volts, Watts) or Log (dB,
dBm), the correct RMS value results.

Avg (of logs) – The detector is used to emulate legacy spectrum analyzer results and for the
specification of displayed average noise level. In older swept analyzers, a voltage envelope detector is
used in the process of measuring signal level, and the result is then converted to Watts and then to
dBm. Averaging is then applied to the resultant traces.

For CW signals, this method results in an accurate power measurement. However, with random noise
and digitally modulated carriers, errors result from this 'average of logs' method. For random noise,
the average of logs methods results in power levels -2.51 dB lower than that measured with a power
meter, or with a signal analyzer that measures the rms value of a signal, and performs averaging on the
calculated power in Watts and not dBm or other log-power units.

This detector should be used when following a measurement procedure that specifies it, or when
checking the Displayed Averaged Noise Level (DANL) of the instrument. The 'average of logs'
detection and trace function is used for DANL specification to provide similar results to other
spectrum/signal analyzers for comparison purposes. Use of the Average of Logs method of
measurement is not recommended for digitally modulated carriers, as power measurement errors
will occur.

NOTE. The Detection setting does not affect the trace until the spectrum length is longer than the Auto
setting.

Sample – The first value is selected from the set of results to be compressed into a trace point.

CISPR Peak – The trace value is calculated by the methods described for peak detectors in the
CISPR documents.

Trace Processing

Traces can be processed to display in different ways. The Function setting controls trace processing.
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Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace, which will contain just
one vertical value for each underlying frequency data point. Once the specified number of traces have
been acquired and averaged to generate the displayed trace, additional traces contribute to the running
average, except in Single Sequence run mode. In the case of Single Sequence, the instrument stops
running after the specified number of traces have been averaged together. The Number of Traces
setting specifies how many traces are averaged. The averaging is performed on the linear (Voltage)
values, resulting in the correct RMS average).

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace's
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace's
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.
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5. Check the Show Recalled Trace check box.

6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Traces Tab - Math Trace

This tab is not a distinct tab, it is just how the Traces tab appears when Math is selected in the Traces
drop-down list.

Trace 4 is a mathematically-derived trace defined as Trace A minus Trace B. You can select Trace 1, 2, or
3 to serve as either Trace A or Trace B.

Setting Description

Trace When set to Trace 4 (Math), this tab is displayed.

Show Shows / hides the selected trace.

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Trace minus Trace Selects which traces serve as Trace A and Trace B.

xxx

BW Tab

The BW (bandwidth) tab allows you to change Resolution Bandwidth and Video Bandwidth settings,
and set the windowing method used by the transform process by selecting a filter shape (not present
for all displays).
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Setting Description

RBW Sets the Resolution Bandwidth value to be used in the spectrum analysis view. The
value is italicized when Auto is selected.

Auto When Auto is checked, the RBW is calculated as a percentage of the Span. Kaiser is
selected as the windowing method. When Auto is unchecked, the RBW is set by the user.
Selecting any Window other than Kaiser changes the RBW setting to manual.

Span/RBW ratio If Auto is checked, this value is used to calculate the RBW. If Auto is unchecked, this
setting is not selectable.

Filter Shape Specifies the windowing method used for the transform (when Auto is unchecked).
(Spectrum and Spectrogram displays only.)

VBW Adjusts the VBW (Video Bandwidth) value. (Spectrum and Spectrogram displays only.)

xxx

Filter Shape Settings

In the analyzer, computationally efficient discrete Fourier transform algorithms such as FFT (Fast Fourier
Transform) or CZT (Chirp-Z Transform) are generally employed to transform time-domain signals into
frequency-domain spectra. There is an assumption inherent in the mathematics of Discrete Fourier
Transforms that the data to be processed is a single period of a periodically repeating signal. The
discontinuities between successive frames will generally occur when the periodic extension is made to the
signal. These artificial discontinuities generate spurious responses not present in the original signal, which
can make it impossible to detect small signals in the presence of nearby large ones. This phenomenon is
called spectral leakage.

Applying a filter, such as Kaiser, to the signal to be transformed is an effective method to combat the
spectral leakage problem. Generally the filter has a bell shape. Multiplying the transform frame by the
filter function eliminates or reduces the discontinuities at the ends of the frame, however, at the expense of
increased RBW.

Filter Shape Characteristics

The choice of filter shape depends on its frequency response characteristics such as side-lobe level,
equivalent noise bandwidth and maximum amplitude error. Use the following guidelines to select the
best filter shape.

Filter Shape Characteristics

Kaiser (RBW) Best side-lobe level, shape factor closest to the traditional Gaussian RBW.

-6dB RBW (MIL) These filters are specified for bandwidth at their -6 dB point, as required by military
EMI regulations.

CISPR These filters comply with the requirements specified in the P-CISPR 16 -1-1 document
for EMI measurements.

Blackman-Harris 4B Good side-lobe level.

Uniform (None) Best frequency resolution, poor side-lobe level and amplitude accuracy.

Flat-Top Best amplitude accuracy, best representation of brief events captured near the beginning
or end of the time-domain data frame, poor frequency resolution.

Hanning Good frequency resolution, high side-lobe roll-off rate.

xxx
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VBW

The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the RBW
setting. VBW is disabled when the Filter shape is set to CISPR.

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

The Scale tab values are unique to each display. Also, note that each display uses horizontal and vertical
units that are appropriate for the display. For example, for the Spectrum display uses power (dBm) units
and frequency (Hz) units; the Amplitude vs. Time display uses power (dBm) and time (seconds) units; and
the Phase vs. Time display uses phase (degrees) and time (seconds) units.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale.

Offset Vertical Offset adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Zoom Start Sets the starting frequency for ...

Zoom Stop Sets the stop frequency for ...

Log Resets the scale of the horizontal axis to contain the complete trace.

Reset Scale Resets all settings to their default values.

xxx
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Prefs Tab

The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling marker
Readout and switching the Graticule display on/off.

Each of the General Signal Viewing displays maintains its own separate values for the controls that appear
on the Prefs tab. Some parameters appear with most displays while others appear with only one display.

For example, in the following image, the Show Marker readout in graph check box appears in the Prefs tab
for every display. However, the Show Power Trigger level check box only appears on the Amplitude vs
Time Prefs tab.

The following image shows the Prefs tab for the Time Overview display.

The following table explains the controls that can appear on the Prefs tab.
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Setting Description

Show: Selects the horizontal settings that appear below the graph area. You can choose Start,
Stop or Center, Span.

Trace points Sets the number of trace points used for marker measurements and for results export.

Max trace points

(Time Overview Display only)

Sets the maximum number of trace points used for marker measurements and for
results export.

Show trace legend Enables display of a legend in the measurements area that shows the Detection method
and Function setting for displayed traces. The color of the legend text matches the color
of the associated trace.

Show graticule Select to display or hide the graticule.

Navigator View

(Time Overview Display only)

Places the Time Overview display across the top of the application window, above all
other active displays.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show timestamp in graph
(selected line)

For spectrogram displays, this readout shows or hides the timestamp associated with the
selected line or marker position.

Show Power Trigger Level Displays or hides a green line in the graph that indicates the level at which the power
trigger is set. The line is not displayed if Trigger is set to Free Run.

xxx
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Overview

The displays in Analog Modulation (Displays > Measurements > Analog Modulation) are:

AM

FM

PM

The Analog Modulation displays provide measurements and time-domain trace displays.

AM Display

The Amplitude Modulation Display is a graph of Modulation Factor vs Time. The AM display includes
three numeric readouts.

To show the AM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From theMeasurements box, select Analog Modulation.

3. Double-click the AM icon in the Available Displays box. This adds the AM icon to the Selected
displays box.

4. Click the OK button. This shows the AM display.

Elements of the Display
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the AM display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the %AM indicated at the top of the graph by increasing or decreasing
the vertical scale. Changing the top value affects the bottom of graph value
because the graph scales about vertical center. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable).

3 Position Specifies the %AM shown at the center of the graph display.

4 Bottom Readout Displays the value of the modulation factor shown at the bottom of graph.

5 Measurement readouts Displays numeric values for the +AM (positive modulation factor), –AM
(negative modulation factor), and Total AM.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the horizontal range of the graph. By decreasing the scale (time
across the entire graph), the graph essentially becomes a window that you
can move over the trace by adjusting the position.

8 Clear Erases the trace from the graph.

9 Trace Detection readout Displays the Settings > Trace > Detection setting.

xxx

Changing the AM Settings (see page 98)

AM Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The AM Settings control panel provides access to settings that control parameters of the AM Display.
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Setting Description

Parameters (see page 99) Sets the Carrier Amplitude Detection method. You can choose either Average or Median.

Trace (see page 100) Sets Trace display parameters.

Scale (see page 102) Sets vertical and horizontal scale and position parameters.

Prefs (see page 103) Specifies whether or not certain display elements are shown. Specifies the maximum
number of points shown in the display graph.

xxx

Parameters Tab

The Parameters tab enables you to specify two parameters that control the carrier amplitude detection.

Setting Description

Average Selects the Average method for computing the average baseline for measurements.

Median Selects the Median method for computing the average baseline for measurements.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

xxx

AM Modulation

An amplitude modulated carrier can be described mathematically by:

A, in the above equation, represents the carrier amplitude, a(t) represents the time-varying modulation
and ω0 represents the carrier frequency.

The signal modulation envelope is given by:

There are several ways to express the AM modulation depth, expressed as a percentage.

Peak method

Trough Method

Max-Min Method
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In each case, the value of the carrier amplitude, A, needs to be estimated from the input signal.

The instrument represents signals in a sampled form. The sampled envelope can be expressed as a function
of sample index K and sampling period T as:

The instrument allows the choice of two methods for estimating the carrier amplitude:

Average Method

Median Method

In both cases, the instrument computes the average and the median over the analysis period. It should be
noted that the two methods give the same result for sinusoidal modulation where the sampling frequency
is much higher than the modulation frequency.

Trace Tab

The Trace Tab allows you to set the display characteristics of a trace.

Setting Description

Show Shows/hides the trace. If the instrument continues to run, the measurement results below
the graph display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak,
-Peak, and Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show recalled trace Displays a saved trace instead of a live trace.

xxx
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Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Trace Processing

Traces can be processed to display in different ways. The Detection setting controls trace decimation,
when needed. When the trace points each cover more than one sample data point, the vertical results
values for multiple data points are combined into each trace point. Each trace point ends up with a single
vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point represents the highest vertical value among the results it includes.

–Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:
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1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the level shown at the center of the graph.

Autoscale Resets the Position so that the entire trace is in the graph.

Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the position of the acquisition record shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to provide the optimum display.

xxx
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Prefs Tab

The Prefs tab enables you to change appearance characteristics of the AM display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the AM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx

FM Display

The Frequency Modulation Display shows Frequency Deviation vs. Time. The vertical axis units are
Hertz and the horizontal axis units are seconds. When taking measurements, only the first burst in the
Analysis period is analyzed. No trace points are shown for data outside the first detected burst, nor are
measurements made on data outside the first detected burst.

To show the FM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From theMeasurements box, select Analog Modulation.

3. Double-click the FM icon in the Available Displays box. This adds the FM icon to the Selected
displays box.

4. Click the OK button. This shows the FM display.
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Elements of the Display

104 SignalVu-PC Printable Help



Analog Modulation FM Settings

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the FM display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Top of Graph control Sets the frequency indicated at the top of the graph. Since the Position value
at the vertical center of this graph remains constant as the Top of Graph value
is adjusted, the Vertical Scale increases as the Top of Graph value increases,
which also affects the bottom of graph readout. Vertical Scale can also be
controlled from the Settings control panel's Scale tab.

3 Position Specifies the frequency shown at the center of the graph display. Changing
this value moves the trace up and down in the graph, which affects the Top of
Graph and Bottom of Graph values as well.

4 Bottom of Graph Readout Displays the frequency value at the bottom of the graph.

5 Measurement readouts Displays numeric values for the +Pk (positive frequency deviation), –Pk
(negative frequency deviation), RMS (RMS value of the deviation), Pk-Pk
(peak-to-peak frequency deviation), and Pk-Pk/2 (peak-to-peak frequency
deviation divided by two).

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time
over 10 divisions), the graph essentially becomes a window that you can
move over the acquisition record by adjusting the horizontal position.

8 Clear Clears the trace and numeric measurement results.

9 Trace Detection readout Displays the Settings > Trace > Detection setting.

10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq
Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal's carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Parameters
tab. If Freq Error is displayed, it also indicates that the Carrier frequency
detection setting is Auto. If Freq Offset is displayed, it indicates that the
Carrier frequency detection setting is manual.

xxx

Changing the FM Settings (see page 105)

FM Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The FM Settings control panel provides access to settings that control parameters of the FM Display.
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Setting Description

Parameters (see page 525) Sets the burst detection threshold, measurement bandwidth, and carrier frequency
detection method.

Trace (see page 108) Sets Trace display parameters.

Scale (see page 110) Sets vertical and horizontal scale and position parameters.

Prefs (see page 111) Specifies whether or not certain display elements are shown. Specifies the maximum
number of points shown in the display graph.

xxx
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Analog Modulation Parameters Tab

Parameters Tab

The Parameters tab enables you to specify parameters for carrier detection.

Setting Description

Burst detect threshold This parameter specifies the power level used to determine whether a burst is present.
A valid burst is required to take measurements. The burst detected first is used for
the analysis. The units for burst detect threshold are dBc, relative to the maximum
acquisition sample data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

Frequency offset Displays the carrier signal's offset from the instrument's measurement frequency. Auto is
used to select the method for determining the carrier frequency. When Auto is selected,
the instrument determines the carrier frequency by analyzing the signal. When Auto is
deselected, you can set the carrier frequency offset using Frequency Offset.

Load from Marker Pressing this button sets the frequency offset to the frequency offset of the selected
marker. (Pressing this button automatically deselects Auto.)

xxx

Frequency Offset

In Auto (Auto is selected), the instrument scans the measurement bandwidth about the measurement
frequency and looks for the highest-powered signal. This is defined as the carrier frequency. In Manual
(Auto is deselected), the carrier frequency is specified by adding/subtracting the specified Frequency offset
from the measurement frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement BW*1.1)/2. If
the Load from Marker button is pressed, the frequency offset is determined from the phase difference
between the two markers on screen compared to the time between the two markers. This function is useful
for removing frequency slope from the phase modulated signal.

Load from Marker

When the Auto check box is selected, the instrument scans the measurement bandwidth about the center
frequency and looks for the highest-powered signal. This is defined as the carrier frequency. When
the Auto check box is deselected, the carrier frequency is specified by adding/subtracting the specified
Frequency offset from the center frequency. Pressing the Load from Marker button loads the marker
frequency into the Frequency offset box.
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Trace Tab

The Trace Tab allows you to set the display characteristics of displayed traces.

Setting Description

Show Shows / hides the trace. If the instrument continues to run, the measurement results
below the graph display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak,
-Peak, and Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

xxx

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.
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Analog Modulation Trace Tab

Trace Processing

Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point represents the highest vertical value among the results it includes.

–Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.

SignalVu-PC Printable Help 109



Analog Modulation Scale Tab

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the frequency shown at the center of the graph.

Autoscale Resets the Position so that the entire trace fits within the graph.

Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the position of the acquisition record shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to provide the optimum display.

xxx
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Analog Modulation Prefs Tab

Prefs Tab

The Prefs tab enables you to change appearance characteristics of the FM display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the FM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx

PM Display

The Phase Modulation Display shows Phase vs. Time. The vertical axis units are degrees and the
horizontal axis units are seconds. When taking measurements, only the first burst in the Analysis period is
analyzed. No trace points are shown for data outside the first detected burst, nor are measurements made
on data outside the first detected burst.
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Analog Modulation PM Display

Elements of the Display
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Analog Modulation PM Settings

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the PM display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Top of Graph control Sets the phase value indicated at the top of the graph. Since the Position
value at the vertical center of this graph remains constant as the Top of Graph
value is adjusted, the Vertical Scale increases as the Top of Graph value
increases, which also affects the bottom of graph readout. Vertical Scale can
also be controlled from the Settings control panel's Scale tab.

3 Position Specifies the phase shown at the center of the graph display. Changing this
value moves the trace up and down in the graph, which affects the Top of
Graph and Bottom of Graph values as well.

4 Bottom of Graph Readout Displays the phase value at the bottom of the graph.

5 Measurement readouts Displays numeric values for the +Pk (positive phase deviation), –Pk (negative
phase deviation), Pk-Pk (peak-to-peak phase deviation), and RMS (RMS
value of the phase deviation).

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the time range of the graph. By decreasing the scale (full-scale time
over 10 divisions), the graph essentially becomes a window that you can
move over the acquisition record by adjusting the horizontal position.

8 Clear Clears the measurement results.

9 Trace Detection readout Displays the Trace Detection setting (see Settings > Trace > Detection).

10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq
Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal's carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Parameters
tab. If Freq Error is displayed, it also indicates that the Carrier frequency
detection setting is Auto. If Freq Offset is displayed, it indicates that the
Carrier frequency detection setting is manual.

xxx

Changing the PM Settings (see page 113)

PM Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The PM Settings control panel provides access to settings that control parameters of the PM Display.
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Setting Description

Parameters (see page 114) Sets the Carrier Frequency Detection method. You can choose either Automatic or
Manual. Sets burst threshold and phase detection method.

Trace (see page 115) Sets Trace display parameters.

Scale (see page 118) Sets vertical and horizontal scale and position parameters.

Prefs (see page 119) Specifies whether or not certain display elements are shown. Specifies the maximum
number of points shown in the display graph.

xxx

Parameters Tab

The Parameters tab enables you to specify parameters that control the carrier frequency and phase detection.
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Analog Modulation Trace Tab

Setting Description

Burst detect threshold Specifies the power level used to determine whether a burst is present. A valid burst is
required to take measurements. The burst detected first is used for the analysis. The
units for burst detect threshold are dBc, relative to the maximum acquisition sample
data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.

Frequency offset Displays the carrier signal's frequency offset from the instrument's Measurement
Frequency. Auto is used to select the method for determining the carrier frequency. When
Auto is selected, the instrument determines the carrier frequency by analyzing the signal.
When Auto is deselected, you can set the carrier frequency offset using Frequency Offset.

Load Δ from Marker Pressing this button disables the Auto Frequency Offset function and sets the Frequency
offset to the frequency offset calculated from the difference between MR (the marker
reference) and the selected marker (or M1 if MR is currently the selected marker).

Phase offset Displays the phase offset. When Auto is selected, the instrument determines the phase
offset. When Auto is deselected, the user sets the phase offset with this control.

Load from marker Pressing this button sets the phase offset to the phase offset of the selected marker.
(Pressing this button automatically deselects Auto.)

xxx

Frequency Offset

In Auto (Auto is selected), the instrument scans the measurement bandwidth about the Measurement
Frequency and looks for the highest-powered signal. This is defined as the carrier frequency. In Manual
(Auto is deselected), the carrier frequency is specified by adding/subtracting the specified Frequency offset
from the Measurement Frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement BW*1.1)/2. If
the Load Δ from marker button is pressed, the frequency offset is determined from the phase difference
between the two markers on screen compared to the time between the two markers. This function is useful
for removing frequency slope from the phase modulated signal.

Phase Offset

In Auto (Auto is selected), the instrument sets the phase offset to fit the waveform to the screen centering
0° phase on the vertical axis. The actual phase offset is indicated on the Phase Offset readout. In Manual
(Auto is deselected), the instrument sets the phase offset using the value specified in Phase offset. For
example, when Phase offset is set to 10°, the waveform shifts upward by 10° on screen. Selecting Load
from marker sets the phase offset to the value of the selected marker. Range: –180 to +180°.

Trace Tab

The Traces Tab allows you to set the display characteristics of displayed traces.
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Setting Description

Show Shows / hides the trace. If the instrument continues to run, the measurement results
below the graph display continue to update even if the trace is hidden.

Detection Sets the Detection method used for the trace. Available detection methods are +Peak,
-Peak, and Avg (VRMS). Not available for saved traces.

Function Selects the trace processing method. The only available setting is Normal.

Freeze Halts updates to the trace.

Save Trace As Saves the trace to a file for later recall and analysis.

Show Recalled trace Displays a saved trace instead of a live trace.

xxx

Detection

Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Trace Processing

Traces can be processed to display in different ways. The Function setting controls trace processing.
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Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point is represents the highest vertical value among the results it includes.

–Peak - Each trace point is represents the lowest vertical value among the results it includes.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.
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Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the phase shown at the center of the graph.

Autoscale Resets the Position so that the entire trace in the graph.

Horizontal

Scale Changes the range shown between the left and right sides of the graph.

Position Adjusts the phase shown at the left edge of the graph.

Autoscale Resets the Scale and Position settings to show the entire trace within the graph.

xxx
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Prefs Tab

The Prefs tab enables you to change appearance characteristics of the PM display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the PM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx
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RF Measurements Overview

Overview

The displays in RF Measurements (Displays > Measurements > RF Measurements) are:

CCDF

Channel Power and ACPR

Frequency and Phase Settling Time (Option SVT)

MCPR

Occupied Bandwidth

Spurious

Signal Strength

The RF Measurements power measurements and signal statistics help you characterize components
and systems.

Power Measurements

Measurement Description

Channel Power The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.

Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power
in adjacent channels.

Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted
signal (located in the CCDF display).

CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much
time a signal spends at or above a given power level relative to the average power of
a measured signal.

xxx

Channel Power and ACPR (Adjacent Channel Power Ratio) Display

Use the Channel Power and ACPR measurement to measure channel power by itself, or adjacent channel
leakage ratio with one main channel.
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RF Measurements Channel Power and ACPR (Adjacent Channel Power Ratio) Display

Measuring Adjacent Channel Power Ratio

1. Recall the acquisition data file you wish to analyze.

2. Select the Displays button.

3. Select RF Measurements from theMeasurements box.

4. Double-click Chan Power and ACPR in the Available displays box. Click OK to complete your
selection.

5. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to
that of your main channel.

6. Press the Settings button. This displays the control panel for Chan Power and ACPR (the tab displayed
will be the tab displayed the last time the Settings panel was opened).

7. To set the number of adjacent channels, select the Channels tab. Enter the number of channels in
the Number of adjacent pairs value box. If zero is entered for the number of adjacent pairs, the
resultant measurement will be channel power only.

NOTE. As you add adjacent channels, the span of the display is adjusted so that all the channels can be
seen. Use the horizontal scale and offset to zoom the display in on any portion of the trace.
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RF Measurements RF Channel Power Measurement

8. To set the spacing between channel centers, enter the required value in theChannel Spacing value box.

9. To set the channel bandwidth, enter the required value in the Channel Bandwidth value box.

10. After you have configured the channel settings, click the close button ( ) in the Settings panel or
press the Settings button again to remove the settings panel.

11. Press Replay to take measurements on the recalled acquisiton data.

Viewing Results

Measurement results are displayed in a table below the graph and within the graph itself (which can be
enabled/disabled in the Settings > Prefs tab). To see all measurements, you might need to scroll the
table. The size of the results table can be changed by dragging the horizontal divider bar between the
graph and table areas.

Heading Description

Channel Identifies the displayed channels. A1 means the first adjacent channel. A2 means
second adjacent channel. Adjacent channels are numbered according to their offset from
the Main channel. The closest channel is numbered 1. The next closest channel is
numbered 2; and so forth.

Lower The power measured for the lower adjacent channel. Adjacent channel power
measurements are displayed in dB relative to the Main channel.

Upper The power measured for the upper adjacent channel. Adjacent channels power
measurements are displayed in dB relative to the Main channel.

Avg Channel Power (Main) The power measured for the Main channel. The detection type used for measuring
channel power and adjacent channel powers is Average. This means that the average of
the linear (pre-log) samples is used to determine the power. The Main channel power is
displayed in dBm.

xxx

Setting Channel Power and ACPR Settings Parameters (see page 124)

RF Channel Power Measurement

The RF channel power gives an indication of the total average (and other measures) RF power in a given
channel.

For some communications systems, there is an “out-of-service” total power measurement defined in the
specifications that calls for a specified constant modulation. In this case, the output power should be
relatively constant. For many measurements, this may not be the case, and the Power Measurement
results will vary as the signal varies.
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Average power is the square root of the sum of the squares of the voltage samples over the measurement
time.

The defined “channel” width for the Power Measurement defines the bandwidth and shape of the filter
used to remove any RF power on frequencies outside of the channel bandwidth.

Channel Power

The total RF power in the selected frequency band. The detection type used for measuring channel power
is Average. This means that the average of the linear (pre-log) samples is used to determine the channel
power. To measure channel power, use the ACLR measurement, and set the number of adjacent channels
to zero. This results in only the channel power being measured.

Average Channel Power

The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Leakage Power Ratio

Adjacent Channel Leakage power Ratio (ACLR) is the ratio of the mean power centered on the
assigned channel frequency to the mean power centered on an adjacent channel frequency. In the 3GPP
specification, both the main channel and adjacent channels are required to be filtered with RRC (Root
Raised Cosine) filters.

Adjacent Channel Power

Measure of the signal power leaking into nearby channels.

Channel Power and ACPR Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Channel Power and ACPR display are shown in the following table.
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RF Measurements Channels Tab for ACPR

Settings tab Description

Freq & RBW (see page 140) Specify the frequency and resolution bandwidth used for the ACPR measurement.

Measurement Params (see
page 140)

Specify several parameters that control the measurement, such as channel filter, chip
rate, averaging, and correcting for noise floor.

Channels (ACPR) (see
page 125)

This tab specifies the BW and offset parameters of the Channels for the selected ACPR
measurement.

Scale (see page 199) Specifies the vertical and horizontal scale settings.

Prefs (see page 134) Specifies whether certain display elements are visible.

xxx

Restore defaults. Sets parameters for a 1-channel WCDMA measurement.

Channels Tab for ACPR

The Channels tab is where you specify parameters for the channels measured in the ACPR display.

Setting Description

Number of adjacent pairs Specifies the number of adjacent channel pairs. Range: 1 - 50; Resolution 1.

Channel Bandwidth Specifies the frequency width of each channel (all channels share the same value).

Channel Spacing Specifies the difference in frequency between the centers of each channel.

xxx

The following figure illustrates the settings controlled from the Channels tab.
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RF Measurements Channels Tab for ACPR

Changing the Number of Adjacent Pairs

1. Select Number of adjacent pairs number entry box.

2. Enter a value for the number of adjacent pairs using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the spectrum
display to identify the adjacent channels.

3. Select the Close box when you have finished making changes.

Changing the Channel Bandwidth

1. Select the Channel Bandwidth number entry box.

2. Enter a value for the number of adjacent pairs using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the display to
indicate the channel bandwidth.

3. Select the Close box when you have finished making changes.

Channel Spacing

1. Select Channel Spacing number entry box.

2. Enter a value for the difference in center frequency between channels using the knob or the keypad.
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NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the display to
indicate the channel bandwidth.

3. Select Close when you have finished making changes.

Signal Strength Display

Use the Signal Strength display to measure signal strength (channel power and peak channel power).

Measuring channel power and field strength

1. Select the Displays button.

2. Select RF Measurements from theMeasurements box.

3. Double-click Signal Strength in the Available displays box. Click OK to complete your selection.

4. Tune the analyzer to the channel. To do this, you can enter the frequency directly into the Frequency
field on the Basic Toolbar (see the bottom of the above image), or you can use the Select Channel
button on the Channel Navigation toolbar.

5. Press the Run button to take the measurements.

6. If you are measuring a signal with a directional antenna, select the Audio checkbox located above
the graph, on the left side.
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When Audio is checked, the analyzer sounds a tone that varies in frequency with the channel power. If
you change the direction of the antenna and the channel power drops, the frequency of the audio tone
will also drop. If the channel power increases, the audio tone frequency will also increase.

As channel power changes, the vertical channel power bar graph located on the far right side of the
measurement display will rise and fall with the channel power.

Viewing Results

Measurement results are displayed below the graph and within the graph itself (the latter of which can be
enabled/disabled in the Signal Strength Settings > Prefs tab).

Results for Signal Strength measurement

Heading Description

Channel Power (Main) The integrated power measured for the Main channel.

Peak Channel Power (Main) The maximum integrated power measured for the Main channel.

xxx

Signal Strength Settings (see page 128)

Signal Strength Settings

Menu Bar: Setup > Settings

Basic Control Toolbar:

The settings for the Signal Strength display are shown in the following table.
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RF Measurements Signal Strength Settings

Settings tab Description

Freq & RBW (see page 130) Specify the frequency and resolution bandwidth used for the signal strength
measurements.

Measurement Params (see
page 130)

Specify several parameters that control the measurement, averaging. External amplitude
corrections, and display units.

Channels (see page 132) This tab specifies the BW

Scale (see page 133) Specifies the vertical and horizontal scale settings.

Prefs (see page 134) Specifies trace points, trace detection, and visible display elements ( graticule, marker
readouts, etc ) for the Signal Strength measurement display.

xxx
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RF Measurements Freq & RBW Tab for Signal Strength display

Freq & RBW Tab for Signal Strength display

The Freq & RBW tab specifies frequency parameters for the signal strength measurements.

Setting Description

Meas Freq Specifies the center/measurement frequency.

Step The Step control sets the increment/decrement size for the adjustment of the center
frequency. If Auto is enabled, the analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view's RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = current RBW value. VBW
Minimum = 1/10,000 RBW setting.

xxx

NOTE. While the center frequency and step settings on this control tab are shared between ACPR, MCPR
and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW

The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.

NOTE. If you are following a procedure that says to "set VBW to three times the RBW value or greater", it
means that the test should be conducted with no VBW effects. In the application, this condition is met by
disabling the VBW function.

Measurement Params Tab for Signal Strength display

The Measurement Params tab is where you set parameters that control the Signal Strength measurement.
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RF Measurements Measurement Params Tab for Signal Strength display

Parameter Description

Average Enables/disables measurement averaging. Averaging can be enabled in either the
Frequency Domain or Time Domain.

Frequency domain This setting takes the average linear value of the traces (so that rms values are
preserved). The number of averages is user-defined. Frequency domain averaging
is available in spans larger (or smaller) than the maximum real time bandwidth.
This is the mode to use unless you need to extract maximum dynamic range from
an ACPR measurement.

Time domain This setting takes the average linear value of the traces. It is useful if you need to
extract maximum dynamic range from an ACPR measurement. The number of traces
is user defined. But, the signals must be triggered and repeating. That is, the signal
needs to be exactly the same for each acquisition. When this condition is met, each
waveform contains the same signal, but the random noise changes from acquisition
to acquisition and the average value of the random noise is lowered, while the signal
value remains constant. Time domain averaging is not available in spans wider
than the maximum real-time bandwidth.

Off This setting turns averaging off.

Number Specifies the number of acquisitions to be averaged when Averaging is set to
Frequency Domain. Specifies the number of successive capture records that are
averaged when Averaging is set to Time Domain.

Amplitude Units Opens the Amplitude Units (see page 612) dialog box.

Ext Corrections Opens the External Gain/Loss Correction (see page 622) dialog box.

xxx
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Channels Tab for Signal Strength display

The Channels tab is where you specify the channel bandwidth measured in the Signal Strength display.

Changing the Channel Bandwidth

1. Select the Channel Bandwidth number entry box.

2. Enter a value for the channel bandwidth.

3. Select the Close box when you have finished making changes.

132 SignalVu-PC Printable Help



RF Measurements Scale Tab for Signal Strength display

Scale Tab for Signal Strength display

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Center Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units. This is only accessible when the vertical units are
set to dBm.

Offset Adjusts the Reference Level away from the top of the trace display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Offset Allows you to pan a zoomed trace without changing the Measurement Frequency. Offset
is only enabled when the span, as specified by Freq / div, is less than the acquisition
bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

xxx
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Prefs Tab

The Prefs tab enables you to change parameters of the measurement display. The parameters include
enabling/disabling Marker Readout, switching the Graticule display on/off, and trace points and detection.

Setting Description

Trace Points Sets the number of trace points computed for each line. These are the points used for
marker measurements and for results export.

Show graticule Shows or hides the graticule.

Trace Detection +Peak: Shows the peak power in a bin (of chosen RBW) if there are multiple points to
choose from within a bin.

Avg (VRMS): Shows the average power in a bin (of chosen RBW) if there are multiple
points to choose from within a bin.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

xxx

MCPR (Multiple Carrier Power Ratio) Display

Use the MCPR measurement to measure adjacent channel power ratio for multiple main channels or
when adjacent channel pairs have different offsets and/or bandwidths. The MCPR display show the
Reference Power and the ratio of each adjacent channel to the Reference Power. You can select whether
the Reference Power is the total of all active channels or a single channel.

Measuring Multiple Carrier Power Ratio

1. Recall an appropriate acquisition data file.

2. Press the front-panel Displays button.

3. From the Select Displays window, select RF Measurements or P25 Analysis from the Measurements
box.

4. Double-click theMCPR icon in the Available displays box. Click OK to complete your selection.
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5. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to
that of the main channel. SelectMeas. Freq to set the measurement frequency. Use the front panel
knob to adjust the frequency.

6. Press the Settings button. This displays the control panel for MCPR (the tab displayed will be the tab
displayed the last time the Settings panel was opened).

7. Click on the Channels tab. To set the number of Main channels, enter the number of Main channels in
the Number text entry box underMain Channels.

NOTE. As you add channels, the span of the display will be adjusted so that all the channels can be seen.

8. To set the bandwidth of all main channels, enter a value in the BW value box.

9. To set the spacing between the main channels, enter a value in the Spacing value box.

10. To prevent a main channel power level from being included in the Power Reference (Total) calculation,
select the channel to be excluded in the Inactive box.

11. To add adjacent channels, click the Add button under Adj Chans.

12. To edit Frequency Offset or Bandwidth, click within the value box and use the front-panel knob or
your keyboard to set the value. Click Close to save your changes.
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NOTE. Frequency Offset is the difference between the center frequency of the selected channel and
the Measurement Frequency. All channels (Main or Adjacent) are specified by their offset from the
Measurement Frequency.

13. To enable and define power limits, check the Enable Power Limits box and enter the desired Upper
and Lower limits. You can read more about power limits here (see page 137).

14. After you have configured the Main and Adjacent channels, click the close button ( ) in the
Settings panel or the Settings button to remove the settings panel.

15. Click the Replay button to take measurements on the recalled acquisition data file.

Viewing Results

MCPR measurement results are displayed both in the spectrum graph and in a table below the spectrum
display. Individual Main channel power measurements appear in the graph under their channel identifiers.
Individual adjacent channel power ratios also appear in the graph under the adjacent channel identifier.
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The following table details the entries in the results table.

Heading Description

Ch Identifies the adjacent channels. Adjacent channels are numbered according to their
offset from the Main channel. The closest channel is numbered 1. The next closet
channel is numbered 2; and so forth. The prefix “L” means lower; “U” means upper.

Offset The offset is the difference in frequency between the Measurement Frequency and the
center frequency of the channel.

Lower Displays the ratio of the lower adjacent channel power to the Power Reference.

Upper Displays the ratio of the upper adjacent channel power to the Power Reference.

L. Limit Displays the lower power limit.

U. Limit Displays the upper power limit.

Power Reference Depending on the selected Power Ref, this readout displays either the power of the
selected main channel or the total power in the active main channels.

xxx

Depending on the number of adjacent channels, to see all the measurements, you might need to drag
the divider bar between the main display and the results table at the bottom of the window to change
the height of the results table.

Setting MCPR Measurement Parameters (see page 140)

Setting Power Limits

When power limits are enabled (Settings > Channels > Add or Settings > Channels > Edit), the
comparison of the actual results of an adjacent channel is done against the limits. If there is a failure, the
Lower and Upper power cells in the MCPR table will be red and the failure segments of the trace display
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will be red. The words Fail in red will also appear in the top left corner of the display (even if one adjacent
band fails). See the following image for an example.

Multiple Carrier Power Ratio

The ratio of the signal power in an adjacent channel to the power in one or more main channels.

MCPR Settings

Main menu bar: Setup > Settings

The Setup control panel tabs for MCPR (Multiple Carrier Power Ratio) are:
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Settings tab Description

Freq & RBW (see page 140) Specify the frequency and resolution bandwidth used for the MCPR measurements.

Measurement Params (see
page 140)

Specifies parameters controlling how the MCPR measurement is made.

Channels (see page 143) Specifies the parameters of the channels to be measured.

Scale (see page 199) Specifies the vertical and horizontal scale and offset values.

Prefs (see page 134) Specifies whether or not certain display elements are shown.

xxx

Restore defaults. Sets parameters for a 4-carrier WCDMA measurement.
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Freq & RBW Tab for ACPR and MCPR Displays

The Freq & RBW tab specifies frequency parameters for the Channel Power & ACPR measurements and
MCPR measurement.

Setting Description

Meas Freq Specifies the center/measurement frequency.

Step The Step control sets the increment/decrement size for the adjustment of the center
frequency. If Auto is enabled, the analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view's RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = current RBW value. VBW
Minimum = 1/10,000 RBW setting.

xxx

NOTE. While the center frequency and step settings on this control tab are shared between ACPR, MCPR
and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW

The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.

Measurement Params for ACPR and MCPR Displays

TheMeasurement Params tab is where you set parameters that control the ACPR andMCPRmeasurements.
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Parameter Description

Average Enables/disables measurement averaging. Averaging can be enabled in either the
Frequency Domain or Time Domain.

Frequency-domain This setting takes the average linear value of the traces (so that rms values are
preserved). The number of averages is user-defined. Frequency domain averaging
is available in spans larger (or smaller) than the maximum real time bandwidth.
This is the mode to use unless you need to extract maximum dynamic range from
an ACPR measurement.

Time-domain This setting takes the average linear value of the traces. It is useful if you need to
extract maximum dynamic range from an ACPR measurement. The number of traces
is user defined. But, the signals must be triggered and repeating. That is, the signal
needs to be exactly the same for each acquisition. When this condition is met, each
waveform contains the same signal, but the random noise changes from acquisition
to acquisition and the average value of the random noise is lowered, while the signal
value remains constant. Time domain averaging is not available in spans wider
than the maximum real-time bandwidth.

Off This setting turns Average off.

Number Specifies the number of acquisitions to be averaged when Averaging is set to
Frequency Domain. Specifies the number of successive capture records that are
averaged when Averaging is set to Time Domain.

Correct for Noise Floor Enables/disables the Noise Floor Correction function.

Power Reference Specifies power against which the results are compared. Choices available are each
of the existing main channels and “Total (active channels”.

Only present when MCPR is the selected display.

Channel Filter Specify the channel filter used. Select between None (default) and Root-raised
Cosine.

Filter Parameter Value entry box for the Root-raised Cosine filter Adjacent Channel Filter.

Present only when the Channel Filter is set to Root-raised Cosine.

Chip Rate Value entry box for the Root-raised Cosine chip rate.

Present only when the Channel Filter is set to Root-raised Cosine.

xxx

Correct for Noise Floor

This setting is only available when an RSA500 series or RSA600 series instrument is connected.

When this setting is enabled, the instrument applies a correction to the ACPR or MCPR measurement to
reduce the effect of instrument noise on the results. It generates this correction by taking a preliminary
acquisition to measure the instrument noise floor. Once this is done, the measurement proceeds, applying
the correction to each result. When any relevant settings (reference level, attenuator, frequency, or span)
are changed, the instrument performs a new noise measurement and correction.

The noise correction signal is created by switching off the input to the RSA and performing acquisitions of
the instrument internal noise. A minimum of 100 acquisitions are averaged to create the noise reference
signal. It is possible to increase the number of acquisitions for creation of the noise reference signal. When
frequency domain averaging is enabled and the number of averages exceeds 100, the number of frequency
domain averages becomes the total number of acquisitions to determine the instrument internal noise.
Noise is measured for each channel defined by the measurement. The noise reference from each channel is
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subtracted from the incoming signal power for each channel to create the corrected result. All calculations
are performed in Watts, and then converted to the desired units.

The amount of noise correction is limited to 12 dB to avoid the possibility of a negative power
measurement. This is a rare condition that could occur if the subtraction of the reference power from the
channel power results in a negative value (or ‘infinite’ dBm).

The measured values differ from the displayed trace in two ways. First, any filtering applied to the channels
is not displayed on the trace. Second, the single value of measured noise for a channel is subtracted from
each trace point in the channel, rather than offsetting the entire channel by a single amount. This produces
a smooth trace with no discontinuities at the channel edges.

Channels Tab for MCPR

Main menu bar: Setup > Settings > Channels

Favorites toolbar:

The Channels tab is where you specify the parameters for the channels measured in the MCPR display.

Setting Description

Main Channels

Number Sets the number of Main channels.

BW Sets the bandwidth of the Main channels.

Spacing Sets the frequency difference between the centers of the Main channels.

Inactive Selected channels are ignored by the measurement routine.

Adj Chans

Add Opens the Edit Channel Parameters dialog, which you use to specify the parameters of a
new pair of adjacent channels. You can add up to 50 adjacent channel pairs.

Edit Opens the Edit Channel Parameters dialog box. (You must first select a channel to
enable the Edit button.)

Delete Deletes the selected main channel or adjacent channel pair.

Channel Definition table A table of the parameters for every channel. Offset is the frequency difference between
the Center Frequency and center of the selected channel. Nothing in the table is editable
directly. You can set the upper and lower limits by clicking on the Add button.

xxx

The following figure illustrates the settings controlled from the Channels tab.
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Editing Channel Parameters

To edit the offset or bandwidth of a Main channel:

1. Select the value in the BW or Spacing number entry boxes.

2. Adjust the value as required. All the Main channels share the same BW and Spacing.

3. Select the appropriate check box to make a channel Inactive, as appropriate.

4. Click the Close button when you have finished making changes.

To edit the offset or bandwidth of an Adjacent channel:

1. Select the channel to be edited in the channel definition table.

2. Select Edit. This displays the Edit Channel Parameters dialog box.

3. Adjust the values for the Frequency Offset, Bandwidth, and upper and lower Limits, as required.

4. Click the Close button when you have finished making changes.

Adding Channels

To add a main channel:

1. Select the Number entry box.

2. Use the knob to enter a value for the desired number of Main channels.

3. Click the Close button when you have finished making changes.

To add an adjacent channel pair:

144 SignalVu-PC Printable Help



RF Measurements Occupied BW & x dB BW Display

1. Select Add. This displays the Edit Channel Parameters dialog box.

2. Use the knob to enter values for the Frequency Offset, Bandwidth, and upper and lower Limits, as
required. The Frequency Offset is measured from the Meas Frequency of the Main channels.

3. Click the Close button when you have finished making changes.

Deleting Channels

To delete a main channel:

1. Select the Number entry box.

2. Use the knob to reduce the number of channels or enter a new value using the front-panel keypad.

3. Click the Close button when you have finished making changes.

To delete an adjacent channel:

1. Select the channel to be deleted in the channel definition table.

2. Select Delete. This removes the selected channel from the channel table.

3. Click the Close button when you have finished making changes.

Occupied BW & x dB BW Display

The Occupied BW display shows the bandwidth within which 99% (a user-defined value, the default is
99%) of the power transmitted within the measurement bandwidth falls.

To show the Occupied BW display:

1. Recall an appropriate acquisition data file.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select RF Measurements in theMeasurements box.

4. In the Available displays box, double-click the Occupied Bandwidth icon or select the icon and
click Add. The Occupied Bandwidth icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to display the Occupied Bandwidth.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display
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Item Display element Description

1 Check mark indicator The check mark indicator denotes the display for which the acquisition
hardware is optimized. This indictor appears only when the display is the
selected display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Averaging readout Appears when averaging is enabled (Settings > Parameters tab > Average
results). Displays "Avg: n of m" while averaging the results and "Avg: m"
once the requested number of results have been averaged.

3 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

4 Trace function readout Displays either Normal or MaxHold to indicate trace function.

5 Clear Resets count for Average and MaxHold functions. Enabled only when
Averaging or MaxHold is enabled. Pressing Clear will clear the trace and, if
acquisition is running, restart the averaging or hold process.

6 Graph Displays the input signal. Shaded areas indicate the measurement bandwidth
(Settings > Parameters tab > Measurement BW).

7 Blue lines The blue lines indicate where the selected results (selected in the Main
results area) are being measured on the trace.

8 Grid divider Determines the portion of the display allocated to the graph and detailed
results area. You can move the grid divider all the way to the top or bottom
and any position in between.

9 Detailed results area Displays additional measurements results.

10 Position and dB/div Position sets the top of graph value. The dB/div setting is the vertical scale
value.

11 Main results area Displays results for Occupied Bandwidth (OBW) and x dB bandwidth. Use
the two radio buttons to select which of the two results are illustrated in the
graph with the blue lines and arrows. There are also controls for adjusting
OBW % Power, x dB BW, and RBW.

12 VBW Enables the VBW (Video Bandwidth) filter. Displays current VBW filter setting.
See Setup > Settings > Freq & RBW tab (see page 140).

xxx

Detailed Results Readouts

Measurement Description

Freq Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the analyzer.

OBW Level left The signal level at the left edge of the occupied bandwidth.

OBW Level right The signal level at the right edge of the occupied bandwidth.

OBW Ref Power The total power measured within the measurement bandwidth.

x dB BW Ref Power The peak power measured within the measurement bandwidth.

xxx
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Changing the Occupied Bandwidth Settings (see page 148)

Occupied Bandwidth

Bandwidth within which some defined percentage of the power transmitted on a single channel lies.

Occupied BW & x dB BW Settings

Main menu bar: Setup > Settings

The control panel tabs for the Occupied Bandwidth display are shown in the following table.

Settings tab Description

Freq & RBW (see page 195) Allows you to specify the Center Frequency, Step size and RBW.

Parameters (see page 149) Allows you to specify the Occupied BW % Power, x dB level, Measurement BW, enable
averaging and the Max Hold function.

Scale (see page 199) Allows you to set the vertical and horizontal scale parameters.

Prefs (see page 134) The Prefs tab enables you to set characteristics of the measurement display.

xxx
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Parameters Tab

The Parameters tab enables you to specify parameters that control the Occupied BW measurement.

Setting Description

Occupied BW % Power Specifies the proportion of power within the occupied bandwidth (referenced against the
total power in the measurement bandwidth).

x dB level x dB level defines the x dB BW level search threshold.

Measurement BW Specifies the frequency range used by the measurement.

Max Hold spectral data Enables the Max Hold function.

Average results Enables/disables results averaging. Note that this is not an averaging of the trace, but an
averaging of the results.

Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to
10,000.

xxx

x dB Level

The x dB level determines the x dB BW. The instrument analyzes the spectrum trace to locate the
frequencies at which the level is x dB down from the peak level calculated over the measurement
bandwidth. The frequency difference between the upper and lower crossing thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -26 dB

Max Hold Spectral Data

Max Hold displays the maximum value in the acquisition record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Spurious Display

To show the Spurious display:

1. Recall an appropriate acquisition data file.

2. Click the Displays button or select Setup > Displays.
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3. From the Measurements box, select RF Measurements.

4. Double-click the Spurious icon in the Available displays box. This adds the Spurious icon to the
Selected displays box (and removes it from the Available displays box). Alternatively, you can click
the Spurious icon and then click the Add button to select Spectrum for display.

5. Click the OK button.

6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Spurious Display
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Item Display element Description

1 dB/ div Sets the vertical scale value. The maximum value is 20.00 dB/division.

2 Vert Position Sets the top of graph value. This is only a visual control for panning the graph.
The Reference Level is adjusted in the Toolbar and the Ampl control panel.
By default, Vert Position = Ref Level.

3 Check mark indicator Indicates the display for which the acquisition hardware is optimized.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

4 Pass / Fail readout Indicates whether one or more spurs have exceeded a limit specified on
the Settings > Limits tab.

5 Ref: If enabled, displays the power reference level.

6 Trace function Indicates the trace processing method. If Average or Max Hold is selected,
this readout displays the number of traces being processed (averaged or
compared for the Max Hold value).

7 Clear Restarts multi-trace functions (Average, Max Hold).

8 Stop Adjusts the graph stop frequency. This setting affects only visual scaling, not
measurement parameters.

9 Green bar Indicates the range that is selected on the Settings > Ranges and Settings >
Limits tabs.

10 Spur table Displays spur measurements. See the following table for details.

11 Start Adjusts the graph start frequency. This setting affects only visual scaling, not
measurement parameters.

12 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on
screen. Selects Multi-range display mode.

13 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with
the dB/div and Vertical Position settings.

xxx

Elements of the Spurious Graph Display
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Item Display element Description

1 The green line or shading indicates an Abs (absolute) limit. The absolute limit
is enabled when the mask is set to Abs, Abs & Rel, or Abs OR Rel. Note that
absolute and relative amplitude masks can overlap.

2 The gray-shaded area indicates a portion of the spectrum where no
measurements are being taken.

3 The cyan line or shading indicates a Relative limit. The relative limit is
enabled when the mask is set to Rel, Abs & Rel, or Abs OR Rel. Note that
absolute and relative amplitude masks can overlap.

4 abs rel Reminder that green-shaded areas highlight absolute limits and cyan-shaded
areas highlight relative limits.

5 This indicates the selected spur, when it is in violation of the limits. In Run
mode, this is the peak spur violation. The selected marker is highlighted in
the Spur table below the graph with a blue background.

6 A spur marker. Indicates a spur that does not exceed the mask settings. See
the Settings > Ranges and Limits tab (see page 156).

7 A violation marker. Indicates a spur that exceeds the mask settings. See the
Settings > Ranges and Limits tab (see page 156).

- - Indicates the selected spur when it is not in violation of the limits. The
selected marker is highlighted in the Spur table below the graph with a blue
background.

8 1, 2, 3... A Spur number. The number indicates the row in the spur table that
corresponds to the spur. The instrument can display up to 999 spurs.

9 A, B, C, D... Identifies the enabled ranges.

10 Green bar Indicates the range selected on the Settings > Ranges and Limits (see
page 156) tab.

11 Ref Indicates the location of the power reference. See Settings > Reference
(see page 154).

xxx

Elements of the Spur Table
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Column Description

Spur A number that identifies a spur in the graph area. The instrument can display a maximum
of 999 spurs.

Range The letter representing the frequency range where the spur is located.

Freq Abs The absolute frequency at which the spur occurs.

Freq Rel The relative frequency at which the spur occurs. The relative frequency is the difference
between the absolute frequency (absolute) and the carrier frequency.

Ampl Abs The absolute amplitude of the spur.

Ampl Rel The relative amplitude at which the spur occurs. The relative amplitude is the difference
between the absolute amplitude and the carrier amplitude. See the Settings > Limits tab.

Lim Abs The value of the absolute amplitude limit at the spur frequency. This value can vary even
with small spur frequency changes if the start and stop limit values are different. See the
Settings > Ranges and Limits tab (see page 156).

Lim Rel The relative amplitude limit at which the spur occurs. This value can vary even with small
spur frequency changes if the start and stop relative amplitude limit values are different.
See the Settings > Ranges and Limits tab (see page 156).

Blue background The cell in the Spur column with a blue background identifies the selected spur.

Red background Cells in the Spur column with a red background identify violations.

Cells in the results area with a red background identify the measurement that exceeded a
limit.

xxx

Rearranging the Columns in the Spur Table

You can rearrange the order of the columns in the Spur Table. To move a column, click on the column
heading and drag it to the desired position.

Sorting the Rows in the Spur Table

You can sort the rows in the Spur table by clicking on the column heading. For example, if you click on
the Freq Abs heading, the results in the Spur table will be sorted by frequency. If you click on Range, the
rows will be sorted by range. Clicking a second time on the same heading reverses the order.

Changing the Spurious Display Settings (see page 153)

Spurious Display Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The control panel tabs for the Spurious display are shown in the following table.
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Settings tab Description

Parameters (see page 154) Specifies whether the graph displays one range or multiple ranges. Specifies whether all
spurs are shown or only spurs over specified limits.

Reference (see page 154) Specifies the Power Reference level.

Ranges (see page 156) Specifies start and stop frequencies of ranges and which ranges to take measurements in.
Sets parameters that define a spur. Review, save and load the Range table from this tab.

Limits (see page 156) Specifies Pass/Fail limit parameters.

Trace (see page 196) Specifies the trace Function.

Scale (see page 199) Specifies the vertical and horizontal scale settings.

Prefs (see page 134) Specifies the appearance features of the graph area.

xxx

Restore defaults. Sets the Spurious parameters to their default values.

Parameters Tab

The Parameters tab enables you to specify settings that control the Spurious measurement.

Setting Description

Frequency Ranges

Multi Enables the instrument to display all enabled ranges in the graph.

Single Limits the graph to the display of only one range. The displayed range is set to the range
that contains the selected spur.

List Spurs

All spurs Displays any spur that exceeds the Threshold and Excursion values set on the Ranges
tab.

Over Limit Displays only spurs that exceed both the Threshold and Excursion values set on the
Ranges tab and the limits specified on the Limits tab.

xxx

Reference Tab

The Reference tab enables you to specify the Power Reference parameter. The Power reference parameter
is used to calculate relative values in the Spur table and to calculate relative amplitude limits.
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Setting Description

Power Reference Specifies the power reference level used for relative values and limits.

No reference Power level readings are calculated only for absolute values, no relative values are
calculated.

Manual level The reference level for relative measurements is specified by the Reference power
level setting.

Carrier The reference level for relative measurements is based on the power level calculated at
the specified carrier frequency.

xxx

Setting the Power Reference Level to No Reference

To set the power reference to No Reference:

Select No reference from the Power reference drop-down list.

Setting the Power Reference Level to Manual Level

To set the power reference to manual level:
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1. SelectManual level from the Power reference drop-down list. This displays the Reference power
level entry box.

2. Specify the desired power level in the Reference power level entry box.

Setting the Power Reference Level to Carrier

To set the power reference to Carrier:

1. Select Carrier from the Power reference drop-down list.

2. To set the Carrier frequency, specify the necessary values in the Frequency and Channel width
entry boxes .

3. Specify the Threshold level.

4. Specify the Integration BW. The Integration BW is the bandwidth over which the carrier is measured.

5. If necessary, specify the Resolution Bandwidth by changing the value in the Res BW entry box. Auto
is the recommended setting.

6. Set the Detection method. Select +Peak, Avg (VRMS), or Avg (of logs).

NOTE. If the power level measured over the Integration BW about the carrier frequency is below the
threshold level, the instrument concludes that no carrier is present and no relative measurements will be
taken. Absolute measurements will still be taken.

Ranges and Limits Tab

Use the Ranges and Limits tab to specify the parameters that control the Spurious measurement. From the
Ranges and Limits tab, you specify the start and stop frequencies for ranges, whether or not a range is
enabled, the parameters that specify what constitutes a spur, measurement filter shape and bandwidth, and
the detection method used for processing signals, as well as the pass/fail parameters for Limit Testing.
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Setting Description

Expand Displays the Ranges and Limits Table in a new, resizeable window.

Reset layout You can reorder columns in the Ranges and Limits Table by dragging the columns to a
new position. Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Ranges and Limits table from a file.

Save Click to save the current Ranges and Limits table to a file.

xxx

To specify the ranges and limits for the Spurious measurement:

Edit the values in the Ranges and Limits table.

You can edit the Ranges and Limits table in two ways:

Edit values directly from the Ranges and Limits tab. You will need to scroll the table to access all
settings.

Click the Expand button. This displays the Ranges and Limits Table in a new window that can be
sized to the fullscreen.

The following table describes the parameters that are set in the Ranges and Limits Table.
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Ranges and Limits Table Settings

Setting Description

On Specifies whether or not measurements are taken in the specified range.

Start (Hz) Readout of the start frequency for the selected range.

Stop (Hz) Readout of the stop frequency for the selected range.

Filter shape Specifies the filter shape used for the Spurious measurement.

BW (Hz) Specifies the bandwidth used for the selected filter shape.

Auto Sets the BW automatically. If CISPR is selected for Filter shape, this control is disabled.

Detector Sets the processing method used for compressing excess intermediate data into the
desired number of trace points.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW
Minimum: 1/10,000 RBW setting. Disabled when Filter shape is set to CISPR.

VBW On Specifies whether the VBW filter is applied.

Thrshld (dBm) Threshold specifies the level that must be exceeded for a signal peak to be recognized
as a spur. A signal peak must also exceed the Excursion setting to be considered a spur.

Excrsn (dB) Excursion specifies the peak to peak magnitude that must be exceeded for a signal peak
to be recognized as a spur. A signal transition must also exceed the Threshold setting
to be considered a spur.

Mask Selects the type of limits used for Pass/Fail testing. Spurs that exceed the mask settings
are considered violations. The available choices are shown below.

Abs Spurs that exceed the Absolute limits settings are identified as violations.

Rel Spurs that exceed the Relative limits settings are identified as violations.

Abs & Rel Spurs that exceed both the Absolute and Relative limits settings are identified as
violations.

Abs OR Rel Spurs that exceed either the Absolute or Relative limits settings are identified as
violations.

Off Turns off limit testing for the selecting range. Measurements are still taken in the range,
but violations are not flagged. Signal peaks that exceed the Threshold and Excursions
values will still be identified as spurs.

(Abs Start and Abs Stop) Absolute amplitude limits are not based on the measured carrier amplitude or manual
reference. Start and stop values can be different.

Abs Start (dBm) Abs Start specifies the limit at the start frequency of the range.

Abs Stop (dBm) Abs Stop specifies the limit at the stop frequency of the range.

Abs Same Sets the limit at the start and stop frequencies to the value set for the start frequency.

(Rel Start and Rel Stop) Relative amplitude limits are calculated from the Power Reference. If the Power
Reference is set to the Carrier level, the relative amplitude limits will change with the
carrier level. Start and stop values can be different.

Rel Start (dB) Specifies the limit at the start frequency of the range.

Rel Stop (dB) Specifies the limit at the stop frequency of the range.

Rel Same Sets the limit at the stop frequency to the value set for the start frequency.

Save As Click to save the current Ranges and Limits table to a file.

Load Click to load a saved Ranges and Limits table from a file.

Done Save changes and close the Ranges and Limits Table window.
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xxx

Changing the Range Start and Stop Frequencies

To change the range start and stop frequencies, edit the Start and Stop frequencies in the Ranges and
Limits Table:

1. Click the Expand button on the Settings > Range and Limits tab. This displays the Ranges and
Limits Table.

2. Click the On box for a range to take measurements in the range.

3. Click on the Start or Stop frequency setting to change it. Type in a number for the frequency and a
letter as a multiplier. You can use k, m, or g to set the frequency multiplier.

4. Click Done to save your changes.

Specifying Spur Requirements

A spur is a signal peak that exceeds both the Threshold and Excursion settings in the Ranges and Limits
table. The Threshold and Excursion settings are absolute values; they are not calculated relative to a
reference. The Threshold and Excursion settings are specific to the selected range. If you want to use
different settings for spurs in different ranges, you have to set the values separately for each range. The
Excursion control is used to avoid interpreting a single spur as multiple narrower spurs by requiring the
amplitude to drop by the Excursion amount between spurs. Raising the Threshold value means that
fewer, larger signals will be identified as spurs.

To specify the spur requirements for a range:

1. Click the Expand button on the Range and Limits tab. This displays the Ranges and Limits Table.

2. Select the Range (A–T) for which you want to specify the spur requirements.

3. Set the Thrshld value.

4. Set the Excrsn value.

Setting Limits

Use the Limits settings in the Ranges and Limits Table to specify the pass/fail parameters for the Spurious
measurement. When the Mask setting is set to any value except off, the instrument identifies any signal
peak that exceeds the specified limits as a violation and displays Fail on the screen. If no signal peak
exceeds the limits, the instrument displays Pass on the screen.

Performing Pass/Fail Limit Testing

To set limits:

1. Click the Expand button on the Range and Limits tab. This displays the Ranges and Limits Table.

2. Adjust the Start and Stop frequencies as required for each range you want to test.

3. For ranges that you wish to test, verify that the On box is checked.
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4. For each range you wish to test, select the desiredMask type from the drop-down list.

5. Set the limits as desired in the Abs Start, Abs Stop, Rel Start, and Rel Stop boxes. The values you
can edit depend on the mask type you select.

6. Verify that the Thrshld and Excrsn values are set as required. These are the values that define a spur.

7. Click Done to save your changes and close the Range and Limits Table window.

8. Click Run to begin testing.

CCDF Display

The CCDF (Complementary Cumulative Distribution Function) is a statistical characterization that plots
power level on the x-axis and probability on the y-axis of a graph. Each point on the CCDF curve shows
what percentage of time a signal spends at or above a given power level. The power level is expressed in
dB relative to the average signal power level. The CCDF Display also shows the Average power level
and the Peak/Average ratio.

To show the CCDF display:

1. Recall an appropriate acquisition data file.

2. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

3. From theMeasurements box, select RF Measurements.

4. Double-click the CCDF icon in the Available Displays box. This adds the CCDF icon to the Selected
displays box.

5. Click the OK button.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the CCDF Display

Item Display element Description

1 100% The top of the graph represents the 100% probability that the signal will be at
or above the average signal level.

2 Power level select Adjust to display the value of the CCDF curve at a specific power level. The
selected power level is indicated by a small triangle on the CCDF curve.

3 CCDF value Readout of the value of the CCDF curve at the selected power level.

4 Avg Readout of the Average power level and the CCDF value at the Average
power level.

5 Readout Table Readout of the CCDF curve at six points.

6 Pk / Avg Readout of the Peak to Average power ratio.

7 Measurement time Readout of the length of time used for the measurement. Displays --- s when
the Measurement time is set to continuous.

xxx

Changing the CCDF Display Settings (see page 161)

CCDF Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The control panel tabs for the CCDF Display are shown in the following table.
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Settings tab Description

Parameters (see page 162) Specifies the time to be measured.

Traces (see page 196) Select the trace to be measured and select reference trace for display.

Prefs (see page 134) Specifies whether on not certain display elements are shown.

xxx

Restore defaults. Sets the CCDF parameters to their default values.

Parameters Tab

The Parameters tab enables you to specify several parameters that control signal acquisition for the
CCDF Display.

Setting Description

Single When Single is selected, the CCDF measurement is based on the Analysis Time
parameters set on Analysis control panel (Setup > Analysis > Analysis Time), shared by
all displays. In Single, CCDF is time-correlated with the other open displays.

Total Time When Total Time is selected, you can adjust its value. The value set here does not affect
the Analysis Length value set in the Analysis control panel. If the Total Time value is
longer than the Analysis Length, CCDF uses multiple acquisitions to collect signal data.

Continuous When Continuous is selected, the CCDF measurement combines each new record
(Actual Analysis Length) into the existing result. It does not erase and start over until
user presses STOP or CLEAR.

Span Specifies the range of frequencies used for analysis.

xxx

Single

To have statistically meaningful results, CCDF works best when calculated on at least 1 ms of data.
Depending on the Analysis Time setting, the CCDF display may present error messages:

If the Actual Analysis Time is greater than 1 ms, the CCDF Display will calculate the trace without
any problems.

If the Actual Analysis time is less than 1 ms, the CCDF Display will measure the data as best if
can, but if it receives fewer than 20 samples, the CCDF display will clear the trace and report "Not
enough samples".
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Settling Time Measurement Overview

The Settling Time measurement (Option SVT) is used to measure frequency and phase settling time
of frequency-agile oscillators and subsystems. Automated measurements can reduce user-to-user
measurement variations, improve repeatability and measurement confidence, and save time in gathering
results.

Measurement Definitions

Settling time. The time measured from a reference point to when the signal of interest settles to within
user-defined tolerance.

Settled frequency. The final reference frequency, determined automatically or manually. The tolerance
band is centered about this settled frequency.

Settled phase. The final reference phase, determined automatically or manually. The tolerance band is
centered about this settled phase.

Mask Testing

Mask testing is a tool to automatically determine the pass/fail state of the Device-Under-Test. The mask
is defined over three or fewer user-defined time zones, with an independent limit band for each time
zone. If the mask is violated, the area of violation is highlighted in red on screen, and a Fail message is
displayed. The pass/fail status of the mask test can be queried over GPIB for rapid results. To configure
Mask testing, see the Mask tab (see page 179).

The instrument's Search function can watch the Settling Time measurement for either pass or fail results,
and perform actions such as stopping or saving data when the defined condition occurs. See Mask Test
Limits Settings (see page 601) for details on configuring Mask Test.

Frequency Settling Time Theory of Operation

The following paragraphs describe how a frequency and phase settling measurement is made.
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Frequency settling time flow diagram
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Phase settling time flow diagram

Acquisition hardware collects I and Q samples at the measurement frequency. Sample Rate is based
on the measurement bandwidth setting.

The instantaneous phase is computed as:
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The instantaneous frequency is the derivative of the phase:

Data smoothing is applied (if selected by the user). This filtering method uses ±n adjacent samples to
produce an average value that is used to replace the values of the original 2n samples. An example
is shown below.

If averaging is turned on, the smoothed data array is averaged with data arrays of previous acquisitions on
a point-by-point basis. Smoothing has the advantage of reducing noise-like variations in the measurement,
but carries the risk of masking real measurement data. The amount of smoothing applied must be
determined by evaluating the waveform you see for artifacts that result from the process.

Next, Settled Frequency is calculated. Settled frequency is the average frequency determined by looking
back in time from the point set by the Measurement Length control over a minimum of 256 samples. This
value is used to determine the frequency level about which to center the Tolerance range. The measurement
then searches backward through the data until it finds the first point that exceeds the tolerance range. A
maximum of 20 million acquisition data samples can be processed by the measurement.

Settling Time is measured as the time from the start reference to the point where the frequency remains
within the tolerance band. The start reference can be any of three points:

The trigger point

The beginning of the analysis period. This result can only be computed when the instrument can find a
previous settled state within the measurement period

The point at the end of the previous frequency hop where the frequency first leaves the tolerance band.
This result can only be computed when the instrument can find a previous settled state within the
measurement period.
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Settling time start reference points

All measurements are now complete and the numeric settling time values can be sent to the display.
However, no result traces have been produced yet. Detection is used to reduce the measured points (which
can number up to 10 million) to a number more easily processed by the display processor. +/- Peak
detection is always used, preserving the maximum positive and negative excursions for display. Reducing
the number of points in the result reduces the time resolution of the markers. If averaging is on, the
measurement results are computed on the average of the undecimated results.

Phase Settling Time Overview

Phase settling time is determined, as described previously, with the addition of tilt correction.

The instrument estimates tilt (or slope of the phase) using linear least square fitting over (at least)
256 samples of the phase vs. time waveform, looking backwards from the point set by the Measurement
Length. The instrument adjusts the phase waveform so that its phase is of zero value at the point set
by the Measurement Length.

Settling Time Displays

The Frequency Settling Time measurement is used to measure the frequency settling time of
frequency-agile oscillators and subsystems. The Phase Settling Time measurement is used to measure
the phase settling time of phase-agile oscillators and subsystems. Automated measurements can reduce
user-to-user measurement variations, improving repeatability and measurement confidence and saving
time in gathering results. To measure phase settling, a phase reference is required. This means that the
measurement tool must be frequency- referenced to the device under test, or must act as the frequency
reference to the device under test. To lock the reference to an external source, go to Setup > Configure
In/Out > Frequency Reference and choose External. Values from 1 MHz to 25 MHz in 1 MHz steps
can be used as an external reference.
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To show a Settling Time display:

1. Recall an appropriate acquisition data file.

2. Click the Displays button or select Setup > Displays.

3. From the Measurements box, select RF Measurements.

4. Double-click the Freq Settling icon or the Phase Settling icon in the Available displays box. This
adds the selected display to the Selected displays box (and removes it from the Available displays box).

5. Click the OK button.

6. Press the Replay button to take measurements on the recalled acquisition data file.

Frequency settling time display
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Phase settling time display
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Elements of the Display

Item Display element Description

1 Top of graph Sets the frequency/phase that appears at the top of the graph. However,
note that the top of graph setting, vertical scale setting (Settings > Scale
tab), and Vertical Position settings interact. Adjusting this value changes the
frequency/phase at the top of the graph by adjusting the scale setting.

Phase Settling Time: Sets

2 Vertical Position Sets the frequency/phase value at the vertical center of the graph.

3 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on
screen.

4 Horizontal Position Sets the horizontal position of the trace on the graph.

5 Measurement readouts Displays measurement results. See Measurement Readout Text Color below.

6 Signal transition start indicator A blue vertical line that indicates the staring point of the Settling Time
measurement that is based on the signal transition away from the previous
settled state, if a previous settled state is found within the measurement
period.

7 Trigger point indicator An orange line and “T” (which appears below the graph) that indicates the
location of the trigger point in time.

8 +/- Tolerance indicators A pair of blue horizontal lines that show the tolerance range.

9 Settled time indicator A blue vertical bar that shows the point on the trace at which the measurement
has determined the signal frequency or phase to be settled.

10 Measurement length indicator A magenta vertical line that specifies the end of the allowed measurement
period. This is a control, not a result.

11 Scale Adjusts the horizontal (time) scale of the graph.

12 Clear Restarts multi-trace functions (Avg, Hold) and erases the trace.

13 Function Displays the Detection and Function selections for the selected trace.
(Detection is always +/-Peak for Settling Time measurements.)

14 Show Controls whether the selected Trace is visible or not. When trace is Off, the
box is not checked.

15 Trace Selects a trace. Touching here displays a menu that shows the available
traces and whether they are enabled or not. If you select a trace that is not
currently enabled, it will be enabled.

xxx

Measurement Readout Text Color

The measurement readouts can appear in either black text or red text. Measurement results that appear
in black text indicate:

the signal is settled AND

the signal is settled longer than the minimum settled duration AND

the settling time is valid OR the settling time from trigger is valid

If any of the conditions listed are not met, the measurement results text is red.
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Elements of the Frequency Settling Time Graph

The following illustration shows the various indicators that appear in the Frequency Settling Time graph.

NOTE. The blue vertical bar that indicates the end of the previous settled state may not always appear.
For frequency settling time, this can happen because the starting frequency is outside the measurement
bandwidth.

Elements of the Phase Settling Time Graph

The following illustration shows the various indicators that appear in the Phase Settling Time graph. For
most phase settling time measurements, there is not a previous settled state within the measurement
period, making it impossible to measure the settling time from the previous settled value. However, the
settling time from trigger is typically available.
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NOTE. The blue vertical bar indicating the measurement start time may not appear. Zero phase is
referenced to the measured hop, as the phase will not typically have a settled value during the previous hop.

Measuring Settling Time

1. Select the Displays button.

2. Select RF Measurements from theMeasurements box.

3. Double-click the Freq Settling icon or Phase Settling icon in the Available displays box. Click OK
to complete your selection.

4. Select General Signal Viewing from theMeasurements box.

5. Double-click the Time Overview icon in the Available displays box. Click OK to complete your
selection.

6. Press the front-panel Freq button and use the front-panel keypad or knob to adjust the frequency to
that of the signal you want to measure.
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7. Select the Trig button.

8. In the Trigger control panel, select Triggered. Configure the trigger settings an needed to achieve a
triggered signal.

For the next step in measuring settling time, you must set the starting point of the measurement. To do
this, you will use the Time Overview display.

9. Select the Time Overview display.

10. At the left edge of the graph, drag across the graph to adjust the analysis offset. Adjust the Analysis
Offset to locate the start of the settling time measurement just ahead of the signal transition where
you want to measure the settling time. Any portion of the signal in the gray area will be excluded
from the settling time measurement.

Setting the starting point of the settling time measurement

Even if the signal transition is difficult to see on the Time Overview display, you can set the starting
point based on the location of the Trigger indicator below the graph. Or open the Frequency vs. Time
graph to see the frequency transition.

11. Click in the Settling Time display to select it.

12. Select the Settings button to display the Settling Time Settings control panel.

13. On the Define tab, adjust the Meas BW (see page 176) to improve the signal-to-noise ratio as
appropriate. Make sure the bandwidth covers the settled frequency, particularly when the instrument
Measurement Frequency is not locked to the spectrum Center Frequency (Analysis control panel >
Frequency tab).

14. Set the Target reference (see page 177) to Auto or Meas freq as appropriate. If you select Meas freq,
also set Offset to fine-tune the measurement frequency if necessary.

15. Set the Tolerance (see page 177) as required for your measurement.

If your signal must be settled for a period of time before it is considered settled, you can specify a
minimum settled duration for the settling time measurement.
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16. Select the Time Params tab. Adjust the Min settled duration (see page 178) as required.

To get the measurement made in the correct location on the signal, you must adjust the measurement
length. You do this by dragging the magenta line in the Settling Time graph.

17. Drag the measurement length indicator (magenta line) to the correct location on the signal. Choose a
point at which the signal appears to be well settled. The measurement will then find the exact time at
which the signal actually settled to within the specified tolerance.

Note the difference in the settling time in the two illustrations that follow. In both examples, the Target
reference is set to Auto. The only difference is the measurement length, as shown by the magenta line.

Frequency settling time display before setting the measurement length
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Frequency settling time display after setting the measurement length

Settling Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Frequency and Phase Settling Time displays are shown in the following table.

Settings tab Description

Define (see page 176) Sets the measurement parameters that characterize the settling time measurement.

Time Params (see page 178) Sets measurement end-time and minimum settled duration parameters.

Mask (see page 179) Enable or disables mask testing and sets the parameters that specify the three zones
used for mask testing.

Trace (see page 179) Specifies trace display characteristics and which traces are displayed.

Scale (see page 199) Sets vertical and horizontal scale and position parameters.

Prefs (see page 134) Specifies whether or not to show certain display elements, the maximum number of points
in the exported trace, and the displayed precision of the settling time measurement.

xxx

Settling Time Displays Shared Measurement Settings

The control panel tabs in this section are shared by the Frequency and Phase Settling Time displays. These
control panel tabs are not shared with other RF Measurement displays. With few exceptions, each display
shares values for each of the controls on these tabs. For example, Vertical Scale values are independent for
each of the displays (degrees for Phase Settling Time and Hertz for Frequency Settling Time).
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Common controls for settling time measurement displays

Settings tab Description

Define (see page 176) Specifies the parameters that characterize the settling time measurement.

Time Params (see page 178) Specifies the Measurement length and minimum settled duration for the settling time
measurement.

Mask (see page 179) Specifies the parameters used for Mask testing.

Trace (see page 179) Specify which traces to show and how they are computed.

Scale (see page 182) Specifies the vertical and horizontal scale settings.

Prefs (see page 183) Specifies display parameters of the Settling Time displays.

xxx

Define Tab for Settling Time Displays

The Define tab for the Frequency Settling Time measurement controls several parameters that affect
how the measurement is made.

Meas Freq

Select the frequency of the signal to be measured. Measurement Frequency can be selected as the target
frequency (see Target Reference).

NOTE. If Lock Center Frequency of Spectrum Display to Measurement Frequency is unchecked, then
Measurement Frequency is independent of Center Frequency) Range: Entire input frequency of the
instrument

Meas BW

This control limits the bandwidth of the Settling Time measurement. You use the measurement bandwidth
setting to improve the signal-to-noise ratio of the measurement, resulting in lower measurement
uncertainty. However, if the measurement bandwidth is set too low, resulting in fewer samples per second,
it can reduce the number of points within the measurement length below the 256 stable samples required,
thus causing the analysis to fail. The measurement bandwidth depends on the oscilloscope on which the
recalled file was acquired. To see the effect of measurement bandwidth on measurement uncertainty, see
the RSA6100B Series Specifications and Performance Verification Reference, Tektronix part number
077-0647-XX. This manual can be downloaded from www.tek.com/manuals.
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Target Reference

The target reference is a calculated or user-specified value of final settled frequency within the
measurement period. When set to Auto, the instrument determines this value by averaging at least the last
256 samples at the end of the measurement period. When set toMeas freq, the Target Reference is set to
the Measurement Frequency of the instrument. You can enter a manual offset from the target frequency to
fine-tune the Target Reference whenMeas freq is selected.

Tolerance(+/-)

The Tolerance is the frequency or phase range within which the signal must remain to be considered
settled. This is set as a ± value by the user. In the frequency settling time measurement, the tolerance
band is centered about the target value. In the phase settling time measurement, the tolerance band is
centered about the settled phase value.

The target frequency depends on the Target reference value setting:

If Target Reference is set to AUTO, then the target value is the settled value (the frequency at which
the signal is considered settled).

If Target Reference is set to MeasFreq, then the Target value =Meas Frequency + Offset.

Offset

Offset is used for fine-tuning the Target Reference whenMeas freq is selected. The value for Offset is
entered manually.
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Time Params Tab for Settling Time Displays

The Time Params tab is used to set the Measurement length and minimum settled duration parameters.

Measurement Length

Measurement length locates the end of the measurement period for settling time. This value is set
independently of the analysis period for other measurements in the analyzer. This allows other
measurements to display multiple frequency hops during an analysis, while focusing the settling time
analysis on a single hop. You can set the measurement length either by entering a value in the entry box, or
by dragging the magenta bar to the desired location in the graph. Traces and the display to the right of
the measurement time are shown in grey to indicate that this section of the waveform is not being used
in the measurement. If your signal does not settle to within your tolerance band, make sure that the
measurement time ends during the settled portion of the waveform. The beginning of the settling time
measurement is set with the analysis offset control, the same as other measurements in the instrument.
Use analysis offset to exclude earlier hops from the measurement. See Analysis Time (see page 607)
for setting the analysis offset control.

If there is more than one phase or frequency hop in the signal to be analyzed, use the Measurement Length
control to instruct the analyzer which hop to measure. First, adjust the main Analysis Offset control to a
point in time slightly earlier than the transition you wish to measure. Do this in the Time Overview display
or the Analysis Settings control panel. Then adjust the Measurement Length so the end of the Settling Time
measurement falls within the apparent settled period after the signal transition. The reason it is important
for the user to set this control is that the Settling Time measurements start at this point and look backwards
in time (towards the signal transition) to find the latest trace point that is not inside the tolerance band.

NOTE. If your signal does not settle to within your tolerance bands, make sure that the measurement time
ends during the settled portion of the waveform.

Min Settled Duration

The minimum settled duration is the amount of time the signal must remain within the tolerance band to be
considered settled. Some user specifications require that the signal be settled for a minimum period. If this
is not required in your application, set this value to the default of 0 seconds.
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Mask Tab for Settling Time Displays

The Mask tab is used to specify the parameters used for Mask testing.

Enable Mask Test

Enables or disables mask testing.

Start 1, 2, 3

Sets the starting point for the time zone of interest. If you don't want to use all three zones, set the Start
Time for the unneeded zones to a time after the end of the Measurement Length.

Stop

Sets the end point for the final time zone of interest.

Limit (+/-)

Sets the mask violation limits for each time zone.

Mask Time Reference

When mask testing is enabled, the Mask time reference selection specifies the starting point of the mask.
You can choose to start the mask test at the trigger point or at the point on the trace where the signal began
its transition from its previous settled frequency or phase level to the level you intend to measure.

This capability is useful because some applications do not have a trigger signal available. For those
situations where a trigger signal is available, the specification for the device-under-test may require
that measurements be referenced to that signal.

Trace Tab for Settling Time Displays

The Traces Tab allows you to set the display characteristics of displayed traces.
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Smooth

Smooth is a low-pass filter function that uses n points in the trace to determine the smoothed value. For
example, in the case of n=3, 3 consecutive points are averaged to determine the result of the smoothed
output. This is very useful for single-shot signals that contain significant noise where multiple trace
averages cannot be used. However, smoothing does have limits, and the user should visually determine
whether smoothing is removing noise from the measurement, or if it is affecting the signal. The following
illustration shows the effect smoothing has on the displayed trace.

The range for the Smooth function is 2–1000. The setting resolution is 1. arrow keys increment it in steps
of 1, 2, 5, 10. When smoothing is enabled, it applies to both traces. Smooth is turned off by default.

Average

This sets the number of acquisitions to be averaged together to produce the result. Averaging reduces
random variations but maintains the correct waveshape for repeating signal aberrations. To use averaging,
the signal must be repetitive. For example, the tuning direction must always be same for each measurement
to be averaged. Signals that vary in tuning direction will tend to average positive-going effects with
negative-going effects and the settling time characteristics will cancel out.
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The range for the Average function is 2–10000. The setting resolution is 1. arrow keys increment it in
steps of 1, 2, 5, 10. When smoothing is enabled, it applies to both traces. Smooth is turned off by default.

Trace

Selects a trace for display. Choices are Trace 1 and 2. Either trace can be a recalled trace.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.

5. Check the Show Recalled Trace check box.

6. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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Scale Tab for Settling Time Displays

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical

Scale Changes the vertical scale or span of the graph.

Position Sets the frequency (or phase) at the vertical center of the graph.

Relative Freq Sets the vertical (position) display readouts to show frequency values relative to the
center frequency or as absolute values.

Autoscale Resets the Scale and Position to center the trace in the graph.

Horizontal

Scale Sets the range of time shown in the graph.

Position Allows you to pan the graph left and right.

Autoscale Resets Scale and Position to the automatically determined settings.

xxx
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Prefs Tab for Settling Time Displays

The Prefs tab allows you to change display parameters of the Settling Time displays.

The following table explains the controls that can appear on the Prefs tab.

Setting Description

Max trace points Sets the number of trace points used for marker measurements and for results export.

Show graticule Select to display or hide the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Settling Time decimal places Specifies the precision of the settling time measurement readout that appears below the
graph. This setting does not affect the precision of internal calculations.

xxx

SEM Display

The SEM (Spectrum Emission Mask) display measures out-of-band emissions immediately outside the
channel bandwidth that result from the modulation process and non-linearity in the transmitter. The
Spectrum Emission Mask display allows you to define up to six pair of masks, or offsets, that specify the
limits for out-of-band emissions and performs a pass/fail tests of the signal against the defined offsets
and limits.

To show the Spectrum Emission Mask display:

1. Recall an appropriate acquisition data file.

2. Select Displays or select Setup > Displays.

3. In the Select Displays dialog, select RFMeasurements orWLAN Analysis in the Measurements box.

4. In the Available displays box, double-click the SEM icon or select the icon and click Add. The SEM
icon will appear in the Selected displays box and will no longer appear under Available displays.

5. Click OK to show the Spectrum Emission Mask display.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Check mark indicator Indicates the display for which the acquisition hardware is optimized.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Top-of-graph setting Sets the level that appears at the top of the graph.

3 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

4 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with
the dB/div and Vertical Position settings.

5 Autoscale Properly offsets the peak of the display from the top of the screen.

If the screen has been enlarged through a manual vertical (dB/div) setting
entry, the view is not vertically rescaled when Autoscale is used.

6 CF / Pos Default function is CF - center frequency (equivalent to the Measurement
Freq setting). If Horizontal scaling has been manually adjusted in Setup >
Settings > Scale, then Pos replaces CF as the setting at the bottom-left
corner of the screen. Adjusting Pos shifts the trace left or right in the graph,
but does not change the measurement frequency.

7 Span / Scale Default function is Span - frequency difference between the left edge of
the display and the right edge. If Horizontal scaling has been manually
adjusted in Settings > Scale, then Scale will replace Span as the setting at
the bottom-right corner of the screen.

8 Clear Erases the current results from the display.

9 Function readout Readout of the Function selection for the Reference channel (Setup >
Processing > Function).

Spurious

10 Detection readout Readout of the Detection selection for the Reference channel (Setup >
Processing > Detection).

11 Pass / Fail readout Readout indicating whether any part of the trace has exceeded the any of
the limits defined in the Offsets & Limits table (Setup > Settings > Offsets
& Limits Table).

xxx

Pass / Fail Readout

This readout displays either Pass or Fail XX%. When the signal exceeds the mask in any offset, it is
considered a mask violation, and results in Fail XX% being displayed. If there are no mask violations,
Pass is displayed.

How the fail percentage is determined. Each offset has two sides, one lower and one upper. For example,
Offset A has two sides: AL (lower side) and AU (upper side). In the SEM display, there is a maximum of
six offsets (A-F) and each offset can have a maximum of two sides (if Both is selected for Side in the Offsets
& Limits table). This results in a total of six offsets multiplied by two sides per offset, which results in 12
offsets. Mask violations can occur in any of these offsets. The failure percentage is calculated as follows:

Fail percentage = Number of offsets with mask violations x 100 / Total number of enabled offsets
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For example: Assume there are three enabled offsets: A, B, C, and all these offsets have both lower and
upper sides. Thus, the total number of enabled offsets is equal to six. Suppose there are mask violations
in the offsets AL and CU, then the number of offsets having mask violations is equal to 2. Therefore,
Fail percentage = 2 * 100 / 6 = 33%.

Results Display

The Results Display shows the measurement results for the SEM display.

Readout Description

Ref: A two-part readout to the left of the table that displays information about the
Reference Channel. The first part of the readout displays the Measurement Type
selected on the Parameters tab. The second part of the readout displays the
measurement result for the Reference channel.

Row A sequence number for ordering the offsets. Click to organize by row number,
resort rows from high to low or low to high.

Offset The Offset name. A combination of the offset (A-F) and the location (U for upper
and L for Lower).

Start Freq The start frequency of the offset (relative to the Measurement Freq).

Stop Freq The stop frequency of the offset (relative to the Measurement Freq).

Peak Abs Absolute power peak power at worst case margin of the offset

Margin Abs The worst case difference between the trace and the absolute limit line. Note that
an offset can have different start and stop levels, thus, the margin can vary if the
offset start and stop levels are different.

Peak Rel Relative peak power of worst case margin of the offset. Relative with respect
to the reference power level.

Margin Rel The worst-case difference between the trace and the relative limit line. Because
an offset can have different start and stop levels, the margin can vary if the offset
start and stop levels are different.

@Freq The frequency at which the worst margin occurs.

Integ Abs The absolute integrated power of the offset.

Integ Rel The relative integrated power of the offset (with respect to the reference power).

xxx

Reordering results in the results table. You can sort the results in the Results table by clicking the column
heading containing the values you want to sort on. You can sort results for the following columns: Row,
Offset, Start Frequency, Stop Frequency, Peak Abs, and Peak Rel.
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Rearranging columns in the results table. You can rearrange the order of the columns and their size. To
rearrange columns, select the column heading you want to move and drag it to the new position; the new
location is indicated by a dark blue bar that appears between column headings.

You can resize the columns by selecting the divider between columns and dragging it to a new position.

Spectrum Emission Mask Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Spectrum Emission Mask display are visible when SEM is the selected display. To
display the SEM Settings, select Setup > Settings.

Settings tab Description

Parameters Tab (see
page 187)

Specifies several characteristics that control how the measurement is made.

Processing Tab (see page 189) Specifies settings for detection on the Reference channel and the offsets. Specifies
the function setting.

Ref Channel Tab (see
page 190)

Specifies how the measurements on the reference channel are performed.

Offsets & Limits Table (see
page 190)

Specifies characteristics of offsets and mask limits.

Scale Tab (see page 193) Specifies the vertical and horizontal scale settings.

Prefs Tab (see page 194) Specifies the appearance features of the graph area and the maximum trace points.

Standards Presets (see
page 21) button

Click this button to access the Standards Presets options dialog window. You can select
the standard and bandwidth to apply to the standard you select. Click on the link to the
left for information about standards presets.

xxx

Parameters Tab - SEM

The Parameters tab specifies several characteristics that control how the Spectrum Emission Mask
measurements are made.

Setting Description

Meas Freq Specify the frequency of the signal to be measured.

Step Sets the increment size when changing the Frequency using the knob or mouse wheel.

Auto When Auto is enabled, the step size is adjusted automatically based on the span setting.

Real-Time When Real-Time mode is enabled, the entire SEM span is measured using a
real-time/contiguous acquisition. Not all described parameters are available in Real-Time
mode.
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Setting Description

Measure Noise floor

(Only available when
SignalVu-PC is connected to
an MDO4000B/C instrument.)

Takes preliminary acquisitions to measures the instrument noise floor. This initiates a
noise correction. A noise correction signal is created by switching off the RF input to
the MDO4000B/C and performing acquisitions of the instrument’s internal noise. Fifty
acquisitions are averaged to create the noise reference signal. The noise reference
signal is measured for the Reference channel and each Offset is defined by the
measurement settings.

Apply noise correction

(Only available when
SignalVu-PC is connected to
an MDO4000B/C instrument.)

This item is enabled and the check box automatically checked after the noise reference
signal is taken when the Measure Noise floor button is clicked. This initiates noise
reference subtraction from the incoming signal power for each region to create the
corrected result. All calculations are performed in Watts and then converted to the
desired units.

The amount of noise correction is limited to 20 dB to avoid the possibility of a negative
power measurement. This is a rare condition that could occur if the subtraction of the
reference power from the channel power results in a negative value (or “infinite” dBm).
The noise reference for a region is subtracted from each trace point in the channel,
rather than offsetting the entire region by a single amount. This produces a smooth trace
with no discontinuities at the region edges.

NOTE. If any relevant settings (such as reference level, frequency, span, RBW) are
changed once the noise reference is measured, the following warning message will be
displayed to notify you that Noise Correction was not applied:

Noise correction not applied - select Measure Noise Floor for new noise correction.

Measurement Type Specifies the type of measurement for the reference channel; used as a reference for
the offsets.

Total Power Sets the reference to the integrated power of the reference channel within the reference's
integration bandwidth.

PSD Sets the reference to the mean of the power spectral density (dBm/Hz) of the reference
channel. The trace and the absolute and relative limits line are also in dBm/Hz

Peak Sets the reference to the Peak power of the reference channel.

Offset definition Defines the relative position of the start/stop frequency of an offset. Choose the offset
definition based on the standard.

Ref center to OS center Specifies that the start/stop frequencies are defined from the center frequency of the
reference channel to the center of the filter BW.

Ref center to OS edge Specifies that the start/stop frequencies are defined from the center frequency of the
reference channel to the center of the (inner) edge of the filter BW of the offset.

Ref Edge to OS center Specifies that the start/stop frequencies are defined from the edge of the reference
channel to the center of the filter BW of the offset.

Ref Edge to OS edge Specifies that the start/stop frequencies are defined from the edge of the reference
channel to the (inner) edge of the filter BW of the offset.

Filter Shape Specifies the shape of the filter determined by the window that is applied to the data
record, in the spectrum analysis, to reduce spectral leakage. 3GPP specifies a Gaussian
window shape be applied to the reference channel measurements.

Gaussian This filter shape provides optimal localization in the frequency domain.

Rectangular This filter shape provides the best frequency, worst magnitude resolution. This is
essentially the same as no window.

xxx
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Processing Tab - SEM

The Processing tab controls the Detection settings for the Reference Channel and Offsets, as well as
selecting the Function.

Settings tab Description

Detection (in each sweep)

Ref Channel Specifies the Detection method used for the Reference Channel. Detection is used to
produce the desired measurement result (peak or average) and to reduce the results
of a measurement to the desired number of trace points.

Avg (VRMS) For each sweep, each point of the trace is the result of determining the RMS voltage
value for the last 'n counts' of the collected traces for the same point. When 'n count' has
not been reached, partial averaging results are displayed.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from
the results to be compressed into a trace point.

Offsets Specifies the detection method used for the offsets.

Avg (VRMS) Selects the Average Vrms detection method. With this method, each point on the trace
in each offset is the result of determining the RMS Voltage value for all of the results
values it includes.

+Peak Selects the +Peak detection method. With this method, the highest value in each offset is
selected from the results to be compressed into a trace point.

Function (across multiple sweeps)

Function Selects the trace processing method. Available settings are: Normal, Avg (VRMS),
and Hold.

Normal When a new trace has been computed, it replaces the previous trace.

Max Hold With each sweep, each trace point in the new trace is compared to the point’s value in
the old trace and the greater value is retained for display and subsequent comparisons.

Avg (VRMS) For each sweep, each point on the trace is the result of determining the RMS Voltage
value for all of the collected traces' values for the same point.

xxx
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Ref Channel Tab

The Ref Channel tab controls how the measurement of the Reference channel is performed.

Settings tab Description

Power Reference The value used to calculate relative measurements.

Auto When Auto is unchecked, you can enter a value for the reference power, and the
measured reference power is not used or displayed

RBW Sets the RBW for the Reference Channel.

VBW Enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer
emulates the VBW filters of traditional swept analyzers. When the checkbox next to
VBW is not checked, the VBW filter is not applied. SEM standards specify what value of
VBW should be applied, if any.

Channel width Specifies the width of the reference channel.

Integration BW Specifies the integration bandwidth used to compute the total power in the reference
channel.

Channel Filter Specifies the measurement filter used in the Reference Channel. Choices are None
and Root-raised Cosine.

Filter param Specifies the alpha value (or roll-off factor) of the Root-raised cosine filter. Present only
when Channel Filter is set to Root-raised Cosine.

Chip rate Specifies the chip rate used for the Root-raised Cosine filter. Present only when Channel
Filter is set to Root-raised Cosine.

xxx

Offsets & Limits Table Tab - SEM

The Offsets & Limits Table tab is used to specify parameters that define Offsets and masks.
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Expanded display of Offsets & Limits Table
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Setting Description

Buttons

Expand Displays the Offsets & Limits Table in a new, resizeable window.

Reset Layout You can reorder columns in the Offsets & Limits Table by dragging the columns to a new
position. Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Offsets & Limits table from a file.

Save As Click to save the current Offsets & Limits table to a file.

Done When the table is expanded, click Done when you have finished editing the table to save
your changes and close the expanded table display.

Table columns

On Specifies whether or not measurements are taken in the specified offset.

Start (Hz) Start Frequency of the selected offset.

Stop (Hz) Stop Frequency of the selected offset.

Side Specifies whether the specified range appears on both side of the carrier frequency or
just one side (left or right).

RBW (Hz) Specifies the RBW for the selected range.

n (RBWS) An integer value that specifies how many times to multiply the RBW to set the Filter
bandwidth.

Filter BW (n x RBW) Displays the Filter BW. Filter BW is the equivalent BW of each point in the offset. When
n > 1, an integration technique is used to achieve the Filter BW using narrower RBWs.
For most SEM measurements, this value is set to 1. The 3GPP standard suggests n
greater than 1.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW
Minimum: 1/10,000 RBW setting.

VBW On Specifies whether the VBW filter is applied.

Mask Select the type of limits used for Pass/Fail testing. Signal excursions that exceed the
mask settings are considered violations. The available choices are shown below.

Abs Start (dBm) Specifies the mask level at the inner edge of the selected offset.

Abs Stop (dBm) Specifies the mask level at the outer edge of the selected offset.

Abs Same Specifies whether the value for the inner and outer edges of the offset must be the same
value. When enabled, the Abs Stop cell is grayed-out and set to the value of the Abs
Start cell.

Rel Start (dBm) Specifies the mask level for the Relative mask at the inner edge of the selected offset.

Rel Stop (dBm) Specifies the mask level for the Relative mask at the outer edge of the selected offset.

Rel Same Specifies whether the inner and outer edges of the offset must be the same value.
When enabled, the Rel Stop cell is grayed-out and its value is set to the value of the
Rel Start cell.

xxx
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Scale Tab - SEM

Use the Scale tab to change the vertical and horizontal scale settings. Changing the scale settings changes
how the trace appears on the display. In effect, these controls operate like pan and zoom controls.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Specifies the frequency range displayed in the graph

Position Specifies the frequency shown at the center of the graph.

Autoscale Resets the scale of the horizontal axis to optimize the display of the trace.

Reset Scale Resets all settings to their default values.

xxx
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Prefs Tab - SEM

The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout and switching the Graticule display on/off. Some parameters appear with most displays while
others appear with only one display.

Setting Description

Show graticule Controls the vertical position and scale of the trace display.

Max Trace points (per range) When the spectrum analysis produces more than the selected maximum number of
points, the method specified in Detection control is used to decimate the result. This
setting applies to both the Reference channel and offsets.

Show Marker readout in graph Adjusts the reference level away from top of the graph.

Show limits Controls the appearance of mask limits in the graph.

Shaded Shows limits using a shaded area. Green shading is used to identify Absolute limits. Blue
shading is used to indicate Relative limits.

Line only Shows limits using only a line. A green line is used to identify Absolute limits. A blue line
is used to indicate Relative limits.

None No lines or shading are used to indicate limits in the graph. Violations of the mask are still
identified by red shading.

xxx

RF Measurements Shared Measurement Settings

The control panel tabs in this section are shared by multiple displays in the RF Measurement folder (Setup
> Displays). With few exceptions, each display maintains separate values for each of the controls on these
tabs. For example, Scale values are independent for each of the displays.
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Common controls for RF measurement displays

Settings tab Description

Freq & RBW (see page 195) Allows you to specify the Center Frequency, Step size and RBW.

Traces (see page 196) Specifies trace parameters such as detection method and whether smoothing is enabled.
Traces can also be saved and loaded for reference from this tab.

Scale (see page 199) Specify vertical and horizontal scale settings.

Prefs (see page 134) Specify appearance features of the graph area.

xxx

Freq & RBW Tab

The Freq & RBW tab specifies frequency parameters for some of the RF Measurements displays.

Setting Description

Meas Freq Specifies the measurement frequency.

Step The Step control sets the increment/decrement size for the adjustment of the center
frequency. If Auto is enabled, the analyzer will adjust the Step size as required.

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is
Independent of the Spectrum view's RBW setting.

VBW Adjusts the VBW (Video Bandwidth) value.

xxx

NOTE. While the measurement frequency and step settings on this control tab are shared between ACPR,
MCPR and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each
measurement.

VBW

The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.
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Traces Tab

The Traces tab enables you to select traces for display. You can choose to display live traces and/or
recalled traces. The Trace tab (see page 179) for Settling Time displays is described in the Settling Time
controls section.

NOTE. Not all RF Measurements support multiple traces and/or save and recall of traces.

Setting Description

Trace Selects a trace for display. Choices are Trace 1, 2, and Gaussian (CCDF display only).
Trace 1 and 2 can be recalled traces.

Show Shows / hides the selected trace.

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show recalled trace Used to select a saved trace for display.

Function Selects the trace processing method (Spurious display only). Possible settings are:
Normal, Average (VRMS), Avg (of logs), and Max Hold.

xxx

Trace Processing

The trace can be processed to display in different ways. The Function setting controls trace processing.

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Normal - Displays the trace record for each display point without additional processing.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Avg (of logs) – This is a trace function used to emulate legacy spectrum analyzer results and for the
specification of displayed average noise level. In older swept analyzers, a voltage envelope detector is
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used in the process of measuring signal level, and the result is then converted to Watts and then to
dBm. Averaging is then applied to the resultant traces.

For CW signals, this method results in an accurate power measurement. However, with random noise
and digitally modulated carriers, errors result from this 'average of logs' method. For random noise,
the average of logs methods results in power levels -2.51 dB lower than that measured with a power
meter, or with a spectrum analyzer that measures the rms value of a signal, and performs averaging on
the calculated power in Watts and not dBm or other log-power units.

This detector should be used when following a measurement procedure that specifies it, or when
checking the Displayed Averaged Noise Level (DANL) of the instrument. The 'average of logs'
detection and trace function is used for DANL specification to provide similar results to other
spectrum/signal analyzers for comparison purposes. Use of the Average of Logs method of
measurement is not recommended for digitally modulated carriers, as power measurement errors
will occur.

NOTE. The Detection setting does not affect the trace until the spectrum length is longer than the Auto
setting.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.
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1. Navigate to the desired file and click Open.

2. Check the Show Recalled Trace check box.

3. Verify that the trace's Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Gaussian Trace

The Gaussian trace is a reference trace that you can compare your trace against. Because the Gaussian
trace is for reference, there are no settings for the trace other than whether or not it is shown.
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Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Center Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units. This is only accessible when the vertical units are
set to dBm.

Offset Adjusts the Reference Level away from the top of the trace display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Offset Allows you to pan a zoomed trace without changing the Measurement Frequency. Offset
is only enabled when the span, as specified by Freq / div, is less than the acquisition
bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Log (Spurious only) Resets the display to show the frequency axis in a logarithmic scale.

xxx
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Prefs Tab

The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout and switching the Graticule display on/off. Some parameters appear with most displays while
others appear with only one display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points In general, time-domain traces can include up to 100K points and frequency-domain
traces can include up to 10K points. When the analysis produces a results array longer
than the selected trace length, the trace is decimated (using the method specified with
the Detection control) to be equal to or less than the Max trace points setting (except
when Max trace points is set to Never Decimate). This decimated (or undecimated) trace
is what is used for marker measurements and for results export.

Settling Time decimal places
(Frequency and Phase Settling
Time displays only)

Specifies the number of decimal places shown in the results readout below the graph.
This setting does not affect the precision of internal calculations.

Show trace legend (CCDF
(Complementary Cumulative
Distribution Function) display
only)

Displays or hides the trace legend.

xxx
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Tracking Generator

The tracking generator feature (Option 04) enables the Transmission Gain measurement and allows you to
use the internal signal generator to measure the gain and response of filters, amplifiers, attenuators, and
other such devices. The Transmission Gain display shows the frequency on the horizontal axis and the
gain or loss on the vertical axis. You may also use this display to tune responses to needed specifications.
When used for gain and loss, the tracking generator trace can be normalized using the calibrate function.
You may select important operating parameters, including number of measurement points, output power,
and measurement resolution bandwidth.

The Return Loss (see page 225) measurements (Option SV60-SVPC) provide return loss, VSWR, cable
loss, and distance to fault (DTF) measurements. The Return Loss option requires the tracking generator
option (Option 04). These measurements use a vector calibration, which requires the use of an open, short,
and load calibration kit. Calibration kits are available from Tektronix, or you can use your own.

NOTE. Options 04 and SV60-SVPC are not available for the RSA7100A or RSA306B.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

How to use the Transmission Gain display

Perform the following procedures in the order presented to perform a transmission gain measurement.

Access the Settings panel

1. Select Setup > Displays.

2. In the Measurements panel, select Tracking Generator.

3. Double click the Transmission Gain icon in the Available displays panel to select that display.

4. Click OK.

5. Click on the Favorites bar to open the Transmission Gain Settings panel.
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Set parameters before running normalization

1. Connect your test setup without the DUT (filter) to the RF Out and RF In connectors.

2. Set the Start and Stop frequencies and the RBW in the Freq Setup tab of the Settings panel.

Entering the Start and Stop frequencies sets the measurement span.

3. If desired, select how you want the display to appear in the Prefs tab.

Run a normalization

1. Click the Normalize button on the Transmission Gain Settings panel. The following dialog will
appear. The first column shows the conditions of the most recent normalization. The second column
shows the current settings.

2. Click the Perform Normalization... button. The following dialog will appear with a connection
diagram.
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3. Set the amplitude, connect the test setup (without the DUT) between the RF Out/REFL In and RF In
ports.

4. Click the Normalize button. Progress is shown in yellow text on the display as percent complete.

5. When the process is complete, the normalization conditions will show in the dialog.

6. Click Close.

7. The normalization status will show as Norm: On in the top left portion of the display.

Taking a measurement

1. Once the normalization is complete, connect the DUT into the test setup and the measurement will
begin.

2. Select Setup > Amplitude to open the Amplitude control panel.

3. In the Internal Settings tab, set Internal Attenuator to 0 dB. This will reduce the noise floor. You may
want to set this to something else depending on your measurement environment, but this is typical
for a 3 GHz loss filter.

4. Click to return to the Transmission Gain Settings control panel and select the Tracking Gen tab.
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5. Set the Output Power Level. You should set this and the Ref Level to the same value. In the following
example (see below image), both are set to –8 dB.

6. If you change settings after the initial normalization, run another normalization with the new settings
and then rerun the measurement.

Reading the display

The following image shows a measurement performed on a low pass filter from 10 MHz to 7.5 GHz. A
reference marker (MR) is placed at 3.006 GHz. A marker (M1) is placed at the minimum gain value.

1. Norm: Shows the normalization status at the top of the Transmission Gain display. This can be
one of the following:

On: The unit has been normalized and is making measurements at the same frequencies at
which it was normalized.

On: Interp: The unit has been normalized, but is making measurements at frequencies other than
the normalized points and is interpolating the normalization between points.

Off: The unit has not been normalized or one or more of the operating conditions has changed.
Operating conditions are Frequency Range (outside normalized frequency range), Tracking
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Generator Output Power, Reference Level, Preamp On/Off, RF Attenuation, or Temperature
(>5° C from the normalized temperature).

2. Start: Shows the start frequency of the measurement, which is set in the Freq Setup tab of the Settings
control panel.

3. Stop: Shows the stop frequency of the measurement, which is set in the Freq Setup tab of the Settings
control panel.

Transmission Gain Display Settings

Favorites Toolbar:

The Settings control panel tabs allow you to change various parameters and settings for the Transmission
Gain display.

Freq Setup - Tracking generator

The Freq Setup tab provides access to frequency settings for the Transmission Gain display.

Setting Description

Frequency The frequency at the center of the selected Span.

Span The difference between the start and stop frequencies.

Points The number of frequency points in the measurement range.

Res BW The resolution bandwidth of the measurement.

Start Freq The lowest frequency in the span.

Stop Freq The highest frequency in the span.

xxx

Center, Start, Stop, and Span Frequencies Are Correlated

Changing the values for the Frequency, Start frequency, Stop frequency or Span will change the values for
the other settings, depending on the setting you change. For example, if you change the Frequency, the
Start and Stop frequencies will be adjusted automatically to maintain the same Span.
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If the Start and Stop frequencies are changed so that they are closer than the minimum span setting, the
Start and Stop frequencies will be adjusted to maintain the minimum Span setting.

Setting Changed Manually Settings Changed Automatically As
a Result

Setting Not Automatically Changed

Start Frequency, Span Stop

Stop Frequency, Span Start

Frequency Start, Stop Span

Span Start, Stop Frequency

xxx

Track Gen tab - Tracking generator

The Track Gen tab allows you to adjust the output power level from -3 dBm to -43 dBm.

Prefs tab - Tracking generator

The Prefs tab enables you to change parameters of the measurement display.

Setting Description

Show measurement
points

Marks each measurement point on the trace.

Show graticule Displays or hides the graticule in the display.

Show Marker readout in
graph

When a marker is enabled, this setting displays or hides the marker readout, but not the
marker itself, on the graph area.

xxx
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Scale tab - Tracking generator

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Center Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Set the position in the middle of the vertical axis.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Reset Resets both vertical and horizontal scales.

Horizontal Controls the span of the trace display and position of the trace.

Start Set the Zoom Start frequency. This only affects the start frequency shown on the graph.

Stop Set the Zoom Stop frequency. This only affects the start frequency shown on the graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Log Resets the display to show the frequency axis in a logarithmic scale.

xxx

Traces tab - Tracking generator

The Traces tab allows you to set the display characteristics of displayed traces.
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Setting Description

Trace Selects a trace.

Show Shows / hides the selected trace.

Function Selects the trace processing method. Available settings are: Normal, Average (VRMS),
Max Hold, Min Hold and Average (of logs).

Count Sets the number of traces averaged to generate the displayed trace. (Present only when
Function is set to anything but Normal.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show recalled trace Displays a saved trace instead of a live trace.

xxx

Trace

Available traces for Transmission Gain are: Trace 1, Trace 2, and Trace 3. These traces are based on the
input signal and enable you to display the input signal using different processing (Function). For example,
you could display Trace 1 with Function set to Normal, Trace 2 with Function set to Max Hold and
Trace 3 with Function set to Min Hold.

Function (trace processing)

The Function setting controls how traces are processed to display.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When the averaging function is applied
to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace's
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace's
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Avg (of logs) – In the process of measuring signal level, the result is converted to Watts and then to
dBm. Averaging is then applied to the resultant traces.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.
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Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Click the ... button to display the Open dialog box.

3. Navigate to the desired file and click Open.

4. Check the Show Recalled Trace check box.

5. Verify that the Show check box is selected for the trace (either on this tab or next to the drop-down
list located at the top-left corner of the graph).
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Calibration for Cable Loss, Return Loss, and DTF measurements

The instrument uses the vector values of the transmitted and reflected signals when making a cable loss,
return loss, and distance to fault (DTF) measurement. These vector values can change with operating
conditions, particularly over temperature, making recalibration sometimes necessary for best results.

NOTE. Option SV60-SVPC (Cable Loss, Return Loss, and DTF) available for the RSA500A series and
RSA600A series only.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

You can perform a new calibration or load an existing calibration. Select one of the following topics to
view the related procedure.

How to perform a new calibration (see page 212)

How to save a calibration (see page 219)

How to load a User calibration (see page 217)

How to load a Factory calibration (see page 217)

You can also view the following calibration topics in this section:

Calibration types (see page 211)

Calibration status messages (see page 223)

Calibration types

The instrument can be used with three different types of calibrations.

Factory

This calibration set is generated during initial factory adjustment or whenever the instrument is returned
for service for NIST calibration, and is stored in the instrument hardware. The factory calibration can
be recalled at any time, and cannot be changed by the user. The calibration is done at high and low
level power settings over the entire frequency range of the instrument. This calibration provides good
measurement accuracy without requiring the use of a calibration kit.

This calibration is good to the PORT of the instrument and does not include any additional cabling
(jumpers) used in your measurement.
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Full

This calibration set is generated by the user at a single power level, over the full frequency range of the
instrument. The number of calibration points used in this calibration is fixed. This was selected as a trade
off between interpolation accuracy versus calibration time. This calibration can be named and stored by
users, and multiple Full calibrations can be saved.

Custom

This calibration is generated by the user and it is user-controlled with regards to power level, start and stop
frequency, and number of calibration points. You can name and store this calibration, and multiple Custom
calibrations can be saved. Because the frequency range of the calibration is limited by your specified
settings, it is recommended only for when you need to optimize measurement speed by specifying a limited
operation range with a defined number of points.

How to perform a new calibration

Before performing a calibration, disconnect any signal from the RF In port. To perform a new calibration
for a cable loss, return loss, or distance to fault measurement, perform the following procedure.

1. Click the Calibrate button located at the bottom right of the display window. The following dialog
will appear. This dialog allows you to select the calibration type.
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2. Click the New Calibration button to open the New Calibration window, and then select a calibration
type.

If you select Full, then you will need to set the Power Level for a calibration covering the full
frequency range of the instrument.

If you select Custom, then you will need to enter frequency, power level, and number of points.
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3. If desired, click the Notes... button and enter notes for this specific calibration. Click OK to save
and close the window.

4. If you want to change the calibration kit details or load an existing calkit file, click on the Cal Kit Info
button. Enter the calkit information and then do one of the following:
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Click Save As to save the calkit file.

Click OK to close the Calkit Information window and use the information one time without
saving a calkit file.

Click Load Cal Kit File to load your own file.

Click Cal Kit Default to load the Spinner 3-N-1 default calkit file.

5. Connect one end of the cable to the REFL In port of the instrument. Ideally, you should use the cable
for the calibration with which you will perform the measurement, effectively removing its influence
from the measurement.

6. Terminate the other end of the cable with an open termination (from the calibration kit).

Later in the procedure, you will switch out the open for the short and then the short for the load.
However, you can do this in any order.

7. Click the Open button to run the Open calibration.
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8. Verify a check mark and the “Complete” message has appeared next to the Open button. This means
that the Open calibration is complete.

9. Remove the open termination from the cable and attach the short termination.

10. Click the Short button to run the Short calibration.

11. Verify a check mark and the “Complete” message has appeared next to the Short button. This means
that the Short calibration is complete.

12. Remove the short termination from the cable and attach the load termination.

13. Click the Load button to run the Load calibration.

14. Verify a check mark and the “Complete” message has appeared next to the Load button. This means
that the Load calibration is complete.

15. The Save As and OK buttons will become available once all calibrations are complete. Select OK
to accept the calibration but not save the file for future use. Select Save As to save the calibration
(see page 219) as a file.

16. Click on the Details button in the Active Calibration window to view the calibration details.

17. Remove the calibration kit from the test setup before starting a measurement.

You are now ready to take a measurement:

Make a cable loss measurement (see page 225)

Make a return loss measurement (see page 229)

Make a distance to fault measurement (see page 232)
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How to load a User calibration

Before performing a calibration, disconnect any signal from the RF In port. If you want to load and use an
existing calibration, click the Load calibration button in the Active calibration window. You will then
need to navigate to the stored calibration file and select it. Click OK to load the calibration.

You are now ready to take a measurement:

How to make a cable loss measurement (see page 225)

How to make a return loss measurement (see page 229)

How to make a distance to fault measurement (see page 232)

How to load a Factory calibration

Before performing a calibration, disconnect any signal from the RF In port. If you want to load Factory
calibration, click the Factory calibration button in the Active calibration window.
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Choose the Power Output Level

The High Power Level output is –10 dBm. High power measurements are the default setting and are
recommended for measurements of all passive circuits such as cables and filters.

The Low Power Level output is –30 dBm. Low power measurements may be needed for testing circuits
that have gain and may be compressed if there are high powers input to them.

Load calibration

Click OK to load the calibration. The Active Calibration window will close.

You are now ready to take a measurement:

How to make a cable loss measurement (see page 225)

How to make a return loss measurement (see page 229)

How to make a distance to fault measurement (see page 232)
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How to save a calibration

Before performing a calibration, disconnect any signal from the RF In port. To save a new calibration,
do the following:

1. Click the Calibrate button located at the bottom right of the display window. The following dialog
will appear. This dialog allows you to select the calibration type.

2. Click the New Calibration button to open the New Calibration window, and then select a calibration
type.

If you select Full, then you will need to set the Power Level for a calibration covering the full
frequency range of the instrument.

The High Power Level output is –10 dBm. High power measurements are the default setting and
are recommended for measurements of all passive circuits such as cables and filters.

The Low Power Level output is –30 dBm. Low power measurements may be needed for testing
circuits that have gain and may be compressed if there are high powers input to them.
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If you select Custom, then you will need to enter frequency, power level, and number of points.

The High Power Level output is –10 dBm. High power measurements are the default setting and
are recommended for measurements of all passive circuits such as cables and filters.

The Low Power Level output is –30 dBm. Low power measurements may be needed for testing
circuits that have gain and may be compressed if there are high powers input to them.

3. If desired, click the Notes... button and enter notes for this specific calibration. Click OK to save
and close the window.
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4. If you want to change the calibration kit details or load an existing calkit file, click on the Cal Kit Info
button. Enter the calkit information and then do one of the following:

Click Save As to save the calkit file.

Click OK to close the Calkit Information window and use the information one time without
saving a calkit file.

Click Load Cal Kit File to load your own file.

Click Cal Kit Default to load the Spinner 3-N-1 default calkit file.

5. Connect one end of the cable to the REFL In port of the instrument. Ideally, you should use the cable
for the calibration with which you will perform the measurement, effectively removing its influence
from the measurement.

6. Terminate the other end of the cable with an open termination (from the calibration kit).
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Later in the procedure, you will switch out the open for the short and then the short for the load.
However, you can do this in any order.

7. Click the Open button to run the Open calibration.

8. Verify a check mark and the “Complete” message has appeared next to the Open button. This means
that the Open calibration is complete.

9. Remove the open termination from the cable and attach the short termination.

10. Click the Short button to run the Short calibration.

11. Verify a check mark and the “Complete” message has appeared next to the Short button. This means
that the Short calibration is complete.

12. Remove the short termination from the cable and attach the load termination.

13. Click the Load button to run the Load calibration.

14. Verify a check mark and the “Complete” message has appeared next to the Load button. This means
that the Load calibration is complete.

15. Click the Save As button, which will become available once all calibrations are complete. Enter the
file name and save the file.

16. Click on the Details button in the Active Calibration window to view the calibration details.

17. Remove the calibration kit from the test setup before starting a measurement.

You are now ready to take a measurement:

Make a cable loss measurement (see page 225)

Make a return loss measurement (see page 229)

Make a distance to fault measurement (see page 232)
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Calibration status messages

The calibration status of a measurement will show as one of the following at the top right of the display.

Uncalibrated: The measurement is not calibrated. This may be because the measurement parameters
have changed versus the loaded calibration set, or the instrument temperature has changed more
than 5 degrees from the loaded calibration set.

Factory: The measurement is using the Factory calibration set.

User: The measurement is performed at the same frequency range, power level, and temperature
at which it was calibrated.

Interpolated: The measurement is calibrated. Calibration data used during the measurement is
interpolated to match the measurement frequency’s points (if the measurement frequency range is
less than the calibration set frequency range).

Tooltips

Hovering over the calibration status with the mouse will show you one of the following calibration
messages.

Calibration is uncalibrated: This indicates that the original calibration conditions have changed and
so the calibration is not valid for the current conditions. We recommend you set the User Calibration
to maximize possible measurement accuracy.

Temperature outside calibration spec: This indicates that the temperature of the calibration is out of
range. We recommend you set the User Calibration to maximize possible measurement accuracy.

Factory calibration: This message indicates that a Factory Calibration was performed.

Calibration data interpolated. May reduce accuracy of measurement: This indicates that the
calibration data used during the measurement is interpolated to match the measurement frequency’s
points. We recommend you set the User Calibration to maximize possible measurement accuracy.
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Return Loss measurements overview

The Return Loss measurement suite (Option SV60-SVPC) provides return loss, VSWR, cable loss,
Distance to Fault (DTF) Return Loss, and DTF VSWR measurements. These measurements are vector
calibrated. The vector calibration is performed using three known mismatches: open, short, and load, and
they are part of a calibration kit. Calibration kits are available from Tektronix, or you can use your own.

This option also requires the tracking generator option (Option 04).

NOTE. Option SV60-SVPC (Cable Loss, Return Loss, and DTF) available for the RSA500A series and
RSA600A series only.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

The following displays are available in the Return Loss suite:

Cable Loss display (see page 227)

RL/DTF (Return Loss / Distance to Fault) display (see page 238)

The following topics about Return Loss measurements are available:

How to make a Cable Loss measurement (see page 225)

How to make a Return Loss measurement (see page 229)

How to make a Distance to Fault measurement (see page 232)

How to make a Cable Loss measurement

Disconnect any signal from the RF In port before performing a measurement. Perform the following
procedures in the order presented to use the Cable Loss display to perform a cable loss measurement.
You can also read more about the elements of the Cable Loss display in the Elements of the display
(see page 227) topic.

NOTE. Option SV60-SVPC (Cable Loss, Return Loss, and DTF) available for the RSA500A series and
RSA600A series only.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.
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3. Select display and set parameters

4. Perform or load a calibration (see page 226)

5. Take a measurement (see page 227)

Select display and set parameters

1. Select Setup > Displays.

2. In the Measurements panel, select Return Loss.

3. Double click the Cable Loss icon in the Available displays panel to select that display, and then
click OK.

4. Click on the Favorites bar to open the Cable Loss Settings control panel.

5. In the Setup tab, set the start and stop frequencies and the number of desired measurement points for
the frequency sweep. Use the Parameters tab to set the Output Power Level. Use the Traces, Scale,
and Prefs tabs to set various trace and display preferences.

Perform or load a calibration

Before you can take a measurement you must perform or load a calibration. View one of the following
topics and follow those procedures before going to the next section.

Perform a new calibration (see page 212)

Load a Factory calibration (see page 217)

Load a User calibration (see page 217)
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Take a measurement

1. Connect your DUT and the measurement will start.

Elements of the display
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Item Display element Description

1 Show Indicates whether the trace is Off (unchecked box) or if the trace is showing
(checked box) and which method that trace is processed (Normal, Avg, Min,
or Max).

Set trace processing using the Function menu in the Traces tab of the Cable
Loss Settings control panel.

2 Trace Indicates the selected trace. The trace is only displayed if the Show box
is checked.

3 Calibration status Indicates which calibration set the analyzer is using. See the Calibration
status messages (see page 223) topic for details.

4 dB (upper limit) Vertical scale position (top of display range).

5 dB/div Bottom of the vertical display range.

6 dB (lower limit) Lower limit of cable loss.

7 Autoscale Properly offsets the peak of the display from the top of the screen.

If the screen has been enlarged through a manual vertical (dB/div) setting
entry, the view is not vertically rescaled when Autoscale is used.

8 Start Shows the start frequency of the frequency sweep. Set in the Setup tab of the
Cable Loss Settings control panel.

9 Average Average cable loss over the frequency range measured from the selected
trace.

10 Maximum The maximum value of the selected trace and the frequency at which that
value occurs.

11 Stop Shows the stop frequency of the frequency sweep. Set in the Setup tab of the
Cable Loss Settings control panel.

12 Slope Shows the rate of change of the cable loss over the frequency range for
the selected trace.

13 Minimum The minimum value of the selected trace and the frequency at which that
value occurs.

14 Clear Erases the current results from the display.

xxx

Cable Loss display Settings control panel

Main menu: Setup > Settings

Favorites Toolbar:

The Settings control panel tabs for the Cable Loss display are shown in the following table. Click on a link
to view the parameters and settings associated with a tab.
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Settings tab Description

Setup (see page 243) Specifies the start and stop frequencies and the number of measurement (display) points
in the frequency sweep.

Parameters (see page 244) Specifies output power level.

Cable Type (see page 245) Specifies the cable type and allows you to add a new cable type.

Traces (see page 246) Specifies the display characteristics of displayed traces and allows you to save and
recall trace.

Scale (see page 248) Specifies the vertical and horizontal scale settings.

Prefs (see page 249) Specifies whether or not certain display elements are shown.

xxx

How to make a Return Loss measurement

Disconnect any signal from the RF In port before performing a measurement. Perform the following
procedures in the order presented to make a return loss measurement. You can also read more about the
elements of the RL/DTF display in the Elements of the display (see page 230) topic.

NOTE. Option SV60-SVPC (Cable Loss, Return Loss, and DTF) available for the RSA500A series and
RSA600A series only.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

3. Select display and set parameters

4. Perform or load a calibration (see page 230)

5. Take a measurement (see page 230)

Select display and set parameters

1. Select Setup > Displays.

2. In the Measurements panel, select Return Loss.

3. Double click the RL/DTF icon in the Available displays panel to select that display, and then click OK.

4. Click on the Favorites bar to open the RL/DTF Settings control panel.

5. Click on the Displays tab, select Return Loss for Display 1, and then select Display 1 in the Show
Displays panel to view the Return Loss display only.
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6. In the Setup tab, set the start and stop frequencies and the Points value. Use the Parameters tab to set the
Output Power Level. Use the Traces, Scale, and Prefs tabs to set various trace and display preferences.

TIP. The Factory Calibration will be used if you change the power level to a value that is different from your
calibration, or is you change the start and/or stop frequency to be outside of the range that you calibrated.

Perform or load a calibration

Before you can take a measurement you must perform or load a calibration. View one of the following
topics and follow those procedures before going to the next section.

Perform a new calibration (see page 212)

Load a Factory calibration (see page 217)

Load a User calibration (see page 217)

Take a measurement

1. Connect your DUT and the measurement will start.

Elements of the Return Loss display

The following image and table show the elements of the RL/DTF display.
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Item Display element Description

1 Show Indicates whether the trace is Off (unchecked box) or if the trace is showing
(checked box) and which method that trace is processed (Normal, Avg
(VRMS), Min Hold, or Max Hold).

2 Trace Indicates the selected trace. Note that the selected trace will only be visible
if the "show" box is checked identifies if the selected trace is on the RL
or DTF display view.

3 Calibration status Indicates which calibration set the analyzer is using. See the Calibration for
cable loss, return loss, DTF measurements topic for details.

4 dB (upper limit) Vertical scale position (top of display range)

5 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

6 dB (lower limit) Bottom of vertical display range (vertical position - vertical scale)

7 Autoscale Properly offsets the peak of the display from the top of the screen.

If the screen has been enlarged through a manual vertical (dB/div) setting
entry, the view is not vertically rescaled when Autoscale is used.

8 Start Shows the start frequency set of the measurement. Set in the Setup Tab with
the Start Freq control in the Settings control panel.

9 Maximum The maximum value of the selected trace and the distance at which that
occurs.

10 Minimum The minimum value of the selected trace and the distance at which that
occurs.

11 Stop Shows the stop frequency of the measurement. Set in the Setup Tab with the
Start Freq control in the Settings control panel.

12 Clear Erases the current measurement results and active trace(s) from the display.

xxx
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How to make a Distance to Fault measurement

Disconnect any signal from the RF In port before performing a measurement. Perform the following
procedures in the order presented to make a Distance to Fault measurement. You can also read more about
the elements of the RL/DTF display in the Elements of the display (see page 230) topic.

NOTE. Option SV60-SVPC (Cable Loss, Return Loss, and DTF) available for the RSA500A series and
RSA600A series only.

TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

3. Select display and set parameters

4. Perform or load a calibration (see page 234)

5. Take a measurement (see page 234)

Learn more about DTF parameters in the following topics:

How to change the vertical scale units (see page 235)

How to limit the bandwidth for a bandpass filter (see page 236)

How to improve the display of distance to fault measurements (see page 237)

How to improve the resolution of distance to fault measurements (see page 238)

Select display and set parameters

1. Select Setup > Displays.

2. In the Measurements panel, select Return Loss.

3. Double click the RL/DTF icon in the Available displays panel to select that display, and then click OK.

4. Click to open the RL/DTF Settings control panel.
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5. Click on the Displays tab, select DTF/Return Loss for Display 2, and then select Display 2 in the
Show Displays panel to view the DTF/Return Loss display only.

6. Use the Parameters tab to set the Output Power Level and the DTF Window view. Use the Traces,
Scale, and Prefs tabs to set various trace and display preferences.

You can read about the DTF Window settings in the How to improve the display of distance to fault
measurements (see page 237) topic.

7. Select the Cable Type tab and specify the cable type. If the cable type is not listed, you can add
a cable by clicking the New Cable button. This provides access to the New Cable panel where you
can add a name, velocity, and loss for the cable.

8. Click on the DTF Setup button to open the DTF Setup window.

9. Set the Cover Distance. Specify the length of the cable or the distance to the DUT (for example, an
antenna). This setup is recommended when there are no frequency limitations on the signal path
between the analyzer and the system under test. However, you can reduce the cover distance to just
include the fault (for example, if your cable is 100 m long, but there is one fault at 30 m, you can
reduce the distance to 35 m).

10. If you want to set a bandwidth limit for the system instead of using distance, select Limit Bandwidth.
Otherwise, go to step 11
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This setup is recommended when frequency-limited devices, such as filters, are in the signal path
between the analyzer and the system under test.

11. In the Parameters column of the DTF Setup window, change the Center Freq, if needed. A range of
values for the center frequency is provided as an aid. The center frequency depends on the system or
DUT.

12. Select the Method: Fast, Normal, Long Distance (if Limit Bandwidth is selected), or High Resolution
(if Cover Distance is selected). Each method provides a range of number of points for the frequency
sweep. The Fast method has the smallest range of points, and the Long Distance and High Resolution
methods have the largest range of points. If you select Limit Bandwidth, increasing the number of
points will result in a longer measurable distance.

13. In the Results column, inspect the results. They show the parameters for the frequency sweep and
the distance values that will be used for the DTF measurement. If these results do not suit your
measurement needs, you will need to adjust the measurement parameters (Setup, Center Freq. and
Method) to achieve your desired measurement settings results.

14. Click OK to accept the settings and close the DTF Setup window.

Perform or load a calibration

Before you can take a measurement you must perform or load a calibration. View one of the following
topics and follow those procedures before going to the next section.

Perform a new calibration (see page 212)

Load a Factory calibration (see page 217)

Load a User calibration (see page 217)

Take a measurement

1. Connect your DUT and the measurement will start.

Read about the display in the Elements of the RL/DTF display (see page 239) topic.

Explore these topics related to DTF measurements

How to change the vertical scale units (see page 235)

How to limit the bandwidth for a bandpass filter (see page 236)
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How to improve the display of DTF measurements (see page 237)

How to improve the resolution of DTF measurements (see page 238)

About the RL/DTF display (see page 238)

How to change the vertical scale units

The default setting for vertical scale units for the Return Loss and DTF measurements is dB. You can also
display faults using VSWR as the vertical scale unit. Use the Displays tab in the DTF/Returm Loss
Settings control panel to change the vertical scale unit to VSWR. Select VSWR for the desired display.
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How to select the appropriate settings for DTF Setup

The analyzer automatically adjusts the frequencies it uses to make the distance to fault measurement
depending on the user selected Method and Cover Distance settings in the DTF Setup window (see
page 251). The Cover Distance setting is recommended when there is low or no restriction on the
frequency of the system and provides the most flexibility in selections of method (number of points) and
desired measurement distance. However, if your antenna uses a filter to minimize interference from other
sources, you will need to limit the measurement bandwidth used by the analyzer so that its measurement
signal can pass through the filter.

The distance resolution of the DTF waveform is inversely proportional to the frequency range of the
sweep. By constraining the bandwidth of the sweep (frequency range of the sweep), the resolution of the
DTF waveform is decreased.

The analyzer automatically computes the results for the available methods in this setup. Each Method has
a range of number of points, with Fast having the smallest range of measurement points and Long Distance
(High Resolution) having the largest range. By increasing the number of points, more points are added
inside the limited bandwidth of the sweep. This decreases the frequency step in the sweep (the frequency
points in the sweep will be closer), resulting in longer measurable distance in the DTF waveform.

In the Method drop-down menu, only the methods that can yield to the Limit Bandwidth (or less ) will be
available. If a desired method is not available, try changing the limit bandwidth or the center frequency.

Values in the Results column will change as you change values for the Setup, cover distance, Method,
Limit Bandwidth or the Center Frequency. If the DTF setup results don't meet your measurement
requirements, adjust these parameters to achieve your desired measurement setup.
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How to improve the display of distance to fault measurements

The DTF display will show a large main lobe at a fault location, surrounded by series of side lobes of
decreasing amplitude. The analyzer provides a choice of windowing functions that enable you to make
a tradeoff between resolution of the fault location and suppression of waveform “noise” (side lobe
magnitude). This setting is in the Parameters tab of the DTF/Return Loss Settings control panel.

The Rectangular window produces a display with a narrow main lobe and relatively higher side lobes,
resulting in better distance resolution but a “noisier” waveform. Nominal, Low, and Minimum Side Lobes
windows produce a display with lower size lobes and wider main lobes, respectively. The lower side lobes
make the fault easier to identify as the noise around the main lobe is reduced. On the other hand, the
wider main lobe reduces the distance resolution.
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How to improve the resolution of distance to fault measurements

The resolution (distance between data points) shown in the DTF display is based on several interacting
factors. Resolution is important because it limits how accurately you can locate a fault. The distance
resolution is inversely proportional to the frequency range of the sweep: the wider the frequency range, the
smaller the distance resolution. The maximum distance of the DTF waveform depends on the frequency
step of the sweep. Therefore, when setting the DTF by Cover Distance, the frequency step size of the
sweep is also set.

The analyzer automatically computes the results for the methods in this setup. Each method has a range of
number of points, with Fast having the smallest range and Long Distance having the largest range. By
increasing the number of points, more points are added inside the limited bandwidth of the sweep. This
increases the frequency step in the sweep, resulting in better distance resolution. Distance resolution is
inversely proportional to the frequency bandwidth (span) of the sweep.

Increase the bandwidth to get better distance resolution. The number of points only affects the max
cover distance (for a fixed bandwidth).

Values in the Results column of the DTF Setup window will change as you change the Cover Distance or
the Center Frequency.

Normally, the only settings you need to adjust are the maximum distance and the method. However, if
your antenna has a bandpass filter installed, you will need to limit the bandwidth on the analyzer to
make correct distance to fault measurements. Limiting the bandwidth used by the analyzer may limit the
distance and resolution of the measurement. Refer to the How to select the appropriate settings for DTF
(see page 236) section for additional information.

RL/DTF display overview

You can perform Return Loss (RL) and Distance to Fault (DTF) measurements using the RL/DTF display.
Return loss, as a function of frequency, measures the ratio in dB of the signal reflected by the DUT to the
signal sent to the DUT. A larger (absolute) value of return loss indicates less signal is reflected by the DUT.
DTF is the return loss measured as a function of distance along the cable connected to the DUT. It is used
to locate faults when the return loss as a function of frequency indicates a problem.

This display allows you to view the RL and DTF/Return Loss ( DTF/VSWR) displays together or one at
a time. Return Loss or VSWR are different views of ratio of the signal reflected from the DUT and the
signal sent to the DUT.

Read the How to make a Return Loss measurement topic to help you perform a return loss measurement.
Read the How to make a Distance to Fault measurement (see page 232) topic to help you perform
a DTF measurement.
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Elements of the display

The following image shows the DTF view of the RL/DTF display. However, the elements of the display
are the same for the Return Loss display view, so the table that follows applies to both display views.
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Item Display element Description

1 Show Indicates whether the selected trace is Off (unchecked box) or if the trace is
showing (checked box) and which method that trace is processed (Normal,
Avg, Min, or Max).

Set this using the Function menu in the Traces tab of the settings control
panel.

2 Trace Indicates the selected trace and identifies if the selected trace is on the RL or
DTF display view (trace is only visible if the "show" box is checked).

3 Calibration status Indicates which calibration set the analyzer is using. See the Calibration
status messages (see page 223) topic for details.

4 dB (upper limit) Vertical scale position (top of display range).

5 dB/div Sets the vertical scale value in dB/div (when not in VSWR mode).

6 dB (lower limit) Bottom of vertical display range (vertical position - vertical scale).

7 Autoscale Properly offsets the peak of the display from the top of the screen.

If the screen has been enlarged through a manual vertical (dB/div) setting
entry, the view is not vertically rescaled when Autoscale is used.

8 Start Shows the start frequency of the frequency sweep. Set in the Setup Tab Start
Freq control of the Settings control panel.

9 Maximum The maximum value of the selected trace and the frequency at which that
occurs.

10 Minimum The minimum value of the selected trace and the frequency at which that
occurs.

11 Stop Shows the stop frequency of the frequency sweep. Set in the Setup Tab Start
Freq control of the Settings control panel.

12 Clear Erases the current measurement results and active traces from the display.

xxx

RL/DTF display Settings control panel

Main menu: Setup > Settings

Favorites Toolbar:

The following table shows the contents of the Settings control panel for this display. Click on a link to
view detailed information about the parameters accessible from each tab.
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Settings tab Description

Setup (see page 252) Specifies the type of modulation used for the input signal and other parameters.

Parameters (see page 253) Specifies parameters used by the instrument to analyze the input signal.

Cable Type (see page 254) Specifies the cable type and allows you to add a new cable type.

Displays (see page 255) Specifies to display the RL measurement, the DTF measurement, or both. You can also
select VSWR view in either measurement.

Traces (see page 255) Specifies the display characteristics of displayed traces and allows you to save and
recall a trace.

Scale (see page 257) Specifies the vertical and horizontal scale settings.

Prefs (see page 259) Specifies whether or not certain display elements are shown.

DTF Setup button (see
page 251)

(Only available in the
DTF/Return Loss view)

Configure distance to fault measurement by Cover Distance or Limit Bandwidth settings.

xxx
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Cable Loss Display Settings

Favorites Toolbar:

The Settings control panel tabs allow you to change various parameters and settings for the Cable Loss
display.

Setup - Cable Loss

The Setup tab provides access to frequency settings for the Cable Loss display.

Setting Description

Start Freq The lowest frequency used for the measurement.

Stop Freq The highest frequency used for the measurement.

Points The number of measurement points from start frequency to stop frequency.

xxx
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Parameters tab - Cable Loss

The Parameters tab allows you to adjust the output power level to High or Low.

Setting Description

Output Power Level Select from High and Low output power levels.

xxx
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Cable Type

Setting Description

Cable Select a cable from the drop-down list. You can also click in the Cable field and search
for the cable name by typing in the name.

The icon at the bottom of the drop-down list allows you to clear search results and
view the full list again.

Velocity The velocity factor of the cable.

Loss The loss per meter at the loss frequency.

New Cable button Click this button to access the New Cable panel where you can enter and save cable
information.

Name Enter the cable name.

Velocity Enter the velocity factor of the cable.

Loss Enter the power. This dB value will be divided by the Loss Distance value to provide
the loss per meter at the loss frequency.

Loss Distance Enter the loss distance in meters or feet.

Loss Frequency Enter the loss frequency.

Metric Units Check this box to use metric units for distance.

Save Click to save the cable. Once saved, the cable name will appear in the Cable drop-down
list.

Cancel Click to cancel a New Cable entry and close the New Cable panel.

xxx
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Traces tab - Cable Loss

The Traces tab allows you to set the display characteristics of displayed traces.

Setting Description

Trace Selects a trace. The selected trace is the source for the displayed measurements (max,
min, freq, etc).

Function Selects the trace processing method. Available settings are: Normal, Average (VRMS),
Max Hold, and Min Hold.

Show Shows / hides the selected trace.

Count Sets the number of traces averaged to generate the displayed trace. (Present only when
Function is not set to Normal.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show recalled trace Displays a saved trace instead of a live trace.

xxx

Trace

Available traces for Cable Loss are: Trace 1, Trace 2, and Trace 3. These traces are based on the input
signal and enable you to display the input signal using different processing (Function). For example, you
could display Trace 1 with Function set to Normal, Trace 2 with Function set to Max Hold and Trace 3
with Function set to Min Hold.

Function (trace processing)

The Function setting controls how traces are processed to display.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Avg (VRMS) [Average VRMS] – Displays the average of measured value of each trace point.
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Max Hold - Displays the maximum value in the trace record for each display point. Each new trace's
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace's
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box in the display.

3. Click the ... button in the Traces tab to display the Open dialog box.

4. Navigate to the desired file and click Open.

5. Check the Show recalled trace check box in the Traces tab.

6. Verify that the Show check box in the display is selected for the trace (either on this tab or next to the
drop-down list located at the top-left corner of the graph).
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Scale tab - Cable Loss

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as center frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Sets the vertical scale (overall vertical display range).

Position Set the position in the middle of the vertical axis.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Reset Scale Resets both vertical and horizontal scales.

Horizontal Controls the span of the trace display and position of the trace.

Start Set the Start frequency. This affects the Start frequency of the measurement.

Stop Set the Stop frequency. This affects the Stop frequency of the measurement.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

xxx
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Prefs tab - Cable Loss

The Prefs tab enables you to change parameters of the measurement display.

Setting Description

Show graticule Displays or hides the graticule in the display.

Show measurement
points

Marks each measurement point on the trace.

Show Marker readout in
graph (selected marker)

When a marker is enabled, this setting displays or hides the marker readout, but not the
marker itself, on the graph area.

xxx
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RL/DTF Display Settings

Favorites Toolbar:

The Settings control panel tabs allow you to change various parameters and settings for the RL/DTF
display.

DTF Setup button – RL/DTF

The DTF Setup button allows you to access DTF measurement specific parameters and results information.
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Setting Description

Cover Distance Select and specify the length of the cable or the distance to the device under test.

This selection is recommended when there are no frequency limitations on the signal
path between the analyzer and the system under test.

Range Shows the possible cable length range in meters as 3 m to 1500 m. Changing the Cover
Distance value changes this range.

A cable distance of greater than 1500 m would result in attenuation of the signal below
the noise floor.

Limit Bandwidth Select and specify the maximum bandwidth for the measurement.

This selection is recommended when frequency-limited devices, such as filters, are in the
signal path between the analyzer and the system under test.

Range Shows the possible bandwidth range when Limit Bandwidth is selected. This range is
based on the limits of the analyzer.

Center Freq Specify the desired center frequency for the measurement.

Range Shows the possible center frequency range for the measurement.

Method Select Fast or Normal. If Limit Bandwidth is selected, then you can also choose Long
Distance if the measurement points value is below 1500 m. If Cover Distance is selected,
then you can also choose High Resolution.

Results Panel shows the DTF setup values.

xxx

Setup - RL/DTF

The Freq Setup tab provides access to frequency settings for the RL/DTF display.

Setting Description

Start Freq The lowest frequency in the measurement.

Stop Freq The highest frequency in the measurement.

Points The number of measurement points from start frequency to stop frequency.

xxx
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Parameters tab - RL/DTF

The Parameters tab allows you to set the output power level and DTF Window view.

Setting Description

Output Power Level Select from High and Low output power levels.

The High Power Level output is –10 dBm. High power measurements are the default
setting and are recommended for measurements of all passive circuits such as cables
and filters.

The Low Power Level output is –30 dBm. Low power measurements may be needed for
testing circuits that have gain and may be compressed if there are high powers input
to them.

DTF Window Select a setting to improve the display of DTF measurements.

You can read more about this feature in the How to improve display (see page 237) topic.

xxx
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Cable Type

Setting Description

Cable Select a cable from the drop-down list. You can also click in the Cable field and search
for the cable name by typing in the name.

The icon at the bottom of the drop-down list allows you to clear search results and
view the full list again.

Velocity The velocity factor of the cable.

Loss The loss per meter at the loss frequency.

New Cable button Click this button to access the New Cable panel where you can enter and save cable
information.

Name Enter the cable name.

Velocity Enter the velocity factor of the cable.

Loss Enter the power. This dB value will be divided by the Loss Distance value to provide
the loss per meter at the loss frequency.

Loss Distance Enter the loss distance in meters or feet.

Loss Frequency Enter the loss frequency.

Metric Units Check this box to use metric units for distance.

Save Click to save the cable. Once saved, the cable name will appear in the Cable drop-down
list.

Cancel Click to cancel a New Cable entry and close the New Cable panel.

xxx
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Displays tab - RL/DTF

Setting Description

Show Displays Select to show Display 1 only, Display 2 only, or both displays simultaneously.

Display 1 Select which display type you want to appear in Display 1. You can select Return Loss
or VSWR.

Display 2 Select which display type you want to appear in Display 2. You can select DTF/Return
Loss or DTF/VSWR.

xxx

Traces tab - RL/DTF

The Traces tab allows you to set the display characteristics of displayed traces.
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Setting Description

Trace Selects a trace.

Show Shows / hides the selected trace.

Function Selects the trace processing method. Available settings are: Normal, Average (VRMS),
Max Hold, and Min Hold.

Count Sets the number of traces averaged to generate the displayed trace. (Present only when
Function is set to anything but Normal.)

Freeze Halts updates to the selected trace.

Save Trace As Saves the selected trace to a file for later recall and analysis.

Show recalled trace Displays a saved trace instead of a live trace.

xxx

Trace

Available traces for the RL/DTF display are: DTF Trace 1, DTF Trace 2, and DTF Trace 3. These
traces are based on the input signal and enable you to display the input signal using different processing
(Function). For example, you could display DTF Trace 1 with Function set to Normal, DTF Trace 2 with
Function set to Max Hold and DTF Trace 3 with Function set to Min Hold.

Function (trace processing)

The Function setting controls how traces are processed to display.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When the averaging function is applied
to a trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace's
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace's
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces

To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.
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Recalling Traces

You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list

2. Click the ... button in the Traces tab to display the Open dialog box.

3. Navigate to the desired file and click Open.

4. Check the Show recalled trace check box in the Traces tab.

5. Verify that the Show check box in the display is selected for the trace (either on this tab or next to the
drop-down list located at the top-left corner of the graph).

Scale tab - RL/DTF

The Scale tab allows you to change the vertical and horizontal scale settings. The content on this tab
changes depending on which displays are active. Changing the scale settings changes the measurement
parameters. This is different then Spectrum displays, for example, where the scale controls allow you
to zoom without changing the underlying measurement. Also note that you may still right click in the
measurement window and zoom the horizontal display without impacting the underlying RL/DTF
measurement settings.

The following image shows the Scale tab when Return Loss is selected for Display 1 and viewing is
set to Display 1 only.
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The following image shows the Scale tab when VSWR is selected for both displays and viewing is set
to both displays.

The following image shows the Scale tab when both VSWR is selected for Display 1 and Return Loss is
selected for Display 2.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Sets the vertical scale (overall vertical display range).

Position Set the vertical position (top of measurement scale for vertical display).

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Link scales Check this box to link vertical scale in both displays. This selection works when Both is
the display view selection and both displays are set to either Return Loss or VSWR.

Reset Scale Resets both vertical and horizontal scales.

Horizontal Controls the span of the trace display and position of the trace.

Start Set the measurement Start frequency.

Stop Set the measurement Stop frequency.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

xxx
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Prefs tab - RL/DTF

The Prefs tab enables you to change parameters of the measurement display.

Setting Description

Show measurement
points

Marks each measurement point on the trace.

Show graticule Displays or hides the graticule in the display.

Show Marker readout in
graph (selected marker)

When a marker is enabled, this setting displays or hides the marker readout, but not the
marker itself, on the graph area.

Distance Units Sets units to meters or feet.

xxx
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WLAN Overview

The WLAN Analysis option allows you to evaluate WLAN signals, performing standards based
transmitter measurements in the time, frequency, and modulation domains. WLAN measurements can
be made on signals defined by 802.11a/b/g/j/n/p (standard IEEE 802.11-2012) and 802.11ac (draft IEEE
P802.11ac-D4.0 or later). User controls allow you to modify signal parameters for analysis of signals.
The analysis results give multiple views of WLAN signal characteristics to allow the diagnosis of signal
imperfections and impairments quickly and easily. Display controls allow you to selectively display the
analysis results to help locate trouble-spots in the signal.

WLAN Standards

The following options support the given standards:

Option SV23: Supports IEEE 802.11a, g, j, and p OFDM signals and 802.11b DSSS/CCK signals

Option SV24: Supports IEEE 802.11n signals with bandwidths of 20 MHz and 40 MHz

Option SV25: Supports IEEE 802.11ac signals with bandwidths of 20, 40, 80, and 160 MHz

WLAN Standards Presets

The Standards Presets button located on the WLAN Settings Control Panel allows you to recall
preconfigured displays for the standards and bandwidths that you select. You can also access these presets
from Presets on the display menu bar. You can read more information about the Standards Presets (see
page 21).

The following table shows the center frequency and displays that are automatically loaded for each of the
listed standards and bandwidths. SEM masks are also loaded and are explained here (see page 389).
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Table 1: WLAN presets standards, bandwidths, center frequencies, and displays

Standard
Bandwidth
(MHz)

Center
frequency
(GHz) Displays loaded

802.11a 20 5.18

802.11g 20 2.412

10802.11j

20

5.18

5

10

802.11p

20

5.8

20802.11n

40

2.412

20 5.18

40 5.19

80 5.21

802.11ac

160 5.25

802.11b 2.412

SEM, Time Overview, WLAN Constellation, WLAN
Summary

xxx

SEM mask parameters. The SEM wireless standard masks that are applied to the WLAN signal depend on
the standard you select when you configure the preset. Once you select a standard and bandwidth, the
application will automatically load the mask that best fits the signal for which the standard applies. All
mask parameters are derived from IEEE standards and loaded for you. This provides you the assurance
that you are evaluating the signal with the most appropriate mask.

WLAN Displays

The displays in WLAN Analysis (Setup > Displays > Measurements) are:

SEM (see page 183)

WLAN Channel Response (see page 263)

WLAN Constellation (see page 266)

WLAN EVM (see page 268)

WLAN Magnitude Error (see page 270)

WLAN Phase Error (see page 272)

WLAN Power versus Time (see page 274)

WLAN Spectral Flatness (see page 277)
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WLAN Summary (see page 279)

WLAN Symbol Table (see page 284)

WLAN Channel Response Display

The WLAN Channel Response display plots the channel response (magnitude and phase) versus the
subcarrier or frequency. Here, the channel refers to all sources of signal frequency response impairment up
to the analyzer input, including the transmitter itself, as well as any transmission medium through which
the signal travels between the transmitter and the analyzer.

NOTE. WLAN Channel Response is only available for OFDM (non-802.11b) signals.

To show the WLAN Channel Response display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN Analysis in theMeasurements box.

4. In the Available displays box, double-click theWLAN Chan Response icon or select the icon and
click Add. The WLAN Chan Response icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the WLAN Chan Response display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select the Modulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing, and
Bandwidth controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display
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Item Display element Description

1 Magnitude graph (top graph)

1a Top of graph Sets the level that appears at the top of the magnitude graph. This
is only a visual control for panning the graph. The Reference Level
is adjusted in the Toolbar and the Ampl control panel. By default, Vert
Position = Ref Level.

1b Position (dB) Sets the vertical position value. The maximum value is 20.00 dB. The
readout indicates the subcarrier (for non-b standards only) or frequency
shown at the bottom of the display.

1c Bottom of graph readout Indicates the magnitude at the bottom of the top graph. This value
changes with the dB and vertical Position settings.

2 Phase graph (bottom graph)

2a Top of graph Sets the phase value indicated at the top of the graph. Since the Position
value at the vertical center of this graph remains constant as the Top of
Graph value is adjusted, the Vertical Scale increases as the Top of Graph
value increases, which also affects the bottom of graph readout.

2b Position (°) Specifies the phase shown at the center of the graph display. Changing
this value moves the trace up and down in the graph, which affects the
Top of Graph and Bottom of Graph values as well.

2c Bottom of bottom graph
readout

Indicates the phase at the bottom of the bottom graph. This value
changes with the Position setting.

3 Autoscale Adjusts the Vertical and Horizontal scaling to optimize the trace display
on screen.

4 Start (Position) Shifts the trace left or right in the graph. The readout indicates the
subcarrier (for non-b standards only) or frequency shown at the left
edge of the display.

5 Stop (Scale) Specifies the number of subcarriers (for non-b standards only) shown
in the graph.

xxx

WLAN Channel Response Settings

The WLAN Channel Response Settings control panel provides access to settings that control parameters of
the Channel Response Display.

Settings tab Description

Modulation Params (see
page 287)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range Tab (see
page 290)

Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 291)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the time units (Symbols or Seconds) for WLAN
Analysis displays.
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Settings tab Description

Traces Tab (see page 292) Enables you to select from magnitude or phase trace, save a trace, and recall an trace

Scale Tab (see page 293) Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN Constellation Display

The WLAN Constellation Display shows the WLAN signal modulation amplitude and phase in I
(horizontal) versus Q (vertical) form. For multicarrier WLAN OFDM signals, the points show all data
symbol subcarriers' modulation. For single-carrier 802.11b, each point corresponds to a single modulated
chip.

To show the WLAN Constellation display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN Constellation in theMeasurements box.

4. In the Available displays box, double-click theWLAN Constellation icon or select the icon and
click Add. The WLAN Constellation icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the WLAN Constellation display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select the Modulation Params tab. Set the Standard, Guard Interval, Channel Bandwidth, and
Subcarrier Spacing controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display

Item Display element Description

1 Plot Constellation graph.

2 Marker readout If markers are enabled, the marker readout shows the selected Marker,
Symbol, Subcarrier, Type, Value, Magnitude, and Phase for the symbol at
the marker location. Located to the left of the constellation plot or below it,
depending on the size of the window.

3 Marker controls Define and position markers.

xxx

WLAN Constellation Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The WLAN Constellation Settings control panel provides access to settings that control parameters of the
Constellation Display.
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Settings tab Description

Modulation Params (see
page 287)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 291)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

Trace Tab (see page 292) Enables you to freeze the display or hide the measurement or average trace.

Scale Tab (see page 293) Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN EVM Display

The WLAN EVM display shows the data symbols' individual subcarrier Error Vector Magnitude values
versus symbol interval (time) and subcarrier (frequency).

NOTE. For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN EVM display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN EVM in theMeasurements box.

4. In the Available displays box, double-click theWLAN EVM icon or select the icon and click Add.
The WLAN EVM icon will appear in the Selected displays box and will no longer appear under
Available displays.

5. Click OK to show the WLAN EVM display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard as appropriate. Set the Standard, Guard Interval,
Channel Bandwidth, and Subcarrier Spacing controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph Sets the EVM value that appears at the top of the graph. This is only a visual
control for panning the graph.

2 Bottom of graph Sets the EVM value that appears at the bottom of the graph. This is only a
visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Start (Position) Specifies the horizontal position of the trace on the graph display.

5 Stop (Scale) Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

WLAN EVM Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN EVM display are shown in the following table.
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Settings tab Description

Modulation Params (see
page 287)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 291) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

Trace (see page 292) Enables you to freeze the display or hide the measurement or average trace.

Scale (see page 293) Specifies the vertical, subcarrier (for non-b standards only) and symbols scale and
position settings.

Prefs (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN Magnitude Error Display

The WLAN Magnitude Error display shows the data symbols' individual subcarrier Magnitude Error
values versus symbol interval (time) and subcarrier (frequency).

NOTE. For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN Magnitude Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN Analysis in theMeasurements box.

4. In the Available displays box, double-click theWLAN Mag Error icon or select the icon and click
Add. The WLAN Mag Error icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the WLAN Mag Error display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph Sets the Magnitude Error value that appears at the top of the graph. This is
only a visual control for panning the graph.

2 Bottom of graph Sets the Magnitude Error value that appears at the bottom of the graph. This
is only a visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

WLAN Magnitude Error Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Mag Error display are shown in the following table.
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Settings tab Description

Modulation Params (see
page 287)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 291)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

Trace (see page 292) Enables you to display or hide the measurement or average trace.

Scale Tab (see page 293) Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and
position settings.

Prefs Tab (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN Phase Error Display

The WLAN Phase Error display shows the data symbols' individual subcarrier Phase Error values versus
symbol interval (time) and subcarrier (frequency).

NOTE. For 802.11b analysis, the subcarrier graph is not displayed.

To show the WLAN Phase Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN Analysis in theMeasurements box.

4. In the Available displays box, double-click theWLAN Phase Error icon or select the icon and click
Add. The WLAN Phase Error icon will appear in the Selected displays box and will no longer
appear under Available displays.

5. Click OK to show the WLAN Phase Error display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph Sets the Phase Error value that appears at the top of the graph. This is only a
visual control for panning the graph.

2 Bottom of graph Sets the Phase Error value that appears at the bottom of the graph. This is
only a visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

WLAN Phase Error Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Phase Error display are shown in the following table.
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Settings tab Description

Modulation Params (see
page 287)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 291)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

Trace (see page 292) Enables you to display or hide the measurement or average trace.

Scale Tab (see page 293) Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and
position settings.

Prefs Tab (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN Power vs Time Display

The WLAN Power vs Time display shows the signal power amplitude versus time. For 802.11b signals,
the packet Power-On and Power-Down ramp times are also measured.

To show the WLAN Power vs Time display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN Analysis in theMeasurements box.

4. In the Available displays box, double-click theWLAN Power vs Time icon or select the icon and
click Add. The WLAN Power vs Time icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the WLAN Power vs Time display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display
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Item Display element Description

1 Top of graph, first settting Sets the Power level that appears at the top of the graph, in dBm. This is only
a visual control for panning the graph.

2 Top of graph, second setting Sets the vertical Scale of the graphs, in dB/div. This is only a visual control
for panning the graph.

3 View Selects the specific view of the packet burst within the display:

- Full Burst displays the entire packet, with vertical lines indicating length
of the packet

- Rising Edge zooms the display into the interval around the packet rising
edge, with vertical lines indicating the 10% to 90% Power-On Ramp time

- Falling Edge zooms the display into the interval around the packet falling
edge, with vertical lines indicating the 90% to 10% Power-Down Ramp time

4 Bottom of graph readout Shows the Power level at the bottom of the graph in dBm.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Bottom of graph, left side Sets the starting time of the graph in seconds

7 Bottom of graph, right side Sets the scale (width) of the graph in seconds

8 Table below graph - Burst Power: Average power of the burst packet, in dBm

- Burst Width: Measured time width of the burst packet from Power-On to
Power-Down (or end of waveform, if that occurs before Power-Down), in
seconds

NOTE. Power-On Ramp Time and Power-Down Ramp Time values are
only available for 802.11b analysis.

- Power-On Ramp Time: Time interval for signal level to increase from 10%
to 90% of maximum packet power, in seconds

- Power-Down Ramp Time: Time interval for signal level to decrease from
90% to 10% of maximum packet power, in seconds. This value is not available
is the analysis record does not include the packet power-down portion.

xxx

WLAN Power vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Power vs Time display are shown in the following table.
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Settings tab Description

Modulation Params (see
page 287)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 291) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

Scale (see page 293) Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and
position settings.

Prefs (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN Spectral Flatness Display

The WLAN Spectral Flatness display shows the average power levels of subcarriers across the signal
bandwidth and indicates if they remain within the limits defined for a particular standard.

The averaged subcarrier level is shown as a line on the display, while the individual subcarrier levels are
shown as points. The Pass or Fail result indicates whether the average line remains between the upper and
lower limit mask boundaries.

NOTE. WLAN Spectral Flatness is only available for OFDM (non-802.11b) signals.

To show the WLAN Spectral Flatness display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN Analysis in theMeasurements box.

4. In the Available displays box, double-click theWLAN Flatness icon or select the icon and click
Add. The WLAN Flatness icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the WLAN Flatness display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select the Modulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing, and
Channel Bandwidth controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph, first setting Sets the Flatness value that appears at the top of the graph in dB. This is only
a visual control for panning the graph.

2 Top of graph, second setting Sets the lower range of the Flatness value that appears at the top of the
graph in dB/div. This is only a visual control for panning the graph.

3 Bottom of graph Shows the Flatness value set at the bottom of the graph.

4 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

5 Posn Specifies the horizontal position of the trace on the graph display.

6 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

WLAN Spectral Flatness Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Spectral Flatness display are shown in the following table.
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Settings tab Description

Modulation Params (see
page 287)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 291)

Specifies parameters that define the portion of the acquisition record that is used for
analysis.

NOTE. The Units control on this tab only affects the Analysis Length (AFAIK). Use the
Units control in the Prefs tab to affect the displays.

Trace (see page 292) Enables you to display or hide the measurement or average trace.

Scale Tab (see page 293) Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and
position settings.

Prefs Tab (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN Summary Display

The WLAN Summary display shows several measurements of WLAN signal quality. The summary display
and it’s contents will vary by standard selected. Not all of the display contents are provided in this section.

To show the WLAN Summary display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN Analysis in theMeasurements box.

4. In the Available displays box, double-click theWLAN Summary icon or select the icon and click
Add. The WLAN Summary icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the WLAN Summary display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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WLAN Summary Display for 802.11a/g/j/p/n/ac Signals
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Elements of the Display for 802.11a/g/j/p/n/ac Signals

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Bandwidth Display of the channel bandwidth selected on Setup > Settings > Modulation Parameters
tab.

Burst Power The average power of all symbols in the packet, including Preamble and Data segments.

Peak-to-Average The ratio of the highest instantaneous signal power level to the average signal power.

Burst Index The index of the analyzed packet within the analysis record.

IQ Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It
indicates the level of carrier feedthrough detected at the center (DC) subcarrier.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
measurement frequency setting.

Common Pilot Error The RMS magnitude error of the pilots over all data symbols.

Symbol Clk Error The symbol clock error in parts per million.

EVM The RMS and Peak values of the normalized subcarrier Error Vector Magnitude values.
The normalized subcarrier EVM values are calculated as the difference between the
detected received signal subcarrier constellation points and ideal reference points
estimated by the instrument from the received signal. Values are reported in units of
percent or dB. Peak values include the symbol and subcarrier location.

RMS and Peak values are displayed for groupings of all subcarriers, Pilots only and Data
only. Results are calculated over all Data symbols in the packet.

Average RMS and Peak RMS values are accumulated over multiple packet analysis
cycles. The Clear button on the display resets these values by clearing the result memory.

Packet Format Displays the packet format: AG, HT_MF, HT_GF, VHT.

Data Modulation Displays the modulation used in the Data symbols: BPSK, QPSK, 16QAM, 64QAM,
256QAM.

Guard Interval Displays the Guard Interval used by the Data symbols: 1/4, 1/8.

Symbols, EVM, Avg Power Displays the type and number of symbols, EVM-RMS and average power of the
Preamble and Data portions of the packet.

SIG Data

L-SIG Data

HT-SIG Data

VHT-SIG Data

Displays he decimal values of the received packet SIGNAL, HT-SIGNAL and
VHT-SIGNAL symbols' fields. The Pass/Fail result in each heading line indicates whether
the calculated Parity or CRC value matches the received Parity or CRC value of the
corresponding SIGNAL symbol grouping.

xxx
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WLAN Summary Display for 802.11b Signals
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Elements of the Display for 802.11b Signals

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Parameters tab.

Burst Power The average power of the entire packet.

Peak-to-Average The ratio of the highest instantaneous packet signal power level to the average signal
power.

Burst Index The index of the analyzed packet within the analysis record.

IQ Origin Offset The amount of power at the signal carrier frequency relative to the total power of the
signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
measurement frequency setting.

EVM The RMS and Peak values of the normalized Error Vector Magnitudes taken at signal
chip intervals. The normalized EVM values are calculated as the difference between the
detected received signal constellation points and ideal reference points estimated by the
instrument from the received signal. Values are reported in units of percent or dB. Peak
values indicate the associated chip locations.

RMS and Peak values are displayed for groupings of All chips, and the first 1000 (1k)
chips.

Average RMS and Peak RMS values are accumulated over multiple packet analysis
cycles. The Clear button on the display resets these values by clearing the result memory.

Packet Format Displays the packet format: DSSS 1M, DSSS 2M, CCK 5.5M or CCK 11M.

Data Modulation Displays the modulation used in the PSDU/Data packet segment.

Chips, EVM, Avg Power Displays the number of chips, EVM-RMS and average power of the Preamble, Header
and Data portions of the packet.

Header Data Displays he decimal values of the received packet Header's Signal, Service, Length, and
CRC fields. The CRC Pass/Fail result indicates if the received CRC value is equal to the
CRC value computed from the received Signal, Service and Length values.

xxx

WLAN Summary Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Summary display are shown in the following table.
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Settings tab Description

Modulation Params (see
page 287)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 291) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

EVM (see page 295) Specifies the EVM units (dB or %) and Max Bursts to Avg. The EVM is generally
measured on symbol or chip instants and is usually measured after best-fit estimates of
the frequency error and a fixed phase offset have been removed.

Prefs (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN Symbol Table Display

The WLAN Symbol Table display shows decoded data values for each data symbol in the analyzed
signal packet. For OFDM signals (all standards except 802.11b), results are presented with subcarrier
(frequency) indices in the horizontal dimension and symbol (time) intervals in the vertical dimension.
For 802.11b signals, the Preamble, Header, and Data (PSDU) symbol values are presented sequentially,
with symbol indices in the left column.

To show the WLAN Symbol Table display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, selectWLAN Analysis in theMeasurements box.

4. In the Available displays box, double-click theWLAN Symb Table icon or select the icon and click
Add. The WLAN Symbol icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the WLAN Symbol Table display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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WLAN Symbol Table for OFDM signals

Item Description

1 Subcarrier identifiers (OFDM only). Yellow column indicates Pilot subcarrier locations.

2 Symbol identifiers.

3 Subcarrier data values.

4 Marker readout when markers are enabled.

xxx

WLAN Symbol Table for 802.11b signals

SignalVu-PC Printable Help 285



WLAN Measurements WLAN Symbol Table Settings

Item Description

1 Symbol number index (from beginning of packet or segment) of first Symbol data value on the line.

2 Symbol values, with the value in column 2 of each row corresponding to the symbol number index in
column 1, and then the symbol value in column 3 corresponding to the next symbol number index,
etc., to the end of each row.

For example: The symbol number index 130 = 0 in column 2. The symbol number index for column 3
is 131, which equals 0. The symbol number index for column 4 is 132, which equals 1. This pattern
continues to the end of the row.

xxx

WLAN Symbol Table Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the WLAN Symbol Table display are shown in the following table.

Settings tab Description

Modulation Params (see
page 287)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 291) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

Prefs (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

WLAN Analysis Shared Measurement Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The control panel tabs in this section are shared between the displays in the WLAN Analysis folder (Setup
> Displays). Some tabs are shared by all the displays, some tabs are shared by only a subset of displays.
The settings available on some tabs change depending on the selected display.
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WLAN Measurements Modulation Params Tab - WLAN

Common controls for WLAN analysis displays

Settings tab Description

Modulation Params (see
page 287)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 288)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 290) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 291) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

Trace (see page 292) Enables you to display or hide the measurement or average trace.

Scale (see page 293) Specifies the vertical, subcarrier (for non-b standards only), and symbols scale and
position settings.

EVM (see page 295) Specifies the EVM units and max burst averages.

Prefs (see page 296) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

Modulation Params Tab - WLAN

The Modulation Params tab specifies the type of modulation used by the input signal and other parameters
that define the signal format.
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Settings Description

Standard Specifies the standard used for the input signal. Choices are
802.11a/b/g/j/n/p/ac.

Guard Interval Specifies the guard interval used in the input signal. You can select the
following:

– Auto from SIG uses the Guard Interval value extracted from the signal

– 1/8 allows setting the value manually

– 1/4 allows setting the value manually

Channel Bandwidth Specifies the nominal channel bandwidth. This setting affects the Subcarrier
Spacing value when the Subcarrier Spacing Auto box is checked.

Subcarrier Spacing Specifies the spacing between subcarriers. When Auto is selected, this setting
is automatically calculated according to the Channel Bandwidth value. If Auto is
unchecked, a custom subcarrier spacing value can be entered for nonstandard
signal definition.

FFT Sample Rate Indicates the FFT sample rate, based on the bandwidth or subcarrier setting.

FFT Length Indicates the fixed FFT length.

xxx

Analysis Params Tab - WLAN

The Analysis Params tab contains parameters that control the analysis of the input signal.
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WLAN Measurements Analysis Params Tab - WLAN

Settings Description

Burst Selection Index Allows specifying the burst you want to measure when multiple bursts are
present in an acquisition. Index number of the first burst is 1, second burst
is 2, etc.

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error
and the measured Frequency Error is displayed. When the Auto box is
unchecked, the entered value is used by the analysis as a fixed frequency
offset. This is useful when the exact frequency offset of the signal is known.

Symbol Analysis Offset Specifies the analysis offset in the symbol interval. This value is a percentage
of the Guard Interval. The allowable range is -100% to 0%. -100% positions
the FFT to start at the beginning of the Guard Interval, 0% positions it to start
at the end of the Guard Interval. Default value is -50% which usually gives
the best measurement results.

Swap I & Q Select the checkbox to swap the I and Q components of a signal. This
compensates the input signal for spectral inversion.

Equalizer Training Specifies the method used to estimate channel frequency response and
equalization. This control can be used to diagnose changes in frequency
response over the signal packet.

Preamble The instrument uses only the Preamble to estimate channel frequency
response. This response is then used to equalize the entire signal packet.

Preamble + Data The instrument makes an initial channel frequency response estimate from the
Preamble. It then estimates the channel response for each data symbol using
the decoded data content to derive equalization for each symbol individually.
This allows compensation for time-varying channel response over the packet.

Data Modulation Allows choice of automatic or manual method of data symbol modulation
identification, as follows:

– Auto Detect estimates the modulation from the data symbol IQ content.

– Auto from SIG sets the modulation as indicated by the embedded SIG
preamble symbol format data.

– Manual allows specifying the modulation type regardless of the signal
content.

Pilot tracking Specifies if pilot subcarriers should be used to correct amplitude, phase, and
symbol timing variations over the packet. The choices available are Phase,
Amplitude, and Timing. The default setting is Phase correction enabled,
Amplitude and Timing correction disabled..

Subcarrier derotation Allows some displays to show subcarriers with or without Gamma subcarrier
phase rotation removed. Gamma phase rotation is applied to 802.11n and
802.11ac subcarriers in defined subranges depending on the selected Channel
Bandwidth >40 MHz. Only Constellation and Symbol Table results are affected
by this control.

When the box is unchecked, the rotation is not removed, which provides a
direct view of the physical modulation on the channel.

When the box is checked, the rotation is removed, allowing easier decoding of
the underlying data content.

xxx
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Data Range Tab - WLAN

The Data Range tab enables you to control how much signal is analyzed, as well as specify the range of
results that are displayed for the WLAN Constellation, EVM, Flatness, Magnitude Error, Phase Error, and
Symbol Table graphs. The tab contents vary by standard.

Data Range tab for non-b standards.

Settings Description

Symbols Specifies which symbols are displayed in the graphs.

All Select All to display all symbols.

Range Select Range to specify a subset of symbols for display.

Start Specifies the first symbol to include in the display.

Stop Specifies the last symbol to include in the display.

Single Select Single to display a single symbol.

Index Use Index to specify the symbol you want to display.

Subcarriers Specifies which subcarriers are displayed.

All Select All to display all subcarriers in the signal.

Pilots Select Pilot to display only pilot subcarriers.

Data Select Data to display only data subcarriers.

Single Specifies a specific subcarrier for display.

Index Specifies the specific subcarrier to be displayed.

Range Specifies a range of subcarriers to be displayed.

Start Specifies the start value of the range to be displayed.

Stop Specifies the ending value of the range to be displayed.

Max symbols to analyze Specifies how many symbols are analyzed. You can use this setting to speed
analysis by limiting the number of symbols being analyzed.

xxx

Data Range tab for 802.11b standards.
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WLAN Measurements Analysis Time Tab - WLAN

Settings Description

Chips Specifies which symbols are displayed in the graphs.

All Select All to display all chips.

Preamble Only Select to include only the Preamble in the display.

Header Only Select to include only the Header in the display.

Data Only Select to include only the Data in the display.

Max number of chips to analyze Specifies how many chips are analyzed. You can use this setting to speed
analysis by limiting the number of chips being analyzed. Check this box and
then enter the maximum number of chips to analyze.

xxx

Analysis Time Tab - WLAN

The Analysis Time tab contains parameters that define how the signal is analyzed in the WLAN Analysis
displays.

Settings Description

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in
either symbols or seconds, depending on the Units setting.

Use this to specify how long a period of time is analyzed.

– Range: minimum value depends on modulation type

– Resolution: 1 symbol

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Units Specifies the units of the Analysis Length in either Symbols or Seconds.

xxx
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Trace Tab - WLAN

The Trace tab allows you to set the trace display characteristics of the selected display. This tab is not
available for all WLAN displays.

Settings Description

Trace Use this drop-down list to select whether or not the Average trace or the measurement
trace is displayed. The measurement trace depends on the selected display.

Show Symbols Select or deselect this checkbox to show or hide symbols.

Freeze Selecting Freeze halts updates to the symbols.

xxx

Traces Tab - WLAN Channel Response

The Traces tab allows you to set the trace display characteristics of the WLAN Channel Reponse display.

Settings Description

Trace Selects the Magnitude or Phase trace for saving or recalling.

Save Trace As . . . Select to save a trace.

Recall Trace . . . Select to recall a trace.

xxx
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WLAN Measurements Scale Tab - WLAN

Scale Tab - WLAN

The Scale tab allows you to change the scale settings that control how the trace appears on the display but
does not change control settings such as Measurement Frequency. There are four versions of the Scale
tab for WLAN displays. One version is used for the Constellation display, one for the Spectral Flatness
display, one for the Power vs Time display, and one for the EVM, Magnitude Error, Phase Error, and
Channel Response displays.

Scale tab for the WLAN Power vs Time display

Scale tab for WLAN EVM, Magnitude Error, Phase Error, and Channel Response displays

Scale tab for WLAN Constellation display
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Scale tab for WLAN Spectral Flatness display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Subcarrier Controls the scale of the subcarrier graph and position of the trace.

Scale Specifies how many subcarriers are displayed horizontally.

Position Specifies the subcarrier that appears at the left edge of the subcarrier graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Symbols Controls the scale of the Symbols graph.

Scale Specifies the number of symbols that appear in the symbols graph.

Position Specifies the symbol that appears at the left edge of the Symbols graph.

Autoscale Resets the scale and position settings to optimize the display.

Auto When Auto is checked, the scale and position values for the Symbols graph are
automatically adjusted to maintain the optimal display.

Zoom Sets the Constellation display size and position.

Scale Sets the magnification value for the Constellation display.

Vertical Position Sets the vertical location of the Constellation display within the graph. Range is -3.7 to
+3.7.

Horizontal Position Sets the horizontal location of the Constellation display within the graph. Range is -3.7 to
+3.7.

xxx
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EVM Tab - WLAN

The EVM Tab enables you to chose between dB and percent for the EVM units and to select to set the
maximum bursts to average. The EVM Tab is only available for the WLAN Summary display.

Settings Description

EVM units Specifies whether the displayed EVM units are dB or percent.

Max Bursts to Avg Specifies the maximum number of bursts to average when Count is selected.

Count Enables the Max Bursts to Avg function.

xxx
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Prefs Tab - WLAN

The Prefs tab enables you to change appearance characteristics of the WLAN Analysis displays. Not all
settings on the Prefs tab shown below appear for every WLAN display.

Settings Description

Time units Specifies whether the displayed time units are seconds or symbols.

Freq units Specifies whether the displayed frequency units are frequency (Hz) or subcarrier channel.

Radix Specifies whether symbol values are displayed in binary or hex format (for example, in
the Symbol Table or markers readouts).

Show graphs Specifies which graphs are displayed. Select from Symbols, Subcarriers or Both,
Magnitude, Phase, or Both. Disabled (no masks), Shaded Region, or Line Only. These
selections are only available for OFDM signals.

Show graticule Specifies to show the graticule on the display when checked.

Show marker readout Specifies to show the marker readout when checked.

xxx
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802.11 ad Analysis Overview of 802.11ad

Overview of 802.11ad

The optional Tektronix 802.11ad solution provides repeatable signal quality measurement (such as EVM)
for the single carrier 802.11ad Transmitter PHY at RF (up to 66 GHz) for offline analysis.

The IEEE 802.11ad-2012 standard was approved on December 2012 and amended in 2014. It allows
wireless communication of devices at multi-gigabit speeds and enables high performance wireless data,
display, and audio applications that supplement the capabilities of previous wireless LAN devices. It
operates in the 60 GHz band and delivers data transfer rates up to 7 Gbit/s, while maintaining compatibility
with existing Wi-Fi devices. The 60 GHz signal cannot typically penetrate walls, but can propagate off
reflections from walls, ceilings, floors, and objects using beamforming built into an 802.11ad system.
When roaming away from the main room, the protocol can switch to make use of the other 802.11 lower
bands at a much lower rate, but which can propagate through walls.

ITU-T recommends the use of the following four channels at the 60 GHz band.

Chan-
nel Center (GHz) Min (GHz) Max (GHz) BW (GHz)

1 58.32 57.24 59.4 2.16

2 60.48 59.4 61.56 2.16

3 62.64 61.56 63.72 2.16

4 64.8 63.72 65.88 2.16

xxx

802.11ad Standards Presets

Select Presets > Standards in the menu to open the window to select the 802.11ad preset. You can
then select to recall preconfigured displays for the Single Carrier or Control PHY standards. The preset
displays are Spectrum, Time Overview, 802.11ad Summary, and 802.11ad Constellation. The preset sets
the measurement filter is to Root Raised Cosine, the filter parameter to 0.25, and the default data length
to analyze at 1000 for Single Carrier and 512 for Control PHY in EVM test setup. You can read more
about Standards Presets (see page 21).
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802.11 ad Analysis Overview of 802.11ad

NOTE. The default resolution bandwidth for the SEM display is 1 MHz.

Settings Description

Standard Allows you to choose between Single Carrier and Control PHY.

Test Setup Allows you to choose between EVM and SEM.

Retain current center
frequency setting

Allows you to retain the previous center frequency. It is disabled by default. To enable or
disable this setting, select the checkbox.

Retain current reference level
setting

Allows you to retain the previous reference level. It is enabled by default. To enable or
disable this setting, select the checkbox.

xxx

802.11ad topics in this Help

The following information about the 802.11ad Analysis option is available:
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802.11ad measurements

802.11ad displays

802.11ad measurement control settings

802.11ad measurements

The 802.11ad option supports the Control PHY and Single Carrier PHY standards. Information about the
packet type and frame format is given in Section 21 of IEEE Std 802.11adTM (Amendment 3).

These measurements are only supported for Windows oscilloscopes of bandwidth > 3 GHz. ATI
oscilloscopes support real time data analysis at RF, without any downconverters. The 802.11ad option
allows you to do the following:

Automatically detect the packet start, if it is included in the analysis region

Synchronize to preamble start using the Golay codes in STF (Short training field) region

Demodulate Preamble, Header, and Payload regions separately and measure EVM in each of these
sections.

The input data is filtered with a RRC filter, corrected for frequency, phase and symbol timing
errors, IQ DC offset errors and Equalization is done based on Channel estimated using the Channel
Estimation Field (CEF) data.

Decode packet information in header (like MCS, length etc.)

Measure the following:

EVM

RF power and Received Power Indicator (RCPI)

Estimated SNR

Frequency error

IQ DC origin offset

IQ Gain imbalance is calculated with the equation

Gain Error in dB = 20 log [ / ]

Where, 2εA is the amplitude difference between the signal paths.

IQ phase imbalance or quadrature error

Perform Transmit Mask measurement with the set up file given under Example Files. The Mask
(Offset frequencies and Start and Stop limits) is developed as per standard recommendations. After
loading set up file, you can set the Center Frequency manually to that of the signal.

The following features are also available:

Analyze EVM result with and without equalization.

Analyze EVM result with and without IQ DC offset correction.
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802.11 ad Analysis 802.11ad Constellation Display

View the constellation color coded for the preamble, header, guard, and payload regions. You can also
view the pi/2 rotated constellation against the final de-rotated constellation.

View the demodulated symbols in tabular form with different color codes and with an option to
traverse to the start of each region.

View the EVM spread across the analyzed packet with color codes differentiating regions.

View of scalar results in the Summary display.

EVM numbers can be seen in percentage or in dB.

EVM and Frequency Error limits for the transmitter can be set in the Limits tab of the Settings control
panel. If the measured EVM is greater than the limits, or if the measured Frequency Error is greater
than the limit, then a FAIL status will appear against the respective measurement.

Save the Channel Impulse response coefficients as a .txt or .csv file.

802.11ad displays

The displays in 802.11ad Analysis (Setup > Displays > Measurements) are:

802.11ad Constellation display (see page 351)

802.11ad EVM vs Time display (see page 355)

802.11ad Symbol Table display (see page 355)

802.11ad Summary display (see page 358)

802.11ad Constellation Display

This display shows a digitally-modulated signal in constellation form.

To show the 802.11ad Constellation display:

1. Recall the data file.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select 802.11ad Analysis in theMeasurements box.

4. In the Available displays box, double-click the 802.11ad Constellation icon or select the icon and
click Add. The 802.11ad Constellation icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the 802.11ad Constellation display.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the display

Item Display element Description

A Scalar results Gives results of Data EVM (Average EVM over the data region and the Peak
Error in the data region), Freq Error, and IQ Origin Offset.

B Marker readout Specifies the Marker readout values.

C Graph Displays the input signal.

xxx
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802.11 ad Analysis 802.11ad Constellation Display

The above image shows an 802.11ad signal with QPSK data region
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802.11 ad Analysis 802.11ad Constellation Display

The above image shows an 802.11ad signal with 16QAM data region
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802.11 ad Analysis 802.11ad EVM vs Time

Constellation display settings

Settings tab Description

Modulation Params (see
page 313)

Specifies the input signal standard, measurement filters and filter parameters.

Analysis Params (see
page 314)

Specifies parameters used by the instrument and software to analyze the input signal.

Advanced Params (see
page 315)

Specifies additional parameters used by the instrument and software to analyze the
input signal.

Analysis Time (see page 316) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for 802.11ad Analysis displays.

EVM (see page 317) Specifies the EVM units, start and length of data symbols to be analyzed for EVM, and
the number of acquisitions used for averaging. For Control PHY, the Start and Length
of data symbols is specified in terms of de-spread symbols and also the number of
Bursts to Avg by enabling the count.

Traces (see page 321) Specifies the trace type and the result content. Select either rotated or de-rotated
constellation. De-rotated constellation is shown by default.

Prefs (see page 320) Specifies the radix of the data symbols and the option to see the marker readout.

Scale (see page 319) Defines the vertical and horizontal axes.

xxx

802.11ad EVM vs Time

This display shows the EVM plotted against time in seconds or symbols. The analysis region in which
EVM measurement done is indicated by a purple line in the Time Overview to indicate the region
of analysis.

To show the 802.11ad EVM vs Time Display:

1. Recall the data file.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select 802.11ad Analysis in theMeasurements box.

4. In the Available displays box, double-click the 802.11ad EVM vs Time icon or select the icon and
click Add. The 802.11ad EVM vs Time icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the 802.11ad EVM vs Time display.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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802.11 ad Analysis 802.11ad EVM vs Time

Elements of the display

Item Display element Description

A Freq error Displays the frequency error which has been corrected after which the EVM
is calculated. The displayed frequency error is followed by either Auto or
Manual. This indicates the error calculation mode which is set under Settings
>Analysis Params.

B Top of graph The error at the top of the graph in dB or percent.

C Position The error at the bottom of the graph in dB or percent.

D Autoscale Adjusts the vertical and horizontal settings to provide the best display.

E Position Displays the horizontal position of the trace on the graph display.

F Scale Adjusts the span of the graph in seconds or symbols.

G Graph Displays the input signal. Different color codes are used in the 802.11ad
EVM vs Time to indicate different regions of the packet. Check legend at the
bottom of the symbol table for color codes

xxx
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802.11 ad Analysis 802.11ad Symbol Table Display

EVM vs Time display settings

Settings tab Description

Modulation Params (see
page 313)

Specifies the input signal standard, measurement filters, and filter parameters.

Analysis Params (see
page 314)

Specifies parameters used by the instrument to analyze the input signal.

Advanced Params (see
page 315)

Specifies parameters used by the instrument to analyze the input signal, with options to
enable the Equalizer and IQ DC Offset correction.

Analysis Time (see page 316) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for 802.11ad Analysis displays.

EVM (see page 317) Specifies the number of data symbols to be analyzed for EVM. For Control PHY, the Start
and Length of data symbols is specified in terms of de-spread symbols.

Prefs (see page 320) Specifies the radix of the marker readout and whether elements of the graphs are
displayed.

Scale (see page 319) Defines the vertical and horizontal axes.

xxx

802.11ad Symbol Table Display

This display shows a digitally-modulated signal. It is similar to the Constellation display except that a
text table is used to display data bits as symbols rather than a graph.

1. Recall the data file.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select 802.11ad Analysis in theMeasurements box.

4. In the Available displays box, double-click the 802.11ad Symbol Table icon or select the icon and
click Add. The 802.11ad Symbol Table icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the 802.11ad Symbol Table display.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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802.11 ad Analysis 802.11ad Symbol Table Display

Elements of the display

Different Color codes are used in the table to indicate different regions of the packet. The legend at the
bottom of the table indicates which color represents which packet component. The bit colors in the table
match the packet colors. The packet will have the following regions:

Preamble (pi/2-BPSK)

Header (pi/2-BPSK)

Data (pi/2 BPSK, pi/2 QPSK or pi/2 16QAM)

Guard (pi/2-BPSK)

Using markers

Markers are indicators in the display that you can position on a trace to measure values such as frequency,
power, and time. A Marker always displays its position and, if the Delta readout is enabled, will display
the difference between its position and that of the Marker Reference. Within the Symbol Table, colored
cells indicate the location of markers. The selected Marker is highlighted with a light green background.
All other markers are highlighted with a light gray background. In the Symbol Table, the marker readout
below the table shows the marker location in time, symbol numbers and symbol value.
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Symbol Table display settings

Settings tab Description

Modulation Params (see
page 313)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 314)

Specifies parameters used by the instrument to analyze the input signal.

Advanced Params (see
page 315)

Specifies additional parameters used by the instrument to analyze the input signal.

Analysis Time (see page 316) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for 802.11ad Analysis displays.

Prefs (see page 320) Specifies the radix of the symbols and the option to see the marker readout.

xxx

802.11ad Summary Display

The 802.11ad Summary display shows a summary of all scalar measurements done on the acquired test
pattern. Pass/Fail information is also provided in this display for all enabled scalar measurements. You can
set limits and choose which measurement to compare for Pass/Fail from the Limits tab in the 802.11ad
Summary Settings control panel. The default limits come from the performance recommendation limits
given by the Standards document. The default limits can be reloaded by selecting the 802.11ad as the
preset in the Standards Preset window.

1. Recall the data file.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select 802.11ad Analysis in theMeasurements box.

4. In the Available displays box, double-click the 802.11ad Summary icon or select the icon and click
Add. The 802.11ad Summary icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the 802.11ad Summary display.

6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the display

The results presented in the display include scalar results of modulation characteristics, shown in the
following areas of the dipslay: EVM - Packet, Average results over multiple Acquisitions (One Bust per
Acquisition), and Packet Information. These scalar results are averaged over the previously acquired
packets. The packet number to be analyzed is set in the EVM tab of the Settings control panel.

SignalVu-PC Printable Help 309



802.11 ad Analysis 802.11ad Summary Display

The above image shows an 802.11ad Single Carrier signal with pi/2 16QAM data modulation
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802.11 ad Analysis 802.11ad Summary Display

Display element Description

Standard Display of the standard selected on the Setup > Settings > Standard Params tab.

Data Modulation Indicates data modulation. Data modulation types are as follows:

Single Carrier: pi/2 BPSK, pi/2 QPSK, pi/2 16QAM

Control PHY: pi/2 DBPSK

Clear Click to reset the scale measurements.

RF Power Measures the RF power in the signal.

RCPI Calculates the Received Channel Power Indicator from RF power.

Frequency error The frequency difference between the measured carrier frequency of the signal and the
measurement frequency setting in ppm and Hz.

Estimated SNR Measures the estimated SNR in the measurement setup.

IQ Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It indicates
the level of carrier feedthrough detected at the center (DC) carrier.

IQ Gain Imbalance Measures the Gain mismatch of the signal (sinusoid) in dB. It indicates the mismatch
between I and Q signal paths.

IQ Quadrature Error Measures the phase part of the imbalance in degrees. It indicates the mismatch between I
and Q signal paths.

EVM – Packet Gives EVM results for each packet region. The number of symbols analyzed in each region
is given alongside the packet region labels.

Single Carrier: STF, CEF, Header, Guard, and Data

Control PHY: STF, CEF and Data + Header in despread symbols

EVM Gives Average EVM in the region of the packet.

Peak EVM Gives the Peak error/EVM in the corresponding region of the packet.

@ Symbol Gives the symbol index at which the peak error occurred out of the entire set of symbols in
the packet (it is not an index just within the region). The symbol index shown here can be
used to place a marker in the Symbol Table or EVM vs Time displays to observe the exact
symbol position at which the peak error occurred.

Average results over multiple
acquisitions (one burst per
acquisition)

Avg Data EVM

Max Data EVM

Avg Frequency Error

Max Frequency Error

Gives data EVM and Frequency error results over multiple acquisitions. Gives both the
Average and Max over multiple acquisitions. Also shows how many acquisitions have
been used for these results below. The number of acquisitions to be used for these
measurements can be selected from the EVM tab of the Settings Control panel using the
Max Bursts to Avg selection.

Packet Information The packet header information includes the Scrambler initialization, MCS, Length, Packet
type, Training Length, Turnaround and HCS. MCS, Length and Training length are shown in
decimal.

PDDU, Aggregation, Beam Tracking Request, and Last RSSI are shown only for Single
Carrier.

xxx
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Summary Table display settings

Settings tab Description

Modulation Params (see
page 313)

Specifies the input signal standard and other signal parameters.

Analysis Params (see
page 314)

Specifies parameters used by the instrument to analyze the input signal.

Advanced Params (see
page 315)

Specifies additional parameters used by the instrument to analyze the input signal.

Analysis Time (see page 316) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for 802.11ad Analysis displays.

EVM (see page 317) Specifies the EVM units and number of data symbols to be analyzed for EVM. For Control
PHY, the Start and Length of data symbols is specified in terms of de-spread symbols
and also the number of Bursts to Avg by enabling the count.

Limits (see page 322) Load and define 802.11ad measurement limits for Pass/Fail comparison. You can save
defined limits as a .csv file and also load previously saved .csv files.

xxx

802.11ad Control Panel Settings

Favorites Toolbar:

The control panel tabs in this section are shared between the displays in the 802.11ad Analysis folder
(Setup > Displays). Some tabs are shared by all the displays, some tabs are shared by only a couple of
displays. The settings available on some tabs change depending on the selected display.
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Settings tab Description

Modulation Params (see
page 313)

Specifies the type of modulation used for the input signal and other parameters.

Analysis Params (see
page 314)

Specifies parameters used by the instrument to analyze the input signal.

Advanced Params (see
page 315)

Specifies parameters used by the instrument to analyze the input signal.

Analysis Time (see page 316) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for 802.11ad Analysis displays.

EVM (see page 317) Specifies the EVM units and number of data symbols to be analyzed for EVM.

Limits (see page 322) Load and define 802.11ad measurement limits for Pass/Fail comparison. You can save
defined limits as a .csv file and also load previously saved .csv files.

Traces (see page 321) Specifies the trace type and the result content. Select either rotated or de-rotated
constellation. De-rotated constellation is shown by default.

Prefs (see page 320) Specifies the radix of the symbols, the option to see the marker readout, and whether
elements of the graphs are displayed.

Scale (see page 319) Defines the vertical and horizontal axes.

xxx

Modulation Params tab – 802.11ad

The Modulation Params tab specifies the type of modulation used by the input signal and other parameters
that define the signal format. This tab is available for the 802.11ad EVM vs Time, Constellation, Symbol
Table, and Summary displays.

Settings Description

Standard Specifies the standard used for the input signal. Choices are Control PHY and Single
Carrier.

Measurement filter Specify whether a filter is used to limit the bandwidth of the input signal. Options are
None and Root Raised Cosine.

Filter parameter Enter a value used for defining the alpha parameter for Root Raised Cosine filter. (Not
present when Measurement filter is None.)

xxx
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Analysis Params tab – 802.11ad

This tab contains parameters to control the analysis of the input signal. This tab is available for the
802.11ad EVM vs Time, Constellation, Symbol Table, and Summary displays.

Settings Description

Frequency Error When Auto is checked, the analysis determines the Frequency Error and the measured
Frequency Error is displayed. When unchecked, the entered value is used by the
analysis as fixed frequency offset. This is useful when the exact frequency offset of
the signal is known.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Select Manual, Auto, or Link to Span.

xxx
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Advanced Params tab – 802.11ad

This tab specifies additional parameters that control the demodulation of the signal. This tab is available
for the 802.11ad EVM vs Time, Constellation, Symbol Table, and Summary displays. Not all settings
appear for every display.

Settings Description

Enable DC Offset Correction Enables DC offset correction before EVM results are calculated.

Blockwise Correction Enables impairments correction in a blockwise approach. This selection allows you to
see if impairments like frequency error vary within the packet. Disabled by default.

Handle Multipath Channels Select to enable. Allows you to experiment with multipath channels This selection is
disabled by default.

Save Chan Imp Resp As... Opens a file dialogue box that allows you to save the Estimated Channel Impulse
response (64 coefficients). You can save it as a .txt or .csv file.

The saved file will have two columns. The first and the second columns give the 64 real
and imaginary coefficients, respectively.

The generated coefficients are that of the last analyzed acquisition.

The impulse response will show an early and a late multipath propagation.

When channel response coefficients are plotted, the horizontal axis represents symbols.

OFF The EVM measurement is done with the equalizer switched off.

Non Adaptive (CEF) The EVM measurement is done with an equalizer that is non-adaptive and the
equalization is done based on the data in Channel Estimation Field (CEF).

Adaptive (STF and CEF) The EVM measurement is done with the equalizer that adapts its coefficients from
acquisition to acquisition. Equalization in this case is done based on the data in the Short
Training Field (STF) and Channel Estimation Field (CEF) regions.

Mode Specifies whether the equalizer is in learning (Train) mode or analysis (Hold) mode.

Convergence Specifies the update rate.

Taps/Symbol The number of filter coefficients per symbol used by the filter

Taps The number of filter coefficients. Range: 3 to 100 (you can set a higher number, but
100 is the practical limit).

Length Specifies the number of symbols analyzed (or filter length).

Reset Equalization Resets the equalizer.

You can read more about how to use the equalizer in the topic here (see page 572).

xxx
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Analysis Time tab – 802.11ad

This tab contains parameters that define how the signal is analyzed in the 802.11ad EVM vs Time,
Constellation, Symbol Table, and Summary displays.

Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in
either symbols or seconds, depending on the Units.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Actual This readout displays the analysis length (time or symbols) used by the analyzer. This
value may not match the Analysis Length requested in manual mode.

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the analysis length to either Symbols or Seconds.

xxx

Analysis offset

Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data (all time values are relative
to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis length

Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the
actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the control in the
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"Actual" readout. This setting is not available when Auto is checked. Range: minimum value depends on
modulation type. Resolution: 1 symbol.

Time zero reference

All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.

Acquisition Start sets the analyzer to measure the offset from the starting point of the acquisition.

Trigger sets the analyzer to measure the offset from the trigger point of the acquisition.

EVM tab – 802.11ad

This tab enables you to set the EVM Units, Data Start, and Data Length. Not all settings appear for
every display.

The above image is the EVM tab for the 802.11ad EVM vs Time and Constellation displays for Single Carrier

The above image is the EVM tab for the 802.11ad EVM vs Time and Constellation displays for Control PHY
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The above image is the EVM tab for the 802.11ad Summary display for Single Carrier

Settings Description

EVM Units Specifies whether the displayed EVM units are dB or percent.

Max Bursts to Avg Specifies the maximum number of acquisitions to average when Count is selected.

Count Enables the Avg function. Multiple acquisitions are averaged when this is enabled.

Data Symbols (for Single Carrier)

De-spread Data Symbols (for Control PHY)

Start Specified the EVM measurement start data symbol.

Length Specifies the length in terms of Data Symbols to analyze the EVM in data region starting
from Start.

Analyze all Check to analyze all data symbols in the packet. When checked, Start and Length
options will be disabled. However, Length will be automatically updated to the number
of data symbols analyzed when this option is selected.

xxx
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Scale tab – 802.11ad

This tab allows you to change the scale settings that control how the trace appears on the display but
does not change control settings such as Measurement Frequency. There are two versions of the Scale
tab for 802.11ad displays. One version is used for Constellation display, and one for EVM vs Time. Not
all settings appear for every display.

The above image is the Scale tab for the 802.11ad Constellation display

The above image is the Scale tab for the 802.11ad EVM vs Time display

Settings Description

Vertical

Scale Changes the vertical scale.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal

Scale Changes the horizontal scale.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Zoom

Scale Sets the magnification value for the Constellation display.

Vertical position Sets the vertical location of the Constellation display within the graph.

Horizontal position Sets the horizontal location of the Constellation display within the graph.

xxx
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Prefs tab – 802.11ad

This tab enables you to change appearance characteristics of the 802.11ad Analysis displays. Not all
settings appear for every display.

The above mage is the Prefs tab for the 802.11ad Constellation display

The above mage is the Prefs tab for the 802.11ad Symbol Table display

The above mage is the Prefs tab for the 802.11ad EVM vs Time display

Settings Description

Data radix Specifies whether symbol values are displayed in binary or decimal format (for example,
in the Symbol Table or markers readouts).

Show graticule Specifies to show the graticule on the display when checked.

Show Marker readout in graph
(selected marker)

Specifies to show the marker readout when checked.

xxx
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Traces tab – 802.11ad

This tab allows you to set the trace display characteristics of the selected display.

Settings Description

Trace Type Specifies the trace type is regular or pi/2 rotated.

Result Contents Selects which regions of the packet to show in constellation display. You can choose
from Preamble, Header, Guard, and Data for Single Carrier. You can choose from
Preamble, Header, and Data for Control PHY.

xxx
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Limits tab – 802.11ad

This tab allows you to load an existing limits table, save a limits table, or edit limits values. By default,
FreqErrorLimit is turned on and EVMLimit is turned off. This tab is available for the 802.11ad Summary
display only.

Settings Description

On Click on a cell in the On column next to the measurement name to specify whether or not
measurements are selected for limit comparison to indicate Pass or Fail. EVMLimit is off
by default and FreqErrorLimit is on by default.

Measurement Name Specifies the name of the measurement related to the limit (not editable).

Limit Specifies the value of the limit to the related measurement. When the cell is selected,
the value is shown along with the units. This is editable.

Load Click to load a saved Limits table from a .csv file.

Save Click to save the current Limits table to a .csv file.

xxx

Edit Limits

To directly edit measurement limits in the table, click on the value in the Limit column that you want
to change.
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Overview

The OFDM Analysis option provides measurements for OFDM signals specified by 802.11a/g/j (Wifi)
and 802.16 (2004) (commonly known as Fixed WiMAX) standards. User controls allow you to modify
signal parameters for analysis of non-standard signals. The analysis results give multiple views of OFDM
signal characteristics to allow diagnosing signal imperfections and impairments quickly and easily.
Display controls provide the ability to selectively display the analysis results to help locate trouble-spots in
the signal.

The displays in OFDM Measurements (Displays > Measurements > OFDM Measurements) are:

OFDM Channel Response (see page 323)

OFDM Constellation (see page 326)

OFDM EVM (see page 327)

OFDM Spectral Flatness (see page 329)

OFDM Mag Error (see page 331)

OFDM Phase Error (see page 333)

OFDM Power (see page 335)

OFDM Summary (see page 337)

OFDM Symbol Table (see page 340)

OFDM Channel Response Display

The OFDM Channel Response display plots the channel response (magnitude or phase) versus the
subcarrier or frequency. Here, the channel refers to all sources of signal frequency response impairment up
to the analyzer input, including the transmitter itself, as well as any transmission medium through which
the signal travels between the transmitter and the analyzer.

To show the OFDM Channel Response display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM Analysis in theMeasurements box.

4. In the Available displays box, double-click the OFDM Chan Response icon or select the icon and
click Add. The OFDM Chan Response icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the OFDM Chan Response display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.
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8. Select the Modulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display
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Item Display element Description

1 Top-of-graph (magnitude) Sets the level that appears at the top of the magnitude graph. This is only a
visual control for panning the graph. The Reference Level is adjusted in the
Toolbar and the Ampl control panel. By default, Vert Position = Ref Level.

2 dB/div (magnitude) Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 Display selector Selects the display type. Channel Response Magnitude or Phase can be
displayed as a Magnitude or Phase graph.

4 Bottom-of-graph readout
(magnitude)

Indicates the amplitude at the bottom of the graph. This value changes with
the dB/div and Vertical Position settings.

5 Autoscale Adjusts the Vertical and Horizontal scaling to display the optimize the trace
display on screen.

6 Pos Shifts the trace left or right in the graph. The readout indicates the subcarrier
or frequency shown at the left edge of the display.

7 Scale Specifies the number of subcarriers shown in the graph.

8 Top-of-graph (phase) Sets the phase value indicated at the top of the graph. Since the Position
value at the vertical center of this graph remains constant as the Top of Graph
value is adjusted, the Vertical Scale increases as the Top of Graph value
increases, which also affects the bottom of graph readout.

9 Position (phase) Specifies the phase shown at the center of the graph display. Changing this
value moves the trace up and down in the graph, which affects the Top of
Graph and Bottom of Graph values as well.

10 Bottom-of-graph (phase) Indicates the phase at the bottom of the graph. This value changes with the
Position setting.

xxx

OFDM Channel Response Settings

The OFDM Channel Response Settings control panel provides access to settings that control parameters of
the Channel Response Display.

Settings tab Description

Modulation Params (see
page 342)

Specifies the input signal standard and additional user-settable signal parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range Tab (see
page 344)

Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 344)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the time units (Symbols or Seconds) for OFDM
Analysis displays.

Prefs Tab (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx
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OFDM Constellation Display

Display shows the OFDM signal subcarriers' amplitude and phase in IQ constellation form.

To show the OFDM Constellation display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM Constellation in theMeasurements box.

4. In the Available displays box, double-click the OFDM Constellation icon or select the icon and
click Add. The OFDM Constellation icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the OFDM Constellation display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display
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Item Display element Description

1 Plot Constellation graph.

2 Marker Readout If markers are enabled, the marker readout shows the selected Marker,
Symbol, Subcarrier, Type, Value, Magnitude, and Phase for the symbol at
the marker location. Located to the left of the constellation plot or below it,
depending on the size of the window.

xxx

OFDM Constellation Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The OFDM Constellation Settings control panel provides access to settings that control parameters of the
Constellation Display.

Settings tab Description

Modulation Params (see
page 342)

Specifies the input signal standard and additional user-settable signal parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 344)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 346) Enables you to freeze the display or hide the measurement or average trace.

Scale Tab (see page 346) Specifies the Zoom scale, and vertical and horizontal positions of the display.

Prefs Tab (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

OFDM EVM Display

The OFDM EVM display shows the data symbols' individual subcarrier Error Vector Magnitude values
versus symbol interval (time) and subcarrier (frequency).

To show the OFDM EVM display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM EVM in theMeasurements box.

4. In the Available displays box, double-click the OFDM EVM icon or select the icon and click Add.
The OFDM EVM icon will appear in the Selected displays box and will no longer appear under
Available displays.
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5. Click OK to show the OFDM EVM display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard as appropriate. Set the Standard, Guard Interval
and Spacing and Bandwidth controls as appropriate for the input signal.

9. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

NOTE. There is no carrier assigned to DC.
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Item Display element Description

1 Top of graph Sets the EVM value that appears at the top of the graph. This is only a visual
control for panning the graph.

2 Bottom of graph Sets the EVM value that appears at the bottom of the graph. This is only a
visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

OFDM EVM Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the OFDM EVM display are shown in the following table.

Settings tab Description

Modulation Params (see
page 342)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 344) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 346) Enables you to freeze the display or hide the measurement or average trace.

Scale (see page 346) Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

OFDM Spectral Flatness Display

The OFDM Spectral Flatness display shows the average power levels of subcarriers across the signal
bandwidth and indicates if they remain within the limits defined for a particular standard.

The averaged subcarrier level is shown as a line on the display, while the individual subcarrier levels are
shown as points. The Pass or Fail result indicates whether the average line remains between the upper and
lower limit mask boundaries.

To show the OFDM Spectral Flatness display:
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1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM Analysis in theMeasurements box.

4. In the Available displays box, double-click the OFDM Flatness icon or select the icon and click
Add. The OFDM Flatness icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the OFDM Flatness display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval, Subcarrier Spacing and Channel
Bandwidth controls as appropriate for the input signal.

9. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display
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Item Display element Description

1 Top of graph Sets the Flatness value that appears at the bottom of the graph in dB. This is
only a visual control for panning the graph.

2 Bottom of graph Shows the Flatness value set at the top of the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

OFDM Spectral Flatness Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the OFDM Spectral Flatness display are shown in the following table.

Settings tab Description

Modulation Params (see
page 342)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 344)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for WLAN Analysis
displays.

Trace (see page 346) Enables you to display or hide the measurement or average trace.

Scale Tab (see page 346) Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Tab (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

OFDM Magnitude Error Display

The OFDM Mag Error display shows the data symbols' individual subcarrier Magnitude Error values
versus symbol interval (time) and subcarrier (frequency).

To show the OFDM Magnitude Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM Analysis in theMeasurements box.
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4. In the Available displays box, double-click the OFDMMag Error icon or select the icon and click
Add. The OFDM Mag Error icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the OFDM Mag Error display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display
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Item Display element Description

1 Top of graph Sets the Magnitude Error value that appears at the top of the graph. This is
only a visual control for panning the graph.

2 Bottom of graph Sets the Magnitude Error value that appears at the bottom of the graph. This
is only a visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

OFDM Magnitude Error Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the OFDM Mag Error display are shown in the following table.

Settings tab Description

Modulation Params (see
page 342)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 344)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 346) Enables you to display or hide the measurement or average trace.

Scale Tab (see page 346) Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Tab (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

OFDM Phase Error Display

The OFDM Phase Error display shows the data symbols' individual subcarrier Phase Error values versus
symbol interval (time) and subcarrier (frequency).

To show the OFDM Phase Error display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM Analysis in theMeasurements box.
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4. In the Available displays box, double-click the OFDM Phase Error icon or select the icon and click
Add. The OFDM Phase Error icon will appear in the Selected displays box and will no longer
appear under Available displays.

5. Click OK to show the OFDM Phase Error display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display
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Item Display element Description

1 Top of graph Sets the Phase Error value that appears at the top of the graph. This is only a
visual control for panning the graph.

2 Bottom of graph Sets the Phase Error value that appears at the bottom of the graph. This is
only a visual control for panning the graph.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

OFDM Phase Error Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the OFDM Phase Error display are shown in the following table.

Settings tab Description

Modulation Params (see
page 342)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time Tab (see
page 344)

Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 346) Enables you to display or hide the measurement or average trace.

Scale Tab (see page 346) Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs Tab (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

OFDM Power Display

The OFDM Power display shows the data symbols' individual subcarrier Power values versus symbol
interval (time) and subcarrier (frequency).

To show the OFDM Power display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM Analysis in theMeasurements box.
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4. In the Available displays box, double-click the OFDM Power icon or select the icon and click Add.
The OFDM Power icon will appear in the Selected displays box and will no longer appear under
Available displays.

5. Click OK to show the OFDM Power display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display
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Item Display element Description

1 Vertical Position Sets the top of graph value. This is only a visual control for panning the
graph. The Reference Level is adjusted in the Toolbar and the Ampl control
panel. By default, Vert Position = Ref Level.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

2 Bottom of graph readout Indicates the amplitude at the bottom of the graph. This value changes with
the dB/div and Vertical Position settings.

3 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

4 Pos Specifies the horizontal position of the trace on the graph display.

5 Scale Adjusts the horizontal range of the graph. By decreasing the scale, the graph
essentially becomes a window that you can move over the analysis results by
adjusting the position.

xxx

OFDM Power Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the OFDM Power display are shown in the following table.

Settings tab Description

Modulation Params (see
page 342)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 344) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 346) Enables you to display or hide the measurement or average trace.

Scale (see page 346) Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

OFDM Summary Display

The OFDM Summary display shows several measurements of OFDM signal quality.

To show the OFDM Summary display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM Analysis in theMeasurements box.
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4. In the Available displays box, double-click the OFDM Summary icon or select the icon and click
Add. The OFDM Summary icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the OFDM Summary display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

338 SignalVu-PC Printable Help



OFDM Analysis OFDM Summary Settings

Measurement Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
measurement frequency setting.

IQ Origin Offset The average magnitude of the DC subcarrier level relative to total signal power. It
indicates the level of carrier feedthrough detected at the center (DC) subcarrier.

Average Power The average power of all symbols in the analysis. Calculated over only the data symbols
in the packet.

Symbols How many symbols were analyzed.

Symbol Clk Error The symbol clock error in parts per million.

CPE CPE, Common Pilot Error, is the RMS magnitude error of the pilots over all analyzed
symbols.

Peak-to-Average The ratio of the highest instantaneous signal power level to the average signal power.
Calculated over only the data symbols in the packet.

EVM The RMS and Peak values of the normalized subcarrier Error Vector Magnitude values.
The normalized subcarrier EVM values are calculated as the difference between the
detected received signal subcarrier constellation points and ideal reference points
estimated by the instrument from the received signal. Values are reported in units of
percent and dB. Peak values include the symbol and subcarrier location.

RMS and Peak values are displayed for groupings of all subcarriers, Pilots only and Data
only. Results are calculated over the entire signal packet analyzed, covering the number
of Symbols indicated in the Summary display.

xxx

OFDM Summary Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the OFDM Summary display are shown in the following table.

Settings tab Description

Modulation Params (see
page 342)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 344) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Prefs (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx
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OFDM Symbol Table Display

The OFDM Symbol Table display shows decoded data bits for each subcarrier in each symbol in the
analyzed signal packet. Results are presented with subcarrier (frequency) indices in the horizontal
dimension and symbol (time) intervals in the vertical dimension.

To show the OFDM Symbol Table display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select OFDM Analysis in theMeasurements box.

4. In the Available displays box, double-click the OFDM Symb Table icon or select the icon and click
Add. The OFDM Symbol icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the OFDM Symbol Table display.

6. Set the Frequency appropriate for the signal.

7. Select Setup > Settings to display the control panel.

8. Select theModulation Params tab. Set the Standard, Guard Interval and Spacing and Bandwidth
controls as appropriate for the input signal.

9. If you area analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.

Item Description

1 Subcarrier identifiers.

2 Symbol identifiers.
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(cont.)

Item Description

3 Subcarrier data values.

4 Marker readout when markers are enabled.

xxx

OFDM Symbol Table Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the OFDM Symbol Table display are shown in the following table.

Settings tab Description

Modulation Params (see
page 342)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 344) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Prefs (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

OFDM Analysis Shared Measurement Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The control panel tabs in this section are shared between the displays in the OFDM Analysis folder (Setup
> Displays). Some tabs are shared by all the displays, some tabs are shared by only a couple of displays.
The settings available on some tabs change depending on the selected display.
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Common controls for OFDM analysis displays

Settings tab Description

Modulation Params (see
page 342)

Specifies the type of modulation used for the input signal and other parameters.

Advanced Params (see
page 343)

Specifies parameters used by the instrument to analyze the input signal.

Data Range (see page 344) Specifies which symbols and subcarriers of the signal to display.

Analysis Time (see page 344) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for OFDM Analysis
displays.

Trace (see page 346) Enables you to display or hide the measurement or average trace.

Scale (see page 346) Specifies the vertical, subcarrier, and symbols scale and position settings.

Prefs (see page 348) Specifies the units of the display and whether elements of the graphs are displayed.

xxx

Modulation Params Tab - OFDM

The Modulation Params tab specifies the type of modulation used by the input signal and other parameters
that control the demodulation of the input signal.

Settings Description

Standard Specifies the standard used for the input signal. Choices are 802.11a/g/j and
802.16 (2004).

Guard Interval Specifies the guard interval used in the input signal. Choices are 1/4, 1/8, 1/16/,
1/32, and User. When you select User, you can enter a percentage value to
specify the size of the guard interval as a percentage of the useful symbol
interval. The Guard Interval range is 0–100%.

Spacing and Bandwidth Specifies the spacing between subcarriers and the nominal channel bandwidth.
Only one of these settings can be set at a time, the other setting is automatically
calculated.

Sample Rate Indicates the FFT sample rate, based on the bandwidth or subcarrier setting.

xxx
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Advanced Params Tab - OFDM

The Advanced Params tab contains parameters that control the analysis of the input signal.

Settings Description

Constellation determination Specifies the method used to detect the constellation. Auto Detect analyzes the
signal to determine the appropriate constellation, Manual allows you to specify
the constellation type. Manual choices are: BPSK, QPSK, 16QAM, and 64QAM.

Symbol analysis offset Specifies the analysis offset in the symbol interval. This value is a percentage
of the Guard Interval. The allowable range is -100% to 0%. -100% positions
the FFT to start at the beginning of the Guard Interval, 0% positions it to start
at the end of the Guard Interval. Default value is -50% which usually gives
the best measurement results.

Channel Estimation Specifies the method used to estimate channel frequency response and
equalization. This control can be used to diagnose changes in frequency
response over the signal packet.

Preamble When you select Preamble, the instrument uses only the Preamble to estimate
channel frequency response. This response is then used to equalize the entire
signal packet.

Preamble + Data When you select Preamble + Data, the instrument makes an initial channel
frequency response estimate from the Preamble. Then estimates the channel
response for each data symbol using the decoded data content to derive
equalization for each symbol individually. This allows compensation for
time-varying channel response over the packet.

Pilot tracking Specifies if pilot subcarriers should be used to correct amplitude, phase, and
symbol timing variations over the packet. The choices available are Phase,
Amplitude, and Timing. The default setting is Phase.

Swap I & Q Select the checkbox to swap the I and Q components of a signal. This
compensates the input signal for spectral inversion.

xxx
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Data Range Tab - OFDM

The Data Range tab enables you to control how much signal is analyzed, as well as specify the range of
results that are displayed in the Constellation, EVM, Magnitude Error, Phase Error, Power and Symbol
Table graphs.

Settings Description

Symbols Specifies which symbols are displayed in the graphs.

All Select All to display all symbols.

Range Select Range to specify a subset of symbols for display.

Start Specifies the first symbol to include in the display.

Number Specifies how many symbols to display in the graphs.

Single Select Single to display a single symbol.

Index Use Index to specify the symbol you want to display.

Subcarriers Specifies which subcarriers are displayed.

All Select All to display all subcarriers in the signal.

Pilots Only Select Pilot to display only pilot subcarriers.

Data Only Select Data to display only data subcarriers.

Single Specifies a specific subcarrier for display.

Index Specifies the specific subcarrier to be displayed.

Range Specifies a range to subcarriers to be displayed.

Start Specifies the start value of the range to be displayed.

Stop Specifies the ending value of the range to be displayed.

Max symbols to analyze Specifies how many symbols are analyzed. You can use this setting to speed
analysis by limiting the number of symbols being analyzed.

xxx

Analysis Time Tab - OFDM

The Analysis Time tab contains parameters that define how the signal is analyzed in the OFDM Analysis
displays.
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Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in
either symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols)
being used by the analyzer, this value may not match the Analysis Length requested
(in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

xxx

Analysis Offset

Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (all time values are relative
to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length

Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the
actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the control in the
"Actual" readout. This setting is not available when Auto is checked. Range: minimum value depends on
modulation type. Resolution: 1 symbol.
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Time Zero Reference

All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Offset is measured from the trigger point.

xxx

Trace Tab - OFDM

The Trace tab allows you to set the trace display characteristics of the selected display. This tab is not
available for all OFDM displays.

Settings Description

Trace Use this drop-down list to select whether or not the Average trace or the measurement
trace is displayed. The measurement trace depends on the selected display.

Show Select or deselect this checkbox to show or hide the trace selected in the Trace
drop-down list.

Freeze Selecting Freeze halts updates to the trace.

xxx

Scale Tab - OFDM

The Scale tab allows you to change the scale settings that control how the trace appears on the display but
does not change control settings such as Measurement Frequency. There are two versions of the Scale tab
for OFDM displays. One version is used only for the Constellation display and the other version is used
for the OFDM EVM, OFDM Magnitude Error, OFDM Phase Error, and OFDM Power displays.
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Scale tab for OFDM EVM, OFDM Mag Error, OFDM Phase Error, and OFDM Power displays

Scale tab for OFDM Constellation display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Subcarrier Controls the scale of the subcarrier graph and position of the trace.

Scale Specifies how many subcarriers are displayed horizontally.

Position Specifies the subcarrier that appears at the left edge of the subcarrier graph.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Symbols Controls the scale of the Symbols graph.

Scale Specifies the number of symbols that appear in the symbols graph.

Position Specifies the symbol that appears at the left edge of the Symbols graph.

Autoscale Resets the scale and position settings to optimize the display.

Auto When Auto is checked, the scale and position values for the Symbols graph are
automatically adjusted to maintain the optimal display.

Zoom Sets the Constellation display size and position.

Scale Sets the magnification value for the Constellation display.

Vertical Position Sets the vertical location of the Constellation display within the graph. Range is -3.7 to
+3.7.

Horizontal Position Sets the horizontal location of the Constellation display within the graph. Range is -3.7 to
+3.7.

xxx
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Prefs Tab - OFDM

The Prefs tab enables you to change appearance characteristics of the OFDM Analysis displays. Not all
settings on the Prefs tab shown below appear for every OFDM display.

Settings Description

Time units Specifies whether the displayed time units are seconds or symbols.

Freq units Specifies whether the displayed frequency units are frequency (Hz) or subcarrier channel.

Radix Specifies whether symbol values are displayed in binary or hex format (for example, in
the Symbol Table or markers readouts).

Show graphs Specifies which graph types are displayed.

Both Displays both the Subcarrier and Symbol graphs.

Subcarriers Displays only the subcarrier graph.

Symbols Displays only the symbol graph.

Show graticule Displays or hides the graticule in the graphs.

Show marker readout Displays or hides the marker readouts in the graphs.

xxx
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Overview

The Pulsed RF option (SVPH-SVPC) allows you to take measurements that provide deep insight into pulse
train behavior. You can define and analyze unique pulse characteristics in the time and frequency domains
and gain additional insight into the performance of Radar or EW subsystems. The Pulse Cumulative
Histogram and Pulse Cumulative Statistics Table accumulate results over multiple acquisitions. The
remaining Pulse displays show results for the current acquisition. You can use cross-correlated markers to
pinpoint events in one display and debug in other displays.

The displays in Pulsed RF (Setup > Displays > Pulsed RF) are:

Cumulative Histogram

Cumulative Statistics

Pulse-Ogram™

Pulse Statistics

Pulse Table

Pulse Trace

Pulse Measurements

The analyzer takes the following pulse measurements.

Measurement Description

Average ON Power The average power transmitted during pulse on.

Peak Power Maximum power during pulse on.

Average Transmitted Power The average power transmitted, including both the time the pulse is on and the time
it is off, and all transition times.

Pulse Width The time from the rising edge to the falling edge at the –3 dB / –6 dB level (50%) of the
user selected 100% level. Level is user selectable for Volts or Watts.

Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user
selected 100% level.

Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user
selected 100% level.

Repetition Interval The time from a pulse rising edge to the next pulse rising edge.

Repetition Rate The inverse of repetition interval.

Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.

Duty Factor (Ratio) The ratio of the pulse width to the pulse period.
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Measurement Description

Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot,
overshoot, or undershoot. By default, the first 25% and the last 25% of the pulse top is
excluded from this measurement to eliminate distortions caused by these portions of
the pulse.

If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements
for the analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple
results will be in %Watts. The default for the general Units control is dBm, so the Ripple
results default is %Watts.

See also Ripple (see page 736).

Ripple dB The Ripple measurement expressed in dB.

Droop Droop is the power difference between the beginning and the end of the pulse on time. A
straight-line best fit is used to represent the top of the pulse. The result is a percentage
referenced to the Average ON Power.

Droop dB The Droop measurement expressed in dB.

Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units
are %Watts or %Volts.

Overshoot dB The Overshoot measurement expressed in dB.

Pulse-ref-Phase Difference The phase difference between the current pulse and the first pulse in the analysis
window. The instantaneous phase is measured at a user-adjustable time following the
rising edge of each pulse.

Phase Difference The time interval by which one wave leads of lags another.

Pulse-ref Freq Difference The difference between the frequency of the current pulse and frequency of the previous
pulse. The instantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

RMS Freq Error The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time
trace, computed over the Measurement Time.

Max Freq Error The maximum frequency error is the difference between the measured carrier frequency
of the signal and the user-selected center frequency of the analyzer.

RMS Phase Error The RMS Phase Error measurement is the RMS average of the Phase vs Time trace,
computed over the Measurement Time.

Max Phase Error The phase is measured at each point during the pulse on time. The phase error for
each point is the difference between the measured phase value and the calculated ideal
phase value. After the phase error is calculated for all points in the acquisition record,
the largest error in the positive direction and the largest in the negative direction are
determined. Whichever of these two values has the greater absolute value is designated
the Max Phase Error.

Freq Deviation The Frequency Deviation measurement is the difference between the maximum and
minimum measured values of the signal frequency during the Measurement Time.

Phase Deviation The Phase Deviation is the difference between the maximum and minimum Phase values
measured during the on time of a pulse.

Impulse Response Amplitude The difference in dB between the levels of the main lobe and highest side lobe.

Impulse Response Time The difference in time between the main lobe and highest side lobe.

Time This is the time in seconds relative to the time reference point in the first acquisition
record in the data set.

350 SignalVu-PC Printable Help



Pulsed RF Cumulative Histogram Display

Measurement Description

Absolute Frequency The absolute pulse frequency measured at a point specified by the user. The
measurement includes carrier frequency as well. The measurement point should be
within the pulse width, starting from the 50% point.

Pulse-Pulse Frequency
Difference

The difference between the frequency of the current pulse and frequency of the previous
pulse. The instantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

Pulse-Pulse Phase Difference The phase difference between the selected pulse and the first pulse in the analysis
window. The instantaneous phase is measured at a user-adjustable time following the
rising edge of each pulse.

Delta Frequency (Non-chirped
pulse)

The Delta Frequency measurement is the difference from the measurement frequency
to each pulse frequency. Pulse frequency is calculated across the time defined by the
Frequency Domain Linearity setting in the Define tab.

The measurement is available for modulation types CW (Constant Phase), CW
(Changing phase). and Other (manual) setting in the Freq Estimation tab.

The measurement is not specified for chirp or other signals and no answer is returned
when frequency estimation is set to Chirp.

If frequency estimation is set to Other, then Frequency Offset must be set to 0 Hz and the
Range can be set to ±40% of the acquisition bandwidth.

A least-square fit of slope of phase vs. time over the measurement period is used for the
measurement of the individual pulse frequency. Frequency difference is calculated as the
difference between the reference frequency and the calculated frequency of the pulse.

xxx

Cumulative Histogram Display

This histogram display shows the numerical distribution of the various pulse measurement results
accumulated over multiple frames (in Fast Frame mode) and acquisitions. You can see the pulse count
in a chosen bin by choosing the bin number or the X value (of the chosen result). Pulses that do not lie
within the chosen Min/Max are shown as outliers.

To show the Cumulative Histogram display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select Pulse Analysis in theMeasurements box.

4. In the Available displays box, double-click the Cumulative Histogram icon or select the icon and
click Add. The icon will appear in the Selected displays box and will no longer appear under
Available displays.

5. Click OK to show the Cumulative Histogram display.

6. If you are analyzing a stored data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the display
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Item Display element Description

1 Result Drop down list of measurements. The results of the selected measurement
in this Cumulative Histogram display will also show in the Pulse Statistics
display and be highlighted in the Pulse Table display. All results will be
available for view when Auto mode is enabled in the Histogram Settings
button (see page 354) window. Only selected results will be available for view
when Manual mode is enabled in the Histogram Settings window.

2 X A value of the selected result where the pulse indicator is positioned.
Changing X will automatically change the bin number to the one that contains
the X value.

3 Bin Bin number where the indicator is positioned. Changing this number will
change the value of X to the middle of the selected bin.

4 Pulses in Bin Number of pulses in the selected bin.

5 Total Pulses Total number of pulses analyzed in the current acquisition.

6 Vertical Sets the vertical range.

7 Autoscale Sets the axes to values for clear visibility of trace points.

8 Horizontal offset and scale Controls that specify the offset and scale on the horizontal axis.

9 Clear button Clears results from the display and starts a new measurement.

10 Outliers Number of pulses that have measurement values outside of the maximum
and minimum values indicates the outliers below the lower limit and those
exceeding the upper limit.

11 Histogram Table button Contains the Bin number, Bin Range, and Pulses in bin for the chosen
measurement.

xxx

Cumulative Histogram display settings

Main menu: Setup > Settings

Favorites Toolbar:

The Settings control panel tabs for the Cumulative Histogram display are shown in the following table.
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Settings tab Description

Params Specifies several parameters that control how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Levels Specifies parameters that control the method and levels used to calculate some pulse
values.

Freq Estimation Specifies the reference used for computing frequency error.

Scale Specifies the vertical and horizontal scale settings.

Prefs Specifies whether or not certain display elements are shown.

xxx

Histogram Settings button

This button is located on the Pulse Cumulative Histogram Settings control panel. Click this button to open
a window where you can select which measurement results will be available in the Result drop down
menu. You can select to use Auto or Manual mode.

Manual mode for histogram settings. InManual mode, the histogram computation is done for the selected
measurement results. You set the maximum and minimum values. The Bin field represents the total
number of bins used in the histogram.

Auto mode for histogram settings. In Auto mode, the histogram computation is done for all measurement
results. Minimum and maximum limits are chosen automatically based on the first 10,000 pulses. The
Bin field represents the total number of bins used in the histogram.
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Restore Defaults button

This button is located on the Pulse Cumulative Histogram Settings control panel. Click this button to set
the Cumulative Histogram parameters to their default values.

Cumulative Statistics Table display

This display is a statistics table that provides information on Pulse Count, Max, Max TimeStamp, Min,
Min TimeStamp, Peak to Peak, Average, and Standard Deviation over different acquisitions.

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select Pulsed RF in theMeasurements box.

4. In the Available displays box, double-click the Cumulative Statistics icon or select the icon and click
Add. The icon will appear in the Selected displays box and will no longer appear under Available
displays.

5. Click OK to show the Cumulative Statistics display.

6. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the display
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Display element Description

Measurement The row across the top of the table shows the selected measurement.

You can right click on this row to access this menu to edit the table:

Select Add Measurements to open this window to select measurements:

Maximum Maximum value of the measurement across acquisitions with a time stamp.

Maximum TimeStamp This time stamp denotes the time the maximum value of the measurement occurred across
acquisitions.

Minimum Minimum value of the measurement across acquisitions with a time stamp.

Minimum TimeStamp This time stamp denotes the time the minimum value of the measurement occurred across
acquisitions.

Average Average value of the measurement values accumulated over multiple acquisitions until the
current acquisition.

Peak to peak This is the difference between Maximum and Minimum value of the measurement

Standard deviation Standard deviation of the measurement that has a population equal to the Pulse Count value.

Clear button Clear the results and starts a new measurement.

xxx
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NOTE. When analysis is done on only one pulse, the Standard Deviation is zero. Log10 (0) is not defined
and thus is reperesented by a “–” when the unit is dB.

Cumulative Statistics Table display settings

Main menu: Setup > Settings

Favorites Toolbar:

The Settings control panel tabs for the Cumulative Statistics Table display are shown in the following table.

Settings tab Description

Measurements Specifies which measurements to show in the table. Click the box(es) next to the
measurement(s) you want to show. You can also click the Select All and Clear All buttons.

Params Specifies how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Levels Specifies parameters that control the method and levels used to calculate some pulse
values.

Freq Estimation Specifies the reference used for computing frequency error.

Prefs (see page 384) Specifies whether on not certain display elements are shown.

xxx

Restore defaults button

This button is located on the Cumulative Statistics Table Settings control panel. Sets the Cumulative
Statistics Table parameters to their default values.

Pulse-Ogram display

The Pulse-Ogram™ display shows a stacked view of radar pulses when the analyzer is using fast-frame
mode. The fast-frame captures IQ samples around a pulse when triggered. Each fast frame is configured to
capture few IQ samples before rise-time, and after fall-time of a single pulse, and a timestamp associated
with that pulse. With this information, the different fast-frame captures are stacked one after the other and
displayed as Time v/s Time, and the corresponding spectrum information as Frequency v/s Time. The
stacking allows for overlap of adjacent frames. The user can also select the range of frames for viewing
in the display. This enables the user to study various aspects of pulse such as pulse width, reflections,
rise-time, fall-time, etc.

Marker correlation in Pulse-Ogram

At the end of an acquisition, the TOV and Spectrum show the last frame acquired. When we place a
marker in Pulse-Ogram, the marker would not move in TOV and Spectrum unless you bring the marker to
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the last frame in Pulse-Ogram. Similarly, if marker is moved in TOV and Spectrum, then the marker in
Pulse-Ogram will move to the last frame automatically.

If you want the marker movement in Pulse-Ogram to change the pulse indicator in the Pulse Table or Pulse
Trace display, then you must add the Pulse Statistics display in Time trend mode. Movement of the marker
now in the Pulse Statistics display or Pulse-Ogram display will change the pulse indicator position too, and
therefore the appropriate pulse will be shown in the Pulse Trace display.

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select Pulsed RF in theMeasurements box.

4. In the Available displays box, double-click the Pulse-O-gram icon or select the icon and click Add.
The icon will appear in the Selected displays box and will no longer appear under Available displays.

5. Click OK to show the Pulse-O-gram display.

6. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the display
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Display element Description

Time vs Time This view has the IQ data captured in the fast frames in a stacked view (with overlap).

Frequency vs Time This view has the corresponding spectrum of the signal captured.

Frame offset Controls the number of frames that are offset in the display. The starting frame will be
frame offset + 1.

Frame scale Controls the number of frames that can be seen in the display.

Frame count Total number of fast frames in the acquisition.

Frame # Indicates the frame number in which the marker is present. This option will only appear
when the marker is added.

Plot type Shows Stacked and is not selectable.

Display Select to view Time vs Time or Frequency vs Time or Both.

RBW Shows the resolution bandwidth for the Frequency vs Time view.

xxx

Pulse-Ogram display settings

Main menu: Setup > Settings

Favorites Toolbar:

The Settings control panel tabs for the Pulse-Ogram display are shown in the following table.

Settings tab Description

Analysis Specifies settings related to analysis of the signal.

Traces Specifies the display characteristics of displayed traces.

Scale Specifies the parameters related to fast frame.

Prefs Specifies marker readout options.

xxx

Pulse Table display

The Pulse Table lists selected measurements in a spreadsheet format, showing the pulse numbers and all
the results for each measurement on all the detected pulses. Pulses are numbered from one.
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Displaying the Pulse Table

1. Press the Displays button or select Setup > Displays.

2. Select Pulsed RF in the Measurements box.

3. Double-click Pulse Table in theAvailable displays box to add the display to the Selected displays box.

4. Click OK.

Selecting the Measurements to Show

1. With the Pulse Table selected, press the Settings button.

2. In the Pulse Table Settings control panel, select theMeasurements tab.

3. Select the measurements you wish to take from the list of measurements or click Select all to choose
all measurements.

4. Click the close box ( ) to remove the Settings control panel.
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Changing the Pulse Table Display Settings (see page 362)

Pulse Table display settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Settings control panel tabs for the Pulse Table Display are shown in the following table.

Settings tab Description

Measurements Selects the measurements to be show in the Pulse Table.

Params Specifies several parameters that control how pulses are counted and defined.

Define Specifies parameters that control where measurements are taken on a pulse.

Levels Specifies parameters that control the method and levels used to calculate some pulse
values.

Freq Estimation Specifies the reference used for computing frequency errors.

xxx

Restore defaults button

This button is located on the Pulse Table Settings control panel. Sets the Pulse Table parameters to their
default values.

Pulse Trace display

The Pulse Trace display shows one measurement result and a trace graph illustrating that measurement
for a selected pulse number. You can also choose to display arrows and lines in the graph that illustrate
where on the pulse the measurement is being taken.
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Elements of the Pulse Trace Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Pulse Trace display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Result Use this list to select the measurement to show. The measurement chosen
here selects the same result to be displayed in the Statistics view and
highlighted in the Table view. Selecting a result in any of these views causes
the same result to be selected in all of them.

3 Pulse Selects which pulse result is shown. Like the Result, this selection is shared
with the Statistics and Table views. The maximum number of pulses that
can be measured is limited to 10000.

4 Pulse threshold indicator This green triangle indicates the power threshold used to detect pulses. See
Settings > Params > Power threshold to detect pulses.

5 Autoscale Set the axes to values that show all trace points.

6 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the
offset and scale on the horizontal axis.

7 Top of graph adjustment Sets the power level shown at the top of the graph. If the number is greater
than the Ref Level, a white line will appear in the graph to indicate the Ref
Level.

8 Vertical scale Sets the vertical scale value.

xxx
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Changing the Pulse Trace Display Settings (see page 364)

Pulse Trace display settings

Main menu: Setup > Settings

Favorites Toolbar:

The Setup settings for the Pulse Trace display are shown in the following table.

Settings tab Description

Params (see page 370) Specifies several parameters that control how pulses are counted and defined.

Define (see page 372) Specifies parameters that control where measurements are taken on a pulse.

Levels (see page 377) Specifies parameters that control the method and levels used to calculate some pulse
values.

Freq Estimation (see
page 378)

Specifies the reference used for computing frequency error.

Scale (see page 382) Specifies the vertical and horizontal scale settings.

Prefs (see page 384) Specifies whether on not certain display elements are shown.

xxx

Restore defaults button

This button is located on the Pulse Trace Settings control panel. Sets the Pulse Trace display parameters
to their default values.

Pulse Statistics display

The Pulse Statistics view displays a plot of a pulse measurement's values for every pulse in the analysis
period. For example, the Pulse Statistics display will show the Rise Time measurement for each of 30
pulses, with rise time on the Y axis and pulse number on the X axis. Alternatively, the Statistics Display
can show an FFT trace for the values of a measurement over all the pulses analyzed. Numeric readouts
of Pulse Count, Max, Min, Peak to Peak, Average, and Standard Deviation in this display summarize
results for the selected pulse measurement.

Elements of the Pulse Statistics Display

The following images show the display when different plot types are selected. The table following these
images explains the elements of these displays.
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The above image shows an FFT plot.

The above image shows a Trend plot.
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The above image shows a Time Trend plot.

The above image shows a Histogram plot.

Item Display element Description

1 Result Use this list to select which measurement statistics to display. The
measurement chosen here selects the same result to be displayed in the
Pulse Trace display and the Pulse Table display. Selecting a result in any of
these views causes the same result to be selected in all of them.

2 Results indicators

(The indicators shown depend on the plot type selection. The values shown are plot indicator (Item 9) values.)

Pulse Pulse indicator for Trend or Time Trend plots that indicates the pulse selected
by the Pulse setting.

Freq Pulse indicator for FFT plots that marks the trace point at the selected
frequency.
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Item Display element Description

X For Histogram plots: A value of the selected result where the pulse indicator
is positioned. Changing X will automatically change the bin number to the
one that contains the X value.

Bin For Histogram plots: Bin number where the indicator is positioned. Changing
this number will change the value of X to the middle of the selected bin.

Pulses in Bin For Histogram plots: Number of pulses in the selected bin.

Total Pulses For Histogram plots: Total number of pulses analyzed in the current
acquisition.

3 Vertical Sets the vertical range.

4 Autoscale Sets the axes to values for clear visibility of trace points.

5 Histogram Table button Contains the Bin number, Bin range, and Pulses in bin for the chosen
measurement.

6 Plot type selector Select Trend, Time Trend, FFT, or Histogram as plot type.

7 Horizontal offset Adjusts the horizontal offset.

8 Statistics summary Display of measurement statistics for the selected result.

9 Pulse indicator For Trend and Time Trend plot types, this indicates the pulse selected by the
Pulse setting. For the FFT plot type, this indicator marks the trace point at
the selected frequency. For Histogram plot types, this indicator marks the
selected results bin.

10 Scale Adjusts the horizontal scale.

xxx

Changing the Pulse Statistics Display Settings (see page 367)

Pulse Statistics settings

Main menu bar: Setup > Settings

Favorites toolbar:
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The settings for the Pulse Statistics display are shown in the following table.

Settings tab Description

Params (see page 370) Specifies several parameters that control how pulses are counted and defined.

Define (see page 372) Specifies parameters that control where measurements are taken on a pulse.

Levels (see page 377) Specifies parameters that control the method and levels used to calculate some pulse
values.

Freq Estimation (see
page 378)

Specifies the reference used for computing frequency errors.

Scale (see page 382) Specifies the vertical and horizontal scale settings.

Prefs (see page 384) Specifies whether or not certain elements of the display are shown.

xxx

Restore defaults button

This button is located on the Pulse Statistics Settings control panel. Sets the Pulse Statistics display
parameters to their default values.

Pulsed RF Measurement Settings

Some of the control panel tabs are shared by the Pulsed RF displays (Setup > Displays). Changing a
setting in a shared tab changes that setting for all the Pulsed RF displays. The other control panel tabs are
unique for each display. The following information explains both types.
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Common controls for pulsed RF displays

Settings tab Description

Measurements (see page 369) Specifies which measurement results appear in the Cumulative Statistics Table and
Pulse Table displays.

Params (see page 370) Specifies several parameters that control how pulses are counted and defined.

Define (see page 372) Specifies parameters that control where measurements are taken on a pulse.

Analysis (see page 379)

(Only Available for the
Pulse-Ogram display)

Specifies parameters related to analysis of the signal.

Levels (see page 377) Specifies parameters that control the method and levels used to calculate some pulse
values.

Freq Estimation (see
page 378)

Specifies the reference used for computing frequency errors.

Traces (see page 381)

(Only available for the
Pulse-Ogram display)

Specifies the smooth points for the Time vs Time view and the detection method for the
Frequency vs Time view.

Scale (see page 382) Specifies the vertical and horizontal scale settings.

Prefs (see page 384) Specifies whether or not certain elements of the display are shown.

xxx

Measurements Tab

The Measurements tab is used to specify the measurements that appear in the Cumulative Statistics
Table display and the Pulse Table display.

Show in Cumulative Statistics Table

Checked measurements appear in the table.

Select all

Click Select all to choose all measurements for display in the table.
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Clear all

Click Clear all to remove all measurements from the table display.

Params Tab

The Params tab enables you to adjust several measurement parameters for Pulsed RF displays. Not
all parameters show for all displays.

Setting Description

Measurement Filter Specify whether a filter is used to limit the bandwidth of the input signal.

Bandwidth Sets the bandwidth of the measurement filter.

Power threshold to detect
pulses

Specifies the level used for locating pulses in the data.

Minimum OFF time between
pulses

Specifies the time the signal must fall below the power threshold for two pulses to be
considered separate pulses.

Max number of pulses Specifies the number of pulses to measure within the analysis time.

(Only available for the Pulse Statistics, Pulse Trace, and Pulse Table displays.)

xxx

Measurement Filter

Three choices are available for the measurement filter:

No Filter - Max BW: The widest acquisition bandwidth available is used. The Bandwidth setting is
disabled, but shows the value in use.

No Filter: - This is the default. The Bandwidth control is enabled to specify an acquisition bandwidth.

Gaussian - The Bandwidth control is enabled for you to specify a value. The instrument uses an
acquisition bandwidth two times wider than the entered value.

Power Threshold to Detect Pulses

Specifies the minimum power level the trace must exceed to be detected as a pulse. The range for this
setting is: -3 to -70 dBc. The setting resolution is 1 dB. The default value is -10 dB.
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Minimum OFF time between pulses

Specifies the time the signal must fall below the power threshold for two pulses to be considered separate
pulses. The minimum value for this setting is 1.000 ns.

Max Number of Pulses

Only available for the Pulse Statistics, Pulse Trace, and Pulse Table displays.

If the Analysis Time contains fewer pulses than specified, the analyzer will measure all the pulse within
the analysis time. If there are more pulses in the Analysis Time, than the specified number, the analyzer
measures the specified number of pulses and ignores the rest. The setting resolution is: 1. If this setting is
not checked, the analyzer will measure all pulses within the Analysis Time.

To determine the maximum number of pulses that can be analyzed, use the following equation:

where:

Pulse rate is the number of pulses per second (frequency).

Capacity is a length of time which is displayed on the Acquire > Sampling Parameters tab.

Note that the maximum number of pulses is affected by several parameters. For example, measurement
bandwidth affects the sample rate. The measurement algorithm also can reduce the maximum number of
pulses that can be analyzed (by increasing the sample rate) based on the characteristics of the signal.

Additionally, when FastFrame is enabled, determining the maximum number of pulses is even more
challenging. In FastFrame mode, the signal analyzer samples the signal around events of interest and
ignores the signal between events of interest. Thus, if the instrument is only looking at pulses and
ignoring the signal between pulses, the number of pulses that can be analyzed depends strongly on the
characteristics of the pulse itself (for example, fewer wide pulses can be analyzed than narrow pulses,
all other things being equal).

The Pulse Cumulative Statistics display provides statistics of pulses like Average, Standard Deviation,
and Peak to Peak. Pulse Count does not have an upper limit for Pulse Cumulative Statistics. The Pulse
Cumulative Histogram display provides information about the trend of the Pulse characteristics and
outliers. This display does not support any upper limit or lower limit.

NOTE. In Fast Save mode, Pulse /Frame Count can go up to 200,000. This count also depends on the hard
disk drive (HDD) capacity to store acquisitions.

The asterik (*) around a pulse number indicates that it is a Fast Frame.

All Pulse Analysis displays except the Pulse-Ogram update results only after analysis of all fast frames.
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Define Tab

The Define tab enables you to specify parameters that control where measurements are made on a pulse.
The settings available depend on the measurement selected. This tab is not available for the Pulse-Ogram
display.

The settings that appear on the Define tab are described below. They may vary according to the
Measurement(s) selection.

Freq-Domain Linearity
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Setting Description

Time method Specifies how the measurement's duration is determined. The choices are
Absolute and Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Length specifies the period of time that is used for pulse measurements The
measurement time begins at the Start point and continues for the amount of time
specified by Length.

Relative time method

Length In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx

Impulse Response
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Setting Description

Apply ampl corrections Enable/disable corrections that remove errors due to the window function and to
the time offset of the side lobe.

Keep-out time (+/-) The Keep-out time specifies a region that is ignored when the trace is analyzed for
side lobes. The setting defines a region to the left and to the right of the center
of the main lobe. Lobes that fall within this time region are not eligible to be the
“highest side lobe”.

Time method Specifies how measurement parameters are determined. The choices are
Absolute and Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement
time begins at the Start point and continues for the amount of time specified by
Length.

Relative time method In the Absolute time method, Length specifies the period of time that is used for
pulse measurements.

Length In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx

P-R F Diff, P-P F Diff, F Abs, P-R ø Diff, P-P ø Diff

Setting Description

Measurement point Specifies the period in time after the 50% rising edge at which frequency and
phase difference measurements are made.

xxx
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Ripple

Setting Description

Length Length specifies the percentage of the top of the pulse that is used for
measurements. The instrument automatically determines the pulse top. The
measurement length is centered within the pulse ON time. Only the Relative Time
method is available for Ripple.

xxx

Overshoot
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Setting Description

Time method Specifies how measurement parameters are determined. The choices are
Absolute and Relative.

Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement
time begins at the Start point and continues for the amount of time specified by
Length.

Relative time method

Ref Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx
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Levels Tab

Use the Levels tab to set parameters that control the method and levels used to calculate some pulse values.

Setting Description

100% Level Specifies the method used to determine the 100% level(s).

50% Level Specifies the method used to determine the 50% level on the pulse.

Rise/Fall Levels Select whether to use the 10% to 90% or 20% to 80% points (based on voltage level)
to define the rise and fall times.

xxx

100% Level

Use the 100% Level settings to select the method used to determine the 100% level(s) used for calculating
pulse parameters, for example, Rise, Fall, and Width.

The Pulse Average Amplitude defines the pulse top as the average of the values of all the points along
the pulse top. This average is used as the 100% level, from which the 10, 20, 50, 80 and 90% levels are
calculated. Pulse measurements are referenced against these various levels. For example, Rise is the time
between the 10 and 90% (or 20 and 80%) levels on the rising edge of the pulse. When the Pulse Average
Amplitude method is selected, the same 100% level is used for both rising and falling edges.

Because some RF pulse types have droop (a height difference between the beginning and ending points of
the pulse top), the 100% percent level on the rising edge may not be equal to the 100% level on the falling
edge. The Independent method of pulse point location is designed for pulses with different 100% levels
at their rising and falling edges. The Independent method calculates the 100% level for the rising edge
separately from the 100% level of the falling edge. As a result, the 10, 20, 50, 80 and 90% levels are also
different for the rising and falling edges, allowing for more accurate measurements on pulses with droop.

50% Level

Select Voltage to use -6 dB as the 50% point. Select Power to use -3 dB as the 50% level.
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Freq Estimation Tab

Use the Freq Estimation tab to specify parameters used for determining frequency offset. This tab is not
available for the Pulse-Ogram display.

Setting Description

Modulation type Specifies which algorithm to use for estimating frequency error.

Pulse Frequency Reference Specifies the method used to determine the pulse frequency error and if applicable,
the chirp slope.

Auto Selecting Auto causes the instrument to calculate the frequency offset and if applicable,
the chirp slope.

Freq Offset If Auto is not enabled, specify the value for frequency offset here. If Auto is enabled, the
offset is set to zero and this readout displays the calculated frequency error.

Chirp BW If Auto is not enabled, specify the value for Chirp Slope here. If Auto is enabled,
this readout displays the calculated Chirp slope. This setting is used only when the
modulation type is set to Linear Chirp.

xxx

Modulation Type

Frequency estimation is performed by the instrument using selectable methods, depending on signal type.
The selections for modulation type are CW (constant phase), CW (changing phase), Linear Chirp and
Other. Select the method of frequency method based upon a best match to your signal based on the
following descriptions:

CW (constant phase): The signal is not designed to change in either frequency or phase during the
measured pulse train.

CW (changing phase): The signal does not change the carrier phase within each pulse, although it
could change the phase from one pulse to another pulse. The signal is not designed to make frequency
changes.

Linear Chirp: The signal changes frequency in a linear manner during each pulse. The signal has the
same carrier phase at the same time offset from the rising edge of the pulse.

Other: The signal is not one of the listed types. You must manually enter the Frequency Offset value.

The following table maps the appropriate signal type selection with the signal characteristics.
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Phase offset from one pulse to anotherSignature

Zero Any (unknown)

CW CW Constant Phase CW Changing Phase

LFM Linear Chirp N/A

xxx

Analysis Tab

The Analysis tab is only available for the Pulse-Ogram display. It allows you to set parameters related to
analysis of the signal. The settings vary depending on which spectrum analysis region you select.
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Setting Description

Measurement bandwidth Specifies the frequency range used by the measurement. This control is linked to the
Bandwidth control of other Pulsed RF Displays. If No Filter – Max BW is selected in
other displays, the control setting is disabled, but shows the maximum value possible.
If No Filter or Gaussian is selected in other displays, then the Bandwidth control is
also enabled in the Pulse-Ogram display.

Filter shape Spectrum of the signal is windowed by the desired filter shape.

Use analysis time settings Provides the complete analysis length as displayed in Time Overview.

Pulse on time Analysis is done in the ON period of the data.

Length Specifies the analysis length.

Power threshold to detect
pulses

Specifies the level used for locating pulses in the data.

Independent In Manual option, you can choose the analysis length of the desired type for the
Freq vs Time view in the display.

Start Specify the analysis offset. The default value is the offset in Time Overview.

Length Specify the analysis length. The default value is the length in Time Overview.

xxx
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Traces Tab

The Traces tab is only available for the Pulse-Ogram display. It allows you to set the trace characteristics
for the display.

Setting Description

Smooth points Shows the number of filter coefficients used for smoothening the noisy region for visual
clarity.

Detection Trace Detection is used to reduce the results of a measurement to the desired number
of trace points.

xxx

Detection

Trace Detection is used to reduce the results of a measurement to the desired number of trace points. For
example, if the maximum number of trace points is 100,000 and a measurement over the selected analysis
length yields 200,000 points, the measurement must decimate these 200,000 trace points by 2 to prevent
exceeding the 100,000 trace point limit. Since only one value can be represented for each trace point, an
algorithm must be used to select (detect) the appropriate value to use.

The results array from an analysis can be detected (or “decimated”) in a variety of ways. The number of
results points produced for each trace point varies with both analysis length and trace length. For example,
the frequency transform used for the Spectrum display produces just one output value for each desired
trace point. In this case, the detection method chosen has no effect, as no decimation is required.

Increasing the Analysis Length (or for the Spectrum display, the Spectrum Length), causes the available
detection method's output traces to differ from each other because they have a larger set of samples for the
various detection methods to process.

The available detection methods are:

+Peak: The highest value is selected from the results to be compressed into a trace point.

–Peak: The lowest value is selected from the results to be compressed into a trace point.

Avg (VRMS): Each point on the trace is the result of determining the RMS Voltage value for all of
the results values it includes. When displayed in either linear (Volts, Watts) or Log (dB,dBm), the
correct RMS value results.

Sample: The first value is selected from the set of results to be compressed into a trace point.
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Scale Tab

The Scale tab is only available for trace displays. It allows you to change the vertical and horizontal scale
settings. Changing the scale settings changes how the trace appears on the display but does not change
control settings such as Measurement Frequency. In effect, these controls operate like pan and zoom
controls. Each display has different settings, as shown below.

The above image shows the Scale tab for the Pulse Statistics display.

The above image shows the Scale tab for the Pulse Trace display.

The above image shows the Scale tab for the Pulse Cumulative Statistics display.
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Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale. The units for this setting depend on the statistic selected
from the Result drop-down list in the Pulse Statistics display.

Position Adjusts the Reference Level away from the top of the trace display. The units for this
setting depend on the statistic selected from the Result drop-down list in the Pulse
Statistics display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to change the span.

Position Allows you to pan a zoomed trace.

Full Scale (Pulse Trace
display only)

Specifies the Horizontal scale default.

Selected Sets the horizontal scale default to be based on the result value for the currently-select
pulse.

Max Pulse Sets the horizontal scale default to be based on the largest value for the selected pulse
measurement.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Plot (Pulse Statistics display
only)

Specifies the FFT, Trend, Time Trend, or Histogram plot.

Reset Scale Restores all settings to their default values.

xxx

The above image shows the Scale tab for the Pulse-Ogram display.
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Setting Description

Vertical Controls the vertical position and scale of the trace display.

Frame Offset Display will start after the indicated frame number.

Frame Scale Shows how many frames are displayed in both Time vs Time and Frequency vs Time
views.

Horizontal

(Time vs Time view)

Controls the span of the Time vs Time trace display and position of the trace.

Position Allows you to pan a zoomed trace. The default value matches the offset of the acquisition.

Scale Allows you to change the span. The default value matches the length of the acquisition.

Reset Scale Restores the position and scale settings to default value.

Horizontal

(Frequency vs Time view)

Controls the span of the Frequency vs Time trace display and position of the trace.

Start Freq Allows you to set the starting frequency shown in the graph without changing analysis.
The default value matches the highest frequency of the span.

Stop Freq Allows you to set the stop frequency shown in the graph without changing analysis. The
default value matches the highest frequency of the span.

Reset Scale Restores the start frequency and stop frequency to default values.

xxx

Prefs Tab

The Prefs tab is only available for Pulsed RF trace displays. It is not available for the table displays. It
enables you to change parameters of the measurement display. Available parameters vary depending
on the selected display.

The above image shows the Prefs tab for the Pulse Cumulative Histogram display.

The above image shows the Prefs tab for the Pulse-Ogram display.
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The above image shows the Prefs tab for the Pulse Cumulative Statistics display.

The above image shows the Prefs tab for the Pulse Statistics display when Time Trend is the selected plot type. Trend
and FFT plot types do not show the Show Marker readout selection.

The above image shows the Prefs tab for the Pulse Statistics display when Histogram is the selected plot type.

The above image shows the Prefs tab for the Pulse Trace display.
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Setting Description

Show graticule Displays or hides the graticule in the trace display.

Show Marker readout in graph

(Only available for Pulse Trace
and Pulse-Ogram displays.)

When a marker is enabled, this setting displays or hides the maker readout, but not the
maker itself, on Time Trend plots.

Histogram readout

(Only available for Cumulative
Histogram display and the
Pulse Statistics display when
Histogram is the plot type.)

Controls the parameters Histogram readout and Bins. Histogram readout can be set to
either Count or %. Count indicates the number of hits that fell into each bin. % indicates
percentage of the total count (for the acquisition) that fell into each bin.

Calculate statistics in linear
scale (for results in log)

(Only available for Pulse
Statistics display.)

Checking this box allows for calculation of statistics in the linear domain (for example,
the Power values in dB are converted to Watts (linear scale) and statistics are computed
in Watts and then converted back to dB scale). This measurement will be observed
only when this box is selected.

This selection only appears in the Pulse Statistics display for these measurements:
Average ON Power, Average Transmitted Power, Peak Power, Impulse Response
Amplitude, Droop dB, Overshoot dB, and Ripple dB.

Bins

(Only available for Pulse
Statistics display when
Histogram is the plot type.)

Specifies how many "bins" or histogram bars the results are distributed into.

Auto

(Only available for Pulse
Statistics display when
Histogram is the plot type.)

Sets the bin number to automatic default, which is 10.

Outlier readout

(Only available for Cumulative
Histogram display)

Controls the parameters Outlier readout and Bins. Outlier readout can be set to either
Count or %. Count indicates the number of hits that fell into each bin. % indicates
percentage of the total count (for the acquisition) that fell into each bin.

Trace points

(Only available for the
Pulse-Ogram display.)

Sets the number of trace points used for marker measurements and for results export.

Frame Info

(Only available for the
Pulse-Ogram display.)

Displays or hides the frame information in the display.

xxx

The statistics can be calculated in the linear domain as well the log

Average ON Power, Average Transmitted Power, Peak Power, Impulse Response Amplitude, Droop
dB, Overshoot dB, Ripple dB, the statistics can be calculated in linear domain as well, i.e. the Power
values in dB are converted to watts (linear scale) and statistics are computed in watts and then converted
back to dB scale. This measurement will be observed only when the Calculate statistics in linear scale
(for results in log) is selected.

386 SignalVu-PC Printable Help



APCO P25 Analysis APCO P25 Analysis

APCO P25 Analysis

Overview

The Association of Public Safety Communication Officials (APCO) P25 Compliance Testing and
Analysis option allows you to evaluate radio signals to ensure they meet the standards set for the public
safety communications community for interoperable LMR equipment. This complete set of push-button
Telecommunication Industry Association TIA-102 standard-based transmitter measurements includes
modulation measurements, power measurements, and timing measurements. These measurements are also
compared with the limits that best fit the signal for which the standard applies to provide pass/fail results.

The P25 measurements available with this option can be made on signals defined by the Phase 1 (C4FM)
and Phase 2 (HCPM, HDQPSK) P25 standards. With this test suite, test engineers can simplify the
execution of a number of transmitter tests while still allowing for controls to modify signal parameters for
signal analysis. The analysis results give multiple views of P25 signal characteristics to allow the diagnosis
of signal imperfections and impairments quickly and easily. Display controls allow you to selectively
display the analysis results to help locate trouble-spots in the signal.

P25 Topics

The following information about the P25 Analysis option is available:

Reference Table of Supported P25 Measurements (see page 387)

P25 Standards Presets (see page 388)

P25 Displays (see page 389)

P25 Settings (see page 453)

P25 Measurements (see page 390)

P25 Test Patterns (see page 398)

Reference Table of Supported P25 Measurements

TIA-102 transmitter
measurement

Tektronix measurement display(s) (value name if
different from TIA-102 measurement name) Phase 1 Phase 2

RF output power P25 Summary

P25 Power vs Time

Yes Yes

Operating frequency
accuracy

P25 Summary (Operating Freq Accuracy) Yes Yes

Modulation emission
spectrum

SEM (The SEM display can be found in Select
Displays > RF Measurements)

Yes Yes

Unwanted emissions: Non
spurious adjacent channel
power ratio

MCPR (The MCPR display can be found in Select
Displays > P25 Analysis)

Yes Yes
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TIA-102 transmitter
measurement

Tektronix measurement display(s) (value name if
different from TIA-102 measurement name) Phase 1 Phase 2

Frequency deviation P25 Summary (Freq Dev) Yes HCPM

Modulation fidelity P25 Summary

P25 Constellation

Yes Yes

Symbol rate accuracy P25 Summary Yes Yes

Transmitter power and
encoder attack time

P25 Summary (Phase1 Tx Attack Time)

P25 Power vs Time (Power Attack Time and Encoder
Attack Time)

Yes N/A

Transmitter power and
encoder attack time with
busy/idle operations

P25 Summary (Phase1 Tx Attack Time (Busy/Idle))

P25 Power vs Time (Power Attack Time Busy Idle
and Encoder Attack Time Busy Idle)

Yes N/A

Transmitter throughput
delay

P25 Summary (Phase1 Tx Throughput Delay) Yes N/A

Transient frequency
behavior

P25 Freq Dev vs.Time Yes N/A

HCPM transmitter logical
channel peak adjacent
channel power ratio

P25 Summary (HCPM Tx Logic Ch Pk ACPR) N/A HCPM

HCPM Transmitter logical
channel off slot power

P25 Power vs Time (Off Slot Power)

P25 Summary (HCPM Tx Logic Ch Off Slot)

N/A HCPM

HCPM Transmitter logical
channel power envelope

P25 Power vs Time (Power Info)

P25 Summary (HCPM Tx Logic Ch Pwr Env Limits)

N/A HCPM

HCPM Transmitter logical
channel time alignment

P25 Summary (HCPM Tx Logic Ch Time Alignt) N/A HCPM

xxx

P25 Standards Presets

The P25 standards preset allows you to access displays preconfigured for the P25 standards you select.
You can read more about how Presets work here .

The P25 standards preset allows you to access displays preconfigured for the P25 standards you select.
You can read more about how Presets work here (see page 21).

The following table shows the bandwidth, modulation type, and displays that are automatically loaded for
each of the listed standards. MCPR masks are also loaded and are explained here (see page 389).

Table 2: P25 standards, modulation type, bandwidth, and displays

Standard Modulation type
Bandwidth
(kHz) Displays loaded with preset

Phase 1 C4FM 12.5 MCPR, Time Overview, P25 Constellation, P25
Summary

HCPM (inbound) 12.5Phase 2

HDQPSK (outbound) 12.5

MCPR, Time Overview, P25 Constellation, P25
Summary

xxx
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Retain Current Center Frequency

This setting becomes available when P25 is the selected preset in the Standards Preset window. You can
access this window by selecting Presets > Standards and then selecting P25 from the Preset drop down
menu. To activate the Retain current Center Frequency Setting, check the box. This setting allows you
to retain the previously used center frequency. By default, the box is unchecked and therefore the four
P25 preset displays will load with a center frequency of 850 MHz.

The default adjacent channels table for MCPR is different for RF frequencies in the range of 769 to
806 MHz (called 700 MHz band) and for frequency ranges outside it. The option of retaining center
frequency in Standards Preset is therefore useful if you want to load the default table for center frequencies
in the 700 MHz band.

MCPR channel and limit parameters. The MCPR (ACPR) standard channel and limit parameters that are
applied to the P25 signal depend on the standard you select when you configure the preset. Once you
select a standard and center frequency, the application will automatically load the parameters and default
limits recommended for best performance comparison by the Standard document. All channel and limit
parameters are derived from the TIA-102 standard and loaded for you. This provides you the assurance
that you are evaluating the signal with the most appropriate parameters.

NOTE. Changing analysis and display parameters recalculates the measurement results, but does not
affect acquisitions.

P25 Displays

The displays in P25 Analysis (Setup > Displays > Measurements: P25 Analysis) are:

MCPR

P25 Constellation (see page 401)
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P25 Power vs Time (see page 407)

P25 Eye Diagram (see page 404)

P25 Frequency Dev Vs Time (see page 416)

P25 Symbol Table (see page 412)

P25 Summary (see page 409)

Time Overview (see page 63)

P25 Measurements

The following topics contain important information you should know about specific P25 measurements.

RF Output Power (Phase 1 and Phase 2)

This is a measure of RF output power when the transmitter is connected to the standard load during
defined duty cycle. This measurement is presented as a scalar result in the P25 Summary display. Power
variation is shown in the P25 Power vs Time display.

Information of note about this measurement:

For bursty HCPM (Phase 2 Inbound) signals, the RF Output Power is measured only during the on slot
regions centered at the middle of the on slot.

The result shown in the P25 Summary Display is the average RF Output Power of all the bursts
selected in the analysis window.

If only one on slot region is chosen in the analysis window, then the RF Output Power of only the
chosen on slot is reported.

For non-bursty data, the entire duration of analysis window is considered to obtain RF Output Power.

The result shown in the P25 Summary display does not account for any attenuation introduced by a
user. Ensure that this attenuation is accounted for when you enter limits for comparison.

The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.

This measurement result is not shown in the P25 Summary display when Trigger Measurements
are selected.

NOTE. Read about important information related to HCPM bursty data measurements here (see page 400).

Operating Frequency Accuracy (Phase 1 and Phase 2)

The Operating Frequency Accuracy is the ability of the transmitter to operate on its assigned frequency.
This measurement is presented as a scalar result in the P25 Summary display.
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For bursty HCPM (Phase 2 Inbound) signals, the operating frequency accuracy is measured only
during the on slot regions centered at the middle of the on slot.

The result shown in the P25 Summary display is the average of all the bursts selected in the analysis
window.

If only one on slot region is chosen in the analysis window, then the operating frequency accuracy of
only the chosen on slot is reported.

For non-bursty data, the entire duration of the analysis window is considered to obtain the operating
frequency accuracy.

The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.

In Operating Frequency Error, double sided operating frequency error is converted to one sided
error and compared against the Absolute Limit.

This measurement result is not shown in the P25 Summary display when Trigger Measurements
are selected.

Unwanted Emissions (ACPR) (Phase 1 and Phase 2)

This measurement is the ratio of the total power of a transmitter under prescribed conditions and
modulation to that of the output power that falls within a prescribed bandwidth centered on the nominal
frequency of adjacent channels. This measurement is shown in the MCPR display.

For HCPM signals, Adjacent Channel Power Ratio analysis is only done on the first on slot region.
When the Modulation Type is set to HCPM from any P25 display or from Standards Presets, there will
be a search for bursts before ACPR analysis is done. If a burst is found, then analysis is done only on
first burst. If a burst is not found, it will show the results of the entire analysis length. The Main Preset
will remove the HCPM modulation Type setting, allowing MCPR to work in its regular mode.

The MCPR display will only have one Main channel for P25 signals in addition to relevant adjacent
channels.

The default adjacent channels table for Unwanted Emissions (ACPR) as suggested by the standard can
be loaded by using the P25 Standards Preset option (for which MCPR is one of the four displays).

The default adjacent channels table for MCPR is different for RF frequencies in the range of 769 to
806 MHz (called 700 MHz band) and for frequency ranges outside it.

To load the default adjacent channels table of a 700 MHz band, first set the center frequency. Next,
select Presets > Standards to view the Standards Preset window. Lastly, check the Retain current
Center Frequency Setting box.

By default, the Retain Center Frequency box is unchecked and therefore the four P25 preset displays
will load with a center frequency of 850 MHz and load the adjacent channels table for non-700 MHz
band.

By default, only six adjacent channels (on either side) will be shown when 700 MHz band is analyzed
in P25 (for visual clarity). However, analysis is done for all the ten channels and results will be
available in the table just under the display. You can zoom out to see the remaining bands.
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Frequency Deviation (Phase 1 (C4FM) and Phase 2 (HCPM))

This measurement shows the amount of frequency deviation that results for a Low Deviation and High
Deviation test pattern. This measurement is shown in the P25 Summary display.

This measurement only applies to HCPM and C4FM signals and High Deviation or Low Deviation test
patterns. If this measurement is run for any other test patterns or for HDQPSK signals, comparisons for
limits (set in the Limits tab of the control panel) will result in N/A being shown, as the measurement
will not be valid.

This measurement is done using a FM demodulator without any filter. As a result, it will not be exactly
the same as the result given in the P25 Frequency Deviation vs Time display. That display shows the
frequency deviation after complete demodulation and might use relevant shaping filters.

The Low pass filter cut off frequency can be set from the Analysis Params tab of the Settings Control
panel. The default value of the cut off frequency is 5 kHz.

Measurement results are only available when High Deviation, Low Deviation, or Symbol Rate test
pattern is selected.

The scalar result in the P25 Summary display will be shown as f1 (Positive Peak) and f2 (Negative
Peak) when analyzing the High Deviation test pattern (or the Symbol Rate test pattern for C4FM
signals).

The scalar result in the P25 Summary display will be shown as f3 (Positive Peak) and f4 (Negative
Peak) when analyzing the Low Deviation test pattern.

The scalar results in the P25 Summary display do not have a corresponding graphical view. A closely
representative display would be the FM display (Setup > Displays > Analog Modulation).

The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.

Modulation Fidelity (Phase 1 and Phase 2)

This measures the degree of closeness to which the modulation follows the ideal theoretical modulation
determined by the rms difference between the actual deviation and the expected deviation for the
transmitted symbols. This measurement is shown in the P25 Summary and P25 Constellation displays.

This measurement is done on the first on slot region in the analysis window for bursty HCPM data.
The analysis is done on 160 symbols centered at the burst.

This measurement is done on all of the data chosen in the analysis window for non-bursty modulation
types. A warning message is issued if the data is less than 164 symbols (the standard recommends at
least 164 symbols be present for the measurement of non-bursty signals).

This measurement is done by performing the frequency demodulation after taking the signal through
relevant shaping filters and comparing it with expected frequency deviation points.

The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.
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This measurement result is not shown in the P25 Summary display when Trigger measurements
are selected.

HDQPSK-P25 filter attempts to remove the Inter Symbol Interference before symbol detection.

NOTE. Read about important information related to HCPM bursty data measurements here (see page 400).

Symbol Rate Accuracy (Phase 1 and Phase 2)

Symbol Rate Accuracy measures the ability of the transmitter to operate at the assigned symbol rate
(4.8 kHz for Phase 1, 6 kHz for Phase 2). It is a scalar result shown in the P25 Summary display.

This measurement result appears in the P25 Summary display and only applies to High Deviation
or Low Deviation test patterns. Test patterns are selected in the Test Patterns tab in the Settings
control panel.

The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.

This measurement only applies to High Deviation or Low Deviation test patterns. If this measurement
is run for any other test patterns, comparisons for limits will result in N/A being shown, as the
measurement will not be valid.

Common Trigger Related Measurements

The measurements covered in this subsection have some common information. These measurements are:

Transmitter Power and Encoder Attack Time (Phase 1): This measurement is the time required for
a transmitter to prepare and transmit information on the radio channel after changing state from standby
to transmit (applies to conventional mode). This measurement result can be seen in the P25 Summary
display. A graphical representation of these results can be seen in the P25 Power vs Time display.

Transmitter Power and Encoder Attack Time with Busy/Idle Operations (Phase 1): This
measures the time required for a transmitter to prepare and transmit information on the radio channel
after the receiving channel changes state from busy to idle. Transmission is inhibited until a status
symbol indicates an idle channel. This measurement result can be seen in the P25 Summary display. A
graphical representation of these results can be seen in the P25 Power vs Time display.

Transmitter Throughput Delay (Phase 1): This measures the time it requires for audio changes in
the microphone to be encoded and transmitted over the air. A calibrated receiver with a known receiver
throughput delay is used to monitor the transmitted signal. The aggregate delay of the transmitter
under test and calibrated receiver is measured and the desired transmitter throughput delay is then the
aggregate delay less the delay of the calibrated receiver. A calibrated Receiver throughput delay from
the UI is needed. This measurement result can be seen in the P25 Summary display.

Transient Frequency Behavior (Phase 1): This is a measure of difference of the actual transmitter
frequency and assigned transmitter frequency as a function of time when the RF output power is
switched on or off. This measurement appears in the P25 Freq Dev vs Time display.

HCPM Tx Logical Channel Time Alignment (Phase 2 HCPM): This measures the ratio of total
transmitter power under prescribed conditions and modulation to the peak power that falls in a
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prescribed bandwidth centred on the nominal frequency of the adjacent channel during the transmitter
power ramping interval. This applies only to inbound signals. This measurement result appears in
the P25 Summary display.

NOTE. The following information is important when trigger measurements are taken with SignalVu-PC
interfaced with an RSA306B, RSA500A Series, RSA600A Series, RSA7100A, or MDO4000B/C Series
instrument: 1) The RF signal should be connected to the RF Input of the instrument. 2) For the MDO,
one of the 4 analog channels can be set as Trigger input. (Refer to the Trigger Setup section on how
to set a channel as trigger in the MDO manual.) 3) In SignalVu-PC, set Triggered mode in the Setup
> Acquisition control panel.

Common information. The following information applies to all of the measurements in the previous list.

Select the relevant Trigger measurement from the Trig Meas tab of the control panel.

When this measurement is chosen from the Trig Meas tab of the control panel, only this result will be
populated in the P25 Summary display and everything else will have no result.

The Time Zero Reference under the Analysis Time tab in the control panel is forced to Trigger.

Align the Trigger to the RSA/MDO4000B/C as described in the measurement methods standard
document.

When a trigger measurement is chosen from the Trig Meas tab of the control panel, the following
status message will appear: P25: Set instrument in Triggered Mode.

Use the Acquisition control panel to select enough acquisition length to ensure that sufficient data
is available when the acquisition is triggered.

This measurement operates in Single Acquisition mode as the acquisition is triggered.

You can select to do the same experiment multiple times and this measurement will produce an
average result of the last 10 single acquisitions. Clicking the Clear button on the P25 Summary
display will clear the results and start a new measurement.

Transmitter Power and Encoder Attack Time and Transmitter Power and Encoder Attack Time with Busy/Idle
Operations (Phase 1). The following information is specific to these two measurements.

The Transmitter Power Attack Time analysis is done by measuring the time taken from the trigger
point to the point where the transmitter output power will reach 50% of its maximum value.

For Encoder Attack Time, the initial frame synchronization word is searched in the demodulated
output and the time taken from trigger to the start of the synchronization word is reported as the result.

When a clear power ramp up is not available, the analysis will report the following error, indicating
that no power ramp was received as expected: Input data too short. When the synchronization word is
not found, the analysis will report the following error: IQ Processing error.
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The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.

The P25 Power vs Time display shows marking from trigger point to 50% ramp point and also up to
the Synchronization word for Transmitter Power and Encoder Attack Time. Frequency Dev vs Time
can also be used to check for the synchronization word. The following image shows this measurement.

Transmitter Throughput Delay (Phase 1). The following information is specific to this measurement.

Select Tx Throughput Delay from the Trig Meas tab of the Settings control panel to get this
measurement.

The original noise source is connected as input to this trigger and the acquisition is triggered when the
input from the noise source exceeds the trigger level set by the user.

The actual input to the RSA/MDO4000B/C comes after the noise signal from the source has
passed through the DUT and calibrated receiver as shown in the setup for this measurement in the
measurement methods standard document.

The level in the Trigger control panel set by the user is used for analysis to determine that input
to the RSA/MDO4000B/C (after it has gone through the DUT and calibrated receiver) has hit the
power levels desired.

The time difference between the trigger point and the point when the input to the RSA/MDO4000B/C
has exceeded the level set by the user for triggering is calculated.

The calibrated receiver throughput delay entered by the user in the Trig Meas tab in the Settings
control panel (this option appears when Throughput Delay is selected) is subtracted from the calculated
time difference and reported as Throughput Delay.

A limit comparison can be performed by selecting the appropriate limits from the Limits tab in the
Settings control panel.

SignalVu-PC Printable Help 395



APCO P25 Analysis APCO P25 Analysis

Transient Frequency Behavior (Phase 1). The following information is specific to this measurement.

Select Transmitter Frequency Behavior from the Trig Meas tab of the Settings control panel to get
this measurement.

This measurement can be done for On to Off and Off to On behaviors. Select which behavior to
measure by selecting the desired behavior from the Transient Frequency drop down list that appears
when the Transient Frequency Behavior measurement is selected in the Trig Meas tab of the Settings
control panel.

Select enough acquisition length (from the Acquisition control panel) to ensure that sufficient data is
available when the acquisition is triggered. For a transient frequency behavior, there is a need for t1+t2
amount of time after ton as defined in the measurement methods standard document. Approximately
100 ms of data after trigger should ensure that all cases are taken care of as suggested by the standard.
t1, t2, and t3 durations are fetched based on the RF frequency range.

The identification of ton is done by looking for a significant frequency deviation after a certain power
level has been achieved. A manual override for the ton is also provided in the Trigger Meas tab of the
Settings control panel when a Transient Frequency Behavior measurement is chosen. This allows you
to manually override the ton that is calculated (by releasing the Auto Option) and place it appropriately
based on the P25 Freq Dev vs Time display. The same is true for toff when the measurement is being
done for the On to Off behavior.

t1 and t2 regions are identified after ton and t3 before toff (for the On to Off behavior).

The mean and max frequency deviation is reported in the regions identified.

A Pass or Fail is also reported by comparing the Mean frequency deviation with the recommended
values given in the standard. A red band is shown if a particular region’s result is less than the
performance recommendation. The following image shows this measurement.

HCPM Tx Logical Channel Time Alignment (Phase 2 HCPM). The following information is specific to this
measurement. This result can be viewed in P25 Summary and P25 Power vs Time displays.
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This measurement is done in two steps: First by calculating tOB_sync using HDQPSK data (the
ISCH pattern is looked for) and then by using the result to calculate tIB_sync using HCPM data
(the SACCH pattern is looked for).

The first step is done by choosing Time Alignment (tOB_sync measurement) in the Trig Meas tab
in the Settings control panel.

When the second step, Time Alignment (t_error_0 calculation) or (t_error_1 calculation) is selected in
the Trig Meas tab of the control panel, there is an option to override the tOB_sync value calculated
in the first step.

When this measurement is chosen, only this result is provided in the P25 Summary display.

You must provide the ultraframe boundary to the trigger of the analyzer.

An autocorrelation of the input RF signal with the reference patterns is performed to get the peak that
will determine tOB_sync (measured) and t_error_0 or t_error_1 from the trigger point.

HCPM Tx Logical Channel Peak ACPR (Phase 2 HCPM)

This measures the ratio of total transmitter power under prescribed conditions and modulation to the peak
power that falls in a prescribed bandwidth centred on the nominal frequency of the adjacent channel during
the transmitter power ramping interval. This applies only to inbound signals. This measurement result
appears in the P25 Summary display.

This measurement is done by calculating power in the adjacent channels for the entire duration of data
chosen by the user, including the power ramp up and ramp down portions. The standard recommends
360 ms of data for this measurement, unlike the other ACPR measurements for which the analysis
is done only for the on slot region.

The higher and lower adjacent channel power is reported in the P25 Summary display under Power
Measurements.

The two results are then subtracted from the calculated RF output power and the minimum of the two
results is presented as the Min Pk ACPR in the P25 Summary display.

This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation
test patterns.

The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.

This measurement result is not shown in the P25 Summary display when trigger measurements are
chosen.

NOTE. Read about important information related to HCPM bursty data measurements here (see page 400).

HCPM Transmitter Logical Channel Off Slot power (Phase 2 HCPM)

This measures the power of a TDMA transmitter during the off portion of the TDMA pulse. This
measurement only applies to inbound signals. This result can be viewed in P25 Summary and P25 Power
vs Time displays.
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The measurement is done as suggested by the standard to calculate PONREL and POFFREL. PONREL is the
maximum level observed in the interval 1 ms to 29 ms and POFFREL is the maximum level observed
in 30.2 ms to 59.8 ms.

PTX is the rated carrier power and can be set by the user from the Analysis Params tab in the Settings
control panel.

The absolute level of the off slot power is then calculated as POFF = PTX – (PONREL – POFFREL) dBm

This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation
test patterns.

The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.

This measurement result is not shown in the P25 Summary display when trigger measurements are
chosen.

NOTE. Read about important information related to HCPM bursty data measurements here (see page 400).

HCPM Transmitter Logical Channel Power Envelope (Phase 2 HCPM)

This is a measure of how well a portable radio controls the transmitter power as it inserts an inbound
HCPM TDMA burst into a frame on a voice channel. This measurement applies to inbound signals only.

All scalar results relevant to this measurement are shown both in P25 Power vs Time display and
the P25 Summary display.

The measurement results and the duration in which the measurements are made are shown graphically
in P25 Power vs Time display. The results are grouped under Power Info and Time Info in the table
at the bottom of the display.

This measurement is only done for bursty HCPM data and not for High Deviation or Low Deviation
test patterns.

The Limits tab in the P25 Summary Settings control panel allows you to compare the results against
limits set for Pass/Fail.

This measurement result is not shown in the P25 Summary display when trigger measurements are
chosen.

NOTE. Read about important information related to HCPM bursty data measurements here (see page 400).

P25 Test Patterns

A variety of test patterns are specified in the TIA-102 documents for use in performance testing of
transmitters. These test patterns allow the software to compare the measurement result to the standards
limit. Test engineers can select from the test patterns described in the following tables.
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NOTE. Although this table gives the test patterns for measurements as recommended by the Standard, other
measurement results are also be provided as additional information for a given test pattern. For example,
Modulation Fidelity results can also be provided for High Deviation and Low Deviation test patterns.

Table 3: P25 test patterns, Phase 1 C4FM

TIA-102 Phase 1 C4FM test pattern Phase 1 (C4FM) measurement

RF Output Power

Operating Frequency Accuracy

Modulation Emission Spectrum

Unwanted Emissions (Adjacent Channel Power Ratio)

Modulation Fidelity

Standard transmitter

Transmitter Power and Encoder Attack Time

Standard Busy Transmitter Power and Encoder Attack Time (With Busy/Idle Operations)

Operating Frequency Accuracy

Transient Frequency Behavior

Low Deviation

Frequency Deviation

Standard Idle Transmitter Power and Encoder Attack Time (With Busy/Idle Operations)

Symbol Rate AccuracyStandard Transmitter Symbol Rate

(Same as High Deviation test pattern Frequency Deviation

C4FM Modulation Fidelity Modulation Fidelity

Standard Tone Can be used for measurements such as RF Output Power, Operating Frequency
Accuracy, Modulation Fidelity, and ACPR

Other

(User created test pattern)

Can be used for measurements such as RF Output Power, Operating Frequency
Accuracy, Modulation Fidelity, and ACPR

xxx

Table 4: P25 test patterns, Phase 2 Inbound and Outbound

TIA-102 Phase 2 test pattern Phase 2 measurement

RF Output Power

Operating Frequency Accuracy

Modulation Emission Spectrum

Unwanted Emissions (Adjacent Channel Power Ratio)

Standard Transmitter (Inbound and
Outbound)

Modulation Fidelity

Inbound Standard Tone Ch0 Can be used for measurements such as RF Output Power, Operating Frequency
Accuracy, Modulation Fidelity, and ACPR
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Table 4: P25 test patterns, Phase 2 Inbound and Outbound (cont.)

TIA-102 Phase 2 test pattern Phase 2 measurement

Inbound Standard Tone Ch1 Can be used for measurements such as RF Output Power, Operating Frequency
Accuracy, Modulation Fidelity, and ACPR

Outbound Standard Tone Operational Frequency Accuracy

RF Output Power

Modulation Emission Spectrum

Modulation Fidelity

HCPM (Peak ACPR)

HCPM (Off slot power)

HCPM (Power envelope)

Inbound Symmetrical Time Slot

Unwanted Emissions (Adjacent Channel Power Ratio)

Frequency deviation for HCPMLow Deviation (Inbound)

Symbol Rate Accuracy

Low Deviation (Outbound) Symbol Rate Accuracy

High Deviation (Inbound and Outbound) Symbol Rate Accuracy

Other

(User created test pattern)

Can be used for measurements such as RF Output Power, Operating Frequency
Accuracy, Modulation Fidelity, and ACPR

xxx

Analysis of HCPM Bursty Data

It important to take into account the following information when analyzing HCPM bursty data.

It is mandatory that at least one complete on slot and off slot region (including the ramp up and
ramp down portion) have to be included in the analysis window for HCPM measurement results
to be analyzed.

If HCPM is the chosen standard in Standards Presets, then a minimum length of 94 ms is set for the
analysis window. This is to ensure that a full on slot and off slot region is available irrespective of
the selected analysis offset.

Do not use the High Deviation or Low Deviation test patterns for bursty signals. Test patterns are
selected in the P25 Settings control panel on the Test Patterns tab. If selected, analysis would look
for a bursty pattern. High Deviation and Low Deviation test patterns are not bursty and therefore do
not have the above analysis length restriction.

If you try to set the analysis length to less than 94 ms, the following status message will display:
P25:HCPM:Minimum Analysis Length should be ≥ 94 ms.

Most measurements that are required to be done on on slot regions are done centered at the on slot
region of HCPM bursty data.

HCPM Pilot symbols are not displayed in the P25 Symbol Table.
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It is mandatory that at least one complete on slot and off slot region (including the ramp up and
ramp down portion) have to be included in the analysis window for HCPM measurement results
to be analyzed.

The analysis module does not analyze two active adjacent slots (28 ms each) if they do not have
the off slot (power off) region between them.

When HCPM bursty data is analyzed, the following status message will appear on all relevant displays:
P25:HCPM modulation analysis is done only on on slot regions.

NOTE. The test patterns, except for High Deviation and Low Deviation, do not impact the HCPM pattern
analysis for other selected test patterns, such as Standard Transmitter Test Pattern, Inbound Standard
Tone Test Pattern Ch0, Inbound Standard Tone Test Pattern Ch1, Inbound Symmetrical Time Bound
Test Pattern, and Others.

P25 Constellation Display

The P25 Constellation Display shows the P25 signal modulation amplitude. For the HCPM and HDQPSK
standards, you can view this display as frequency deviation or as I and Q. For the C4FM standard, only the
frequency deviation applies.

To show the P25 Constellation display you can select Presets > Standards > P25 or do the following:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select P25 Analysis in theMeasurements box.

4. In the Available displays box, double-click the P25 Constellation icon or select the icon and click
Add. The P25 Constellation icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the P25 Constellation display.

6. Select Setup > Settings to display the control panel.

7. Select theModulation Params tab. Set the Standard, Modulation Type, and Measurement and
Reference filters as appropriate for the input signal.

8. For Phase 2 signals, select the Trace tab and set the Trace Type to Freq Dev or IQ.

9. Select the Test Patterns tab and select the desired test pattern as appropriate for the input signal.

10. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the P25 Constellation display set to IQ for a HDQPSK signal.
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The following image shows the same signal as the previous image, but with the display set to Frequency
Deviation.
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Item Display element Description

1 Marker Readout Located to the left of the constellation plot or below it, depending on the
size of the window. If markers are enabled, the marker readout will show
frequency deviation results or IQ results (time, mag, phase, symbol marker
and symbol value) of the point with the selected marker.

2 Measurement results readout These readouts are located to the left or below of the Constellation plot,
depending on the window size. The readout shows Modulation Fidelity (%)
and Frequency Error (Hz).

The second readout can either be Freq Error where the result is followed
by Auto or it could be Freq Offset where the result is followed by Manual.
This choice between Freq Error and Freq Offset is made from the Analysis
Params tab in the Settings control panel.

3 Plot Shown as either I vs Q or as Frequency Deviation. The trace type is controlled
from the Settings > Trace tab.

xxx

P25 Constellation Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The P25 Constellation Settings control panel provides access to settings that control parameters of the
Constellation Display.

Settings tab Description

Modulation Params (see
page 420)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 423)

Specifies parameters used by the instrument to analyze the input signal.

Analysis Time (see page 423) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for P25 Analysis displays.

Test Patterns (see page 425) Specifies the type of test pattern being used. Some analysis differs based on the
selected test pattern. Available test patterns vary depending on the selected standard
and modulation type.

Trace (see page 426) Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol
when chosen to view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Prefs (see page 429) Specifies the radix of the marker readout and whether elements of the graphs are
displayed.

Trig Meas (see page 428) Enables you to select from several different trigger measurements.

xxx
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P25 Eye Diagram Display

The P25 Eye Diagram display shows a digitally modulated signal overlapped on itself to reveal variations
in the signal.

To show the P25 Eye Diagram display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. From theMeasurements box, select P25 Analysis.

4. Double-click the P25 Eye Diagram icon in the Available Displays box. This adds the P25 Eye
Diagram icon to the Selected displays box.

5. Click OK button. This displays the P25 Eye Diagram view.

6. Select Setup > Settings to display the control panel.

7. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and
Reference filters as appropriate for the input signal.

8. For Phase 2 signals, select the Trace tab and set the Trace Type to Freq Dev or IQ.

9. Select the Test Patterns tab and choose a test pattern appropriate for the input signal.

10. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the P25 Eye display with Trace Type set to IQ.
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The following image shows the P25 Eye display with Trace Type set to Freq Dev.
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Item Display element Description

1 Top of graph The vertical scale is normalized with no units (for IQ) and with Hz (for Freq
dev).

2 Position Specifies the value shown at the center of the graph display.

3 Bottom Readout Displays the value indicated by the bottom of graph.

4 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

5 Position Displays the horizontal position of the trace on the graph display.

6 Scale Adjusts the span of the graph in symbols.

7 Freq Error Displays the difference between the maximum and minimum measured
values of the signal frequency during the Measurement Time. The readout
can either be Freq Error where the result is followed by Auto or it could be
Freq Offset where the result is followed by Manual. This choice between
Freq Error and Freq Offset is made from the Analysis Params tab in the
Settings control panel.

xxx

P25 Eye Diagram Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the P25 Eye Diagram display are shown in the following table.

Settings tab Description

Modulation Params (see
page 420)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 423)

Specifies parameters used by the instrument to analyze the input signal.

Analysis Time (see page 423) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for P25 Analysis
displays.

Trig Meas (see page 428) Enables you to select from various trigger measurements. The trigger selections vary
by signal type.

Test Patterns (see page 425) Specifies the type of test pattern being used. Some analysis differs based on the
selected test pattern. Available test patterns vary depending on the selected standard
and modulation type.

Trace (see page 426) Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol
when chosen to view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Scale (see page 426) Defines the vertical and horizontal axes.

Prefs (see page 429) Specifies the radix of the marker readout and whether elements of the graphs are
displayed.

xxx
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P25 Power vs Time Display

The P25 Power vs Time display shows the signal power amplitude versus time. In HCPM bursty data, the
Regions A, B and C are shown based on the middle of the burst and not based on the pilots.

To show the P25 Power vs Time display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select P25 Analysis in theMeasurements box.

4. In the Available displays box, double-click the P25 Power vs Time icon or select the icon and click
Add. The P25 Power vs Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

5. Click OK to show the P25 Power vs Time display.

6. Select Setup > Settings to display the control panel.

7. Select theModulation Params tab. Set the Standard, Modulation Type, and Measurement and
Reference filters as appropriate for the input signal.

8. Select the Test Patterns tab and choose a test pattern appropriate for the input signal.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display
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Item Display element Description

1 Top of graph, first settting Sets the Power level that appears at the top of the graph, in dBm. This is only
a visual control for panning the graph.

2 Top of graph, second setting Sets the vertical Scale of the graphs, in dB/div. This is only a visual control
for panning the graph.

3 View

(Only available for bursty
HCPM data.)

Selects the specific view of the packet burst within the display:

Full Burst displays the entire packet, with vertical lines indicating Power ramp
up, On Slot, Power ramp down, and Off slot regions.

Ramp Up zooms the display into the interval around the packet rising edge.

Ramp Down zooms the display into the interval around the packet falling
edge.

4 Bottom of graph readout Shows the Power level at the bottom of the graph in dBm.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Bottom of graph, left side Sets the starting time of the graph in seconds

7 Bottom of graph, right side Sets the scale (width) of the graph in seconds

8 Table below graph This table shows the following results.

For non-bursty signals: RF output power

For bursty signals: Power Info (Offslot Power and Power Envelope
results) and Time Info.

xxx

P25 Power vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the P25 Power vs Time display are shown in the following table.
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Settings tab Description

Modulation Params (see
page 420)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 423)

Specifies parameters used by the instrument to analyze the input signal.

Analysis Time (see page 423) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for P25 Analysis
displays.

Trig Meas (see page 428) Enables you to select from various trigger measurements. The trigger selections vary
by signal type.

Test Patterns (see page 425) Specifies the type of test pattern being used. Some analysis differs based on the
selected test pattern. Available test patterns vary depending on the selected standard
and modulation type.

Scale (see page 426) Defines the vertical and horizontal axes.

Prefs (see page 429) Specifies the radix of the marker readout and whether elements of the graphs are
displayed.

xxx

P25 Summary Display

The P25 Summary display shows a summary of all the scalar measurements done on the acquired test
pattern. The summary display and contents will vary according to the selected standard.

Pass/Fail information is also provided in this display for all enabled scalar measurements. You can set
limits and choose which measurement to compare for Pass/Fail from the Limits tab in the P25 Summary
Settings control panel. The default limits come from the performance recommendation limits given by
the Standard document. The default limits can be reloaded by selecting the P25 Standards Preset option
or by loading the default limits table.

To show the P25 Summary display you can select Presets > Standards > P25 or do the following:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select P25 Analysis in theMeasurements box.

4. In the Available displays box, double-click the P25 Summary icon or select the icon and click Add.
The P25 Summary icon will appear in the Selected displays box and will no longer appear under
Available displays.

5. Click OK to show the P25 Summary display.

6. Select Setup > Settings to display the control panel.

7. Select theModulation Params tab. Set the Standard, Modulation Type, and Measurement and
Reference filters as appropriate for the input signal.
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8. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list
depend of the standard and modulation type you have selected.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

P25 Summary Display

The Modulation Measurements, Power Measurements, and Trigger Measurements components of this
display vary depending on which modulation type is selected.

The following image shows an example of the display for a Phase 1 C4FM signal.

The following image shows an example of the display for a Phase 1 C4FM High Deviation signal.

The following image shows an example of the display for a Phase 2 HCPM (Inbound) signal.
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The following image shows an example of the display for a Phase 2 HDQPSK (Outbound) signal.

For more information about specific measurement results, see the P25 Measurements section here (see
page 437).
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Elements of the Display

Element Description

Standard Display of the standard selected on the Setup > Settings > Modulation Params tab.

Bandwidth Display of the channel bandwidth which is set based on the standard and modulation type.

Modulation Type Display of the modulation type selected on Setup > Settings > Modulation Parameters tab.

Clear Click button to reset measurement. Clears all values.

Modulation Measurements Shows the modulation measurements associated with the signal.

Power Measurements Shows the power measurements associated with the signal.

Trigger Measurements Shows the trigger measurements associated with the signal.

xxx

P25 Summary Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the P25 Summary display are shown in the following table.

Settings tab Description

Modulation Params (see
page 420)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 423)

Specifies parameters used by the instrument to analyze the input signal.

Analysis Time (see page 423) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for P25 Analysis
displays.

Trig Meas (see page 428) Enables you to select from various trigger measurements. The trigger selections vary
by signal type.

Test Patterns (see page 425) Specifies the type of test pattern being used. Some analysis differs based on the
selected test pattern. Available test patterns vary depending on the selected standard
and modulation type.

Limits (see page 430) Load and define P25 measurement limits for Pass/Fail comparison. You can save
defined limits as a .csv file and also load previously saved .csv files.

xxx

P25 Symbol Table Display

The P25 Symbol Table display shows decoded data values for each data symbol in the analyzed signal
packet.

To show the P25 Symbol Table display:
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1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select P25 Analysis in theMeasurements box.

4. In the Available displays box, double-click the P25 Symbol Table icon or select the icon and click
Add. The P25 Symbol icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the P25 Symbol Table display.

6. Select Setup > Settings to display the control panel.

7. Select theModulation Params tab. Set the Standard, Modulation Type, and Measurement and
Reference filters as appropriate for the input signal.

8. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list
depend on the standard and modulation type you have selected.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

P25 Symbol Table

The following image shows the P25 Symbol Table for HCPM (bursty) signals. For this signal type, the
symbols are arranged as Bursts vs Symbols. The analysis is done only on the on slot regions of the bursty
HCPM data and 160 symbols (centered at the middle of the burst) are reported on the symbol table for
every on slot region. You can read more about specific measurements here (see page 437).
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The following image shows the P25 Symbol Table for C4FM (non-bursty) signals. For this signal type and
for HDQPSK, there is no grouping into bursts and all symbols that are analyzed are shown.
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Elements of the Display

Element Description

Marker Displays the selected marker label.

Time Displays the time in ms or in Symbols based on the Units chosen in the Analysis Time
tab of the Settings Control panel.

Symbol The value shown here reflects the symbol you have selected (highlighted) in the display.

Value Displays the value of the selected symbol.

xxx

P25 Symbol Table Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the P25 Symbol Table display are shown in the following table.
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Settings tab Description

Modulation Params (see
page 420)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 423)

Specifies parameters used by the instrument to analyze the input signal.

Analysis Time (see page 423) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for P25 Analysis
displays.

Trig Meas (see page 428) Enables you to select from various trigger measurements. The trigger selections vary
by signal type.

Test Patterns (see page 425) Specifies the type of test pattern being used. Some analysis differs based on the
selected test pattern. Available test patterns vary depending on the selected standard
and modulation type.

Prefs (see page 429) Specifies the radix of the marker readout.

xxx

P25 Frequency Dev vs Time Display

The P25 Frequency Deviation vs. Time Display shows how the signal frequency varies with time.

To display the P25 Frequency Dev vs. Time Display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Select the Displays button or Setup > Displays.

3. In the Select Displays dialog, select P25 Analysis in theMeasurements box.

4. In the Available displays box, double-click the P25 Frequency Dev vs. Time icon or select the icon
and click Add. The P25 Frequency Dev vs. Time icon will appear in the Selected displays box and
will no longer appear under Available displays.

5. Click OK to display the Freq Dev vs. Time display.

6. Select the Modulation Params tab. Set the Standard, Modulation Type, and Measurement and
Reference filters as appropriate for the input signal.

7. Select the Test Patterns tab and select a test pattern. The available test patterns in the drop down list
depend of the standard and modulation type you have selected.

8. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the P25 Freq Dev vs Time display for Phase 1 C4FM (non-bursty) High
Deviation signals.
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The following image shows the P25 Freq Dev vs Time display for Phase 2 HCPM (bursty) signals.
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NOTE. For bursty HCPM signals, frequency deviation analysis is done only on 160 symbols centered
at every on slot region in the chosen analysis window and not on off slot regions. That is why there
is no information shown during off slot regions. You can read more specific information about P25
measurements here (see page 390).

Elements of the Display

Item Display element Description

1 Top of graph adjustment Adjust the frequency range displayed on the vertical axis.

2 Position (center) Adjust the frequency shown at the center of the display.

3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the
best display.

4 Position Displays the horizontal position of the trace on the graph display.

5 Scale Adjust the horizontal scale (time).

xxx

Changing Frequency vs Time Display Settings (see page 418)

P25 Frequency Dev Vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for P25 Frequency Dev vs. Time are shown in the following table.
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Settings tab Description

Modulation Params (see
page 420)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 423)

Specifies parameters used by the instrument to analyze the input signal.

Analysis Time (see page 423) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for P25 Analysis
displays.

Trig Meas (see page 428) Enables you to select from various trigger measurements. The trigger selections vary
by signal type.

Test Patterns (see page 425) Specifies the type of test pattern being used. Some analysis differs based on the
selected test pattern. Available test patterns vary depending on the selected standard
and modulation type.

Trace (see page 426) Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol
when chosen to view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Scale (see page 426) Defines the vertical and horizontal axes.

Prefs (see page 429) Specifies the radix of the marker readout and whether elements of the graphs are
displayed.

xxx

P25 Analysis Shared Measurement Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The control panel tabs in this section are shared between the displays in P25 Analysis (Setup > Displays).
Some tabs are shared by all the displays, some tabs are shared by only a subset of displays. The settings
available on some tabs change depending on the selected display.
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Common controls for P25 analysis displays

Settings tab Description

Modulation Params (see
page 420)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 423)

Specifies parameters used by the application to analyze the input signal.

Analysis Time (see page 423) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for P25 Analysis
displays.

Trace (see page 426) Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol
when chosen to view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Scale (see page 426) Defines the vertical and horizontal axes.

Test Patterns (see page 425) Enables you to select from eight different test patterns.

Trig Meas (see page 428) Enables you to select from various trigger measurements. The trigger selections vary
by signal type.

Prefs (see page 429) Specifies the radix of the marker readout and whether elements of the graphs are
displayed.

xxx

Modulation Params Tab - P25

The Modulation Params tab specifies the type of modulation used by the input signal and other parameters
that define the signal format.
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Settings Description

Standard Specifies the standard used for the input signal: Phase 1, Phase 2.

Channel Bandwidth This readout shows the nominal channel bandwidth based on the standard.

Modulation Type Specifies the modulation type of the input signal. Choices vary depending on
the selected standard. Modulation types for Phase 2 are HCPM (Inbound)
and HDQPSK (Outbound). Phase 1 has only C4FM as the modulation type
selection.

Measurement Filter Specifies the filter used as a measurement.

Reference Filter Specifies the filter used as a reference.

Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some
filter types)

Symbol Rate This is a readout that shows the symbol rate for demodulating digitally
modulated signals based on the standard. This rate is always 4.8 kHz for Phase
1 signals and 6 kHz for Phase 2 signals.

xxx

Symbol Rate

Specifies the symbol rate for demodulating digitally modulated signals based on the standard. The symbol
rate and the bit rate are related as follows:

(Symbol rate) = (Bit rate)/(Number of bits per symbol)

The bit rate used for Phase 1 (C4FM) is 9600 bps. For Phase 2 (HCPM and HDQPSK) it is 12000 bps.
There are two bits per symbol for all above mentioned modulation types. Therefore, the symbol rate is
4800 Hz for Phase 1 and 6000 Hz for Phase 2.

Measurement and Reference Filters

The available measurement and reference filters depend on the selected modulation type. The following
table shows the recommended filters for the specified modulation types.

CAUTION. Although there are other filter types listed in the drop down menu, if you select any filter other
than that which is recommended, the measurement results may not be accurate.

Modulation type Measurement filters Reference filters

HDQPSK HDQPSK-P25 None

HPCM None None

C4FM C4FM-P25 RaisedCosine (Filter parameter 0.2)

xxx

The measurement filter is applied before the demodulation bit is detected and the ideal reference is
calculated.

The reference filter is applied to the internally generated ideal reference signal before the modulation
fidelity is calculated.
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How to Select Filters

In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for
another kind of necessary shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a
filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This
setting tells the analyzer what filter your receiver uses. When the analyzer is set to the same filter used by
the receiver, the analyzer sees the signal as your receiver would. The Measurement Filter setting should be
the same as the filter used in the receiver under normal operation (as opposed to testing).

The Reference Filter setting in the analyzer corresponds to the baseband filter in the transmitter-receiver
combination (Fr * Ft). The baseband filter for the transmitter-receiver combination is often referred to as
the System Filter. This filter is called the reference filter because it is used to recreate a reference signal
that is compared to the received signal. This recreated reference signal is the ideal signal with Fr * Ft
applied; differences between this ideal signal and the received signal enables the determination of signal
quality, such as modulation fidelity measurements.

Filter Parameter (C4FM only)

The filter parameter specifies the alpha for the Raised Cosine filter when selected as the Reference filter.
Some filter types have a fixed parameter value that is specified by industry standard, while other filter types
by definition have no filter parameter. For filter types with no filter parameter, there is no filter parameter
control present in the control panel. The recommended Reference filter for C4FM is Raised Cosine and the
corresponding filter parameter for C4FM is 0.2.
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Analysis Params Tab - P25

The Analysis Params tab contains parameters that control the analysis of the input signal.

Settings Description

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error
and the measured Frequency Error is displayed. When the Auto box is
unchecked, the entered value is used by the analysis as a fixed frequency
offset. This is useful when the exact frequency offset of the signal is known.

Measurement BW Specifies the bandwidth about the center frequency at which measurements
are made. Select Manual, Auto, or Link to Span.

PTX Specifies the RF Output Power as recommended for transmitters. This is only
used in the computation of off slot power in HCPM modulated signals.

Low Pass cut off frequency

(only for frequency deviation)

Specifies the filter cut off frequency for Frequency deviation measurement. This
setting will only affect the scalar results Frequency Deviation (Positive and
Negative Peak f1,f2,f3, and f4) in the Summary display.

This selection is only visible when High or Low Deviation or Standard
Transmitter Symbol Rate Pattern is chosen from the Test Patterns tab of the
Settings Control panel.

xxx

Analysis Time Tab - P25

The Analysis Time tab contains parameters that define how the signal is analyzed in the P25 Analysis
displays.
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Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in
either symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols)
being used by the analyzer, this value may not match the Analysis Length requested
(in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

xxx

Analysis Offset

Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (all time values are relative
to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length

Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the
actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the control in the
"Actual" readout. This setting is not available when Auto is checked. Range: minimum value depends on
modulation type. Resolution: 1 symbol.

Time Zero Reference

All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger. When a trigger measurement is chosen from the Trig
Meas tab of the Settings control panel, Time Zero Reference is forced to Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which acquisition begins.

Trigger Time zero starts from the trigger point.

xxx
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Test Patterns Tab - P25

Test patterns allow the software to compare the measurement result to the standards limit. The list of
available test patterns varies depending on which standard and modulation type is selected.

Settings Description

Test Patterns Use this drop-down list to select an appropriate test pattern. The list varies depending on
which standard and modulation type is selected.

xxx

You can read more about test patterns here (see page 398).
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Trace Tab - P25

The Trace tab allows you to set the trace display characteristics of the P25 trace display. The selections
vary depending on the selected display.

The following image shows the tab for the Constellation and Eye Diagram displays. For the other trace
displays, the Trace Type setting is not available.

Setting Description

Trace

(P25 Constellation and P25
Eye Diagram displays only)

Select the trace to display.

P25 Constellation display only: Select the trace that is hidden or displayed based on
whether or not Show is selected.

Show

(P25 Constellation and P25
Eye Diagram displays only)

Specifies whether the trace selected by Trace is displayed or hidden.

Freeze

(P25 Constellation display
only)

Halts updates to the trace selected by the Trace setting. Present for the Constellation
display only.

Points/Symbol Select how many points to use between symbols when connecting the dots. Values:
1, 2, 4, 8.

Content

(P25 Constellation and P25
Freq Dev & Time displays
only)

Select whether to display the trace as vectors (points connected by lines), points
(symbols only without lines), or lines (lines drawn between symbols, but no symbols are
displayed). The choices available depend on the display.

Trace Type

(P25 Constellation and P25
Eye Digram displays only)

Select to specify whether the plots in the Constellation and Eye Diagram displays are
shown as I vs Q or as Frequency Deviation.

xxx

Scale Tab - P25

The Scale tab allows you to change the scale settings that control how the trace appears on the display
but does not change control settings such as Measurement Frequency. There are three versions of the
Scale tab for P25 displays.
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Scale tab for the P25 Eye Diagram display

Scale tab for the P25 Power vs Time display

Scale tab for the P25 Freq Dev vs Time display

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal

Horizontal Full Burst

Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Position Allows you to pan a zoomed trace without changing the Measurement Frequency.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto When Auto is checked, the scale and position values for the Symbols graph are
automatically adjusted to maintain the optimal display.

Reset Resets the vertical and horizontal settings.

xxx
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NOTE. The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for
the horizontal scale, display the Analysis Time tab. On the tab, select the appropriate units from the
Units drop-down list.

Trig MeasTab - P25

The Trig Meas tab enables you to chose a trigger measurement. The available measurements in the
drop-down menu depend on the standard and modulation type selected in the Modulation Params tab. The
Trig Meas tab is not available for Phase 2 HDQPSK (Outbound) signals. You can read more about P25
trigger related measurements here (see page 393).

The following image shows the tab for Phase 1 (C4FM) signals.

The following image shows the tab for Phase 1 (HCPM Inbound) signals.

Settings Description

Trigger Measurements Select the trigger measurement test.

xxx
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Prefs Tab - P25

The Prefs tab enables you to change appearance characteristics of the P25 Analysis displays. Not all
settings on the Prefs tab shown below appear for every P25 display. The Summary display does not
have a Prefs tab.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker
readout in the display. There are three choices for Radix: Binary (00,01,10,11),
Quaternary (0,1,2,3), and Modulation Symbols (+1,+3,-1,-3).

xxx
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Limits Tab - P25

The Limits tab is only available for the P25 Summary display. It enables you to load an existing limits
table, save a limits table, or edit limits values.

Setting Description

Load Click to load a saved Limits table from a .csv file.

Save Click to save the current Limits table to a .csv file.

xxx

Edit Limits

To directly edit measurement limits in the table, click on the value in the Limit column that you want
to change.

The following table describes the parameters that are set in the Limits Table.

Limits Table Settings

Setting Description

On Click on the cell in the On column next to the measurement to specify whether ofrnot
measurements are selected for limit comparison to indicate Pass or Fail.. A check mark
means the measurement will be taken. An empty box means it will not be taken.

Measurement Name Specifies the name of the measurement related to the limit. (Not editable.)

Limit Specifies the value of the limit to the related measurement. When the cell is selected,
the value is shown along with the units.

xxx
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LTE Analysis

Overview

The Long Term Evolution (LTE) Downlink RF Measurements Analysis option allows you to evaluate RF
signals to ensure that they meet 3GPP measurements. These are described in the TS 36.104 Base Station
(BS) radio transmission and reception and test specifications TS36.141 Base Station (BS) conformance
testing documents version 12.5. This analysis option supports both LTE TDD and LTE FDD frame
structures. This analysis option supports the following measurements.

Channel Power

Occupied Bandwidth

Adjacent Channel Leakage Ratio (ACLR)

Spectral Emission Mask (Operating Band Unwanted Emission)

Cell ID

For TDD LTE Transmitter Off Power

These measurements are also compared with the limits provided by the standard to give pass/fail results
(except for Channel Power and OBW).

More detailed information about these measurements is available in the LTE measurements section and the
supported measurements table.

You can also select these measurements from four LTE preset test setups. The test setups load
pre-configured displays and control setting as suggested by the standard to accelerate the test setup of the
analyzer. The following four test setups are available for this analysis option.

Cell ID

ACLR

Channel Power and TDD Toff Power

SEM

More detailed information about these test setups is available here.

With the LTE downlink RF Measurement Analysis test suite, test engineers can simplify the execution of a
number of transmitter tests while still enabled to modify signal parameters for in-depth signal analysis.
The analysis results give multiple views of LTE signal characteristics to allow the diagnosis of signal
imperfections and impairments quickly and easily. Display controls allow you to selectively display the
analysis results to help locate trouble spots in the signal.

LTE topics in this Help

The following information about the LTE Analysis option is available:
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Reference table of supported LTE measurements

LTE measurements

LTE Standards preset test setups

LTE displays

LTE measurement control settings

Supported LTE measurements

The following table gives a brief description of the available LTE measurements. More detailed
information can be found here. LTE measurements

LTE measurement LTE standard(s) Description

Cell ID detection TDD

FDD

The Cell ID is detected from the input LTE
signal.

Adjacent Channel Leakage Ratio
(ACLR)

TDD

FDD

The Adjacent Channel integrated power
is calculated and shown. The relative
power compared to the reference signal
is also computed. The computed power
is compared against limits suggested by
the selected standard and pass/fail is
reported. The appropriate settings for this
measurement are loaded with the ACLR
test setup (Presets>Standards>LTE).

Channel Power TDD

FDD

The channel power is calculated in the
channel bandwidth.

Occupied Bandwidth TDD

FDD

The Occupied bandwidth is calculated
as bandwidth containing 99% of the total
integrated power in the selected span
around the selected center frequency.

Operating Band Unwanted Emission TDD

FDD

The power in the offset regions is calculated
and presented and compared against limits
set in the offset and limits table and pass/fail
is reported. The appropriate settings for
this measurement are loaded with the SEM
test setup (Presets>Standards>LTE).

TOFF TDD The power in off-slot region is computed
and compared against selected limits.

xxx

LTE Standards preset test setups

Presets > Standards

The LTE Standards preset allows you to access displays preconfigured for the test setup you select. The
test setups load the displays and control setting options suggested by the LTE standard to perform the
measurements. You can read more about how Presets work here.
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There are four test setups for LTE:

Cell ID

ACLR
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Channel Power and TDD Toff Power

SEM

434 SignalVu-PC Printable Help



LTE Analysis LTE Analysis

The following table shows what automatically loads with each test setup.

Table 5: LTE preset test setups

Test setup Displays loaded with preset

Frame structure:
- Downlink FDD
- Downlink TDD

(Default is Downlink FDD.)

Cell ID

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Spectrum, Time Overview, LTE
Constellation

Frame structure:
- Downlink FDD
- Downlink TDD

(Default is Downlink FDD.)

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Base station category:
- Wide Area Cat A
- Wide Area Cat B — Option 1
- Home Area (P-rated ≤ 20 dBm)
- Local Area (P-rated ≤ 24 dBm))
- Medium Area (P-rated ≤ 38 dBm))

(Default is Wide Area Cat A.)

Adjacent channel type:
- UTRA
- E-UTRA

(Default is UTRA.)

LTE ACLRACLR

UTRA chip rate.
1.28 Mcps
3.84 Mcps
7.68 Mcps

Chip rate is only displayed under the following conditions:
TDD is frame structure
Adjacent channel type selected is UTRA
Channel bandwidth is >3 MHz

(Default chip rate is 3.84 Mpcs.)

Frame structure:
- Downlink FDD
- Downlink TDD

(Default is Downlink FDD.)

Channel Power
and TDD Toff
Power

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

Time Overview (TDD only), LTE
Channel Spectrum, LTE Power vs Time
(TDD only)

SignalVu-PC Printable Help 435



LTE Analysis LTE Analysis

Table 5: LTE preset test setups (cont.)

Test setup Displays loaded with preset

Frame structure:
- Downlink FDD
- Downlink TDD

(Default is Downlink FDD.)

Channel bandwidth: 1.4, 3, 5, 10, 15, 20 MHz

(Default is 1.4 MHz.)

SEM

Base station category:
- Wide Area Cat A
- Wide Area Cat B — Option 1
- Home Area (2 dBm ≤ P ≤ 20 dBm)
- Local Area
- Medium Area (P ≤ 31 dBm)

(Default is Wide Area Cat A.)

SEM

xxx

Retain current center frequency and reference level settings

The Retain current Center Frequency setting appears when the LTE Standards Preset is chosen. This
setting allows you to retain the previously used center frequency. By default, the Center Frequency setting
box is unchecked and the LTE preset displays will load with 1.96 GHz for FDD and 1.9 GHz for TDD.

The Retain current Ref Level setting appears when the LTE Standards Preset is chosen. This setting
allows you to retain the previously used reference level. By default, the Ref Level setting box is checked.

To activate these settings, check the box next to the desired setting. The following image shows the
Retain current Ref Level setting box checked.
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LTE displays

The displays in LTE Analysis (Setup > Displays > Measurements: LTE Analysis) are:

LTE Channel Spectrum

LTE ACLR

LTE Constellation

LTE Power vs Time

SEM (This display is not an LTE specific display, but is available when RF Measurements is selected
from the Select Displays dialog (Setup > Displays) (see the following image).)

LTE measurements

LTE Analysis enables RF measurements and detection of Cell ID in the transmitted signal for both TDD
and FDD frame structure LTE signals. For TDD signals, the analysis will also do the TOFF measurement.
The following topics contain important information you should know about specific LTE measurements.
You can view a table with all of the available measurements here.

Channel Power and Occupied Bandwidth (TDD and FDD)

The Channel Power measurement is done by calculating the power in the LTE signal based on the selected
channel bandwidth option. The Occupied Bandwidth measurement calculates the frequency range over
which 99% of the power is contained in the acquired signal. This measurement is done for the selected
channel bandwidth option.
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More information about this measurement:

Select the Channel Power and TDD Toff Power test setup from Presets > Standards > LTE to perform
the measurement. This will load the displays found in the LTE preset test setups table .

This test setup allows you to choose the frame structure and the channel bandwidth.

The Channel Spectrum display will contain the results of Channel Power and Occupied Bandwidth.
The result gives the power in the LTE signal (calculated over the channel bandwidth).

Results are presented as scalar and are located below the display.

For TDD signals, the channel power and the occupied bandwidth measurement are done on the on-slot
region. If the valid on-slot region is not found, the measurement is done in the selected analysis length.

ACLR (FDD and TDD)

The Adjacent Channel specification and limits for comparison are set based on selected frame structure,
adjacent channel and base station types from Standards Presets. It calculates the integrated power in the
different adjacent regions and also indicates pass/fail based on comparison with absolute and relative
limits in LTE ACLR display.

More information about this measurement:

Select the ACLR test setup from Presets > Standards > LTE to perform the measurement. This will
load the displays found in the LTE preset test setups table .

This test setup allows you to select the frame structure, channel bandwidth, base station type, and
adjacent channel type with the following restrictions:

Frame Structure can be TDD or FDD

Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz

Base station type can be Wide Area Cat A, Wide Area Cat B- Option 1, Home Area (P-rated ≤ 20
dBm), Local Area (P-rated ≤ 24 dBm), Medium Area (P-rated ≤ 38 dBm)

Adjacent Channel type can E-UTRA or UTRA

UTRA chip rate can be 1.28, 3.84, or 7.68 Mcps

Default rate is 3.84 Mcps for all UTRA adjacent channels of FDD and when channel bandwidth is
1.4 or 3 MHz.

However, you can choose other rates when the frame structure is TDD and when the bandwidth is
more than 3 MHz. Otherwise, the standard recommends use of 3.84 Mcps.

Based on the settings you select from Standards Preset, the offset and bandwidth of the adjacent
channels are set in the Offset and Limits tab of the control panel. The settings are different for paired
and unpaired spectrum.

The settings also include the absolute power limit for comparison based on the base station type. The
standard recommends the settings in dBm/MHz for each base station type. The power limits are
appropriately scaled with the integration bandwidth and presented in dBm in the Offset and Limits
table of the display. The integrated power in each adjacent band is compared with the absolute and
relative limits as recommended by the standard. The absolute limits are dependent on this choice of
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base station type because they apply to different power levels (as the P-rated levels in the drop down
menu indicate). The relative limit is also set.

The results are presented in both tabular and display format. In the tabular display, the reference
channel power and the offset, bandwidth, integrated power, and relative power of the adjacent channels
are presented. An expanded view format is also available.

The integrated power in the display is shaded blue in each adjacent channel region.

Each adjacent channel is clearly shown. Interadjacent channel gaps are shown in gray.

The limit lines are shown in different colors. Based on the Mask option chosen in the Offset & Limits
table, failures in the different bands are shown in red on violation. By default for LTE Standards
Presets, the Mask option is Abs & Rel, so the failure is shown only when the calculated power violates
both relative and absolute power limits.

The respective rows that violate both absolute and relative limits are also shown in red. Pass/fail
information appears in the top left corner of the display.

This measurement can be performed in Real Time or Non-Real Time mode. In Real Time mode,
a single acquisition required for the entire span needed for this measurement is taken and the
measurement is done. In the Non-Real Time mode, a separate acquisition for each adjacent channel
region is taken and analyzed.

Non-real time mode is also useful when the bandwidth offered by the instrument does not support
the span requirement for this measurement. The span requirement comes from the choice of adjacent
channel type and channel bandwidth. In such cases, Non-Real Time mode can be used.

For UTRA adjacent channels, filtering of the adjacent channels with an RRC filter of the same
bandwidth is employed, as suggested by the standard. The chip rate is set to 3.84 Mcps for FDD
and when the channel bandwidth is 1.4 or 3 MHz. For TDD, when the channel bandwidth is more
than 3 MHz, you can choose the UTRA chip rate from the ACLR test setup (Presets > Standards >
LTE). The options are 1.28, 3.84, and 7.68 Mcps.

The standard recommends this measurement be done on the transmitter ON period when the signal
being analyzed is TDD. An on slot detection module in the analysis helps you to do the measurement
in the transmitter ON period.

If you are doing the measurement in Real Time, you can also load the Time Overview display,
which will indicate to you the region in which the measurement is done (a purple line at the
bottom). You can see the measurement is done only on the valid transmitter ON period. However,
when a bursty data is not available, the measurement is done on the available analysis length.

NOTE. Real-Time mode can be set from the Parameters tab of the Settings control panel of the LTE
ACLR display. Disabling Real-Time mode is the non-Real-Time setting.

When the measurement is done in non-Real Time mode, separate acquisitions are obtained for
each adjacent channel band. In such cases, it cannot be ensured that all the adjacent channel
acquisitions are done on the transmitter ON period. It is recommended that you use either Real
time mode or an external trigger from the source (when used with non-Real-Time mode) to do the
measurement. An external trigger from the source can ensure that all the acquisitions are done just
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after the rising edge of the burst. A status message in the display indicates when to use Real-Time
mode or external trigger for TDD signals. The status message that is displayed in the LTE ACLR
display is "Signal must be triggered or measurement in Real-Time". This message is displayed
when TDD is chosen from Standard Presets, when Real-Time is not enabled from the Parameters
tab of the control panel, and when the instrument is in Free Run mode.

Operating Band Unwanted Emission (FDD and TDD)

This measurement finds the power in the offset regions recommended by the standard. The offset
channel specification and limits for comparison are set based on the selected channel bandwidth, frame
structure, and base station types in Standards Preset. It calculates the integrated power in the different
offset regions and also indicates pass/fail information based on comparison with absolute and relative
limits in the SEM display.

More information about this measurement:

Select the SEM test setup from Presets > Standards > LTE to perform the measurement. This will load
the displays found in the LTE preset test setups table .

This test setup allows you to select the frame structure, channel bandwidth, and base station type
with the following restrictions:

Frame Structure can be TDD or FDD

Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz

Base station type can be Wide Area Cat A, Wide Area Cat B - Option 1, Home Area (2 dBm ≤ P ≤
20 dBm), Local Area, Medium Area (P ≤ 31 dBm)

Based on the settings chosen by the user from Standards Presets the offset and bandwidth of the offset
channels are set in the Offset and Limits tab of the control panel of SEM display.

The settings also include the absolute power limit for comparison based on the base station type. The
standard recommends the settings in dBm/MHz for each base station type. The power limits are
appropriately scaled with the integration bandwidth and presented in dBm in the Offset and Limits
table of the display. The integrated power in each adjacent band is compared with the absolute and
relative limits as suggested by the standard. The absolute limits are dependent on this choice of base
station type as they apply to different power levels (as the P-rated levels in the drop down menu
indicate). The relative limit is also set.

The results are presented both in tabular and display form.

The Pass/ Fail information is also shown in the top left corner of the display.

For TDD signals, a detection module in the analysis helps you to do the measurement in the transmitter
ON period.

If you are doing the measurement in Real Time, you can also load the Time Overview display,
which will indicate to you the region in which the measurement is done (a purple line at the
bottom). You can see the measurement is done only on the valid transmitter ON period. However,
when a bursty data is not available, the measurement is done on the available analysis length.
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NOTE. Real-Time mode can be set from the Parameters tab of the Settings control panel of the SEM
display. Disabling Real-Time mode is the non-Real-Time setting.

When the measurement is done in non-Real Time mode, separate acquisitions are obtained for
each adjacent channel band. In such cases, it cannot be ensured that all the adjacent channel
acquisitions are done on the transmitter ON period. It is recommended that you use either
Real-Time mode or an external trigger from the source (when used with non-Real Time mode) to
do the measurement. An external trigger from the source can ensure that all the acquisitions are
done just after the rising edge of the burst. A status message in the display indicates when to use
Real Time mode or external trigger for TDD signals. The status message that is displayed in the
LTE SEM display is "Signal must be triggered or measurement in Real-Time". This message is
displayed when TDD is chosen from Standard Presets, when Real-Time is not enabled from the
Parameters tab of the control panel, and when the instrument is in Free Run mode.
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Settings for all tables provided in the base station conformance testing document (3GPP TS 36.141
v12.5 – for Release 12) has been incorporated from Standards Presets.

Wide Area and Local area settings from standard presets are provided as per the standard
document.

Home Area base station settings loaded from standard presets correspond to Reference power
levels between 2 to 20 dBm.

Medium Area base station settings loaded from standard presets correspond to reference power
levels less than 31 dBm.

The following settings are provided in a *.csv file that you can load. These files will be available
in the installed directory (Example Files\LTE).

Wide Area category B Option 2 (for specific bands specified by the standard). There are three csv
files based on operating band and channel bandwidth for Wide Area.

LTE_SEM_1.4MHz_CatB_optn2_bands_3_8.csv

LTE_SEM_3MHz_CatB_optn2_bands_3_8.csv

LTE_SEM_5to20Hz_CatB_optn2_bands_1_3_8_32_33_34.csv

Home Area base station for power level less than 2 dBm. There are six csv files based on operating
band and channel bandwidth for Home Area.

LTE_SEM_1_4MHz_above3GHz_Home2P.csv

LTE_SEM_1_4MHz_below3GHz_Home2P.csv

LTE_SEM_3MHz_above3GHz_Home2P.csv

LTE_SEM_3MHz_below3GHz_Home2P.csv

LTE_SEM_5to20MHz_above3GHz_Home2P.csv

LTE_SEM_5to20MHz_below3GHz_Home2P.csv

Medium Area base station for reference power level between 31 to 38 dBm. There are six csv files
based on operating band and channel bandwidth for Medium Area.

LTE_SEM_1_4MHz_above3GHz_Medium31P38P.csv

LTE_SEM_1_4MHz_below3GHz_Medium31P38.csv

LTE_SEM_3MHz_above3GHz_Medium31P38.csv

LTE_SEM_3MHz_below3GHz_Medium31P38.csv

LTE_SEM_5to20MHz_above3GHz_Medium31P38.csv

LTE_SEM_5to20MHz_below3GHz_Medium31P38.csv

Additional requirements given in Section 6.6.3.5.3 in 3GPP TS 36.141 v12.5 standard document.
There are 14 csv files based on the requirements in the standard document. The files are named
based on the table numbers of Section 6.6.3.5.3 of the standard document (3GPP TS 36.141
V12.5.0 (2014-09).
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Cell ID (TDD and FDD)

The dominant Cell ID in the transmitted LTE signal is detected and presented in the Constellation display.
Along with the Cell ID scalar results, the group and sector ID are also presented. The constellation of
the Primary and Second Synchronization signals are presented too.

More information about this measurement:

Select the Cell ID test setup from Presets > Standards > LTE to perform the measurement. This will
load the displays found in the LTE preset test setups table .

This test setup allows you to select the frame structure and channel bandwidth with the following
restrictions:

Frame Structure can be TDD or FDD

Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz

Analysis of the LTE signals is done based on the settings you choose in the Standards Presets.

The constellation for PSS and SSS (Primary and Secondary Synchronization Signals) are shown. You
can optionally select to view only the PSS or SSS constellation (selection is made in the Trace tab).

Equalization based on PSS (Primary Synchronization Signal) data can be enabled using the "Enable
Equalization" option (available in the Analysis Params tab of the Settings Control panel.) This
Equalization is based on PSS data and applied on other parts of the OFDM symbol.

TOFF (TDD)

The TOFF measurement is done only for the TDD signal. It is a measure of the off slot power in a LTE
TDD signal.

More information about this measurement:

Select the Channel Power and TDD TOFF Power test setup from Presets > Standards > LTE to perform
the measurement. This will load the displays found in the LTE preset test setups table .

This test setup allows you to select the frame structure and channel bandwidth with the following
restrictions:

Frame Structure can be TDD or FDD

Channel Bandwidth can be 1.4, 3, 5, 10, 15, or 20 MHz

Analysis of the LTE signals is done based on the settings you choose in the Standards Presets.

By default, the TOFF measurement is the average of several non-overlapping and adjoining 70 μs
windows in the off slot region. This measurement is done only on the 70 μs window in the center of
the off slot region, when the Average over entire offslot region option is disabled.

The scalar result is presented in dBm/MHz.

The result is compared against limits that can be defined using the Limits tab of the control panel. By
default, these limits are set based on the Base Station conformance testing document (3GPP TS 36.141
v12.5 – for Release 12). Pass/fail is shown in the top left corner of the LTE Power vs Time display.
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LTE Status Messages

The following status messages may appear. Each message indicates the related condition (Description)
shown in the following table.

Status message Description

LTE Analysis: Signal must be triggered or measured
in Real Time

Shown in the display and status bar when the user attempts to
make the ACLR measurement and SEM measurement for TDD
signals in non-Real-Time mode and when the instrument is in
free run.

Since the standard recommends the ACLR measurement to be
done in transmitter ON periods only, either the measurement
has to be done in Real-Time mode (in which a detection module
ensures the measurement is done on the transmitter ON period)
or has to be externally triggered if in non-Real-Time mode.

LTE Analysis: Recovery done on PSS/SSS on the
center 62 carriers

Shown in the status bar to indicate that the constellation of
PSS and SSS shown in the LTE constellation is done based on
analysis of PSS and SSS signals in the center 62 carriers of the
corresponding OFDM symbols.

Therefore, you may see the correct constellation and Cell ID even
when a different channel bandwidth is chosen from the control
panel because the analysis for PSS and SSS is done only on
the center carriers.

LTE Analysis: Analysis Failure - Synchronization
Sequence not found

Shown in the status bar to indicate that a valid Cell ID (from PSS
and SSS) is not detected.

xxx

LTE ACLR display

The LTE Adjacent Channel Leakage Ratio (ACLR) display shows the ratio of the mean power centered
on the assigned channel frequency to the mean power centered on an adjacent channel frequency. In the
3GPP specification, both the main channel and adjacent channels are required to be filtered with RRC
(Root Raised Cosine) filters.

To show the LTE ACLR display you can select Presets > Standards > LTE.

NOTE. Loading the LTE ACLR display from the Presets > Standards > LTE menu is recommended. This
loads the control settings based on the selected options.

You can also load the LTE ACLR display as follows:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays window, select LTE Analysis in theMeasurements box.
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4. In the Available displays box, double-click the LTE ACLR icon or select the icon and click Add.
The LTE ACLR icon will appear in the Selected displays box and will no longer appear under
Available displays.

5. Click the OK button to show the display.

6. Select Setup > Settings to display the control panel.

7. Select Replay/Run to take measurements on the acquired data.

8. If you are analyzing a data file, click the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the LTE ACLR display.
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Item Display element Description

A Pass/Fail Indicates Pass or Fail based on Absolute and Relative limits set by the user.
The failure condition is set by Mask in the Offset and Limits Table tab of the
Settings control panel. By default, the mask is set to Abs & Rel, meaning
failure is reported only when both absolute and relative results fail against
the respective limits.

B Ref Detection Set to Avg (VRMS) or +Peak based on the choice made in Processing tab of
the Settings control panel.

C Normal Indicates how the result is presented over multiple sweeps. This selection is
made in the Processing tab of the control panel. Displays Average Count if
Avg (VRMS) is checked in the Processing tab in the Settings control panel.

D Clear Resets measurement. Clears all values.

E Plot Shows the reference channel and adjacent channels and the regions in
between them. The Absolute and Relative limit lines are also shown. The
integrated power is shown as a band. Scalar results are also shown.

F Span Adjust the span of the graph in symbols.

G Results Table Tabulates the results in each adjacent band. Table shows the offset,
bandwidth, Integrated Absolute and Relative power in the upper and lower
adjacent channel regions.

H CF Center Frequency at which the measurement is performed.

I Ref Total Power Gives the power in the Reference channel.

J Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

K Bottom readout Displays the value indicated by the bottom of graph.

L dB / div Shows the dB per each division in the Y axis of the plot.

M Top of graph The vertical scale is normalized with appropriate power units.

N Expand button Shows the results table in its own window with larger font size.

xxx

Clicking on the Expand button allows you to view the results table in a separate window, as shown
in the following image.

LTE ACLR Settings

Main menu bar: Setup > Settings

446 SignalVu-PC Printable Help



LTE Analysis LTE Channel Spectrum display

Favorites toolbar:

The LTE ACLR Settings control panel provides access to settings that control parameters of the LTE
ACLR display.

Settings tab Description

Channels (see page 454) Allows you to control how the measurement is performed. When in Real Time, the
RBW and VBW settings apply for all channels (including offset regions) and the other
parameters apply only for the reference channel. When Non-Real Time mode is selected,
all information in this tab, including RBW and VBW, only applies to the reference channel.

Parameters (see page 456) Specifies several characteristics that control how the measurement is made. These
parameters are used by the instrument to analyze the input signal.

Processing (see page 458) Specifies settings for detection on the reference channel and the offsets. Specifies the
function setting on how calculations are done across multiple sweeps.

Offsets & Limits Table (see
page 459)

Allows you to select the characteristics of offsets and mask limits.

Scale (see page 460) Specifies the vertical and horizontal scale settings.

Prefs (see page 462) Allows you to select to show or hide the graticule, power level, limits, and marker
readouts.

xxx

LTE Channel Spectrum display

The LTE Channel Spectrum display shows the spectrum of the input signal across one channel. Channel
power measures the average power within the selected bandwidth and is expressed in dBm. Other units
can be selected from the Units tab of the Analysis control panel. The measured occupied bandwidth is
calculated as the bandwidth containing 99% of the total integrated power within the selected span around
the selected center frequency.

To show the LTE Channel Spectrum display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. From the Measurements box, select LTE Analysis.

4. Double-click the LTE Channel Spectrum icon in the Available Displays box. This moves the LTE
Channel Spectrum icon to the Selected displays box.

5. Click OK button to view the display.

6. Select Setup > Settings to display the control panel.

7. Select Replay/Run to take measurements on the acquired data.

8. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display

The following image shows the LTE Channel Spectrum display.
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Item Display element Description

A Normal Displays Average Count if Average is turned on (set to Time Domain or
Frequency Domain) from the Measurement Params tab in the Settings
control panel.

B Clear Resets measurement. Clears all values.

C Plot Specifies the value shown at the center of the graph display.

D Scale Adjust the span of the graph.

E Position Displays the horizontal position of the trace on the graph display.

F Scalar results Shows the Channel Power and Occupied Bandwidth measurement results.

G Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

H Bottom readout Displays the value indicated by the bottom of graph.

I dB / div Shows the dB per each division in the Y axis of the plot.

J Top of graph The vertical scale is normalized with appropriate power units.

xxx

LTE Channel Spectrum Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the LTE Channel Spectrum display are shown in the following table.

Settings tab Description

Freq & RBW (see page 465) Allows you to specify the frequency and resolution bandwidth used for the measurement.

Measurement Params (see
page 466)

Allows you to set averaging (Time Domain, Off, or Frequency Domain) and to set the
number value associated with the Average setting.

Channels (see page 454) Allows you to set the Channel BW for the Channel Power measurement.

Scale (see page 460) Allows you to specify the horizontal and vertical scale settings.

Prefs (see page 462) Allows you to select to show or hide certain display elements.

xxx

LTE Constellation display

The LTE Constellation display shows the constellation of Primary (PSS) and Secondary (SSS)
Synchronization Signals. Scalar results include Cell ID, Group ID, Sector ID, and frequency error.

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select LTE Analysis in theMeasurements box.
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4. In the Available displays box, double-click the LTE Constellation icon or select the icon and click
Add. The LTE Constellation icon will be added to the Selected displays box and will no longer
appear under Available displays.

5. Click OK to show the display.

6. Select Replay/Run to take measurements on the acquired data.

7. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the LTE Constellation display.
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Item Display element Description

A Scalar results Gives results of Cell ID, Group and Sector ID information along with
Frequency error.

B Plot Displays PSS and SSS (Primary and Second Synchronization Signal)
constellation.

C Status message Shows relevant status messages.

(You can read about status messages here.)

D Marker readout Shows marker type, magnitude, phase and subcarrier number.

xxx

LTE Constellation Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the LTE Constellation display are shown in the following table.

Settings tab Description

Modulation Params (see
page 467)

Specifies the frame structure and channel bandwidth.

Analysis Params (see
page 467)

Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

Analysis Time (see page 468) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for LTE Analysis displays.

Trace (see page 469) Allows you to set the display characteristics of the traces.

Scale (see page 460) Specifies the vertical and horizontal scale settings.

xxx

LTE Power vs Time display

The LTE Power vs Time display shows the filtered power of the data and marks where the TOFF
measurement is done. The TOFF scalar results are also shown.

You can select Presets > Standards > LTE to view the display.

NOTE. Loading the LTE Power vs Time display from the Presets > Standards > LTE menu is
recommended. This loads the control settings based on the selected options.

You can also load the LTE Power vs Time display as follows:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.
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3. In the Select Displays dialog, select LTE Analysis in theMeasurements box.

4. In the Available displays box, double-click the LTE Power vs Time icon or select the icon and click
Add. The LTE Power vs Time icon will be added to the Selected displays box and will no longer
appear under Available displays.

5. Click OK to show the display.

6. Select Replay/Run to take measurements on the acquired data.

7. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the LTE Power vs Time display.
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Item Display element Description

A Pass / Fail Shows Pass or Fail based on whether the TOFF measurement (off slot power) is
below the recommended limit set in the Limit tab of the Settings control panel
or not. The Pass/Fail information is displayed only when the chosen frame
structure if TDD and if a valid off slot is found.

B Plot Displays the filtered signal in case of TDD and the region in which the off slot
power is measured is graphically shown. When the frame structure is chosen
as FDD, the power in the input signal is displayed.

C Scale Adjust the span of the graph in symbols.

D Analysis Start Gives the start of analysis region.

E Toff The TOFF (off slot power) is measured and displayed here when a valid off slot is
found for a TDD signal.

F Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

G Bottom readout Displays the value indicated by the bottom of graph.

H dB / div Shows the dB per each division in the Y axis of the plot.

I Top of graph The vertical scale is normalized with appropriate power units.

xxx

LTE Power vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the LTE Power vs Time display are shown in the following table.

Settings tab Description

Modulation Params (see
page 467)

Specifies the frame structure and channel bandwidth.

Analysis Time (see page 468) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for LTE Analysis displays.

Prefs (see page 462) Allows you to select to show or hide the graticule and marker readouts.

Scale (see page 460) Specifies the vertical and horizontal scale settings.

Limit (see page 470) Specifies the mask limits.

xxx

LTE Analysis Measurement Settings

Main menu bar: Setup > Settings

Favorites toolbar:
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The control panel tabs in this section are shared between the displays in LTE Analysis (Setup > Displays).
Some tabs are shared by all the displays and some tabs are shared by only a subset of displays. The settings
available on some tabs change depending on the selected display.

Controls for LTE Analysis displays

Settings tab Description

Modulation Params (see
page 467)

Allows you to set the frame structure and channel bandwidth.

Available for these displays: LTE Power vs Time, LTE Constellation.

Analysis Params (see
page 467)

Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

Analysis Time (see page 468) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for LTE Analysis
displays.

Available for these displays: LTE Power vs Time, LTE Constellation.

Trace (see page 469) Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol
when chosen to view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Available for the LTE Constellation display only.

Prefs (see page 462) Allows preferences with Radix display and marker readouts.

Available for these displays: LTE Power vs Time, LTE ACLR, LTE Channel Spectrum,
SEM.

Scale (see page 460) Defines the vertical and horizontal axes.

Available for all LTE displays.

Offsets & Limits Table (see
page 459)

NOTE. Available for the LTE ACLR display only.

Freq & RBW (see page 465) Specifies the frequency and resolution bandwidth used for the measurement.

NOTE. Available for the LTE Channel Spectrum display only.

Parameters (see page 456) Specifies several characteristics that control how the measurement is made.

Processing (see page 458) Specifies settings for detection on the reference channel and the offsets. Specifies the
function setting on how calculations are done across multiple sweeps.

Limit (see page 470) Allows you to define limits for pass/fail comparison with calculated values. The default
values are as recommended in the test specification.

Channels (see page 454) Specifies the Channel BW for the Channel Power measurement. Allows you to set RBW,
VBW, power reference, as well.

Available for these displays: LTE ACLR, LTE Channel Spectrum.

Measurement Params (see
page 466)

Allows you to set averaging (Time Domain, Off, or Frequency Domain) and to set the
number value associated with the Average setting.

xxx

Channels tab - LTE

The Channels tab allows you to control how the measurement is performed.

The following image shows the Channels tab for the LTE ACLR display. When in Real Time, the RBW
and VBW settings apply for all channels (including offset regions) and the other parameters such as
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Power Reference, Channel Width, and Integrated bandwidth apply only to the reference channel. When
Non-Real Time mode is selected, all information in this tab, including RBW and VBW, only applies to
the reference channel.

Settings Description

Reference

Power Reference The value used to calculate relative measurements. When Auto is selected,
the calculated reference channel power is displayed. When Auto is unchecked,
you can enter a value for the reference power, and the measured reference
power is not used or displayed.

Channel Width Specifies the width of the reference channel.

Integration BW Specifies the integration bandwidth used to compute the total power in the
reference channel.

All Channels (displayed for Real-Time mode)

Reference Channel (displayed for Non-Real Time mode)

RBW Sets the RBW

VBW Enables/disables the Video Bandwidth filter. VBW is used in traditional swept
analyzers to reduce the effect of noise on the displayed signal. The VBW
algorithm in the analyzer emulates the VBW filters of traditional swept analyzers.
When the check box next to VBW is not checked, the VBW filter is not applied.

The maximum VBW value is the current RBW setting. The minimum VBW
value is 1/10,000 of the RBW setting.

xxx

The following image shows the Channels tab for the LTE Channel Spectrum display. This tab allows you
to set the channel bandwidth, which in turn sets the span for LTE Channel Spectrum.
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Settings Description

Channel Bandwidth Specifies the Channel Bandwidth, which in turn sets the span of the LTE
Channel Spectrum.

xxx

Parameters tab - LTE

The Parameters tab enables you to specify several parameters that control the LTE ACLR measurements
are made.
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Setting Description

Meas Freq Specify the frequency of the signal to be measured.

Step Sets the increment size when changing the Frequency using the knob or mouse wheel.
Auto: When Auto is enabled, the step size is adjusted automatically based on the span
setting.

Real-Time When Real-Time mode is enabled, the entire LTE ACLR span is measured using a
real-time/contiguous acquisition. Not all described parameters are available in Real-Time
mode.

When Real-Time is disabled (non-Real-Time mode), a separate acquisition for each region
is taken and analyzed. Non-Real-Time mode is also useful when the bandwidth offered by
the instrument does not support the span requirement for this measurement. The span
requirement is guided by the choice of adjacent channel type and channel bandwidth
selected in LTE Standards Presets.

Measure Noise Floor Takes preliminary acquisitions to measures the instrument noise floor. This initiates a noise
correction. A noise correction signal is created by switching off the RF input and performing
acquisitions of the instrument’s internal noise. Fifty acquisitions are averaged to create the
noise reference signal. The noise reference signal is measured for the Reference channel
and each Offset is defined by the measurement settings.

Apply noise correction This item is enabled and the check box automatically checked after the noise reference
signal is taken when the Measure Noise floor button is clicked. This initiates noise reference
subtraction from the incoming signal power for each region to create the corrected result.
All calculations are performed in Watts and then converted to the desired units.

The amount of noise correction is limited to 20 dB to avoid the possibility of a negative
power measurement. This is a rare condition that could occur if the subtraction of the
reference power from the channel power results in a negative value (or “infinite” dBm). The
noise reference for a region is subtracted from each trace point in the channel, rather than
offsetting the entire region by a single amount. This produces a smooth trace with no
discontinuities at the region edges.

NOTE. If any relevant settings (such as reference level, frequency, span, RBW) are
changed once the noise reference is measured, the following warning message will be
displayed to notify you that Noise Correction was not applied: Noise correction not applied -
select Measure Noise Floor for new noise correction.

Filter shape Specifies the shape of the filter determined by the window that is applied to the data record,
in the spectrum analysis, to reduce spectral leakage. 3GPP specifies a Gaussian window
shape be applied to the reference channel measurements.

Gaussian: This filter shape provides optimal localization in the frequency domain.

Rectangular: This filter shape provides the best frequency, worst magnitude resolution.
This is essentially the same as no window.

xxx
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Processing tab - LTE

The Processing tab controls the detection settings for the Reference Channel and Offsets, as well as
selecting the function for the LTE ACLR display.

Setting Description

Detection (in each sweep)

Reference Channel Specifies the Detection method used for the Reference Channel. Detection is used to
produce the desired measurement result (peak or average) and to reduce the results of a
measurement to the desired number of trace points.

Avg (VRMS) For each sweep, each point of the trace is the result of determining the RMS voltage value
for the last 'n counts' of the collected traces for the same point. When 'n count' has not
been reached, partial averaging results are displayed.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from
the results to be compressed into a trace point.

Offsets Specifies the detection method used for the offsets.

Avg (VRMS) Selects the Average Vrms detection method. With this method, each point on the trace
in each offset is the result of determining the RMS Voltage value for all of the results
values it includes.

+Peak Selects the +Peak detection method. With this method, the highest value is selected from
the results to be compressed into a trace point.

Function (across multiple sweeps)

Normal When a new trace has been computed, it replaces the previous trace.

Max Hold With each sweep, each trace point in the new trace is compared to the point’s value in the
old trace and the greater value is retained for display and subsequent comparisons.

Avg (VRMS) For each sweep, each point on the trace is the result of determining the RMS Voltage value
for all of the collected traces' values for the same point.

Count Enter the Avg (VRMS) value. Displayed only when Avg (VRMS) is selected.

xxx
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Offsets and Limits Table tab - LTE

The Offsets and Limits Table tab is used to specify parameters that define Offsets and masks for the LTE
ACLR display. The following images show the tab and expanded view of the tab, respectively.

The following image shows the Offsets and Limits Table tab when Real-Time is selected in the Parameters
tab.

The following image shows the Offsets and Limits Table tab when Real-Time is not selected in the
Parameters tab (referred to as non-Real-Time mode).

The following image shows the expanded view of the Offsets and Limits Table (click the Expand
button to view).
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Setting Description

Buttons

Expand (button) Displays the Offsets and Limits Table in a new, resizable window.

Reset Layout Allows you to reorder columns in the Offsets & Limits Table by dragging the columns to a
new position. Clicking Reset Layout returns the column order to the factory default order.

Load Click to load a saved Offsets & Limits table from a file.

Save As Click to save the current Offsets & Limits table to a file.

Done When the table is expanded, click Done when you have finished editing the table to save
your changes and close the expanded table display.

Table columns

On Specifies whether or not measurements are taken in the specified offset.

Freq Offset (Hz) Specifies the frequency offset for the offset region (adjacent channel region) from the
Center frequency of the Reference Channel. This offset is always specified from the center
frequency of the Reference Channel to the center frequency of the Offset region.

Start (Hz) Start Frequency of the selected offset.

Stop (Hz) Stop Frequency of the selected offset.

Bandwidth (Hz) Specifies the bandwidth of the Offset region.

Side Specifies whether the specified range appears on both side of the carrier frequency or
just one side (left or right).

RBW (Hz) Specifies the RBW for the selected range.

n(RBWS) An integer value that specifies how many times to multiply the RBW to set the Filter
bandwidth.

Filter BW (n x RBW) Displays the Filter BW. Filter BW is the equivalent BW of each point in the offset. When n >
1, an integration technique is used to achieve the Filter BW using narrower RBWs.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW
Minimum: 1/10,000 RBW setting.

VBW (On) Specifies whether the VBW filter is applied.

Mask Select the type of limits used for Pass/Fail testing. Signal excursions that exceed the mask
settings are considered violations. The available choices are Abs, Rel and Abs & Rel.

Abs Limit (dBm) The offset region integrated power is compared against the Abs Limit value mentioned here.

Rel Limit (dB) The offset region integrated power relative to the reference channel integrated power is
compared with this limit.

xxx

Scale tab - LTE

The Scale tab allows you to change the scale settings that control how the trace appears on the display but
does not change control settings. In effect, these controls operate like pan and zoom controls. The Scale
tab values are unique to each display. Also, note that each display uses horizontal and vertical units that
are appropriate for that display. There are three versions of the Scale tab for LTE displays.
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The following image shows the Scale tab for the LTE Power vs Time display.

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Reset Resets the scale of the vertical axis to default values.

Horizontal Full Burst Controls the horizontal span.

Start Specifies the horizontal axis start point.

Stop Specifies the horizontal axis end point.

Reset Resets the scale of the horizontal axis to default values.

xxx

The following image shows the Scale tab for the LTE Channel Spectrum and LTE ACLR displays.
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Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the horizontal span of the trace display and position of the trace.

Scale Specifies the frequency range displayed in the graph

Position Specifies the frequency shown at the center of the graph.

Autoscale Resets the scale of the horizontal axis to optimize the display of the trace.

Reset Scale Resets all settings to their default values.

xxx

The following image shows the Scale tab for the LTE Constellation display.

Settings Description

Zoom

Scale Zooms in and out of the constellation. As the scale is increased, it will zoom out.

Vertical Position Adjusts the vertical position.

Horizontal Position Adjusts the horizontal position.

xxx

Prefs tab - LTE

The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout and switching the graticule display on/off. Some parameters appear with most displays, while
others appear with only one display.
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The following image shows the Prefs tab for the LTE ACLR display.

The following image shows the Prefs tab for the LTE Channel Spectrum display.

The following image shows the Prefs tab for the LTE Power vs Time display.
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Setting Description

Show graticule Shows or hides the graticule.

Trace / Max Trace points When the spectrum analysis produces more than the selected maximum number of
points, the method specified in Detection control is used to decimate the result. This
setting applies to both the reference channel and offsets.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show Power Levels In Graph This display the power level (calculated integrated power in the offset region) in the graph.

Show limits

Shaded Shows limits using a shaded area. Absolute limit and Relative limit shading colors can
be set under Presets > Options.

Line only Shows limits using only a line. Absolute limit and Relative limit line colors can be set
under Presets > Options.

None No lines or shading are used to indicate limits in the graph. Violations of the mask are still
identified by red shading.

Average Over Offslot Enables for averaging of offslot power in non-overlapping 70 μs windows in the entire
offslot region. If this option is disabled, the off slot power is measured only in the center
70 μs window of the offslot region.

xxx
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Freq and RBW tab - LTE

The Freq and RBW tab specifies frequency parameters for the Channel Power and ACPR measurements
and the MCPR measurement. It is available for the LTE Channel Spectrum display.

Settings Description

Meas Freq Specifies the center/measurement frequency

RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting
is Independent of the Spectrum view's RBW setting.

Auto: When Auto is enabled, the step size is adjusted automatically based on
the span setting.

Step The Step control sets the increment/decrement size for the adjustment of the
center frequency. If Auto is enabled, the analyzer will adjust the Step size as
required.

Auto: When Auto is enabled, the step size is adjusted automatically based on
the span setting.

VBW Adjusts the Video Bandwidth value.

The maximum VBW value is the current RBW setting. The minimum VBW value
is 1/10,000 of the RBW setting.

xxx
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Measurement Params tab - LTE

The Measurement Params tab allows you to set parameters that control the ACPR and MCPR
measurements. This is available for the LTE Channel Spectrum display.

Settings Description

Average

Off

Frequency-domain This setting takes the average linear value of the traces (so that RMS values
are preserved). The number of averages is user-defined. Frequency domain
averaging is available in spans larger (or smaller) than the maximum real time
bandwidth. This is the mode to use unless you need to extract maximum dynamic
range from an ACPR measurement.

Time-domain This setting takes the average linear value of the traces. It is useful if you need
to extract maximum dynamic range from an ACPR measurement. The number
of traces is user defined, however, the signals must be triggered and repeating
(meaning the signal needs to be exactly the same for each acquisition). When this
condition is met, each waveform contains the same signal, but the random noise
changes from acquisition to acquisition and the average value of the random
noise is lowered, while the signal value remains constant. Time domain averaging
is not available in spans wider than the maximum real-time bandwidth.

xxx
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Modulation Params tab - LTE

The Modulation Params tab specifies the type of modulation used by the input signal and other parameters
that define the signal format. This tab is available for the LTE Constellation and Power vs Time displays.

Settings Description

Frame Structure Select the frame structure to set how the demodulation is done.

Downlink FDD

Downlink TDD

Bandwidth and Spacing

Channel Bandwidth Select from 6 bandwidths: 1.4, 3, 5, 10, 15, 20 MHz

Subcarrier Spacing (readout) This readout shows the subcarrier spacing. It is always at 15 kHz for LTE.

xxx

Analysis Params tab - LTE

The Analysis Params tab allows you to enable equalization on the demodulated LTE packet. The
equalization is based on PSS (Primary Synchronization Signal). This tab is only available for the LTE
Constellation display.

Settings Description

Enable Equalization Allows you to enable Equalization based on PSS (Primary Synchronization Signal).

xxx
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Analysis Time tab - LTE

The Analysis Time tab contains parameters that define how the signal is analyzed in the LTE Analysis
displays. This tab is available for the LTE Constellation and Power vs Time displays.

Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in
either symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols)
being used by the analyzer. This value may not match the Analysis Length requested
(in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

xxx

Analysis Offset

Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (All time values are relative
to the Time Zero Reference.)

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).
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Analysis Length

Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the
actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the control in
the "Available" readout. This setting is not available when Auto is checked. Range: minimum value
depends on the standard. Resolution: 1 symbol.

Time Zero Reference

All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which the acquisition begins.

Trigger Time zero starts from the trigger point.

xxx

Trace tab - LTE

The Trace tab allows you to set the trace display characteristics of the LTE Constellation display.

Setting Description

> The arrow indicates which measurement name is active so that you can check it (on)
or uncheck it (off).

On Check the box next the measurement name you want to turn on.

Measurement Name Selections are PSS (Primary Synchronization Signal) or SSS (Secondary Synchronization
Signal)

xxx
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Limit tab - LTE

The Limit tab is only available for the LTE Power vs Time display. It enables you to specify the limit
used for comparison against measured values of TOFF measurement.

Setting Description

Toff psd Specifies the limit that is used for comparison against measured values of TOFF

measurement. Pass/ Fail is determined with this limit.

xxx
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Bluetooth Analysis

Overview

The Bluetooth Analysis option allows you to evaluate short range RF signals to ensure that they meet
Bluetooth standard per Bluetooth Special Interests Group (SIG) Test Specifications for version 4.2. This
analysis option enables measurements and supports detection, demodulation, and decoding of packet
information for the following three standards: Basic Rate, Low Energy, and Enhanced Data Rate (EDR).
You can also select from three RF test presets for the Low Energy standard and four test presets for
the Basic Rate standard. This analysis option includes modulation, power, carrier drift, and spectral
measurements as mentioned in the Radio Frequency test specification document by the Bluetooth SIG.
These measurements are also compared with the limits provided by the standard to give pass/fail results.
(There are no pass/fail results for EDR.)

With the Bluetooth Analysis test suite, test engineers can simplify the execution of a number of transmitter
tests while still enabled to modify signal parameters for in-depth signal analysis. The analysis results give
multiple views of Bluetooth signal characteristics to allow the diagnosis of signal imperfections and
impairments quickly and easily. Display controls allow you to selectively display the analysis results to
help locate trouble spots in the signal.

Bluetooth topics in this Help

The following information about the Bluetooth Analysis option is available:

Bluetooth key features (see page 471)

Reference table of supported Bluetooth measurements

Bluetooth measurements and test setups (see page 475)

Bluetooth status messages (see page 480)

Bluetooth Standards presets (see page 472)

Bluetooth displays (see page 475)

Bluetooth Settings (see page 507)

Bluetooth key features

Modulation/Carrier Drift/Output Power test setup in Bluetooth Standards Preset that will calculate
results and compare against recommended or user defined limits or Basic Rate and Low Energy.

In-band Emission measurement preset with capability to compare results against recommended or user
defined limits for Basic Rate and Low Energy.

20 dB Bandwidth and Frequency Range measurement preset with capability to compare results against
recommended or user defined limits for Basic Rate.

Appropriate masks for Out-of-band Spurious measurements for ETSI and FCC specifications.
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Enhanced Data Rate (EDR) demodulation of GFSK and PSK data and relative power measurement
preset.

Automatic detection of standards (see page 472).

Automatic detection of test pattern.

Automatic determination of packet type.

Summary display with decoded preamble, access code, packet header, payload header, and CRC
packet information along with other scalar measurements.

Symbol Table display with color coding to show different regions in the packet.

Freq Dev vs Time display with zoomed Octet viewing to help you understand how the modulation
characteristics measurement is done.

CF Offset & Drift display with offset (calculated in preamble and 10 bit intervals in payload) and
drift results in a tabular view.

Summary display that allows you to edit pass/fail limits for comparison with actual results. (Default is
recommended limits from the Bluetooth SIG Radio Frequency test specification document.)

Automatic detection of standards. This function can be enabled from the Standard Parameters control
panel. This automatically detects whether the Bluetooth standard is Basic Rate, Low Energy, or Enhanced
Data Rate (EDR). This function is not available as a test setup from the Standards Presets window.

Supported automated Bluetooth measurements

Bluetooth measurement Bluetooth standard(s)

Modulation characteristics Basic Rate

Low Energy

Carrier frequency offset and drift Basic Rate

Low Energy

Output power Basic Rate

Low Energy

In-band emission /ACPR Basic Rate

Low Energy

Out-of-band spurious emission Basic Rate

Low Energy

20 dB bandwidth Basic Rate

Frequency range Basic Rate

Power density Basic Rate

Relative power Enhanced Data Rate (EDR)

xxx

Bluetooth Standards presets

Presets > Standards
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The Bluetooth Standards preset allows you to access displays preconfigured for the Bluetooth standard
and test setup you select. The test setups load the displays and control setting options suggested by the
standard to perform the measurements. You can read more about how Presets work here.

There are four test setups for the Low Energy standard and eight test setups for the Basic Rate standard.
There is one preset (no test setups) for the EDR standard.

The following table shows the set of Preset displays that load when the specified standards and test
setups are selected.

Table 6: Bluetooth standards, test setups, and Preset displays

Standard Test setup Displays loaded with preset

Modulation/Frequency Offset/Drift/Output
Power

BT Eye Diagram, BT Freq Dev vs Time, BT
Summary, BT CF Offset and Drift, Spectrum, Time
Overview

In-band Emissions BT InBand Emission, Spectrum, Time Overview

Low Energy

Non-compliance BT Freq Dev vs Time, BT Constellation, BT
Summary, Spectrum, Spectrogram, Time
Overview

Modulation/Frequency Offset/Drift/Output
Power

BT Eye Diagram, BT Freq Dev vs Time, BT
Summary, BT CF Offset and Drift, Spectrum, Time
Overview

In-band Emissions BT InBand Emission, Spectrum, Time Overview

Tx Output Spectrum — 20dB Bandwidth Bluetooth 20 dB BW, Spectrum, Time Overview

Basic Rate

Non-compliance BT Freq Dev vs Time, BT Constellation, BT
Summary, Spectrum, Spectrogram, Time
Overview

Enhanced Data
Rate (EDR)

Generic BT Eye Diagram, BT Constellation, BT Summary,
BT Symbol Table, Spectrum, Time Overview

xxx

Retain current center frequency and reference level settings

The Retain current Center Frequency setting appears when the Bluetooth Standards Preset is chosen.
This setting allows you to retain the previously used center frequency.

The Retain current Ref Level setting appears when the Bluetooth Standards Preset is chosen. This
setting allows you to retain the previously used reference level.

To activate these settings, check the box next to the desired setting.
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By default, the Ref Level setting box is checked.

By default, the Center Frequency setting box is unchecked and the Bluetooth preset displays will load
with one of the center frequency values shown in the following table.

Table 7: Default center frequencies for Bluetooth test setups

Standard Test setup
Center
frequency

Basic Rate

Low Energy

Modulation/Frequency Offset/Drift/Output Power 2.441 GHz

Basic Rate

Low Energy

In-band Emissions 2.441 GHz

Basic Rate

Low Energy

Out-of-band Spurious Emissions 2.441 GHz

Basic Rate Tx Output Spectrum — 20dB Bandwidth 2.441 GHz

Basic Rate Tx Output Spectrum — Power Density 2.441 GHz

Basic Rate

Low Energy

Non-compliance 2.441 GHz

Basic Rate Tx Output Spectrum — Frequency Range Lower 2.402 GHz

Basic Rate Tx Output Spectrum — Frequency Range Higher 2.480 GHz

Enhanced Data Rate Generic 2.441 GHz

xxx
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NOTE. Changing analysis and display parameters recalculates the measurement results, but does not
affect acquisitions.

Bluetooth displays

The displays in Bluetooth Analysis (Setup > Displays > Measurements: Bluetooth Analysis) are:

Bluetooth 20dB Bandwidth

Bluetooth Center Frequency Offset and Drift

Bluetooth Constellation

Bluetooth Eye Diagram

Bluetooth Frequency Dev vs Time

Bluetooth InBand Emission

Bluetooth Summary

Bluetooth Symbol Table

Time Overview

Bluetooth measurements and test setups

A variety of measurements and test setups are provided by the Bluetooth Analysis option for use in
performance testing of transmitters. These test setups allow the analyzer to compare the measurement
result to the standards limit. Test engineers can select from the test setups and measurements described
here. The following topics contain important information you should know about specific Bluetooth
measurements and test setups.

NOTE. Although the following information describes test setups for measurements recommended by the
standard document, other measurement results may also be provided as additional information for a given
measurement. For example, carrier frequency offset and drift results may be provided for modulation
characteristics test setups.

Modulation characteristics (Basic Rate and Low Energy)

This measurement verifies that the modulation characteristics of the transmitted signal are correct. The
Bluetooth test specification recommends this measurement be done using fixed frequency, also known as
hopping off, and can be done in Direct Tx mode. This measurement can only be done if the payload has the
bit pattern 10101010 or 11110000. This measurement and test setup are set to Free Run mode by default.
However, you can set the analyzer to Triggered mode (Setup > Trigger) to do the measurements.

More information about this measurement:

Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to
perform modulation characteristics measurements. This will load the displays found in the Bluetooth
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standards, test setups, and Preset displays table . Additionally, you can choose to load the BT Symbol
Table and BT Constellation displays, which can provide useful information.

The Bluetooth Analysis splits the frequency deviation results in the payload region into octets (8 bit
intervals). If the payload pattern is 10101010, the maximum frequency deviation is calculated in every
bit interval within an octet and recorded as Δfmax. The Δfmax results are averaged to give Δf2avg.
The percentage of Δfmax values greater than recommended lower limit is also found.

If the payload is 11110000, the average frequency deviation is found in 4 bit intervals (2, 3, 6 and 7)
and the average of these values is calculated as Δf1avg. The ratio of Δf2avg and Δf1avg is also found.

BT Freq Dev vs Time display has an octet view (zoomed view of the 8 bit intervals in Payload) and
also shows the bit intervals in which the Δfmax values are computed. The octet view option also
allows you to see the regions in which the calculations are done.

NOTE. The octet view option is only available when Preamble is detected.

Specify an octet to view by entering a value in the Octet # field in the BT Freq Dev vs Time display.
This also shows the maximum number of octets used for analysis. The start and end point for every
octet can be clearly seen using the octet view.

In the Summary display, the scalar results (Δf1avg, Δf2avg, Ratio, Percentage of Δfmax values greater
than a limit) averaged over the last 10 packets analyzed are shown along with the packet count. These
averaged results can be compared against limits set in the Limits tab of the Settings control panel.

The Points/symbol option in the Trace tab can be used to control how many samples per symbol should
be used for computation of these measurements. The standard recommends 32 samples per symbol for
Low Energy and 4 samples per symbol for Basic Rate. These are the default values provided for the
respective standards in the Bluetooth Standards presets.

Carrier frequency offset and drift (Basic Rate and Low Energy)

This measurement verifies that the carrier frequency offset and carrier drift of the transmitted signal is
within the specified limits for the specified standard. The Bluetooth test specification recommends this
measurement be done using fixed frequency, also known as hopping off, and can be done in Direct Tx
mode. This test can be done only if the payload contains 10101010 bit pattern. This measurement and
test setup are set to Free Run mode by default. However, you can set the analyzer to Triggered mode
(Setup > Trigger) to do the measurements.

More information about this measurement:

Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to
perform carrier frequency offset and drift measurements. This will load the displays found in the
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Bluetooth standards, test setups, and Preset displays table . Additionally, you can choose to load the
BT Symbol Table and BT Constellation displays, which can provide useful information.

This measurement calculates the following:

Frequency offset in Preamble (initial Carrier Frequency Offset).

Frequency offset in Payload (calculated in 10 bit intervals in Payload).

Drift (the difference in frequency offset calculated in Payload from that calculated in Preamble).

Drift/50 μs (the difference in frequency offset calculated in two 10 bit intervals in Payload
separated by 50 μs (5 intervals away).

The BT CF Offset and Drift display shows all results in a table.

The measurements shows the following scalar results:

Preamble frequency offset (initial carrier frequency offset).

Maximum frequency offset in Payload (along with the index number at which the offset is at
maximum).

Drift of frequency offset from Preamble to first 10 bit interval in Payload (f1-f0).

Maximum drift between Payload and Preamble (fn-f0) (along with index number at which the
drift is maximum).

Maximum drift between two 10 bit intervals spaced 50 µs away (fn-fn-5) (along with index
number at which the drift is maximum).

The Preamble region in which the Preamble offset is calculated is shown in the BT Freq Dev vs Time
display along with markings to show the region in which maximum drift occurred. Maximum drift
between Payload and Preamble is shown from the end of Preamble to the end of 10 bit interval in
Payload in which maximum drift occurred. Maximum drift in payload (in 50 μs duration) is also shown.

In the Summary display, the scalar results (mentioned above) averaged over the last 10 packets are
shown along with the packet count. The results are compared against recommended limits. You can
set these limits in the Limits tab of the Settings control panel.

In-band Emissions (Basic Rate and Low Energy)

This measurement verifies that the in-band spectral emissions are within limits. The standard document
recommends that this measurement be done with Hopping off, finding the integrated power in 1 MHz
band (with RBW 100 kHz) in 80 channels starting from 2401 MHz to 2481 MHz. The test can be done in
Direct Tx mode. The integrated power values calculated in the adjacent channels are compared against
recommended limits (except the three channels around transmitted frequency). This measurement is
referred to as ACPR in the Radio Frequency Test Specification for Basic Rate. It is recommended to do this
measurement in Free Run mode (set in Setup > Trigger) if the analyzer does not support the required BW
(80 MHz). The measurement internally searches for burst and aligns the measurement to the on-slot region.

NOTE. For analyzers with limited bandwidth, this measurement will be done over multiple acquisitions to
generate the data required for the entire span. Therefore, it is important for the user to set an analysis
length that will ensure that on slot region is always included.
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More information about this measurement:

Select the In-band Emissions test setup from Presets > Standards to perform the in-band emissions
measurements. This will load the displays found in the Bluetooth standards, test setups, and Preset
displays table .

The In-band Emissions display will set the Center Frequency to 2.441 GHz by default. When the
Retain CF option is not enabled from Standards Presets, 80 bands (each of bandwidth 1 MHz) are
analyzed and the integrated power is found (indicated by Blue lines in the plot).

The integrated power is compared against limits for comparison (shown by white masks) in all bands
except the three channels around the transmitted frequency. If any band fails, that band is shown in
red color. If more than three channels fail to meet the recommended limits, a FAIL is shown in the
top left corner of the display.

The table below the plot shows the integrated power and also the limit for comparison.

The limits for comparison are set to the values given by the standard by default, but you can manually
set them from the Limits tab of the Settings control panel.

This measurement is done only on the on slot region if a ramp-up and ramp-down portions are
available. However, the measurement is done on the complete analysis region if a ramp up or ramp
down is not available. It is recommended that a complete packet is included in the analysis region.

When the analyzer does not support the 80 MHz bandwidth requirement, multiple acquisitions are
taken in different bands and stitched together. This measurement is therefore best done in Free Run
mode (set in Setup > Trigger) as Triggered mode might not find a proper edge in an acquisition
taken for stitching purposes.

Output Power (Basic Rate and Low Energy)

This test verifies the maximum peak and average power emitted from the EUT. The standards document
recommends this test be done for a PRBS payload pattern. Also, the measurement must be done over
the duration of a burst starting at preamble position. The Bluetooth test specification recommends this
measurement be done using fixed frequency, also known as hopping off, and can be done in Direct Tx mode.

More information about this measurement:

Select the Modulation/Frequency Offset/Drift/Output Power test setup from Presets > Standards to
perform carrier frequency offset and drift measurements. This will load the displays found in the
Bluetooth standards, test setups, and Preset displays table .

Calculates the average power and peak power for any Bluetooth signal. The peak power is the peak
power value in the chosen on slot region.

The measurement is done only on preamble detection; otherwise, it is invalid.

The BT Summary display shows the averaged result over 10 packets.
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20dB Bandwidth (Basic Rate)

This measurement verifies if the emissions inside the operating frequency range are within limits. This
measurement is done with Hopping off. The difference between frequency points at which the power level
drops to 20 dB below the peak power of the emission is found at 20 dB Bandwidth.

More information about this measurement:

Select the 20dB Bandwidth test setup from Presets > Standards to perform the 20 dB emissions
measurements. This will load the displays found in the Bluetooth standards, test setups, and Preset
displays table .

The BT 20 dB BW display allows you to set the relative power level (x dB BW) compared to the peak
power at which the frequency points are to be found.

When you select the 20dB Bandwidth test setup, the center frequency (CF), span, and relative
bandwidth (RBW) are set as recommended by the standard document.

It is recommended this measurement be done over three different center frequencies. You can do
this by changing the center frequency as needed.

From the Params tab of the Settings control panel, you can select that the search for the x dB relative
power (20 dB in this case) be performed in one of two modes: from the edges towards the peak power
(inwards) or vice versa (outwards). The default for this setting is Inwards (from edges to peak power)
when this measurement is chosen from the Standards Preset menu, as recommended.

The blue markings in the plot indicate the 20 dB bandwidth and the frequency points at which the
power level drops down by 20 dB from the peak power.

The resulting 20 dB bandwidth is compared with the limits recommended by the standard document
and Pass/Fail is shown in the top left corner of the plot. This is not user defined.

If the highest power value measured in step d) is equal or higher than 0 dBm: f = |fH - fL| ≤ 1.0 MHz.

If the highest power value measured in step d) is lower than 0 dBm: f = |fH - fL| ≤ 1.5 MHz.

Frequency Range (Basic Rate)

These measurements verify if the emissions inside the operating frequency range are within limits. These
measurements are done with Hopping off in two steps. The first measurement is done at the lower
frequency spectrum of the Bluetooth band. (Start – 2399 MHz and Stop 2405 MHz). The second is
done at the higher frequency spectrum of the Bluetooth band (Start -2475 MHz and Stop at 2485 MHz).
The difference between the frequency point at which the power level drops to -30 dBm from the center
frequency is measured. fL is the difference on the lower side from the center frequency when the lower
end of the spectrum is being analyzed. fH is the difference from the center frequency on the higher side
when the higher end of the spectrum is analyzed. fH – fL is the Frequency Range.

More information about these measurements:

The BT 20dB BW display allows you to set the absolute power level (x dBm level) from the
Parameters tab of the Settings control panel. The Bluetooth SIG Radio Frequency test specification
document suggests that this value be set to -30 dBm for doing the Frequency Range measurement.
If you chose to set up this measurement using start and stop frequencies and RBW, those should be
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set as recommended by the standard. Separate start and stop frequencies are given for the two steps
of this measurement.

You can select for the analysis to find the x dBm frequency difference from the center frequency either
on the lower side, higher side, or both sides. This option (Meas Range) can be set from the Params tab
of the Settings control panel.

The blue marking indicates the frequency difference from the center frequency based on the Meas
Range option choice. You can set this option to Low while analyzing in the lower range of the
frequency spectrum, and set it to High when analyzing the higher range of the frequency spectrum.

Power Density (Basic Rate)

This measurement verifies the maximum RF output power density.

More information about this measurement:

This measurement can be done using the Spectrum display (Displays > Measurements > General
Signal Viewing) and by setting appropriate parameters as recommended in the Bluetooth SIG Radio
Frequency test specification document.

The Bluetooth test specification recommends this measurement be done using fixed frequency, also
known as hopping off, and can be done in Direct Tx mode.

Out-of-band Spurious Emission (Basic Rate and Low Energy)

This measurement can be done for FCC or ETSI masks using the Spurious display.

Relative Power (Enhanced Data Rate)

This measurement calculates the relative power in the GFSK and PSK part of the Enhanced Data Rate
(EDR) signal. This measurement is supported only when an EDR signal is detected.

Select the Enhanced Data Rate standard from Presets > Standards to perform the measurement. This will
load the displays found in the Bluetooth standards, test setups, and Preset displays table .

Bluetooth Status Messages

The following status messages may appear. Each message indicates the related condition (Description)
shown in the following table.
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Status message Description

Bluetooth Analysis: Preamble Not Detected Shown in the display and status bar when no valid Sync and
Preamble are found for the chosen standard. Also shown when
no preamble is found for any of the standards in Automatic
Standard Detection mode.

Bluetooth Analysis: Low Energy Sequence Detected Shown in the status bar when the Low Energy standard is
detected in Automatic Standard Detection mode.

Bluetooth Analysis: Basic Rate Sequence Detected Shown in the status bar when the Basic Rate standard is detected
in Automatic Standard Detection mode.

Bluetooth Analysis: EDR Signal Detected Shown in the status bar when the EDR standard is detected in
Automatic Standard Detection mode.

Bluetooth Analysis: EDR Sync Word Not Detected Shown in the display and status bar when EDR Sync Word is not
found (when EDR standard is selected).

Bluetooth Analysis: Not enough payload data for
Bluetooth measurements

Shown in the display and status bar when Preamble and Access
Address/Sync Word is detected but there is not enough payload
data for Modulation Characteristics and CF Offset and Drift
measurement.

Bluetooth Analysis: Meas BW may be too low Shown in the InBand Emission display and in status bar when
Measurement Bandwidth is too low.

Bluetooth Analysis: BT x dB BW detection failed Shown in the BT 20 dB BW display when x dB measurement
detection fails.

Bluetooth Analysis: BT x dBm BW detection failed Shown in the BT 20 dB BW display when x dBm measurement
detection fails.

xxx

Bluetooth Constellation display

The BT Constellation display shows a digitally modulated signal in constellation form. The constellation
can be viewed either as IQ or Freq Dev. The default view is Freq Dev. The frequency deviation result that
is shown in the Constellation display is compensated for the frequency error (shown as readout).

To show the BT Constellation display you can select Presets > Standards > Bluetooth or do the following:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays window, select Bluetooth Analysis in theMeasurements box.

4. In the Available displays box, double-click the BT Constellation icon or select the icon and click
Add. The BT Constellation icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click the OK button to show the display.

6. Select Setup > Settings to display the control panel.

7. Select the Standard Params tab. Set the Standard, Power class (if required), and Measurement and
Reference filters as appropriate for the input signal. You can also check theAuto Detect Standard box.

8. Select the Trace tab and set the Trace Type to Freq Dev or IQ, as required.
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9. Select Replay/Run to take measurements on the acquired data.

10. If you are analyzing a data file, click the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the BT Constellation display of QPSK data in an EDR signal. Trace Type
is set to IQ.
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Item Display element Description

A Trace Select and enable a trace.

B Trace Type Specifies Trace type (choice between Freq Dev and IQ). This option appears
only when EDR signal is detected.

C Freq Eror / Freq Offset /
marker readouts

The Freq Error, Freq Offset, and marker readout values appear here or below
the plot, depending on the display view and size.

The Freq Error value is the difference between the maximum and the
minimum values of signal frequency during the measurement time. The Freq
Error (Auto) value is displayed when the Auto check box is selected in the
Analysis Params tab in the Settings control panel.

The Freq Offset (Manual) value is displayed when the Auto check box is
unselected in the Analysis Params tab in the Settings control panel.

When markers are enabled, marker information (including time, magnitude,
phase, symbol, and value) is displayed.

D Avg Dev Shows the average deviation result at every symbol point.

E Plot Bluetooth constellation graph. Shown as either IQ or as Frequency Deviation.
The trace type is controlled from the Settings > Trace tab.

F Show Vectors Specifies whether to show or hide the selected trace.

xxx

The following image shows the BT Constellation display of GFSK data in a Basic Rate signal. Trace
Type is set to Freq Dev.

BT Constellation Settings

Main menu bar: Setup > Settings

Favorites toolbar:
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The BT Constellation Settings control panel provides access to settings that control parameters of the
Constellation Display.

Settings tab Description

Standard Params Select the standard, measurement filters, and power class (when applicable). You can
also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can
also select to auto detect test patterns. These parameters are used by the instrument to
analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for Bluetooth Analysis displays.

Trace Allows you to select the trace to view, the trace type (IQ or Freq Dev), the number of
points per symbol (when trace content is set to Vectors or Lines), and to show or freeze
the selected trace.

Prefs Allows you to select to show or hide the graticule and marker readouts.

xxx

Bluetooth Eye Diagram display

The BT Eye Diagram display shows a digitally modulated signal overlapped on itself to reveal variations
in the signal.

To show the BT Eye Diagram display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. From theMeasurements box, select Bluetooth Analysis.

4. Double-click the BT Eye Diagram icon in the Available Displays box. This adds the BT Eye
Diagram icon to the Selected displays box.

5. Click OK button. This displays the BT Eye Diagram view.

6. Select Setup > Settings to display the control panel.

7. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement
and Reference filters as appropriate for the input signal. You can also check the Auto Detect
Standard box.

8. Select the Trace tab and set the Trace Type to Freq Dev or IQ, as required..

9. Select Replay/Run to take measurements on the acquired data.

10. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the BT Eye display of a basic rate signal with Trace Type set to IQ.
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Item Display element Description

A Freq Error / Freq Offset The Freq Error value is the difference between the maximum and the
minimum values of signal frequency during the measurement time. The Freq
Error (Auto) value is displayed when the Auto check box is selected in the
Analysis Params tab in the Settings control panel.

The Freq Offset (Manual) value is displayed when the Auto check box is
unselected in the Analysis Params tab in the Settings control panel.

B Top of graph The vertical scale is normalized with no units (for IQ) and with Hz (for Freq
Dev).

C Position Specifies the value shown at the center of the graph display.

D Bottom Readout Displays the value indicated by the bottom of graph.

E Autoscale Adjusts the vertical and horizontal settings to provide the best display.

F Position Displays the horizontal position of the trace on the graph display.

G Scale Adjusts the span of the graph in symbols.

H Plot Displays the input signal.

xxx

The following image shows the BT Eye display of a Basic Rate signal with Trace Type set to Freq Dev.
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BT Eye Diagram Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the BT Eye Diagram display are shown in the following table.

NOTE. You might save time configuring the BT Eye Diagram display by selecting the Standard Presets
button in the Bluetooth Eye Diagram Settings control panel. This allows you to select a preset optimized
for the selected standard.
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Settings tab Description

Standard Params Select the standard, measurement filters, and power class (when applicable). You can
also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can
also select to auto detect test patterns. These parameters are used by the instrument to
analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for Bluetooth Analysis displays.

Trace Allows you to select the trace to view, the trace type (IQ or Freq Dev), the number of
points per symbol (when trace content is set to Vectors or Lines), and to show or freeze
the selected trace.

Scale Allows you to specify the horizontal and vertical scale settings.

Prefs Allows you to select to show or hide the graticule and marker readouts.

xxx

Bluetooth Carrier Frequency Offset and Drift display

The BT CF (Carrier Frequency) Offset and Drift display shows the frequency offset preamble, payload
regions, and the drift result values are shown in this display. You can also view the values of frequency
offset calculated in every ten bit interval in the payload and look for excursions.

To show the BT CF (Carrier Frequency) Offset and Drift display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select Bluetooth Analysis in theMeasurements box.

4. In the Available displays box, double-click the BT CF Offset and Drift icon or select the icon and
click Add. The BT CF Offset and Drift icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the display.

6. Select Setup > Settings to display the control panel.

7. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement
and Reference filters as appropriate for the input signal. You can also check the Auto Detect
Standard box.

8. Select the Limits tab and set the limits , as required.

9. Select Replay/Run to take measurements on the acquired data.

10. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.
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Elements of the Display

The following image shows the frequency offset and drift values of a basic rate signal in the BT Freq
Offset and Drift display.
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Display element Description

Column 1 Indicates ten bit interval numbers. Zero indicates preamble region and the
non-zero number indicate the ten bit intervals in payload.

Column 2 Shows the calculated frequency offset in the preamble and the ten bit intervals
in the payload.

Column 3 Shows the drift of offset from the preamble and over a 50 μs duration.

Column 4 Shows the drift of offset over a 50 μs duration.

— Results that do not meet the limits are shown with a red colored background,
indicating failure. (Limits can be set in the Limits tab from the Settings control
panel.)

Scalar results The scalar results show below the table. They are as follows:

Freq Offset Preamble

Max Freq Offset (Payload)

Drift f1-f0

Max Drift fn-f

Max Drift fn-f(n-5)

xxx

BT CF Offset and Drift Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the BT CF Offset and Drift display are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, and power class (when applicable). You can
also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can
also select to auto detect test patterns. These parameters are used by the instrument to
analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for Bluetooth Analysis displays.

Limits Allows you to load and define Bluetooth measurement limits for Pass/Fail comparison.
You can save defined limits as a .csv file and also load previously saved .csv files. These
limits also apply to the Settings control panel Limits tab of the BT Summary display.

xxx

Bluetooth Summary display

The BT Summary display shows a summary of all the scalar measurements done on the acquired test
pattern. The summary display and contents will vary according to the selected standard.
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Pass/Fail information is also provided in this display for all enabled scalar measurements. You can set
limits and choose which measurement to compare for Pass/Fail from the Limits tab of the BT Summary
Settings control panel. The default limits come from the performance recommendation limits given by the
Standards document. The default limits can be reloaded by selecting the Bluetooth Standards Preset option.

The results presented in the BT Summary display include scalar results of modulation characteristics,
frequency offset and drift and, output power measurements (these are averaged over the last 10 acquired
packets). The display also shows packet related information for the current acquired packet.

To show the BT Summary display you can select Presets > Standards > Bluetooth or do the following:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select Bluetooth Analysis in theMeasurements box.

4. In the Available displays box, double-click the BT Summary icon or select the icon and click Add.
The BT Summary icon will appear in the Selected displays box and will no longer appear under
Available displays.

5. Click OK to show the display.

6. Select Setup > Settings to display the control panel.

7. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement
and Reference filters as appropriate for the input signal. You can also check the Auto Detect
Standard box.

8. Select the Limits tab and set the limits , as required.

9. Select Replay/Run to take measurements on the acquired data.

10. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the display

The following image shows all average scalar results and packet information for a Basic Rate signal
in the BT Summary display. Modulation characteristics, carrier frequency offset and drift, and power
measurements, along with packet information, are shown. The packet information will vary depending
on the chosen or detected standard. For more information about specific measurement results, see the
Bluetooth measurements and test setups section here (see page 437).
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Element Description

Standard Display of the selected standard or the detected standard (if the Auto Detect Standard
setting is chosen in the Standard Params tab of the Settings control panel).

Power class Display of the Power class in the Standard Params tab of the Settings control panel. Only
available when Basic Rate is the selected or detected standard.

Clear Click button to reset measurement. Clears all values and all results in the queue used
for average computation.

Modulation characteristics

(ten packet average)

Display of a group of scalar results related to Modulation Characteristics measurements.
These scalar results are only populated in the BT Summary display if preamble is
detected in the acquired data. The four scalar results are:

Δf1avg is calculated when analyzed test pattern (payload) is 11110000.

Δf2avg and the percentage of Δf2max value (greater than a given limit) are calculated
only when analyzed test pattern (payload) is 10101010.

The ratio of Δf2avg and Δf1avg is calculated provided both the results are available
(or have been done before).

All the results given are averaged over the last ten packets. The scalar results can
be compared with pass/fail limits set in the Limits tab of the Settings control panel.

More information can be found here (see page 437).

Frequency offset and drift

(ten packet average)

Display of a group of five scalar results related to the carrier frequency offset and drift
measurement. These scalar results are only populated in the BT Summary display if
preamble is detected and if the test pattern payload is a 10101010 pattern. All the results
given are averaged over the last ten packets. The scalar results can be compared with
pass/fail limits set in the Limits tab of the Settings control panel.

The five scalar results are:

Preamble offset.

Maximum offset in Payload (calculated over 10 bit intervals).

Drift (f1-f0)

Max Drift (fn-f0).

Max Drift (fn-fn-5).

For more information about this measurement, see the Carrier frequency offset and
drift (Basic Rate and Low Energy) (see page 476) topic in Bluetooth Measurements
and test setups.

Output power Display of Average Power and Peak Power scalar results for Output Power. All the
results given are averaged over the last ten packets. The scalar results can be compared
with pass/fail limits set in the Limits tab of the Settings control panel.

For Enhanced Data Rate signals, the relative power in GFSK and PSK regions is
measured.

For more information about this measurement, see the Output Power (Basic Rate and
Low Energy) (see page 443) topic in Bluetooth Measurements and test setups.

Packet information The Packet information includes the Packet type, Preamble, Synchronization Word or
Access Code, Packet Header, Payload length, and CRC details. The decoded bits are
shown for the current analyzed packet.

xxx

492 SignalVu-PC Printable Help



Bluetooth Analysis Bluetooth Summary display

The following image shows all average scalar results and packet information for a Low Energy signal
in the BT Summary display.

The following image shows all average scalar results and packet information for an EDR signal in the
BT Summary display.
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BT Summary Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the BT Summary display are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, and power class (when applicable). You can
also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can
also select to auto detect test patterns. These parameters are used by the instrument to
analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for Bluetooth Analysis displays.

Limits Allows you to load and define Bluetooth measurement limits for Pass/Fail comparison.
You can save defined limits as a .csv file and also load previously saved .csv files. The
frequency offset and drift limits set here also apply to the CF Offset and Drift display.

xxx

Bluetooth Symbol Table display

The BT Symbol Table display shows decoded data values for each data symbol in the analyzed signal
packet. It is like the BT Constellation display except that a text table is used to display data instead
of a graph.

To show the BT Symbol Table display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select Bluetooth Analysis in theMeasurements box.

4. In the Available displays box, double-click the BT Symbol Table icon or select the icon and click
Add. The BT Symbol Table icon will appear in the Selected displays box and will no longer appear
under Available displays.

5. Click OK to show the display.

6. Select Setup > Settings to display the control panel.

7. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement
and Reference filters as appropriate for the input signal. You can also check the Auto Detect
Standard box.
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8. Select the Limits tab and set the limits , as required.

9. Select Replay/Run to take measurements on the acquired data.

10. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Regions of the Display

The BT Symbol Table is color coded to indicate different regions of the packet. The legend at the bottom
of the symbol table lists the packet contents in their associated colors. The following image shows values
for a Basic Rate signal.
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Packet standard Associated regions

Basic rate 4 bit preamble

64 bit access code

4 bit trailer

54 bit packet header

8 or 16 bit payload header based on packet type

Variable length payload data

16 bit CRC (Cyclic Redundancy Check)

Low energy 8 bit preamble

32 bit access address / synchronization word

16 bit payload header

Variable length payload data (37 bytes)

24 bit CRC (Cyclic Redundancy Check)

Enhanced Data Rate (EDR) 4 bit preamble

64 bit access code

4 bit trailer (if present, shown in black)

54 bit packet header

Guard region (shown as X)

EDR sync sequence (QPSK or 8PSK symbols)

16 bit payload header (QPSK or 8PSK symbols)

Variable length payload data (QPSK or 8PSK symbols)

16 bit CRC (Cyclic Redundancy Check) (QPSK or 8PSK symbols)

xxx

The following image shows values for a Low Energy signal.
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The following image shows values for an EDR signal.

Markers and the BT Symbol Table. Markers are indicators in the display that you can position on a trace
to measure values such as frequency, power, and time. A Marker always displays its position and, if the
Delta Marker (M1-M4) readout is enabled, will display the difference between its position and that of the
Marker Reference (MR). In the BT Symbol Table, colored cells indicate the location of markers. The
selected Marker is highlighted with a light green background. All other markers are highlighted with a
light gray background. In the BT Symbol Table, the marker readout below the table shows the marker
location in time, symbol numbers and symbol value.

BT Symbol Table Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the BT Symbol Table display are shown in the following table.
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Settings tab Description

Standard Params Select the standard, measurement filters, and power class (when applicable). You can
also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can
also select to auto detect test patterns. These parameters are used by the instrument to
analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for Bluetooth Analysis displays.

Prefs Allows you to select to show or hide the marker readouts and set the radix of shown
symbols.

xxx

Bluetooth Frequency Dev vs Time display

The BT Freq Dev vs. Time display shows how the signal frequency varies with time.

To display the BT Freq Dev vs. Time display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Select the Displays button or Setup > Displays.

3. In the Select Displays dialog, select Bluetooth Analysis in theMeasurements box.

4. In the Available displays box, double-click the BT Freq Dev vs. Time icon or select the icon and
click Add. The BT Freq Dev vs. Time icon will appear in the Selected displays box and will no
longer appear under Available displays.

5. Click OK to show the display.

6. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement
and Reference filters as appropriate for the input signal. You can also check the Auto Detect
Standard box.

7. Select the Trace tab and set the Content to Vectors or Points, as required.

8. Select Replay/Run to take measurements on the acquired data.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the frequency deviation of the complete packet of a Basic Rate signal in the
BT Freq Dev vs. Time display.
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Item Display element Description

A Top of graph The vertical scale is normalized with Hz.

B View (This option is visible only when Preamble is detected.)

Select one of the following:

Packet: view frequency deviation for an entire packet.

Octet: view frequency deviation for a specified octet duration (8 μs). The
Octet is specified in the Octet # field.

C Octet # (xx of total) (This option is visible only when Preamble is detected and Octet is selected
as the View.)

Specifies the Octet number. (The total number of octets is also indicated.)
When View is set to Octet, you can enter a particular octet in the Octet # field
for zoom view. The plot will show only 8 μs of information corresponding to
the octet number chosen in the payload. The regions that are used for doing
the exact measurements are highlighted in the Octet View. For F0F0 (Low
Deviation) pattern in payload, bit intervals 2,3,6,7 regions are highlighted
and for 1010 (high deviation) pattern, all bit regions are highlighted with
appropriate results. The offset calculated for every octet region (f1ccf or
f2ccf) are also shown.

D Position (center) Adjust the frequency shown at the center of the display.

F Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the
best display.

G Position Displays the horizontal position of the trace on the graph display.

H Scale Adjusts the horizontal scale (time).

I Plot Displays the last analyzed complete packet or the selected octet (Octet zoom
view) of the signal.

J Scalar results The Scalar results for Modulation Characteristics and Frequency Offset
and Drift measurements are captured here. These results are from the last
analyzed packet and therefore could be different from the Averaged Scalar
results shown in the BT Summary display.

For Drift results, the index is also shown where the maximum drift occurred.
The Drift results are shown only when the preamble is detected and the test
pattern payload detected is 10101010. ΔF1avg or ΔF2avg is shown only
when the detected test pattern payload is (10101010) or (11110000).

xxx

NOTE. This display shows the frequency deviation results without compensating for the frequency error.
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The following image shows the frequency deviation of the first octet in the payload of a Basic Rate
signal (high deviation).

The following image shows the frequency deviation of the first octet in the payload of a Basic Rate
signal (low deviation).
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BT Frequency Dev Vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for BT Freq Dev vs. Time are shown in the following table.

Settings tab Description

Standard Params Select the standard, measurement filters, and power class (when applicable). You can
also set the analyzer to auto detect the standard.

Analysis Params Specifies frequency error, frequency offset, measurement BW, and test patterns. You can
also select to auto detect test patterns. These parameters are used by the instrument to
analyze the input signal.

Analysis Time Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) and Time Zero
Reference (Trigger or Acquisition Start) for Bluetooth Analysis displays.

Trace Allows you to select the number of points per symbol, content, and to choose between
entire packet view or zoom Octet view for a chosen octet number in a packet.

Scale Allows you to specify the horizontal and vertical scale settings.

Prefs Allows you to select to show or hide the graticule and marker readouts.

xxx

Bluetooth 20dB Bandwidth display

The BT 20dB BW display shows the results of two Bluetooth measurements: 20dB Bandwidth and
Frequency Range. When the xdB BW is chosen, the display shows the x dB bandwidth from the peak
power. More detailed information about this measurement is available here (see page 437).

To display the BT 20dB BW display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Select the Displays button or Setup > Displays.

3. In the Select Displays dialog, select Bluetooth Analysis in theMeasurements box.

4. In the Available displays box, double-click the BT 20dB BW icon or select the icon and click Add.
The BT 20dB BW icon will appear in the Selected displays box and will no longer appear under
Available displays.

5. Click OK to show the display.

6. Select the Standard Params tab. Set the Standard, Power class (when appropriate), and Measurement
and Reference filters as appropriate for the input signal. You can also check the Auto Detect
Standard box.
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7. Select the Trace tab and set the Content to Vectors or Points, as required.

8. Select Replay/Run to take measurements on the acquired data.

9. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image of the BT 20dB BW display shows a Basic Rate signal that would allow you
to measure 20 dB bandwidth.
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Item Display element Description

A PASS / FAIL Indicates Pass or Fail for the 20 dB BW measurement.

B Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

C Normal / MaxHold Indicates whether the measurement is done with a MaxHold or a Normal
condition.

D Clear Resets count for Average and MaxHold functions. Enabled only when
Averaging or MaxHold is enabled. Pressing Clear will clear the trace and, if
acquisition is running, restart the averaging or hold process.

E Main results area Shows the xdBm and xdB results. The requested dB or dBm value can be
set in the controls below the result readout. Use the two radio buttons to
select which of the two results are illustrated in the graph with the blue lines
and arrows. RBW also can be set using the control. VBW enables the VBW
(Video Bandwidth) filter. Displays current VBW filter setting. See Setup >
Settings > Freq & RBW tab.

F Position and dB/div Position sets the top of graph value. The dB/div setting is the vertical scale
value.

G Bottom readout Displays the value indicated by the bottom of graph.

H Position Displays the horizontal position of the trace on the graph display.

I Scale Adjust the span of the graph in symbols.

Displays the following additional measurements results:

Freq Error: The frequency difference between the measured carrier
frequency of the signal and the user-selected center frequency of the
analyzer.

J Detailed results

x db BW Ref Power: The peak power measured within the measurement
bandwidth.

K Grid divider Determines the portion of the display allocated to the graph and detailed
results area. You can move the grid divider all the way to the top or bottom
and any position in between.

L Blue lines Indicates the measurement positions.

M Plot Displays the input signal. Shaded areas indicate the measurement bandwidth
(Settings > Parameters tab > Measurement BW).

xxx

BT 20dB BW settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for BT 20dB BW are shown in the following table.
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Bluetooth Analysis Bluetooth InBand Emission display

Settings tab Description

Freq & RBW Allows you to specify the frequency, resolution bandwidth (RBW), step, and VBW used
for the MCPR measurements.

Parameters Allows you to specify the x dB level, Measurement Direction, Measurement BW, xdBm
level, xdBm Range, and to enable averaging and the Max Hold function.

Scale Allows you to define the vertical and horizontal axes.

Prefs Allows you to specify the radix of the marker readout and whether elements of the graphs
are displayed.

xxx

Bluetooth InBand Emission display

The BT InBand Emission display verifies whether the emissions inside the operating frequency range are
within limits. The power in adjacent channels of 1 MHz bandwidth around the frequency of transmission
are calculated and compared against limits. The integrated power in the 1 MHz band for the adjacent
channels is shown in a table below the plot.

To display the BT InBand Emission display:

1. If you are analyzing a stored data file, recall the data file now. Otherwise, go to the next step.

2. Select the Displays button or Setup > Displays.

3. In the Select Displays dialog, select BT Inband Emission in theMeasurements box.

4. In the Available displays box, double-click the BT Inband Emission icon or select the icon and click
Add. The BT Inband Emission icon will appear in the Selected displays box and will no longer
appear under Available displays.

5. Click OK to show the display.

6. Select the Standard Params tab and select the appropriate standard.

7. Select theMeasurement Params tab and turn on averaging, if desired.

8. Select the Limits tab and set the desired limits.

9. Select Replay/Run to take measurements on the acquired data.

10. If you are analyzing a data file, press the Replay button to take measurements on the recalled
acquisition data file.

Elements of the Display

The following image shows the BT Inband Emission display of a Basic Rate signal operating at 2.441 GHz
(showing 80 adjacent bands).
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Bluetooth Analysis Bluetooth Analysis Measurement Settings

Item Display element Description

A PASS / FAIL Indicates Pass or Fail based on the number of adjacent channels that are
below an upper limit. A maximum of 3 adjacent channels can have integrated
power higher than an upper limit (Pass); otherwise, Fail is reported.

B Normal Displays Average Count if Average is turned on (set to Time Domain or
Frequency Domain) from the Measurement Params tab in the Settings
control panel.

C Clear Resets measurement. Clears all values.

D Top of graph The vertical scale is normalized with appropriate power units.

E dB/div The vertical scale value.

F Bottom readout Displays the value indicated by the bottom of graph.

G Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

H Position Displays the horizontal position of the trace on the graph display.

I Scale Adjust the span of the graph in symbols.

J Plot Divides the spectrum into different adjacent channels (each of 1 MHz
bandwidth) as suggested in the standard document. You can select to show
integrated power by checking the Show power levels in graph box in the
Prefs tab in the Settings control panel). The integrated power level is shown
in blue and the prescribed limits for comparison (set in the Limits tab of the
Settings control panel) are shown in white. The region around the frequency
of transmission is shown in a different color.

K Results table Reports the integrated power results (Channel frequency, Integrated power,
and Limits) from the display in a table.

xxx

Bluetooth Analysis Measurement Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The control panel tabs in this section are shared between the displays in Bluetooth Analysis (Setup >
Displays). Some tabs are shared by all the displays, some tabs are shared by only a subset of displays. The
settings available on some tabs change depending on the selected display.
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Bluetooth Analysis Standard Params tab - BT

Common controls for Bluetooth Analysis displays

Settings tab Description

Standard Params (see
page 508)

Specifies the input signal standard and additional user-settable signal parameters.

Analysis Params (see
page 510)

Specifies parameters used by the application to analyze the input signal.

Analysis Time (see page 511) Specifies parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Symbols or Seconds) for Bluetooth
Analysis displays.

Trace (see page 514) Specifies the trace type (Vectors, Points, and Lines), the number of points per symbol
when chosen to view as Vectors or Lines, and to control the view as Freq Dev or IQ.

Prefs (see page 516) Allows preferences with Radix display and marker readouts.

Scale (see page 513) Defines the vertical and horizontal axes.

Parameters (see page 517) Specifies parameters used to analyze the signal.

Freq RBW (see page 519) Allows you to set Frequency and RBW settings for the BT 20 dB BW display.

Limits (see page 512) Allows you to define limits for pass/fail comparison with calculated values. The default
values are as recommended in the test specification.

Measurement Params (see
page 520)

Allows you to set average (Time Domain, Off, or Frequency Domain) and to correct
for noise floor.

xxx

Standard Params tab - BT

The Standard Params tab allows you to specify the standard, measurement and reference filters, power
class (for some standards), and set standard auto detect.

The following image shows the tab for all of the Bluetooth displays except for the BT InBand Emission
display. The Power Class menu only appears when Basic Rate is the selected standard.

The following image shows the tab for the BT InBand Emission display.
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Bluetooth Analysis Standard Params tab - BT

Settings Description

Standard Select the appropriate standard: Basic Rate, Low Energy, or Enhanced Data
Rate.

Auto Detect Standard Check box to enable automatic detection of the Bluetooth standard (Basic Rate,
Low Energy, or Enhanced Data Rate). A status message will appear indicating
which of the three standards is detected and the result will show as Standard
selection.

Measurement Filter Specifies the filter used for measurement. The default filters for the Low Energy
and Basic Rate standards are LE-Recommended and BR-Recommended,
respectively.

Reference Filter Specifies the filter used as a reference.

Power Class

(only available for Basic Rate)

Select one out of three available power classes. This sets the default limits for
comparison (set in the Limits tab of the Settings control panel) for Average and
Peak power measurements.

xxx

Power class for the Basic Rate standard

The power class for Basic Rate is the reference receive power range as specified by the standard. It sets
the default limits for comparison in the Limits tab of the control panel for Average and Peak power
measurements. The power classes are specified as follows:

Class 1: max power 20 dBm (100 mW) with mandatory power control.

Class 2: max power 6 dBm (4 mW) with optional power control.

Class 3: max power 0 dBm (1 mW) with optional power control.

Recommended measurement and reference filters

The available measurement and reference filters depend on the selected standard. You can use the filters
recommended by the standard (shown in following table) or load your own filters by selecting one of the
User defined filters from a file.

The measurement filter is applied before the demodulation bit is detected and the ideal reference is
calculated.

The reference filter is applied to the internally generated ideal reference signal.

CAUTION. Although there may be other filter types listed in the drop down menu, if you select any filter
other than that which is recommended, the measurement results may not be accurate.
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Standard Measurement filters Reference filters

Basic Rate BR-Recommended None

Low Energy LE-Recommended None

Enhanced Data Rate BR-Recommended None

xxx

How to select filters

In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for
another kind of necessary shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a
filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This
setting tells the analyzer what filter your receiver uses. When the analyzer is set to the same filter used by
the receiver, the analyzer sees the signal as your receiver would. The Measurement Filter setting should be
the same as the filter used in the receiver under normal operation (as opposed to testing).

Analysis Params tab - Bluetooth

The Analysis Params tab contains parameters that control the analysis of the input signal. The Test Patterns
menu only appears when the Auto Detect Test Pattern is not checked. This tab is available for all displays
except for the BT 20dB BW and the BT InBand Emission displays.

Settings Description

Frequency Error When the Auto box is checked, the analysis determines the Frequency Error
and the measured Frequency Error is displayed. When the Auto box is
unchecked, the entered value is used by the analysis as a fixed frequency
offset. This is useful when the exact frequency offset of the signal is known.

Measurement BW Specifies the bandwidth about the center frequency at which measurements
are made. Select Manual, Auto, or Link to Span.

Auto Detect Test Pattern When this box is checked, automatic detection of the test pattern is enabled.
When this box is unchecked (Manual mode), automatic detection id disabled
and you can select the test pattern and specify the Δfavg for the other pattern
for ratio computation.

Test Pattern Allows you to select the test pattern to be analyzed. This choice is available
only when Auto Detect Test Pattern is disabled.

xxx
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Bluetooth Analysis Analysis Time tab - Bluetooth

Analysis Time tab - Bluetooth

The Analysis Time tab contains parameters that define how the signal is analyzed in the Bluetooth
Analysis displays. This tab is available for all displays except for the BT 20dB BW and the BT InBand
Emission displays.

Settings Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in
either symbols or seconds, depending on the Units setting.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Available This is a displayed value, not a setting. It is the Analysis Length (time or symbols)
being used by the analyzer. This value may not match the Analysis Length requested
(in manual mode).

Time Zero Reference Specifies the zero point for the analysis time.

Units Specifies the units of the Analysis Length to either Symbols or Seconds.

xxx

Analysis Offset

Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (All time values are relative
to the Time Zero Reference.)

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).
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Bluetooth Analysis Limits tab - Bluetooth

Analysis Length

Use the analysis length to specify how long a period of time is analyzed. As you adjust this value, the
actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the control in
the "Available" readout. This setting is not available when Auto is checked. Range: minimum value
depends on the standard. Resolution: 1 symbol.

Time Zero Reference

All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.

Parameter Description

Acquisition Start Time zero starts from the point at which the acquisition begins.

Trigger Time zero starts from the trigger point.

xxx

Limits tab - Bluetooth

This tab is only available for the BT CF Offset and Drift, BT InBand Emission, and BT Summary displays.
It enables you to load an existing limits table, save a limits table, or edit limits values. The content under
Measurement Name varies based on the chosen standard and power class.

Some measurements are done only when a specific test pattern is detected. If the specific pattern is not
detected, then N/A appears in blue in the BT Summary display because the measurement is not done. If
the measurement is done, Pass or Fail is shown in the BT Summary display.

The following image shows the Limits tab for the BT CF Offset and Drift and BT Summary displays.

The following image shows the Limits tab for the BT InBand Emission display.
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Bluetooth Analysis Scale tab - Bluetooth

Settings Description

Load Click to load a saved Limits table from a .csv file.

Save Click to save the current Limits table to a .csv file.

xxx

Edit limits

To directly edit measurement limits in the table, click on the value in the Limit column that you want to
change. The following table describes the parameters that are set in the Limits Table.

Settings Description

On Click on the cell in the On column next to the measurement to specify whether or not
measurements are selected for limit comparison to indicate Pass or Fail. A check mark
means the measurement will be taken. An empty box means it will not be taken.

Measurement Name Specifies the name of the measurement related to the limit. (Not editable.) The content
under Measurement Name varies based on the chosen standard and power class.

Limit Specifies the value of the limit to the related measurement. When the cell is selected,
the value is shown along with the units.

xxx

Scale tab - Bluetooth

The Scale tab allows you to change the scale settings that control how the trace appears on the display
but does not change control settings such as Measurement Frequency. In effect, these controls operate
like pan and zoom controls. The Scale tab values are unique to each display. Also, note that each
display uses horizontal and vertical units that are appropriate for that display. There are three versions of
the Scale tab for Bluetooth displays.

The following image shows the Scale tab for the BT 20dB BW and BT InBand Emission displays.

The following image shows the Scale tab for the BT Eye Diagram display.
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Bluetooth Analysis Trace tab - Bluetooth

The following image shows the Scale tab for the BT Freq Dev vs Time display.

Settings Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale of the graph.

Position Adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the horizontal span of the trace display and position of the trace.

Scale Allows you to, in effect, change the horizontal span.

Position Allows you to pan a zoomed trace without changing the frequency.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto When Auto is checked, the scale and position values for the Symbols graph are
automatically adjusted to maintain the optimal display.

Reset Scale Resets all settings to their default values.

xxx

NOTE. The Units used for the horizontal scale for the BT Freq Dev vs Time display can be either Seconds
or Symbols. To set the units for the horizontal scale, display the Analysis Time tab. On the tab, select the
appropriate units from the Units drop-down list.

Trace tab - Bluetooth

The Trace tab allows you to set the trace display characteristics of the BT Constellation, BT Eye Diagram,
and BT Freq Dev vs Time displays. The selections vary depending on the selected display.

The following image shows the tab for the BT Constellation display.
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Bluetooth Analysis Trace tab - Bluetooth

The following image shows the tab for the BT Eye Diagram display.

The following image shows the tab for the BT Freq Dev vs Time display.

Setting Description

Trace Select the trace to display.

Show Shows / hides the selected by trace.

Freeze Halts updates to the selected trace.

Points/Symbol Select how many points to use between symbols when connecting the dots. Values: 1,
2, 4, 8, 16, and 32.

Content Select whether to display the trace as vectors (points connected by lines), points
(symbols only without lines), or lines (lines drawn between symbols, but no symbols are
displayed). The choices available depend on the display.

Trace Type Select to specify whether the plot is shown as IQ or as Frequency Deviation.

View Allows you to see the full packet or only the chosen Octet.

Octet # (of xx) Allows you to view the specified octet. You can also select from the list of the available
number of Payload octets in the packet.

xxx
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Bluetooth Analysis Prefs tab - Bluetooth

Comparing two traces in the BT Constellation display

You can use the Traces tab to enable the display of a second trace. The second trace is a version of
the current acquisition. You can choose to freeze a trace in order to display the current live trace to an
earlier version of itself, you can display the trace as a second trace, or you can choose to display both
traces frozen in order to compare the trace to itself at different times.

To display a second trace in the BT Constellation display:

1. If more than one display is present, select the BT Constellation display to ensure it is the selected
display.

2. Click .

3. Select the Trace tab.

4. Select Trace 2 from the Trace drop-down list.

5. Click the Show check box so that it is checked.

6. Specify the Content as desired.

The Trace 2 lines will appear in blue to help you distinguish Trace 2 from Trace 1.

Prefs tab - Bluetooth

The Prefs tab enables you to change appearance characteristics of some of the Bluetooth Analysis displays.

The following image shows the Prefs tab for the BT 20dB BW, BT Freq Dev vs Time, BT Eye Diagram,
and BT Constellation displays.

The following image shows the Prefs tab for the BT InBand Emission display.
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Bluetooth Analysis Parameters tab - Bluetooth

The following image shows the Prefs tab for the BT Symbol Table display.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker
readout in the display. There are three choices for Radix: Binary (0,1) and Modulation
Symbols (+1,-1). When EDR is detected, the symbol table will always show results
in Hex for the PSK region (after guard).

Trace detection +Peak: Shows the peak power in a bin (of chosen RBW) if there are multiple points to
choose from within a bin.

Avg (VRMS): Shows the average power in a bin (of chosen RBW) if there are multiple
points to choose from within a bin.

Show power levels graph Displays the calculated power levels in graph in each band.

xxx

Parameters tab - Bluetooth

The Parameters tab enables you to specify several parameters that control signal acquisition in the BT
20dB BW display.
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Bluetooth Analysis Parameters tab - Bluetooth

Setting Description

x dB level x dB level defines the x dB BW level search threshold.

Meas Direction Specifies which way the search for the x dB level is done. Selecting Inwards directs the
search for x dB from the edges towards maximum power. Selecting Outwards directs
the search for x dB from maximum power (x dB ref power) to edges.

x dBm level x dBm level defines the x dBm BW level search threshold.

x dBm range Specifies the search direction for the x dBm level. The choices are Lower, Higher, or Both.

Measurement BW Specifies the frequency range used by the measurement.

Max Hold spectral data Enables the Max Hold function.

Average results Enables/disables results average across acquisitions. (This is averaging of the results,
not of the trace.)

Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to
10,000.

xxx

x dB level

The x dB level determines the x dB bandwidth. The analyzer analyses the spectrum trace to locate the
frequencies at which the level is x dB down from the peak level, calculated over the measurement
bandwidth. The frequency difference between the upper and lower crossing thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -20 dB

Meas Direction

The search for the x dB level or x dBm level can be done by selecting Inwards or Outwards in Meas
Direction. Selecting Inwards directs the search from the edges towards maximum power. Selecting
Outwards directs the search from maximum power (x dB ref power or CF for x dBm) to edges.

x dBm level

The x dBm level determines the x dBm bandwidth. The analyzer analyzes the spectrum trace to locate
the frequencies at which the level is x dBm down from the Center frequency. The frequency range is
calculated based on the choice of x dBm Range. The value of x dBm is set to -30 dBm when the BT 20dB
BW display is launched from the Bluetooth Standards Presets.

Meas Range (Higher, Lower, Both)

This determines the search range for the x dB level. The options are as follows:

Lower: Indicates the frequency range from center to the lower frequency at which the power level
drops to x dBm.

Higher: Indicates the frequency range from center to the higher frequency at which power level
drops to x dBm.

Both: Indicates the frequency between the upper and the lower crossing thresholds at which the
power level drops to x dBm.
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Bluetooth Analysis Freq & RBW tab - Bluetooth

Max Hold spectral data

Max Hold displays the maximum value in the acquisition record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Freq & RBW tab - Bluetooth

The Freq & RBW tab allows you to specify the bandwidth parameters used for setting measurement
bandwidth in the BT 20dB BW display. This determines what acquisition bandwidth the measurement
will request.

Setting Description

Meas Freq Specifies the measurement frequency.

RBW Select Auto or Manual. Adjusts the resolution bandwidth for the entire measurement.
This setting is independent of the Spectrum display’s RBW setting.

Step Sets the increment/decrement size for the adjustment of the center frequency. If Auto is
enabled, the analyzer will adjust the step size as required.

VBW Adjusts the video bandwidth.

xxx
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Bluetooth Analysis Measurement Params tab - Bluetooth

Measurement Params tab - Bluetooth

The Measurement Params tab is only available for the BT InBand Emission display. It allows you to select
the average domain and if you want to correct for noise floor.

Setting Description

Average Specify the average domain (Time Domain, Frequency Domain) or set Average to Off. If
a domain is selected, then you can also specify the number.

Number Specify the number value associated with the Average setting.

Correct for Noise Floor Check the box next to this setting to correct for noise floor. This is disabled (unchecked)
by default.

xxx
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Audio Analysis Overview

Overview

Audio Analysis (Option SVNL-SVPC or SVFL-SVPC) measures basic time- and frequency-domain
parameters of analog audio signals modulated on a carrier (AM, FM and PM modulation) or unmodulated
(non-carrier) audio signals (Direct).

For modulated signals, the measurement analysis first demodulates the signal to provide the Audio signal
waveform. Direct input signals bypass the demodulation step. For FM and PM demodulation, the carrier
frequency error is estimated during demodulation.

The Audio signal waveform excursions are then measured to determine the Peak and RMS waveform
parameters. Next, the analysis detects the highest-amplitude frequency component within the audio
bandwidth, and makes a high-accuracy frequency measurement of the frequency component. This value is
called the Audio Frequency.

A spectral analysis of the Audio signal waveform is performed to determine the presence and level of
harmonically- and/or non-harmonically-related narrowband spurs and wideband noise. The Audio
signal, harmonic and non-harmonic spurs, and noise level data are combined to produce signal summary
parameters including SINAD, Modulation Distortion, Signal-to-Noise, Total Harmonic Distortion, and
Total Non-Harmonic Distortion.

Controls are provided to allow the user to select audio filters of Low Pass, High Pass, FM De-emphassis,
or Standard-defined response, as well as completely user-definable filter response. Filtering can be applied
as needed to modify the audio spectrum result before measurement to remove unwanted spurs or noise.

Flexible control parameters are provided to allow setting the Audio Bandwidth for analysis, the Resolution
Bandwidth (RBW) and RBW filter type of the spectral analysis, and number and level qualifications for
Harmonic and Non-harmonic spur detection. Multiple-spectrum averaging can be enabled to provide a
smoothed spectrum for results with less variability than single-spectrum results.

The Audio Spectrum display shows the frequency spectrum waveform with detected harmonic and
non-harmonic components identified by markers, and a corresponding table of frequency and level values
for the spur components. The markers and table provide easy visualization of the significant spurs and
their relation to the fundamental Audio frequency signal.

Audio Spectrum Display

The Audio Spectrum display shows audio modulation characteristics. You can choose to show just the
spectrum of the audio signal or show the audio spectrum of the signal and the results of distortion
measurements. The Audio Spectrum display can show a table listing the frequency of a Harmonic
Distortion (HD) and Non-Harmonic Distortion (NHD) and its level. The Spectrum graph indicates these
harmonics and non-harmonics with special markers.

To display the Audio Spectrum display:

1. Recall an appropriate acquisition data file.

2. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.
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Audio Analysis Audio Spectrum Settings

3. From theMeasurements box, select Audio Analysis.

4. Double-click the Audio Spectrum icon in the Available Displays box. This adds the Audio Spectrum
icon to the Selected displays box.

5. Click the OK button. This shows the Audio Spectrum display.

6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Audio Spectrum Display

Item Display element Description

1 Vertical position Sets the top of graph value.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.

3 Audio BW Specifies the measurement bandwidth of the Audio Spectrum display, which
in turn can influence the acquisition bandwidth.

4 Table Displays a table that shows the distortion measurement results and displays
indicators on the graph that highlight the location of the harmonics on the
trace.

5 Bottom of graph readout Displays the bottom of graph value.

6 Non-harmonic threshold
indicator

Displays the threshold for detecting non-harmonic components.

7 Analysis results Display of the audio analysis results.

xxx

Audio Spectrum Settings

Main menu bar: Setup > Settings

Favorites toolbar:
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Audio Analysis Audio Summary Display

The measurement settings for the Audio Spectrum display are shown in the following table.

Settings tab Description

Params1 Tab (see page 525) Specifies signal type, Audio Bandwidth, RBW, RBW filter, and Ref Audio Frequency.

Params2 Tab (see page 528) Specifies Harmonics and Non-Harmonics measurement parameters.

Audio Filters Tab (see
page 528)

Specifies the audio filter characteristics.

Scale Tab (see page 531) Sets vertical and horizontal scale and position parameters.

Prefs Tab (see page 534) Specifies vertical units, and whether on not some features are displayed in the graph.

xxx

Audio Summary Display

To display the Audio Summary display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From theMeasurements box, select Audio Analysis.

3. Double-click the Audio Summary icon in the Available Displays box. This adds the Audio Summary
icon to the Selected displays box.

4. Click the OK button. This shows the Audio Summary display.

The Audio Summary Display

Audio Summary Displayed Measurements

Table 8: Audio Summary Measurements

Signal type Item Description

AM, FM, PM Carrier Power Average power of the carrier signal with
modulation removed.

Direct Signal Power Average power of the input signal

FM, PM Carr Freq Err Carrier frequency error
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Table 8: Audio Summary Measurements (cont.)

Signal type Item Description

AM, FM, PM. Direct Audio Freq Fundamental audio frequency

+Peak +Peak modulation excursion (where the
modulation excursion readout depends on the
signal type) 1

-Peak -Peak modulation excursion (where the
modulation excursion readout depends on the
signal type) 1

Peak-Peak/2 Half peak-peak modulation excursion (where the
modulation excursion readout depends on the
signal type) 1

RMS RMS modulation excursion (where the modulation
excursion readout depends on the signal type) 1

SINAD Signal to noise and distortion

Mod Distor Modulation distortion

S/N An estimate of the Signal level to Noise (only)
level, with the HD and NHD components removed

THD Total harmonic distortion

TNHD Total non-harmonic distortion

Ref Ref is the RMS modulation value stored when
the Capture Reference button is pressed.
(Displayed only when Hum & Noise is enabled.)

Diff Diff is the difference between the current RMS
mod value and the Ref value captured previously.
(Displayed only when Hum & Noise is enabled.)

xxx

1 For AM signal types, modulation excursion is "% Modulation Depth". For FM signal types, modulation excursion is "Frequency Deviation". For PM
signal types, modulation excursion is "Phase Deviation". For Direct, there is no modulation excursion, it is actually "signal excursion".

Audio Summary Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The measurement settings for the Audio Summary display are shown in the following table.
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Audio Analysis Audio Analysis Measurement Settings

Settings tab Description

Params1 Tab (see page 525) Specifies signal type, Audio Bandwidth, RBW, RBW filter, and Ref Audio Frequency.

Params2 Tab (see page 528) Specifies Harmonics and Non-Harmonics measurement parameters.

Audio Filters Tab (see
page 528)

Specifies the audio filter characteristics.

Hum Noise Tab (see page 533) Specifies whether or not Hum & Noise is measured and enables the capture of a signal
to be used as a reference of the Hum & Noise measurement.

xxx

Audio Analysis Measurement Settings

The control panel tabs in this section are shared by the displays in the Audio Analysis folder (Setup >
Displays).

Common controls for Audio Analysis displays

Settings tab Description

Params1 Tab (see page 525) Specifies characteristics about the audio signal and how measurements are made.

Params2 Tab (see page 528) Specifies parameters that control how measurements are made on harmonics.

Audio Filters Tab (see
page 528)

Specifies characteristics of filters applied to the signal before measurements are taken.

Scale Tab (see page 531) Sets vertical and horizontal scale and position parameters.

Prefs Tab for Audio Analysis
(see page 534)

The Prefs tab enables you to change appearance characteristics of the Audio Analysis
displays.

xxx

Params1 Tab

The Params1 tab is used to specify characteristics of the audio signal to be measured and how the signal
will be measured.

Params1 tab for AM signal types
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Setting Description

Signal Type Specifies the type of signal to be analyzed. The available choices are AM, FM, PM,
and Direct.

Audio BW Specifies the bandwidth used for audio analysis.

Ref Audio Freq A measured value when Auto is selected. If you want to specify the reference audio
frequency, uncheck Auto and enter a value manually. If Ref Audio Freq is set manually,
be aware that the automated detection is still performed, but it is limited to a frequency
range of ±1% of the Audio BW centered around the manually specified value.

Carrier Freq Error / Carrier
Freq Offset

(FM and PM only) A measured value, when Auto is selected. If Auto is unchecked, you
can specify the Carrier Frequency Offset.

RBW Displays the Resolution Bandwidth for Audio measurements. This value is automatically
set by default to 1/500 of the measurement bandwidth. To manually specify the
RBW, uncheck Auto. The minimum RBW value is limited to the larger of 1 Hz or
AudioBW/10000. The maximum is limited to AudioBW/100.

RBW Filter Specifies the windowing method used for the transform.

xxx

Setting Frequency for Direct Signal Types

Direct (unmodulated) signal analysis is only possible with the instrument Frequency control set to 0 Hz.
You will receive a warning to set Frequency to 0 Hz when Direct signal type is selected, if you haven’t
already done so. Modulated signal types may be selected with Frequency set to 0 Hz, but results are not
meaningful in that case. For modulated signals, Frequency should always be set to a value ≥ Audio
Bandwidth to avoid self-interference of the signal due to spectral folding.

Setting Audio Bandwidth

For AM, FM and PM, the Audio Bandwidth control sets not only the demodulated signal bandwidth, but
also determines the pre-demodulation bandwidth. Set it to a value at least half the pre-demodulation
signal bandwidth, as in this equation:

Audio BW ≥ Signal Bandwidth / 2

NOTE. When performing audio analysis, you should allow the Audio BW control to automatically set the
acquisition bandwidth, rather than manually adjusting the Acq BW control on the Sampling Parameters
tab of the Acquire control panel. The audio measurement will cause the Acq BW setting to be ≥ Audio
BW (Direct) or ≥ 2 × Audio BW (AM, FM, PM).

For Direct signals, set Audio Bandwidth large enough to include any significant harmonics/non-harmonics
or other signal component of interest. For example, to measure up to the 10th harmonic of a signal with a 5
kHz fundamental component, set Audio Bandwidth to 10 x 5 kHz = 50 kHz.

For modulated signals, Audio Bandwidth must be set wide enough to include all significant signal
modulation components in addition to the desired audio analysis bandwidth. For AM this is similar to
Direct. For example, to measure up to the 10th harmonic of an AM signal with 3 kHz fundamental
component, set Audio Bandwidth to 10 x 3 kHz = 30 kHz. This ensures that the bandwidth of the data
provided by the system to the measurement will be at least of 60 kHz (2 x 30 kHz) which is sufficient for
this signal and analysis requirement.
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FM and PM are more complex. For FM, the analysis bandwidth needs to be at least twice as wide as the
the sum of peak Frequency Deviation and the Fundamental Frequency (Carsons rule). This is a parallel
condition along with setting Audio Bandwidth large enough for the maximum audio bandwidth to analyze.
Therefore, for FM, Audio Bandwidth should be:

AudioBW (FM) = MAX( MaxAudioAnalysisFreq, FreqDeviation+FundamentalFreq )

where MaxAudioAnalysisFreq is the highest audio frequency desired in the analysis. For example, for
an FM signal with fundamental signal of 5 kHz and peak frequency deviation (one-sided) of 10 kHz,
Acquisition Bandwidth should be at least (2*(10k+5k)) = 30 kHz, or an Audio Bandwidth of 15 kHz. Also
if the analysis should extend to the 8th harmonic, then the Audio Bandwidth needs to be at least 8*5 kHz =
40 kHz. So Audio Bandwidth should be set to 40 kHz. Using the equation:

AudioBW(FM) = MAX( 8x5kHz, (10+5)kHz ) = MAX( 40 kHz, 15kHz) = 40 kHz

The formula for PM is:

AudioBW (PM) = MAX (MaxAudioAnalysisFreq, PMFreqDeviation+FundamentalFreq)

where

PMFreqDeviation = PMPhaseDeviationInRadians x FundamentalFreq

RBW Filter Shape

Select Kaiser in most cases for best measurement performance. Select Flattop only if you want to use
standard markers to measure signal amplitude with highest accuracy.
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Params2 Tab

The Params2 tab is used to specify how the signal harmonics are measured and to control spectrum
averaging.

Setting Description

No. of Harmonics Specifies the number of harmonics to detect. The detected harmonics are tagged with a
number on the spectrum trace. The available range is 1–20.

No. of Non-Harmonics Specifies the number of non-harmonics to detect. The detected non-harmonics are
tagged with a number on the spectrum trace. The available range is 0–20.

Averaging Specifies the number of averages used to compute the results. Range: 2–100.

Ignore region Specifies the region about the signal frequency where the instrument will ignore
non-harmonics.

Non-Harmonic Threshold Specifies the level which a spectrum peak must exceed to be declared a non-harmonic
signal component.

Non-Harmonic Excursion Specifies the difference in level between a spectrum peak and the average noise level
that must be exceeded for the peak to be declared a non-harmonic signal component.

xxx

About Averaging In Audio Analysis Displays

Analysis averaging is implemented using a “block” method. This means that the entire record required for
multiple spectrum computations is acquired and analyzed within one analysis cycle. The result of each
analysis update is a complete, independent result from a set of N spectrums averaged together, where N is
the Averaging control value.. Since each update is a fully averaged result, no partially averaged results
are output before a final result is available, so each output is fully valid. However, with large Averaging
values, acquisition record sizes and measurement times may become large, so care should be taken to
select the minimum amount of averaging needed.

Audio Filters Tab

The Audio Filters tab is used to specify filters to be applied to the acquired audio signal before
measurements are taken. You can select from pre-defined filters or use a filter you define in a text file.
You can also specify the de-emphasis time constant applied to the audio signal and the telecom weighting
filters used to measure noise.
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Pre-defined Filters

You can specify low-pass filter (LPF) and high-pass filter (HPF) settings, a de-emphasis time constant
and/or a telecom weighting filter to match the response of your receiver. Alternatively, you can create a
text file to specify the frequency response points.

To use pre-defined filters:

1. Select the Pre-defined Filters option button.

2. Select the LPF, HPF, De-emphasis and Standard check boxes as appropriate.

3. Select the desired filter parameter from the drop-down list for each of the enabled filters or select User
from the list if you wish to use a custom value. For LPF and HPF, the listed frequencies represent the
3dB cutoff point of the filter.

4. If you select User from the drop-down list, enter a value in the text entry box that appears.

To disable all filtering:

1. Select the Pre-defined Filters option button.

2. Deselect all four filter check boxes.

Table 9: Predefined audio filters

Filter type Available settings

300 Hz

3 kHz

15 kHz

30 kHz

80 kHz

300 kHz

LPF (Low Pass Filter)

(5th-order Butterworth response)

User 1

20 Hz

50 Hz

300 Hz

400 Hz

HPF (High Pass Filter)

(5th-order Butterworth response)

User 1
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Table 9: Predefined audio filters (cont.)

Filter type Available settings

25 μs

50 μs

75 μs

750 μs

De-emphasis (FM only)

User. Range: 25 μs to 10 ms

CCITTStandard

C-message

xxx

1 User-entered values are restricted to maximum of 0.9 * Audio BW, and will automatically adjust downward to meet this limit (if required) when
AudioBW is decreased.

Standard. Use this setting to specify the telecom weighting filter. The characteristics of these filters are
described in ITU-T Recommendation O.41, Psophometer for Use on Telephone-type Circuits.

Using Custom Audio Filters

If you want to use audio filters that have a different response shape than the pre-defined filters, you can
create a custom audio filter using a text or CSV file to specify the desired filter frequency response.

To use a custom audio filter:

1. Verify that Audio Spectrum or Audio Summary is the selected display.

2. Click the Settings icon or select Setup > Settings.

3. Select the Audio Filters tab.

4. Click the File button.

5. Click the ... button and navigate to the location of the custom audio filter file you wish to use. Select
the file you want to use and click Open.

6. Acquire a new trace or replay a saved file to see the effect of the custom filter.

Creating a Custom Audio Filter. A custom audio filter file is either a plain text file or a CSV format file.
The file contains frequency (in Hz) and amplitude (in dB) value pairs which specify the filter frequency
response shape. Each pair must be on a separate line. The filter response between the points is interpolated
using a cubic spline fit.

The following table shows the first few lines of a custom audio filter text file.

0, -100

16.66, -85

50, -63

100, -41

200, -21

300, -10.6
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400, -6.3

500, -3.6

600, -2

700, -0.9

800, 0

... ...

xxx

Format and rule-checking on custom audio filter files is performed as follows:

The maximum number of frequency and amplitude pairs is 1000.

Column 1 (frequency values in Hertz).

Non-negative values only (zero is allowed).

Strictly increasing order of frequencies (frequency value on each line > frequency value on
previous line).

There is no upper limit on the frequency value.

Column 2 (amplitude values in dB units, where gain is a positive value and attenuation is a negative
value).

Values are restricted to the range -200 to +20 dB.

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change acquisition control settings. In effect,
these controls operate like pan and zoom controls.
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Setting Description

Vertical

Scale Changes the range shown between the top and bottom of the graph.

Position Adjusts the level shown at the top of the graph for linear units or the top of the graph
for log units (for example, dBm).

Autoscale Resets the Position so that the highest trace points are in the graph. For linear units
(Volts, Watts), the Autoscale also adjusts Scale.

Horizontal

Left Changes the frequency shown at the left side of the graph.

Right Changes the frequency shown at the right side of the graph.

Autoscale Resets the Left and Right settings to show the entire trace.

Log Sets the graph horizontal axis to a logarithmic scale.

Reset Scale Resets the Vertical and Horizontal settings to their default values.

xxx
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Hum & Noise Tab

Hum & Noise (available only when the Audio Summary display is the active display) is useful for
comparing residual power or modulation if the Ref value is captured when the Signal is On (Direct) or
modulated (AM/FM/PM). When the signal is turned off (Direct) or modulation turned off (AM/FM/PM),
Diff indicates how much residual Hum and Noise are still present in the measurement value.

To display Hum & Noise measurement:

1. Select Setup > Displays.

2. In the Select Displays window, select the Audio Analysis folder.

3. Double-click the Audio Summary icon so that it appears in the Selected displays box.

4. Click OK

5. With the Audio Summary display selected, select Setup > Settings.

6. Select the Hum & Noise tab. Click on theMeasure Hum & Noise checkbox so that it is checked.

The Hum & Noise values appear at the bottom list of measurements in the Audio Summary display.

7. Acquire an appropriate signal.

8. While the analyzer is analyzing a signal you want to use as a reference, click the Capture reference
now button to save a reference value.

The Hum & Noise measurement compares the value of a specific signal quantity captured by the Capture
reference now button with the current measured value of that quantity. For Direct signal types (set on the
Params1 tab), the Signal Level is captured and compared. The Diff measurement is:

SignalLevel(current) – SignalLevel(Ref)

in dB.

For AM, FM, and PM signal types, the RMS modulation value (related to Modulation Depth, Frequency
Deviation or Phase Deviation) is captured and compared. The Diff measurement is:

20 x log10 (RMS(current)/RMS(Ref))

in dB.
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Prefs Tab

The Prefs tab enables you to change appearance characteristics of the Audio Spectrum display.

Setting Description

Units: Specifies the vertical scale units. The units available depend on the signal type selected.

Show graticule Select to display or hide the graticule.

Trace points Sets the number of trace points used for marker measurements and for results export.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show Non-Harm Threshold Shows or hides the non-harmonic threshold line.

xxx
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Audio Demodulation

Main menu bar: Setup > Audio

Favorites toolbar:

Selecting Audio displays the Audio demodulation control panel.

This panel is only available when SignalVu-PC is connected to an RSA306, RSA306B, RSA500A series,
or RSA600A series instrument.

NOTE. Audio Demodulation is available only in real-time acquisition mode (not swept acquisition), and
the Trigger mode must be set to Free Run (not Triggered).

Setting Description

Demodulation Sets both the demodulation type and bandwidth.

Run Starts and stops the live audio demodulation process.

Volume Adjusts the volume of the demodulated audio signal
played out through the PC speakers.

Mute Inhibits the audio from playing out through the PC
speakers

Stream to File These controls allow you to stream the demodulated
audio file directly to disc.

The audio file is saved as a .WAV file.

File: Displays the current location where the audio file is saved.

Browse: Use the Browse... button to navigate to a location to save
the audio file.

Activate This enables the Stream to File function. When
checked, anytime the Run button is pressed, the audio
stream-to-file begins.

xxx
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GP Digital Modulation Overview

Overview

The displays in General Purpose (GP) Digital Modulation (Displays > Measurements > GP Digital
Modulation) are:

Constellation

Demod I & Q vs Time

EVM vs Time

Eye Diagram

Frequency Deviation vs Time

Magnitude Error vs Time

Phase Error vs Time

Signal Quality

Symbol Table

Trellis Diagram

The General Purpose Digital Modulation Analysis (Option 21) provides vector signal analyzer
functionality. A wide variety of modulation types are supported, allowing you to view your signals in
Constellation, Eye and Trellis diagrams, measure the quality of the modulation, display time-domain
waveforms for demodulated I & Q signals, EVM, Phase Error, Magnitude Error, and more.

Modulation Measurements

NOTE. A maximum of approximately 163,800 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).
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Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and can be reported in units of percent or dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.

Magnitude Error The RMS magnitude difference between the measured signal and the ideal reference
signal.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different from
height.

Rho ρ The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the analyzer.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Constellations with quadrature error will show some leakage of
I into Q and vice versa.

xxx

Constellation Display

The Constellation Display shows a digitally-modulated signal in constellation form.

To show the Constellation Display:

1. Recall an appropriate acquisition data file.

2. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

3. From theMeasurements box, select GP Digital Modulation.

4. Double-click the Constellation icon in the Available Displays box. This adds the Constellation icon
to the Selected displays box.

5. Click the OK button. This shows the Constellation display.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Constellation Display

Item Display element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Constellation display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Marker Readout Located to the left of the constellation plot or below it, depending on the size of
the window. If markers are enabled, the marker readout shows the time, mag,
phase, symbol marker and symbol value of the point with the selected marker.

3 EVM Readouts The EVM readouts are located below the Constellation plot. The readout
shows EVM Peak (%) and location, RMS (%).

4 Plot Constellation graph.

xxx

Changing Constellation Settings (see page 539)

Constellation Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Constellation view are shown in the following table.
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NOTE. You might be able to save time configuring the Constellation display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)

Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation, symbol rate, and filters to be used in demodulating
the input signal.

Freq & BW (see page 569) Sets values for frequency error/offset, measurement bandwidth, and frequency deviation
(not every control is present for every modulation type).

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

Specifies additional parameters that are less frequently used.

Find (see page 576) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 576) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 578) Allows you to set the trace display characteristics.

Prefs (see page 581) Enables you to set characteristics of the measurement display.

xxx

Demod I & Q vs Time Display

The Demod I & Q vs Time displays demodulated I and Q vs. Time. You can choose to display I only,
Q only, or both.

Elements of the Display

To show the Demod I & Q vs Time display:

1. Recall an appropriate acquisition data file.

2. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

3. From theMeasurements box, select GP Digital Modulation.

4. Double-click the Demod I&Q vs Time icon in the Available Displays box. This adds the Demod
I&Q vs Time icon to the Selected displays box.

5. Click the OK button. This shows the Demod I&Q vs Time display.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Demod I & Q vs Time display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the I and Q amplitude value indicated at the top of the graph. Changing
the top value affects the bottom of graph readout. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable) such that the range between the top and bottom of the graph
increases or decreases automatically.

3 Position Specifies the I and Q amplitude value shown at the center of the graph display.

4 Bottom Readout Displays the I and Q amplitude value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the
graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq
Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal's carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Freq & BW
(see page 569) tab. If Freq Error is displayed, it also indicates that the Carrier
frequency detection setting is Auto. If Freq Offset is displayed, it indicates
that the Carrier frequency detection setting is manual.

xxx
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Changing Demod I&Q Settings. (see page 542)

Demod I & Q vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Demod I & Q vs Time display are shown in the following table.

NOTE. You might be able to save time configuring the Demod I & Q display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)

Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

Specifies additional parameters.

Find (see page 576) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 576) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 578) Allows you to set the trace display characteristics.

Scale (see page 580) Specifies the horizontal and vertical scale settings.

Prefs (see page 581) Enables you to set characteristics of the measurement display.

xxx

EVM vs Time Display

The EVM vs. Time Display shows the Error Vector Magnitude plotted over Time.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To show an EVM vs. Time display:
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1. Recall an appropriate acquisition data file.

2. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

3. From theMeasurements box, select GP Digital Modulation.

4. Double-click the EVM vs. Time icon in the Available Displays box. This adds the EVM vs. Time
icon to the Selected displays box.

5. Click the OK button. This displays the EVM vs. Time view.

6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the EVM vs Time Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the vertical scale.

2 Position Adjusts the vertical position.

3 Autoscale Adjusts the Horizontal and Vertical scale to show the entire trace.

4 Peak and RMS value readout Shows the maximum result, the time it occurred, and the RMS of the result
over the entire analysis length.

5 Scale Sets the length of time shown in the graph.

xxx

Changing the EVM vs Time Display Settings (see page 543)

EVM vs Time Settings

Main menu bar: Setup > Settings
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Favorites toolbar:

The settings for the EVM vs. Time display are shown in the following table.

NOTE. You might be able to save time configuring the EVM vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)

Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation used in the input signal and other parameters that
controls the demodulation of the input signal.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

Specifies Freq Offset, Magnitude normalization parameters, and enables swapping
I and Q.

Find (see page 576) The Find tab is used to set parameters for finding bursts within the data record.

Analysis Time (see page 576) The Analysis Time tab contains parameters that define how the signal is analyzed in the
general purpose digital modulation displays.

Trace (see page 578) Specifies the display characteristics of the displayed trace.

Scale (see page 580) Specifies the horizontal and vertical scale settings.

Prefs (see page 581) Specifies whether certain display elements are visible.

xxx

Eye Diagram Display

The Eye Diagram Display shows a digitally modulated signal overlapped on itself to reveal variations in
the signal.

To show an Eye Diagram display:

1. Recall an appropriate acquisition data file.

2. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

3. From theMeasurements box, select GP Digital Modulation.

4. Double-click the Eye Diagram icon in the Available Displays box. This adds the Eye Diagram icon
to the Selected displays box.

5. Click the OK button. This displays the Eye Diagram view.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Frequency Deviation vs Time display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Top of Graph The vertical scale is normalized with no units (except for nFSK and C4FM
modulation types where the vertical units are Hz).

3 Position Specifies the value shown at the center of the graph display.

4 Bottom Readout Displays the value indicated by the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Displays the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph in symbols.

8 Freq Error Displays the difference between the maximum and minimum measured
values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx
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Changing Eye Diagram Settings (see page 546)

Eye Diagram Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Eye Diagram display are shown in the following table.

NOTE. You might be able to save time configuring the Eye Diagram display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)

Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 572)

Specifies additional parameters.

Find (see page 576) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 576) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 578) Allows you to set the trace display characteristics.

Scale (see page 580) Specifies the horizontal and vertical scale settings.

Prefs (see page 581) Enables you to set characteristics of the measurement display.

xxx

Frequency Deviation vs Time Display

To show a Frequency Deviation vs Time display:

1. Recall an appropriate acquisition data file.

2. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

3. From theMeasurements box, select Frequency Deviation vs Time.

4. Double-click the Frequency Deviation vs Time icon in the Available Displays box. This adds the
Frequency Deviation vs Time icon to the Selected displays box.
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5. Click the OK button. This displays the Frequency Deviation vs Time view.

6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Display
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Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Frequency Deviation vs Time display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the frequency deviation value indicated at the top of the graph. Changing
the top value affects the bottom of graph readout. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable) such that the range between the top and bottom of the graph
increases or decreases automatically.

3 Position Specifies the frequency deviation value shown at the center of the graph
display.

4 Bottom Readout Displays the value of the frequency deviation value shown at the bottom
of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Specifies the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the
graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Freq Error Displays the difference between the maximum and minimum measured
values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx

Changing Frequency Deviation vs Time Settings (see page 548)

Frequency Deviation vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for Frequency Deviation vs. Time are shown in the following table.

NOTE. You might be able to save time configuring the Frequency vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)
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Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

Specifies additional parameters.

Find (see page 576) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 576) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 578) Allows you to set the trace display characteristics.

Scale (see page 580) Specifies the horizontal and vertical scale settings.

Prefs (see page 581) Enables you to set characteristics of the measurement display.

xxx

Magnitude Error vs Time Display

The Magnitude Error displays the magnitude of the symbol error. The amplitude appears on the vertical
axis while time is plotted along the horizontal axis.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To display Magnitude Error vs. Time:

1. Recall an appropriate acquisition data file.

2. Select the Displays button or Setup > Displays. This displays the Select Displays dialog box.

3. Select GP Digital Modulation in theMeasurements box.

4. Double-click theMag Error vs. Time icon or select the icon and click Add. The icon will appear in
the Selected displays box and will no longer appear under Available displays.

5. Click OK.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Display element Description

1 Top of graph adjustment Use the knob to adjust the value of the vertical scale.

2 Position Adjusts the level shown at the bottom of the display.

3 Autoscale button Adjusts the vertical and horizontal settings to provide the best display.

4 Horizontal Position Adjusts the horizontal position of the signal. Units can be either Symbols or
Seconds (Settings > Analysis Time tab > Units).

5 Peak and RMS value readout Displays the Peak value of the magnitude error, the RMS value of the
magnitude error, and the time at which it occurs within the acquisition. Units
can be either Symbols or Seconds (Settings > Analysis Time tab > Units).

6 Horizontal Scale Sets the time spanned by the graph. Units can be either Symbols or Seconds
(Settings > Analysis Time tab > Units).

7 Freq Error Freq Error is the difference between the Center Frequency and the measured
frequency of the signal being tested. This readout will be Freq Offset if the
Freq Offset parameter on the Settings > Advanced Params (see page 572)
tab is set to Manual.

xxx

Changing Magnitude Error vs Time Display Settings (see page 550)

Magnitude Error vs Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:
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The Setup settings for Magnitude Errors vs. Time are shown in the following table.

NOTE. You might be able to save time configuring the Magnitude vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)

Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

Specifies additional parameters.

Find (see page 576) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 576) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 578) Allows you to set the trace display characteristics.

Scale (see page 580) Specifies the horizontal and vertical scale settings.

Prefs (see page 581) Enables you to set characteristics of the measurement display.

xxx

Phase Error vs Time Display

The Phase Error vs. Time display shows the phase angle of the symbol error over time. The phase is
plotted along the vertical axis while time is plotted along the horizontal axis.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To show the Phase Error display:

1. Recall an appropriate acquisition data file.

2. Press the Displays button or select Setup > Displays.

3. In the Select Displays dialog, select GP Digital Modulation in theMeasurements box.

4. In the Available displays box, double-click the Phase Error icon or select the icon and click Add.
The Phase Error icon will appear in the Selected displays box and will no longer appear under
Available displays.
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5. Click OK to display the Phase Error.

6. Press the Replay button to take measurements on the recalled acquisition data file.

Elements of the Phase Error vs Time Display

Item Display element Description

1 Freq Error Freq Error is the difference between the Center Frequency and the measured
frequency of the signal being tested. This readout will be Freq Offset if the
Freq Offset parameter on the Settings > Advanced Params (see page 572)
tab is set to Manual.

2 Top of graph adjustment Adjusts the phase angle shown at the top of the graph.

3 Position Adjusts the vertical offset.

4 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

5 Offset Adjusts the horizontal offset.

6 Peak and RMS readouts Displays the Peak value of the phase error and the time at which it occurred.
Also displays the RMS value over the analysis length.

7 Scale Sets the time spanned by the graph.

xxx

Changing the Phase Error vs Time Display Settings (see page 552)

Phase Error vs. Time Settings

Main menu bar: Setup > Settings

Favorites toolbar:
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The settings for the Phase Error vs. Time display are shown in the following table.

NOTE. You might be able to save time configuring the Phase Error vs. Time display by pressing the
Standard Settings button from the Settings control panel. This allows you to select a preset optimized for a
standard from the Select Standard dialog box. See Standard Settings Button. (see page 564)

Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

Specifies additional parameters.

Find (see page 576) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 576) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 578) Allows you to set the trace display characteristics.

Scale (see page 580) Specifies the horizontal and vertical scale settings.

Prefs (see page 581) Enables you to set characteristics of the measurement display.

xxx

Signal Quality Display

The Signal Quality display shows several measurements of signal quality. The measurements displayed
depend on the modulation type. There is a set of measurements displayed for all modulation types except
nFSK and C4FM. There is a second set of measurements displayed for nFSK and C4FM modulation types.
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Signal Quality display for all modulation types except nFSK, C4FM, OQPSK, and SOQPSK

Signal Quality display for OQPSK and SOQPSK modulation types
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Signal Quality display for nFSK modulation type

Signal Quality display for C4FM modulation type
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Elements of the Display

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Measurements for OQPSK and SOQPSK modulation types

Measurement Description

EVM The normalized RMS value of the error vector between the measured signal and the ideal
reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q
samples. For EVM, I and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the I and Q
symbol decision points are time-aligned before collecting the I and Q samples. In this
case, one I and one Q sample is collected for each symbol (half as many samples as the
same number of symbols for (non-offset) EVM.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Measurements for nFSK modulation types

Measurement Description

Peak FSK err Peak value of the frequency deviation error at the symbol point.

RMS FSK Err RMS value of the frequency deviation error at the symbol point.

Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal
magnitude.

RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal
magnitude.

Freq Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Freq Deviation Frequency distance from the center frequency at the symbol point.

Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of
the analyzed signal.

Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and
the instrument calculates the error between the user entered value and the instrument
calculated value.

xxx

Measurements for C4FM modulation type

Measurement Description

RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.

Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.

Deviation Frequency distance from the center frequency at the symbol point.

Length Number of symbols in the analysis area.

xxx

Changing the Signal Quality Display Settings (see page 558)

Signal Quality Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for Signal Quality are accessible only when the Signal Quality display is selected.

NOTE. You might be able to save time configuring the Signal Quality display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)
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Settings tab Description

Modulation Params (see
page 565)

The Modulation tab specifies the type of modulation used for the input signal and other
parameters.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

The Advanced Params tab specifies frequency offset, magnitude normalization method
and allows you to swap the I and Q signals.

Find (see page 576) Find tab is used to set parameters for finding bursts within the data record.

Analysis Time (see page 576) The Analysis Time tab contains parameters that define the portion of the acquisition
record that is used for analysis.

Prefs (see page 581) The Prefs tab enables you to set characteristics of the measurement display.

xxx

Symbol Table Display

The Symbol Table Display is like the Constellation Display except that a text table is used to display data
bits at a symbol rather than a graph. The Synch Word characters, if used, are in bold font.

To display the Symbol Table:

1. Recall an appropriate acquisition data file.

2. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.

3. From theMeasurements box, select GP Digital Modulation.

4. Double-click the Symbol Table icon in the Available Displays box. This adds the Symbol Table icon
to the Selected displays box.

5. Click the OK button. This displays the Symbol Table view.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Using Markers

Markers are indicators in the display that you can position on a trace to measure values such as frequency,
power, and time. A Marker always displays its position and, if the Delta readout is enabled, will display
the difference between its position and that of the Marker Reference. Within the Symbol Table, colored
cells indicate the location of markers. The selected Marker is highlighted with a light green background.
All other markers are highlighted with a light gray background. In the Symbol Table, the marker readout
below the table shows the marker location in time, symbol numbers and symbol value.

Changing the Symbol Table Display Settings (see page 560)

Symbol Table Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Setup settings for the Symbol Table view are shown in the following table.

NOTE. You might be able to save time configuring the Symbol Table display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)
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Settings tab Description

Modulation Params (see
page 565)

The Modulation tab specifies the type of modulation used for the input signal and other
parameters.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

The Advanced Params tab specifies additional parameters.

Find (see page 576) Find tab is used to set parameters for finding bursts within the data record.

Analysis Time (see page 576) The Analysis Time tab contains parameters that define the portion of the acquisition
record that is used for analysis.

Prefs (see page 581) The Prefs tab enables you to set characteristics of the measurement display.

xxx

Trellis Diagram Display

To show an Trellis Diagram display:

1. Recall an appropriate acquisition data file.

2. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

3. From theMeasurements box, select GP Digital Modulation.

4. Double-click the Trellis Diagram icon in the Available Displays box. This adds the Trellis Diagram
icon to the Selected displays box.

5. Click the OK button. This displays the Trellis Diagram view.

6. Press the Replay button to take measurements on the recalled acquisition data file.
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Elements of the Display

Item Element Description

1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows
when the Frequency Deviation vs Time display is the optimized display.

NOTE. When Best for multiple windows is selected in the Amplitude control
panel's RF & IF Optimization control, none of the measurement displays
shows a checkmark, as there is not a single optimized measurement.

2 Top of Graph Sets the phase value indicated at the top of the graph. Changing the top value
affects the bottom of graph readout. Also, note that the top of graph setting
interacts with the internal vertical scale setting (which is not user settable)
such that the range between the top and bottom of the graph increases or
decreases automatically.

3 Position Specifies the phase value shown at the center of the graph display.

4 Bottom Readout Displays the value of the phase value shown at the bottom of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.

6 Position Displays the horizontal position of the trace on the graph display.

7 Scale Adjusts the span of the graph in symbols.

8 Freq Error Displays the difference between the maximum and minimum measured
values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx
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Changing the Trellis Diagram Settings (see page 563)

Trellis Diagram Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The settings for the Trellis Diagram display are shown in the following table.

NOTE. You might be able to save time configuring the Trellis Diagram display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 564)

Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 569) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

Specifies additional parameters.

Find (see page 576) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 576) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 578) Allows you to set the trace display characteristics.

Scale (see page 580) Specifies the horizontal and vertical scale settings.

Prefs (see page 581) Enables you to set characteristics of the measurement display.

xxx

GP Digital Modulation Shared Measurement Settings

The displays in the GP Digital Modulation folder (Setup > Displays) are each a different format for
presenting the results of a single underlying analysis. For this reason, all controls that affect the analysis
parameters are shared by all the displays in the GP Digital Modulation folder.

Changing a setting on one tab changes that setting for all the GP Digital Modulation displays. For
example, if you change the Modulation Type for the Constellation Display, it also changes the Modulation
type setting for the Signal Quality display. There are some controls that affect only the way an individual
display presents its results, such as graph scaling.
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Common controls for GP digital modulation displays

Settings tab Description

Modulation Params (see
page 565)

Specifies the type of modulation, symbol rate, and filters to be used in demodulating
the input signal.

Freq & BW (see page 569) Sets values for frequency error/offset, measurement bandwidth, and frequency deviation
(not every control is present for every modulation type).

Equalizer Tab (see page 570) Enable the Equalizer and adjust its parameters.

Advanced Params (see
page 572)

Specifies additional parameters that are less frequently used.

Find (see page 576) Used to set parameters for finding a burst within the data record and for entering a Synch
word.

Analysis Time (see page 576) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 578) Allows you to set the trace display characteristics.

Prefs (see page 581) Enables you to set characteristics of the measurement display.

xxx

Standard Settings Button

On every GP Digital Modulation control panel there is a button labeled Standard Settings. This button is
used to recall settings optimized for analyzing the selected standard. See the following table for a list of
the standards for which standard settings are available. Choosing a standard from the dialog box changes
only settings for GP Digital Modulation displays.

All of the presets in the Standard Settings Dialog make the following settings:

Analysis Length: Auto

Points per Symbol: 4

Data Differential: No

Burst Mode: Off

Burst Detection Threshold: -10 dBc

564 SignalVu-PC Printable Help



GP Digital Modulation Modulation Params Tab

Parameter values set by presets in the standard settings dialog

Standard Modula-
tion

Symbol
Rate

Meas.
Filter

Reference
Filter

Filter
Parameter

Other

802.15.4 OQPSK 1e6 None Half sine NA

SBPSK-MIL SBPSK 2.4e3 None SBPSK-
MIL

NA

SOQPSK-MIL SOQPSK 2.4e3 None SOQPSK-
MIL

NA 1

CPM-MIL CPM 19.2e3 None None NA

SOQPSK-ARTM Tier 1 SOQPSK 2.5e6 None SOQPSK-
ARTM

NA 1

Project25 Phase 1 C4FM 4.8e3 C4FM-P25 RC 0.2

CDMA2000–Base QPSK 1.2288e6 IS-95 TXE-
Q_MEA

IS-95 REF NA

W-CDMA QPSK 3.84e6 RRC RC 0.22

xxx

1 Center Symbol Position, Half Shift Removed

Modulation Params Tab

Menu bar: Setup > Settings > Modulation Params

The Modulation Params tab specifies the type of modulation on the input signal and other parameters
that control the demodulation of the input signal.

Parameter Description

Modulation type Specifies the type of modulation on the input signal.

Symbol Rate Specifies the symbol rate in Hertz.

Measurement Filter Specifies the filter used for measurements.

Reference Filter Specifies the filter used as a reference.

Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some filter types)

Modulation index (Present only for CPM modulation type)

xxx

Modulation Type

The modulation types that can be demodulated and analyzed are:
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Modulation type Description

QPSK Quadrature Phase Shift Keying

8PSK 8-Phase Shift Keying

D8PSK Differential Eight Phase Shift Keying

D16PSK Differential Sixteen Phase Shift Keying

PI/2DBPSK Pi/2 Differential Binary Phase Shift Keying

DQPSK Differential Quadrature Phase Shift Keying

PI/4DQPSK Pi/4 Differential Quadrature Phase Shift Keying

BPSK Binary Phase Shift Keying

OQPSK Offset Quadrature Phase Shift Keying

16QAM 16-state Quadrature Amplitude Modulation

32QAM 32-state Quadrature Amplitude Modulation

64QAM 64-state Quadrature Amplitude Modulation

128QAM 128-state Quadrature Amplitude Modulation

256QAM 256-state Quadrature Amplitude Modulation

MSK Minimum Shift Keying

2FSK 2-Frequency Shift Keying

4FSK 4-Frequency Shift Keying

8FSK 8-Frequency Shift Keying

16FSK 16-Frequency Shift Keying

CPM Continuous Phase Modulation

SOQPSK Shaped Offset Quadrature Phase Shift Keying

SBPSK Shaped Binary Phase Shift Keying

C4FM Constant Envelope 4-Level Frequency Modulation

32APSK 32-symbol Amplitude Phase Shift Keying

xxx

Symbol Rate

Specifies the symbol rate for demodulating digitally modulated signals. The symbol rate and the bit rate
are related as follows:

(Symbol rate) = (Bit rate)/(Number of bits per symbol)

For example, the number of bits per symbol is 3 for 8PSK.

Measurement and Reference Filters

The available measurement and reference filters depend on the selected modulation type. If a particular
filter is not practical for a selected modulation type, it is not presented as an available filter. To determine
which filters are available, make certain that your desired modulation type is selected. See the following
table.
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Modulation type Measurement filters Reference filters

BPSK

PI/2DBPSK

8PSK

D8PSK

DQPSK

PI/4DQPSK

16QAM

32QAM

64QAM

128QAM

256QAM

QPSK

None

RootRaisedCosine

RaisedCosine

Gaussian

User

Rectangular (freq)

IS-95TX_MEA

IS-95TXEQ_MEA

None

RaisedCosine

Gaussian

User

Rectangular (freq)

IS-95REF

16APSK

32APSK

MSK None

Root Raised Cosine

RaisedCosine

Gaussian

User

Rectangular (freq)

None

Gaussian

User

OQPSK None

RootRaisedCosine

User

IS-95TX_MEA

IS-95TXEQ_MEA

None

Half sine

RaisedCosine

User

IS-95REF

HDQPSK HDQPSK-P25 None

RaisedCosine

Gaussian

User

Rectangular (freq)

SOQPSK None

User

SOQPSK-MIL

SOQPSK-ARTM

User

CPM None

User

None

User
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Modulation type Measurement filters Reference filters

2FSK

4FSK

8FSK

16FSK

None

Gaussian

RootRaisedCosine

RaisedCosine

Rectangular (freq)

User

None

Gaussian

RaisedCosine

User

C4FM C4FM-P25 RaisedCosine

User

SBPSK None

User

SBPSK-MIL

User

xxx

The measurement filter is applied before the demodulation bit is detected and the ideal reference is
calculated.

The reference filter is applied to the internally generated ideal reference signal before the EVM is
calculated.

How to Select Filters

In a signal transmitter/receiver system, the baseband signal might be filtered for bandwidth limiting or for
another kind of necessary shaping that needs to be applied. Normally, a filter in the transmitter (Ft) and a
filter in the receiver (Fr) are applied.

The Measurement Filter setting in the analyzer corresponds to the baseband filter in the receiver (Fr): This
setting tells the analyzer what filter your receiver uses. When the analyzer is set to the same filter used by
the receiver, the analyzer sees the signal as your receiver would. The Measurement Filter setting should be
the same as the filter used in the receiver under normal operation (as opposed to testing).

The Reference Filter setting in the analyzer corresponds to the baseband filter in the transmitter-receiver
combination (Fr * Ft). The baseband filter for the transmitter-receiver combination is often referred to as
the System Filter. This filter is called the reference filter because it is used to recreate a reference signal
that is compared to the received signal. This recreated reference signal is the ideal signal with Fr * Ft
applied; differences between this ideal signal and the received signal enables the determination of signal
quality, such as EVM measurements.

The following is an example of a hypothetical signal that is transmitted into a vector signal analyzer
for analysis:

Assume that a signal is transmitted using a baseband filter (Ft). It then travels through a transmission
medium (air/cable/etc) where it may affected by the communication channel (Fc). The signal is received
and filtered by the receiver’s filter (Fr). At this point, the signal has passed through Ft and Fr, and in
addition, the communication channel might have affected it (so: Ft * Fr * Fc). This double-filtered
signal is demodulated as it was received to determine the symbols/bits in it. The obtained bits are used
to regenerate a baseband ideal signal that can be compared against the received signal to determine
signal quality. However, to determine the effect of the environment on the signal quality, the ideal
signal must be filtered by the REFERENCE FILTER (Ft * Fr), so that the ideal signal and the filtered
signal differ only by the effect of the environment. So, the received signal is the ideal signal filtered by
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Ft * Fr * Fc and the reference signal is the ideal signal filtered by Ft * Fr, since they only differ
by the effect of Fc, the comparison will show the effect of the communication channel on the signal.
The communication channel can also include the hardware path the signal follows after (Tx) or before
(Rx) digitizing; this would account for Tx/Rx hardware linear and non-linear distortion.

Common examples of how these filters are used are shown below:

For Transmit Filter = Root Raised Cosine (RRC), Measurement Filter = RRC, the Reference Filter
= RRC ^2 = Raised Cosine

For Transmit Filter = Raised Cosine (RC), Measurement Filter = None, the Reference Filter = Raised
Cosine (When the Measurement Filter = None, the Reference Filter = Transmit Filter)

For Transmit Filter = Gaussian, Measurement Filter = None, the Reference Filter = Gaussian

Filter Parameter

The filter parameter specifies the alpha for the Root Raised Cosine or Raised Cosine filter, or the
bandwidth-time product (BT) for the Gaussian filter, when selected as the Reference filter. Some filter
types have a fixed parameter value that is specified by industry standard, while other filter types by
definition have no filter parameter. For filter types with no filter parameter, there is no filter parameter
control present in the control panel.

Freq & BW Tab

The Freq & BW tab specifies a group of settings that affect how measurements are made.

Freq & BW tab with nFSK or C4FM modulation type selected and Frequency Error readout enabled (Auto selected)
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Freq & BW tab with SOQPSK modulation type selected and Frequency Offset enabled (Auto deselected)

Setting Description

Frequency Error / Frequency
Offset

When Auto is enabled, this readout displays frequency error and the measurement
is made at the calculated frequency. When Auto is disabled, this setting changes to
Frequency Offset. When set to Frequency Offset, this setting is used to demodulate a
signal that is not at the center frequency. The measurement is made at the user-entered
offset. The Measurement Filter (if any, specified on the Modulation Params tab) is applied
about the offset frequency whether set automatically or manually.

Measurement BW This setting allows you to override the automatic bandwidth calculation and directly enter
a bandwidth value. If you enter a value for the measurement bandwidth, be aware that
the actual bandwidth of data provided to the measurement will be at least as wide as
the value you request and may be as much as two times wider than requested. This
override of the selected measurement bandwidth is done so that the instrument uses
sufficient bandwidth relative to the chosen symbol rate to ensure good signal quality
measurements.

Frequency Deviation For nFSK modulation types, this setting specifies the frequency deviation. Select Auto to
make the instrument do this automatically. Deselect Auto to enter a value manually.

This setting is present for only nFSK and C4FM modulation types.

xxx

Equalizer Tab

The Equalizer tab enables you to apply an adaptive equalizer to a digitally modulated signal to compensate
for linear distortions in the signal. The Equalizer is available only for displays in the GP Digital
Modulation folder (Select Displays window). The analyzer implements a decision directed, feed-forward
FIR filter to correct linear distortion in the input signal.
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Parameter Description

Enable Equalization This setting turns the Equalizer on and off.

Reset Equalization Initializes the equalizer filter for training.

Enable EQ Export Exports a text file with equalizer taps in I/Q pairs.

Mode Specifies whether the equalizer is in learning (Train) mode or analysis (Hold) mode.

Convergence Specifies the update rate. Maximum value: 0.002. Default value: 0.0005

Taps/Symbol The number of filter coefficients per symbol used by the filter. Available choices are
1, 2, 4, and 8.

Taps The number of filter coefficients. Range: 3 to 100 (you can set a higher number, but
100 is the practical limit).

Length Specifies the number of symbols analyzed (or filter length).

xxx

Selecting the Mode

When enabled, the Equalizer is in either Train mode or Hold mode. When the equalizer is in Train mode, it
will update internal filter parameters whenever you adjust the Convergence, Taps/Symbol, Taps, or Length
values. When it is in Hold mode, the Equalizer uses the parameter values (both internal and the values
accessible on the Equalizer tab) in effect when it was placed into Hold mode.

NOTE. The Equalizer does not need to be retrained if the modulation type is changed. You can train the
Equalizer by using a simpler modulation type (such as QPSK), place the Equalizer into Hold mode and
can then measure more complex modulation types such as QAM.

Training the Equalizer

To obtain the desired results using the Equalizer, you must first train the Equalizer. This is an iterative
process where you adjust some filter parameters (and the analyzer adjusts internal parameters) to achieve
the lowest error possible on the acquired signal.

To configure the Equalizer:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays window, select GP Digital Modulation fromMeasurements.

3. Add Signal Quality to the Selected Displays and select OK.

4. With the Signal Quality display selected, select Setup > Settings.

5. Select theModulation Params tab set the parameters as necessary for the signal.

6. Select the Equalizer tab.

7. Set the Convergence value to 0.0005.

8. Set Taps/Symbol to 2.

9. Click the Reset Equalization button to reset the equalizer.

10. Set the Mode to Train.
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11. Click Enable Equalization so it is checked.

12. On the Signal Quality display, examine the value for EVM.

13. Change the Convergence, Taps/Symbol, and Taps values iteratively to achieve a minimum EVM value.

NOTE. Changing the Taps/symbol or Taps values resets the equalizer.

Using the Equalizer

To use the equalizer:

1. Select and configure a GP Digital Modulation display.

2. Select Setup > Settings.

3. Select the Equalizer tab.

4. Select Enable Equalization so it is checked.

5. Verify that Mode is set toHold if you have previously trained the Equalizer. If you have not previously
trained the Equalizer, train the Equalizer (see page 571) and then set the Mode to Hold.

Exporting EQ Files

If the Enable EQ Export box is checked, the following outputs files are automatically generated to these
locations after each measurement update cycle if the EQ coefficients change: c:\temp\EqTaps.txt and
c:\temp\EqTapsHdr.txt. These files have EQ taps in I/Q pairs (one pair per row).

The Hdr version file has a five line header before the EQ tap data. Each line in the five line header of the
Hdr version file has two data values, with the second one always being "0":

<line1>Number_of_Header_Lines 0

<line2>EQ_Sample_Rate_Hz 0

<line3>Demod_Symbol_Rate_Sps 0

<line4>EQ_Samples_per_Symbol 0

<line5>Number_of_EQ_Taps_Following 0

Exporting EQ Files

Advanced Params Tab

The Advanced Params tab specifies additional parameters that control the demodulation of the signal.
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Advanced Params tab for all modulation types except nFSK and C4FM

Advanced Params tab for modulation type nFSK

Advanced Params tab for modulation type C4FM

Advanced Params tab for modulation type APSK
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Parameter Description

Mag Normalize

(not present for nFSK or C4FM
modulation types)

Select RMS Symbol Magnitude or Max Symbol Magnitude. This setting applies to Mag
Error and EVM.

Swap I and Q When enabled, the I and Q data are exchanged before demodulating.

APSK Parameters

(Present only for APSK
modulation types)

Sets Constellation display parameters for APSK modulation types.

Symbol rate search

(Present only for nFSK
modulation types)

Determines whether to automatically detect or manually set the symbol rate. When
selected, automatically detects the symbol rate to perform analysis. The calculated
symbol rate is displayed in the Signal Quality display. The Symbol Rate Error is also
calculated and displayed when Symbol rate search is enabled.

User Symbol Map (per
Modulation Type)

Enables the use of custom symbol maps. This enables you to specify the location of
symbols in the display. This control can be set independently for each of the modulation
types.

xxx

Mag Normalize

Specifies whether Magnitude Normalization uses the RMS Symbol Magnitude or the Maximum Symbol
Magnitude as the basis for normalization. Use RMS Symbol Magnitude on QPSK modulations (equal
magnitude symbol locations), and use Maximum Symbol Magnitude for signals that have a large difference
in magnitude among the symbol locations (such as 128QAM). It prevents the instrument from using the
very low magnitude center symbols when normalizing the constellation. The outer symbols are a better
normalization reference than the center in this case.

Swap I and Q

Use the Swap I and Q control to correct a signal sourced by a downconverter that inverts the frequency
of the signal under test.

APSK Parameters

Three parameters can be set for Constellation display of APSK modulation types.

Parameter Description

Ring Use to select which ring the radius and rotation values are being specified for. Values are
0 and 1 for 16APSK. 0, 1, and 2 for 32APSK.

Radius Sets the Ring ratio relative to Ring 0 (inner most ring). Set after selecting the appropriate
Ring setting.

Rotation Sets the rotation value from the I axis. Set after selecting the appropriate Ring setting.

xxx

User Symbol Map

A User Symbol Map is a text file that specifies the location of symbols in the display. The symbol map is
unique for each modulation type. The easiest way to create a custom symbol map is to start with the default
symbol map and modify it. The default symbol map file is located at C:\SignalVu-PC\ExampleFiles.
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The default symbol map file is named DefaultSymbolMaps.txt. See Symbol Maps (see page 581) for
illustrations of the default symbol mapping.

To specify a user symbol map:

1. Click the ... button.

2. Navigate to the directory containing the user symbol text file you want to use.

3. Select the desired file in the Open window and click Open.

4. Select User Symbol Map to enable the user symbol map.

Editing the User Symbol Map. The symbol map is a plain text file and can be edited with any plain text
editor.

CAUTION. Whenever you reinstall the program software, the existing DefaultSymbolMaps.txt file will be
overwritten. To create a custom symbol map, you should make a copy of the default symbol map file, edit
the copy to suit your needs, and save it with a new name. Guidance on how to edit the symbol map file
is contained within the default symbol map file.

The following excerpt from the default symbol map file explains the structure of the file and how to edit it.
## Symbol Mapping Definitions

## Version 1.2

## This file defines the mapping of modulation states to symbol values.

##

## File Format :

## -------------

## 1. Comments begin with '##' and may appear after the last field in a line

## 2. A symbol map begins and ends with a line containing the name of the

## modulation type. These names must exactly match the name of one of the

## modulation types in the RSA software

## 3. Empty cells may be included to preserve the constellation shape.

## 4. Blank lines are ignored.

## 5. A modulation type which does not match the name of an existing

## type will be ignored.

##

## Usage :

## -------

## 1. The file is intended to be edited with Notepad or similar text editor

The following text is an example of a symbol map.
## Symbol Map for 32 QAM

## (Resembles the shape of the constellation)

32QAM

00011 00010 00001 00000

01001 01000 00111 00110 00101 00100

01111 01110 01101 01100 01011 01010

10101 10100 10011 10010 10001 10000
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11011 11010 11001 11000 10111 10110

11111 11110 11101 11100

32QAM

Find Tab

The Find tab is used to set parameters for finding bursts within the data record. This is a post-acquisition
operation. Synch Word search controls are also on this tab.

Setting Description

Burst Detection: Mode Select whether to analyze bursts

- Auto: If a burst is found, analyze just that burst period. If a burst is not found, analyze
the whole analysis length.

- On: If a burst is found, analyze just that burst period. If a burst is not found, display
an error message.

- Off: Analyze the whole analysis length.

If the signal isn't adequate for demodulation, an error message is shown.

Burst Detection: Threshold Sets the level required for the signal to qualify as a burst. Enter a value in dBc down
from top of the signal.

Use Synch Word When enabled, specifies the string of symbols to look for. Enter the search string with
external keyboard or the on-screen keyboard.

Clear Blanks the search string field.

xxx

Analysis Time Tab

The Analysis Time tab contains parameters that define how the signal is analyzed in the general purpose
digital modulation displays.
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The settings values on this tab are the same as those on the main Analysis control panel for the instrument
with the only difference being that Analysis Length can be set in either Seconds or Symbols in this location.

Setting Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in
either seconds or symbols, depending on the Units setting. For most modulation types,
the Analysis Length set when Auto is enabled is 128 symbols. For some modulation
types, a longer length is used.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Time Zero Reference Specifies the zero point for the analysis time.

Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols)
being used by the analyzer; this value may not match the Analysis Length requested
(in manual mode).

Units Sets the units of the Analysis Length to either Symbols or Seconds.

xxx

Analysis Offset

Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (all time values are relative
to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length

Use the analysis length to specify how long a period of time is analyzed by a measurement. As you adjust
this value, the actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the
control in the "Actual" readout. This setting is not available when Auto is checked. Range: minimum
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value depends on modulation type. Resolution: 1 symbol. A maximum of approximately 80,000 samples
can be analyzed (the actual value varies with modulation type).

Time Zero Reference

All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Offset is measured from the trigger point.

xxx

Trace Tab

Menu Bar: Setup > Settings > Trace

The Trace tab allows you to set the trace display characteristics of the selected display.

Example traces tab for constellation display set to SOQPSK modulation type

Note that some settings are not present for all modulation types and some settings are not present for
all displays.

Example trace tab for constellation display set to CPM modulation type
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Example trace tab for Demod I&Q display

Setting Description

Trace Selects the trace that is hidden or displayed based on whether or not Show is selected.

Show Specifies whether the trace selected by Trace is displayed or hidden.

Freeze Halts updates to the trace selected by the Trace setting. Present for the Constellation
display only.

Content Selects whether to display the trace as vectors (points connected by lines), points
(symbols only without lines), or lines (lines drawn between symbols, but no symbols are
displayed). The choices available depend on the display.

Q Offset For traces with offset modulation (OQPSK and SOQPSK), this setting enables the trace
to be displayed with Q offset or without Q offset. Choices available are Remove Q
offset, Include Q Offset, and Use Shared Pref. Selecting Use Shared Pref causes the
analyzer to add or remove Q offset according to the Remove Q Offset setting located on
the Prefs tab. Setting the Q Offset on the Traces tab changes the Q offset only for the
Constellation display. If other GP Digital Modulation displays are shown, they will use the
use the Remove Q Offset setting on the Prefs tab regardless of the Q Offset setting on
the traces tab for the Constellation display. The Q Offset setting is available only when
the modulation type is set to OQPSK or SOQPSK.

Points/symbol Select how many points to use between symbols when connecting the dots. Values:
1, 2, 4, 8.

Symbol point location Selects whether to evaluate the symbol value at the center or the end of the eye opening.
This control is only present for some of the supported modulation types.

Phase Multiplier Sets the multiplication constant for the phase multiplication display: ×1 (default), ×2, ×4,
×8, ×16, or ×32. The phase multiplication display facilitates observation of noisy CPM
signals by multiplying measurement signal phase by the constant to reduce the number
of phase states and expand the phase difference between adjacent symbols.

xxx

Comparing Two Traces in the Constellation Display

When the Constellation display is the selected display, you can use the Traces tab to enable the display
of a second trace. The second trace is a version of the current acquisition. You can choose to freeze a
trace in order to display the current live trace to an earlier version of itself, you can display the trace
as a second trace with or without Q Offset, or you can choose to display both traces frozen in order
to compare the trace to itself at different times.

To display a second trace in the Constellation display:

1. If more than one display is present, select the Constellation display to ensure it is the selected display.

2. Click the settings icon or select Setup > Settings from the menu bar.
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3. Select the Traces tab.

4. Select Trace 2 from the Trace drop-down list.

5. Click the Show checkbox so that it is checked.

6. Specify the Content as desired. Trace 2 lines appear in blue to aid in distinguishing Trace 2 from
Trace 1.

Scale Tab

The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency.

Setting Description

Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.

Position Position adjusts the reference level away from top of the graph.

Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to, in effect, change the span.

Position Allows you to pan a zoomed trace without changing the Measurement Frequency.
Position is only enabled when the span, as specified by Freq/div, is less than the
acquisition bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Auto

xxx

A Note About Units

The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for the horizontal
scale, display the Analysis Time tab. On the tab, select the appropriate units from theUnits drop-down list.
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Prefs Tab

The Prefs tab enables you to change appearance characteristics of the GP Digital Modulation displays.

Setting Description

Show graticule Shows or hides the graticule.

Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker
readout in the Constellation display.

Remove Q offset The I and Q data traces are displayed with an offset of half a symbol when the modulation
type is set to SOQPSK or OQPSK. You can remove this offset by selecting Remove Q
offset. (Which is only present when the modulation type is set to OQPSK or SOQPSK.)

Show EVM and Offset EVM
results

Adds EVM results in the display when enabled (Offset EVM is always displayed). Present
only in Signal Quality display and with SOQPSK and OQPSK modulation types only

xxx

Symbol Maps

This topic shows the symbol mapping for each digital modulation technique.
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D8PSK

Phase shift
(radians)

Symbol value
(binary)

0 000

π/4 001

π/2 011

3π/4 010

π 110

5π/4 111

3π/2 101

7π/4 100

xxx

Pi/2 DBPSK

Phase shift
(radians)

Symbol value
(binary)

+π/2 0

–π/2 1

xxx
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DQPSK

Phase shift
(radians)

Symbol value
(binary)

0 00

π/2 01

π 11

3π/2 10

xxx

Pi/4 DQPSK

Phase shift
(radians)

Symbol value
(binary)

+π/4 00

+3π/4 01

–π/4 10

-3π/4 11

xxx

MSK

Phase shift
direction

Symbol value
(binary)

– 0

+ 1

xxx
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CPM

Phase shift
(h = modulation index)

Symbol value
(binary)

–3h 11

–h 10

+h 01

+3h 00

xxx

Overview: User Defined Measurement and Reference Filters

The Modulation Parameters control tab for GP Digital Modulation displays enables you to load custom
measurement and reference filters. If the existing filters do not meet your requirements, you can create
your own filters for use in the measurement and reference settings. This section describes the structure of
user filters and provides two examples of customized filters. See User Filter File Format (see page 588).

Loading a User Measurement Filter

To load a your own measurement filter:

1. From the Modulation Params control tab (Settings > Modulation Params), click on the drop-down
list for Measurement Filter.

2. Select one of the filter names that starts with User. This displays theManage user filters window.

3. Enter a name for the filter in one of the Name (editable) boxes. This name will appear in the
drop-down list on the Modulation Params tab, prefaced with User. The maximum number of
characters for the filter name is 20.
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4. Click the Browse button and navigate to the directory containing the filter you want to load. Select
the filter and click Open. If you wish to use a filter that is not in the list, select User other and
locate and open the file you wish to use.

5. Click OK to load the filter and return to the Modulation Params page.

User Filter File Format

The filter file is selected on the Modulation Params control panel tab used by the GP Digital Modulation
displays (Option 21 only). It stores the user-defined measurement or reference filter coefficient data in
CSV format. The following figure shows the file structure.

User filter file structure

A filter file is a plain text file, in comma-separated-variable format. The file extension must be CSV.

The filter file contains the following variables:

Rate. Specifies the oversampling rate (the number of samples per symbol). The filter coefficient data will
be interpolated by the specified rate.

FilterI,FilterQ. Specifies IQ pairs (1 to 1024) of the filter coefficient in time domain.

Rules for Creating a Filter File

A line beginning with “#” is a comment line.

Enter a positive value for the oversampling rate.

A decimal number can be expressed by fixed point or floating point. For example, 0.01 and 1.0E-2 are
both valid.

“0” (zero) and “,0” (comma zero) can be omitted. For example, “1.5,0”, “1.5,”, and “1.5” are
equivalent.

Lines with only a comma and blank lines are skipped.
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Example filters. For your reference, two example filters, Raised Cosine and Gaussian, are shown here.
Both filters contain 65 data points with an oversampling rate of 8.

Raised Cosine (α = 0.3)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)

# Rate 0.0383599,0 0.973215,0 0.0743803,0

8 0,0 0.895591,0 0.0720253,0

# FilterI,FilterQ -0.047715,0 0.774975,0 0.0594205,0

0,0 -0.0984502,0 0.623332,0 0.0405144,0

-0.0062255,0 -0.143898,0 0.455249,0 0.0194761,0

-0.0136498,0 -0.174718,0 0.286147,0 0,0

-0.0209294,0 -0.181776,0 0.130455,0 -0.0151973,0

-0.0263419,0 -0.157502,0 0,0 -0.0246357,0

-0.0280807,0 -0.0971877,0 -0.0971877,0 -0.0280807,0

-0.0246357,0 0,0 -0.157502,0 -0.0263419,0

-0.0151973,0 0.130455,0 -0.181776,0 -0.0209294,0

0,0 0.286147,0 -0.174718,0 -0.0136498,0

0.0194761,0 0.455249,0 -0.143898,0 -0.0062255,0

0.0405144,0 0.623332,0 -0.0984502,0 0,0

0.0594205,0 0.774975,0 -0.047715,0

0.0720253,0 0.895591,0 0,0

0.0743803,0 0.973215,0 0.0383599,0

0.063548,0 1,0 0.063548,0

xxx
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Gaussian (BT = 0.5)

(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)

# Rate 0.00191127,0 0.978572,0 0.000401796,0

8 0.00390625,0 0.917004,0 0.000172633,0

# FilterI,FilterQ 0.00764509,0 0.822878,0 7.10E--05,0

2.33E-10,0 0.0143282,0 0.707107,0 2.80E-05,0

9.11E-10,0 0.0257149,0 0.581862,0 1.06E-05,0

3.42E-09,0 0.0441942,0 0.458502,0 3.81E-06,0

1.23E- 08,0 0.0727328,0 0.345977,0 1.32E-06,0

4.21E-08,0 0.114626,0 0.25,0 4.37E-07,0

1.39E-07,0 0.172989,0 0.172989,0 1.39E-07,0

4.37E-07,0 0.25,0 0.114626,0 4.21E-08,0

1.32E-06,0 0.345977,0 0.0727328,0 1.23E-08,0

3.81E-06,0 0.458502,0 0.0441942,0 3.42E-09,0

1.06E-05,0 0.581862,0 0.0257149,0 9.11E-10,0

2.80E-05,0 0.707107,0 0.0143282,0 2.33E-10,0

7.10E-05,0 0.822878,0 0.00764509,0

0.000172633,0 0.917004,0 0.00390625,0

0.000401796,0 0.978572,0 0.00191127,0

0.000895512,0 1,0 0.000895512,0

xxx
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Using Markers

Markers are indicators in the display that you can position on a trace to measure values for the X and Y
axes, such as frequency, power, and time. A Marker always displays its position and, if enabled, will
display the difference between its position and that of the Marker Reference (MR).

You can display up to five markers including the reference marker. Markers can all be placed on the same
trace or they can be placed on different traces. There are three types of Markers: Reference, Delta, and
Power Markers. The Marker Reference (labeled MR in the graph) makes absolute measurements and is
also used for calculating differences when Delta or Power readouts are enabled. The Delta Markers
(labeled M1 to M4 in the graph) are used to measure other points on the trace or the difference between the
Marker Reference and the Delta marker. The Power Markers (labeled M1 to M4 in the graph) function the
same way as the Delta Markers, except they show power density and integrated power density (dBm/Hz)
instead of power level (dBm).

The following two tables show the appearance of the four types of marker readouts.

Marker Reference
Readout

Absolute Marker
Readout

Power Marker Readout Delta Marker Readout

xxx

The following table shows the appearance of the marker indicators as they appear on the trace. Whichever
marker is active will appear as a solid diamond.

Marker Reference Absolute, Delta, and Power Marker

xxx

Controlling Markers with the Right-Click Actions Menu

In addition to controlling the marker actions from the menu controls, you can use the right-click actions
menu to move markers or add and delete markers. Some items are not available for certain displays.
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You display the Right-click Action menu by clicking the right mouse button.

Menu item Description

Marker to peak Moves the selected marker to the highest peak. If no marker is turned on, this control
automatically adds a marker.

Next Peak Moves the selected marker to the next peak. Choices are Next left, Next right, Next
lower (absolute), and Next higher (absolute).

Add marker Defines a new marker located at the horizontal center of the graph.

Delete marker Removes the last added marker.

All markers off Removes all markers.

xxx

Markers Context Menu

The Markers context menu appears when you right-click (or touch and hold) on a marker. The Markers
context menu enables you to assign a marker to a different trace and pan the trace to place the marker at
the measurement frequency.
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Measuring Frequency and Power in the Spectrum Display

To measure the frequency and power at a point on a Spectrum trace:

1. SelectMarkers > Define Markers.

2. Select the Marker Properties tab.

3. Click Add. This displays a drop-down list underMR (Marker Reference), found inside the Reference
box. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are Delta Markers for which readouts can be selected for Delta, Power, or Absolute. You can
also select and adjust markers by clicking on an existing marker on a trace.

4. From the drop-down list, select the trace to which you want to assign the marker.

5. Click the close control panel button to remove the Define Markers control panel.

6. Click on the marker on the trace to activate that marker.

7. Drag the marker in the graph using a mouse to move the marker to the desired location on the trace.
You can also click on the marker location text box in the Markers toolbar at the bottom of the screen
and adjust it with your mouse wheel. The Peak button in the Markers toolbar and the arrow buttons to
the right of it control marker peak searching on the trace.

8. Read the frequency and power level of the marker position on the display.

9. Read the signal density, frequency, and power level of the marker position on the display.

10. If Power markers are selected, read the point power density and the integrated power density.
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Marker Action Controls

Controls for enabling and moving markers and for initiating marker peak searches are found in several
locations. There are buttons for a few of the most common marker activities on the front panel of the
instrument, used along with the knob for adjusting marker positions. The Markers menu contains selections
for peak searches. Each graph display has a Marker button on the status bar that provides access to the
Markers toolbar. The Markers toolbar has buttons for peak searches, centering, and defining markers.

Peak

Selecting Peak from the Markers menu moves the selected marker to the highest level peak within the
acquisition record.

Next Peak

Selecting Next Peak displays a submenu that enables you to move the selected marker to the next peak.

Setting Description

Next Left Moves the selected marker to the next peak to the left of the current marker position.

Next Right Moves the selected marker to the next peak to the right of the current marker position.

Next Lower (absolute) Moves the selected marker to the lower level peak (in absolute terms) on the trace.

Next Higher (absolute) Moves the selected marker to the higher level peak (in absolute terms) on the trace.

xxx

Marker to Center Frequency

Changes the center frequency to match the frequency of the selected marker.

Enabling Markers and Setting Marker Properties

The Define Markers Control Panel is used to enable markers and set their properties. You can set up to five
markers including the marker reference. Markers are shown in most displays.

Markers have three types of on-screen readouts: Absolute, Delta, and Power. When Readouts is set to
Absolute, each readout displays only the marker's position on the trace. In Frequency displays, this means
the marker readout shows the frequency and power of the trace at the marker position. When Readouts
is set to Delta, each delta marker (M1-M4) readout displays both the marker's position on the trace and
the difference between its position and the position of the Reference Marker (MR). When Readouts
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is set to Power, each delta marker (M1-M4) readout displays the marker's position on the trace, the
difference between its position and the position of the Reference Marker (MR), the point power density,
and the integrated power density.

Defining Markers

1. Click theMarkers button on the basic control toolbar to view the Markers toolbar.

2. Click the Define button on the Markers toolbar to open the Define Markers control panel.

3. In the Marker Properties tab, select Add to turn on the next marker. A drop-down list under the marker
label allows you to assign the marker to a trace.

NOTE. The first marker defined will always be MR. The MR marker is the reference for delta marker
readouts.

4. Select the trace to which the marker should be attached from the drop-down list.

5. Click Add to add additional markers.

6. Click on the Readouts drop down menu to select the readout to view. If you select Delta from the
drop down menu, you can check the dBc/Hz box to measure noise in dBc/Hz and show that for the
delta value. Checking this box if other readouts are selected will force the readout to Delta. You can
read more about marker noise (dBc/Hz) mode here (see page 597).

7. Click the close button to remove the Define Markers control panel.

Defining Peaks

You can specify two amplitude values that define peaks. For the DPX display, you can also define peaks
based on signal density characteristics.
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NOTE. The settings shown in the DPX Signal Density section of the Define Peaks tab are not used
by SignalVu-PC.

Amplitude

Peak Threshold Peak Threshold specifies the level that the signal must exceed to be considered a peak.

Minimum Excursion Minimum Excursion specifies how much the signal must decrease and then increase
before another peak can be declared.

DPX Signal Density

Density Threshold Density Threshold specifies the signal density (number of hits per displayed pixel) that
the DPX bitmap must exceed to be considered a trigger event.

Minimum Excursion Minimum Excursion specifies how much the signal density must decrease and increase
again before another peak can be declared.

Smoothing (pixels squared) Smoothing specifies the number of pixels around the marker that are averaged together
to reduce "noise" in the readout of signal density. The value of this control is the number
of pixels on each side of the square area used for averaging. With Smoothing = 1, no
averaging is done and the marker z-axis readout is the hit count (density) of a single
pixel. Use this control to characterize how wide or narrow a range of pixels should be
averaged to determine the signal density.

xxx

1. SelectMarkers > Define Markers to display the Define Markers control panel.

2. Select the Define Peaks tab.

3. To define the level for Peak Threshold, enter a value in the Peak Threshold number entry box.

4. To define the amount the trace must dip, enter a value in the Peak Excursion number entry box.

5. Click the close button to remove the Define Markers control panel.

Using the Markers Toolbar

Favorites toolbar:

Status bar: Markers button

SelectMarkers to display or hide the Markers toolbar at the bottom of the application window. The
Markers toolbar enables you to operate existing markers or define new markers.

Enabling a marker or adjusting the position of a marker automatically opens the Markers toolbar.
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Icon / Readout Description

Opens the Define Markers control panel.

Selected marker readout. This readout shows which marker is selected. The pop-up
menu allows you to choose the selected marker, add markers, and turn all markers off.

Marker position controls. For frequency displays, this readout shows the marker position
in Hertz. For time displays, this readout shows the marker position in seconds. The
position of the selected marker can be changed by selecting the numeric readout and
using the knob to adjust the value.

Changes the analyzer's Center Frequency to the frequency of the selected marker.
Not selectable for time markers.

Moves the marker to the highest peak on the signal. On displays that scale about zero
on the vertical axis (for example, Magnitude Error, EVM, and Frequency vs. Time), the
highest peak selected by the Peak button is an "absolute value", therefore, negative
peaks are included in the search for the highest peak.

Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value here refers to
the numeric value of the peak amplitude. Thus, when repeatedly moving the marker, it
can move to the right or left depending on the location of the next lower value.

Moves the selected marker to the next higher peak value. The peak value here refers to
the numeric value of the peak amplitude. Thus, when repeatedly moving the marker, it
can move to the right or left depending on the location of the next higher value.

Displays/hides the marker table from the display.

Removes the Markers toolbar from the display.

xxx

Measuring Noise Using Delta Markers in the Spectrum Display

In the Spectrum display, you can set Markers to dBc/Hz to measure noise on the trace. Markers in this
mode operate just as they do in normal mode, but the readouts for the markers are in dBm/Hz and dBc/Hz.

dBm/Hz is the power in milliwatts referenced to a 1 Hz bandwidth. To make this measurement, the
analyzer assumes that the measured signal is random noise. It then converts the measured power (made at
any RBW) to the power that would be measured had a 1 Hz filter been applied for the measurement.

dBc/Hz represents dBm/Hz referenced to a carrier. Here, it is assumed that the carrier is a CW signal,
and its signal level does not change when the RBW is changed, so the Reference Marker measurement
on the carrier is unchanged from any other marker measurement. However, the delta marker values
are converted to dBm/Hz, and then a difference value, in dBc/Hz, is calculated between each delta
measurement and the reference.

Measuring Noise

To measure noise on a Spectrum trace:
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1. SelectMarkers > Define to display the Markers control panel.

2. Click Add. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are Delta Markers for which readouts can be selected for Delta, Power, or Absolute. You can
also select and adjust markers by clicking on an existing marker on a trace.

3. Click Add again so that there are at least two markers defined.

4. Check that Readouts is set to Delta and check the dBc/Hz box.

5. If you have more than one trace defined, use the drop-down list for each marker to set it to the trace
on which you want to measure noise.

6. Notice that Detection is set to Average for the trace you are using for this measurement.

7. Check that the Amplitude units are set to dBm (that is the default). If they are not, click the
(Analysis) icon, select the Units tab, and select dBm.

8. Click the Close button to remove the control panel.

9. Move the markers to the desired locations on the trace.

10. Read the frequency and power level for the selected marker in the upper corners of the display. To
display the delta measurement in dBc/Hz, select the delta marker (M1, M2, M3 or M4) by clicking on
it or by selecting it in the drop-down marker list in the Markers toolbar.

The following image shows the Spectrum display with a Delta Marker.

The following image shows the Spectrum display with Power Markers.
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The Mask Test Tool

You can specify pass/fail and mask parameter conditions for the Spectrum, Spurious, Gain, Frequency
Settling Time and Phase Settling Time displays. When these conditions are met, the instrument can
perform actions such as stopping acquisitions or saving data.

Mask Test Settings

Menu Bar: Tools > Mask Test

SelectingMask Test displays the Mask Test control panel. These settings define test parameters and
specify actions to be performed when the test conditions are met. Checking the Enable Test box sets the
application to perform the test once the conditions are defined.

Setting Description

Enable Test Select to perform a test, then set the test conditions.

Define (see page 601) Specifies which result to test and what to test for.

Actions (see page 606) Specifies the action to take when the test condition is met.

xxx

Define Tab (Mask Test)

The Define tab sets the parameters for tests. From this tab, you specify which result to test and what
kind of violation to test for.

The following image shows the Define tab with is great than selected. After you select that test, you will
enter the desired signal level. The procedure is the same if you select is less than.
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The following image shows the Define tab with is outside mask selected. After you select that test, you
need to click the Edit limits button and set the desired test limits. The procedure is the same if you
select is inside mask.

Setting Description

Search in Specifies which result to test.

Test for Specifies what to test for. You can specify a test based on a signal level (“is greater than”,
“is less than”) or a mask (“is outside mask”, “is inside mask”). Options for Spurious and
Settling Time are Pass and Fail.

xxx

Search In

The possible choices for Search in include traces from Spectrum, DPX, Noise Figure, Spurious, and
Setting Time displays. The available choices are Trace 1, Trace 2, Trace 3, Math , Spectrogram Trace,
Spurious, and Settling Time. The available choices include only results from displays that are currently
open.

NOTE. If you select a result that is not the selected trace or result in the target display, you will not see the
results of the test. To see the results, select the trace from the drop-down menu in the target measurement

display and check the Show box:

Test For

The Test for setting has selections that vary based on which display's results you are testing.

Pass/Fail Tests for Spurious and Settling Time

The Frequency Settling Time, Phase Settling Time measurements, and Spurious measurements test
functions provide pass/fail results.

Greater Than/Less Than Tests for Spectrum

If you select a greater than/less than test, you also specify the level that defines a violation. When you
select either is greater than or is less than, a text entry box appears to the right of the drop-down list.
Use the text entry box to specify the signal level you wish to test for. While not as flexible as mask
testing, this type of test is quicker to set up.

The following figure shows the results of an is greater than test. The vertical red bar highlights results
that match the test definition.
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Outside/Inside Mask Tests

If you specify a mask-based test, then you need to edit the mask to specify the levels that define a violation.
When you select is outside mask or is inside mask, an Edit limits button is displayed. Click the Edit
limits button to display the Mask Test Editor window.

To set up and save mask test limits for a test. Perform the following procedure to set up a test using
the mask limits.
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1. After choosing the desired Search in and Test for items, click Edit limits to display the Mask Test
Editor window.

2. Click the New button to create a table. This clears the existing points and loads the default table. You
can also click Open to open an existing table.

3. To edit values, add points, or delete points in a table:

a. To edit an existing value, double-click on the cell you want to edit and enter the desired value. The
active point shows as a red point on the plot.

b. To add a new point, check the box next to the target mask (located below the Auto draw button).

c. Select Add points located below the Open button.

d. Select the target mask (Upper Mask Table or Lower Mask Table) from the drop-down menu.

e. Click in the desired location on the plot to add the point.

f. To use the auto draw feature to automatically place points on the chosen mask, enable the desired
mask from the drop-down menu and then click the Auto draw button.

604 SignalVu-PC Printable Help



Mask Testing Define Tab (Mask Test)

NOTE. Units may be changed for measurements other than Noise Figure in Setup > Analysis > Units.

4. To delete a point from the table, select the point to be removed, and click the X button.

5. To save the mask to a file for later recall, click Save As.

6. From the Save As dialog, name the file and save it in the desired location.

NOTE. Masks are saved in XML format with a .msk extension.

7. To dismiss the Mask Test Editor window, click Done.

Mask Test Result Example

The following figure shows the results of a Spectrum is outside mask test with Upper Mask enabled. The
vertical red bar highlights results that have exceeded the test limits. The shaded region shows the mask area.
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Actions Tab

The Actions tab allows you to trigger the application when a signal in the frequency domain violates
the mask.

Setting Description

During Run or Replay Actions specified here will occur in either Run mode or Replay mode.

(Run actions not available in SignalVu-PC.)

Beep The analyzer beeps when the test condition is met.

Stop The analyzer stops when the test condition is met.

During Run Only Actions specified here are taken only during Run mode (while acquiring live data).

Save acquisition data Saves acquisition data to a file when the test condition is met. Use the drop-down list
to specify the format of the saved data. The available file formats are: TIQ, CSV, and
MAT (see page 685).

Save trace Saves Trace data to a file when the test condition is met.

Save picture Saves a screen capture to a file when the test condition is met. Use the drop-down list to
specify the format of the saved picture. The available file formats are: PNG, JPG, and
BMP (see page 685). Note that no trace will be saved if the tested trace isn't a saveable
trace type. For example, a Spurious trace is not saveable.

Max files Specifies the number of times a test action stores a file. After this limit is reached, no
more files are saved. The instrument will continue to run, but no additional files are
saved when test conditions are met.

Keep in mind when setting this number that picture files are counted as part of the
total number of files. For example, if you set Max files to 100, the instrument will save
100 acquisitions if only acquisitions are saved or only pictures are saved. But, if both
acquisitions and pictures are saved, then 50 acquisitions and 50 pictures will be saved.

xxx

AutoSave File Naming

When one of the AutoSave actions is enabled, the name of the saved file is automatically incremented
even if the Automatically generate filenames option (Tools > Options > Save and Export) is not enabled.
When the file is saved, it will be saved to C:\<instrument name>Files\.
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Analysis Settings

Menu Bar: Setup > Analysis

Favorites toolbar:

The Analysis control panel provides access to settings that are used by all displays. These settings affect
only post processing and they do not control hardware settings.

Setting Description

Analysis Time (see page 607) Specifies the length of time to use in measurements.

Spectrum Time (see page 609) Specifies whether the Spectrum Analysis display uses the same Analysis Time
parameters as all the other displays or if it uses a different Offset and Length.

Frequency (see page 609) Specifies the measurement frequency (center frequency).

Units (see page 612) Specifies the Power units for all displays.

xxx

Analysis Time Tab

The Analysis Time tab contains parameters that define the portion of the acquisition record that is used
for analysis.
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Setting Description

Analysis Offset Specifies the location of the first time sample to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Offset value based on the
requirements of the selected display.

Analysis Length Specifies the length of time to use in measurements.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Time Zero Reference Specifies the zero point for the analysis time.

Actual This is a displayed value, not a setting. It is the Analysis Length (time) being used by the
analyzer; this value may not match the Analysis Length requested (in manual mode).

xxx

Analysis Offset

Use analysis offset to specify where measurements begin. Range: 0 to [(end of acquisition) - Analysis
Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length

Use the analysis length to specify how long a period of time is analyzed by a measurement. After you
enter a value, this box changes to show the actual value in use, which is constrained by Acquisition Time.
This setting is not available when Auto is checked. Range: minimum value depends on modulation type
to Acquisition Length. Resolution: 1 effective sample (or symbol).

Time Zero Reference

The analysis offset is measured from this point. Choices are: Acquisition Start or Trigger Point.

Parameter Description

Acquisition Start Offset is measured from the point at which acquisition begins.

Trigger Point Offset is measured from the trigger point.

xxx
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Spectrum Time Tab

This tab controls whether the Spectrum display uses the same Analysis Time parameters as all the other
views or uses a different Offset and Length.

Settings Description

Spectrum Time Mode

Independent Causes the spectrum analysis views to use the settings unique to those displays.

Use Analysis Time settings Causes the spectrum analysis views to use the settings on the Analysis Time tab.

Spectrum Time (only available when Independent is selected)

Spectrum Offset Sets the beginning of Spectrum Time with respect to the selected time reference point
(selectable in the Analysis Time tab as either Acquisition Start or Trigger).

Spectrum Length The amount of data, in terms of time, from which spectrum traces are computed.

Auto When enabled, causes the instrument to set the Spectrum Length value based on the
RBW setting.

Actual This is a displayed value, not a setting. It is the Spectrum Length (time) being used
by the analyzer; this value may not match the Spectrum Length requested (in manual
mode). The actual spectrum length is always an integer multiple of the time needed to
support the RBW value.

xxx

Frequency Tab

The Frequency tab specifies two frequency values: the Measurement Frequency and the Spectrum Center
Frequency. The Measurement Frequency is the frequency at which most displays take measurements. The
Spectrum Center Frequency is the center frequency used by the Spectrum, DPX Spectrum, Spectrogram
and Time Overview displays.
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The following screen capture shows a display with both the Measurement Frequency and the Spectrum
Center Frequency locked together.

Normally, the Measurement Frequency and the Spectrum Center Frequency are locked together so
that both have the same setting. But in some situations, for example, where a signal contains a set of
channels, it is useful to unlock the Measurement Frequency from the Spectrum Center Frequency.
When the Spectrum Center Frequency is unlocked from the Measurement Frequency, you can adjust the
Measurement Frequency so that measurements can be taken at different frequencies without resetting the
center frequency. The following screen capture shows the magenta-colored measurement frequency
indicator still located at the center frequency.
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The following screen capture shows the measurement frequency indicator located at 2.0402 GHz while the
Spectrum Center Frequency is still located at 2.0000 GHz.

You can drag the Measurement Frequency indicator on the screen to set the measurement frequency. Note
the base of the Measurement Frequency indicator. The width of the box indicates the widest measurement
bandwidth in use among the open displays. You can see how the width of this box changes with the
measurement bandwidth by, in this example, adjusting the Measurement BW setting for the Constellation
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display (Settings > Freq & BW tab). As you adjust the setting, you will see how the width of the box at the
base of the Measurement Frequency Indicator changes.

The Measurement Frequency indicator is useful for interpreting system behavior when MeasFreq is
unlocked. If a measurement has a wide bandwidth relative to the spectrum span, and the Measurement
Frequency is far from spectrum center, the measurement is likely to fail because its required frequency
range exceeds the frequency range of the available data. In such a case, the navigation control will show
that the measurement bandwidth extends outside the Spectrum's span.

There are interactions between frequency unlocking and RF & IF Optimization (see the Amplitude control
panel (see page 621)). When Best for multiple displays is the selected optimization, the instrument is
allowed to use its full bandwidth to meet the needs of all open displays. This is the most user-friendly
optimization because it decreases the number of Acq BW too small errors, but it can increase noise and
slightly decrease measurement accuracies. For all other optimization types, the instrument optimizes the
acquisition bandwidth for the selected display, improving measurement quality somewhat, but reducing
concurrent measurement capability.

There are also interactions with trigger settings. When the Spectrum Center Frequency is unlocked from
Measurement Frequency, the RF triggers (Trigger Source = RF Input) can tune to either Spectrum Center
Frequency or Measurement Frequency. When a spectrum display is selected, the trigger frequency is the
same as the Spectrum Center Frequency. When one of the other displays that uses Measurement Frequency
is selected, the trigger is tuned to the Measurement Frequency also. This allows you to trigger on the
signal you are measuring. But, there is an exception: when the selected RF & IF Optimization is Best for
multiple displays, the trigger is always tuned to the Spectrum Center Frequency.

The reason the trigger frequency is affected by Measurement Frequency and RF & IF Optimization, is
that these functions control how the acquisition is tuned. The optimization Best for multiple displays
keeps the acquisition centered about the Spectrum Center Frequency at all times. To accommodate
off-center Measurement Frequencies, it just widens the acquisition bandwidth. Other optimizations
tune the acquisition frequency to match that of whichever display is currently selected. The RF trigger
module receives the same acquisition data as all the measurements, tuned to the center of the current
acquisition bandwidth.

Units Tab

The Units tab specifies the global Amplitude units for all the views in the analysis window.
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Replay Overview

The Replay function enables you to reanalyze data with different settings and even different measurements.
You can replay all the acquisitions in memory, a single acquisition, a single frame within an acquisition
(if Fast Frame was enabled when the waveform file was saved), or any contiguous set of data records
from acquisition history.

Displaying the Replay Control Panel

To display the Replay control panel:

1. Select View from the main menu bar.

2. Select Replay Toolbar in the menu. The toolbar will appear near the bottom of the display.

3. Click the Define button to open the Replay control panel.

TIP. You can read more about the other toolbar buttons here.

Selecting the Data Type to Replay

You can choose to replay either acquisition data or DPX spectra (providing DPX Spectra were saved in the
waveform file). Choose Acq Data to replay any acquisitions except DPXogram acquisitions. Choose
DPX Spectra to replay a DPXogram acquisition.

Select Data Records Tab

The Select data records tab is used to select which data records to replay. A data record is the smallest unit
that can be replayed. Note that what constitutes a data record can vary. If FastFrame is not enabled, a
data record consists of a single acquisition. If FastFrame is enabled, each acquisition can contain multiple
frames, and a data record consists of a single frame.
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Without FastFrame enabled

With FastFrame enabled

Date and Time Stamps. The line that appears above each Start box (one for acquisitions and one for frames
when FastFrame is enabled) is a date stamp that displays the date and time the first record in the current
acquisition was acquired. The line that appears below each Stop box is a date stamp that displays the date
and time the last record in the current acquisition was acquired.

The line that appears to the right of each Start box displays the date and time the selected acquisition or
frame was acquired. The line that appears to the right of each Stop box displays the date and time the
selected record or frame in the current acquisition was acquired.

Select All button. Selecting Select All resets the Start and Stop values. The Start value is reset to the first
acquisition or frame of the current acquisition. The Stop value is reset to the last acquisition or frame in
the current acquisition.

Select DPX Spectra Tab

The Select DPX Spectra tab is used to select which DPXogram spectra to replay. A spectra is the smallest
DPXogram unit that can be replayed. It is equivalent to one line in the DPXogram display.
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Date and Time Stamps. The line that appears to the right of each Start box displays the date and time the
selected DPX Spectra was acquired. The line that appears to the right of each Stop box displays the date
and time the selected DPX Spectra in the current acquisition was acquired.

Select All button. Selecting Select All resets the Start and Stop values. The Start value is reset to the first
DPX Spectra of the current acquisition. The Stop value is reset to the last DPX Spectra in the current
acquisition.

Acquisition Info Tab

Displays information about acquisition settings and sets the number of decimal places used for displaying
the time stamp.

Replay Speed Tab

Sets the speed at which data records are replayed.

Replay Menu

The Replay menu provides controls that let you choose how to replay acquisitions. The replay function
enables you to, in effect, “rerun” an analysis while applying different measurements to the same set of
acquisition data.

Menu item Description

Acq Data Select Acq Data to replay acquisitions.

DPX Spectra Select DPX Spectra to replay a DPXogram display.
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Menu item Description

Replay all selected records Replays the sequence of records specified by Start and Stop on the Select data records
tab.

Loop overall selected records Replays the sequence of records specified by Start and Stop on the Select data records
tab continuously.

Replay current record Replays the currently selected acquisition (or frame).

Replay from selected Displays a submenu that you use to specify which records are to be replayed.

First record Replays the first record within the selected set.

Previous Replays the previous record within the selected set.

Next Replays the next record within the selected set.

Last record Replays the last record within the selected set.

Pause Suspends replay of the data records as soon as the current record's replay action is
completed. Press Pause again to begin replay with the next record in the sequence.

Stop Halts the replay of acquisitions. If replay is started after Stop has been selected, replay
starts from the first acquisition.

Select all Selects all acquisitions for replay.

Select records from history Displays the Select data records tab of the Replay control panel. Use the Select data
records tab to specify which acquisitions and frames you would like to replay.

Replay toolbar Displays or hides the Replay toolbar.

xxx

Acq Data

Selecting Acq Data selects acquisition data as the source for replay. Selecting Acq Data does not start
replay, it only selects the type of acquisition data that will be replayed.

DPX Spectra

Selecting DPX Spectra selects DPX spectra as the source for replay. Selecting DPX Spectra does not start
replay, it only selects the type of acquisition data that will be replayed.

Replay All Selected Records

Selecting Replay all selected records replays all the selected data records. The set of selected records
may comprise a single record, all records in acquisition history, or a subset of the records in history.
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Replay Current Record

Selecting Replay current record replays the current data record. You can identify the current acquisition
record by looking at the Replay toolbar. The first number to the right of the Select button identifies the
current data record. For example, if the number is 2:10, it means the current record is the tenth frame of
the second acquisition in history.

Replay from Selected

Select Replay from selected to replay records as selected from the submenu. The records replayed can
be from the acquisition memory (history) or from a saved acquisition data file that has already been
recalled as the current acquisition data.

Pause

Select Pause to suspend playback. Selecting Pause again restarts the replay at the point it was paused.

Stop

Select Stop to halt the replay of data. Selecting any Replay action restarts replay of records from the
beginning.

Select All

Select Select all to select all data records for replay.

Select Records from History

Selecting Select records from history displays the Select data records tab of the Replay control panel.
The Select data records tab allows you to specify which records in the acquisition history will be used
when the Replay button is selected.
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Replay Toolbar

Displays or hides the Replay toolbar that appears below the main tool bar.

Replay toolbar

Item Description

Replay Selects data type to be replayed. Select DPX Spectra to replay a DPXogram. Select Acq
Data for all other types of replay.

Replays the first record in the selected set.

Replays the previous record in the selected set.

Replays the current record in the selected set.

Replays the next record in the selected set.

Replays the last record in the selected set.

Replays all records in the selected set.

Replays all records in the selected set continuously until stopped.

Pauses replay. Pressing pause suspends replay with the current record. Selecting pause
again starts Replay with the next record.

Stops replay. Starting any replay action after pressing stop starts a new Replay action
rather than continuing from the record at which the previous replay action was stopped.

Clicking Select All selects all records in history for replay. Selecting Select all resets the
Start and Stop values on the Select data records tab of the Replay control panel.
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Item Description

Clicking the Define button displays the Define Replay control panel. The Acquisition
Info tab displays information about the acquisition data such as acquisition bandwidth,
sampling rate and acquisition length. All data records in the acquisition history were
acquired with identical parameters. When any of these parameters are changed, all
records in history are deleted as soon as the first record acquired under the new
parameter values is received.

You can also view and use the Select data records tab, Select DPX Spectra tab, and
Replay Speed tab.

This readout shows information about the data record being replayed. The information
displayed shows the acquisition and frame number and time stamp for the current data
record.

xxx
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Amplitude Settings

Main menu Bar: Setup > Amplitude

Favorites toolbar:

The Amplitude control panel provides access to power-related settings that are used by all displays within
the SignalVu-PC application.

Setting Description

Internal Settings (see
page 621)

Sets the parameters that control the acquisition of the signal.

External Gain/Loss Correction
(see page 622)

Specifies whether a correction is applied to the signal to compensate for the use of
external equipment.

xxx

Internal Settings Tab

When connected to an RSA500A Series, RSA600A Series, or RSA7100A, the Internal Settings tab is
available from the Amplitude Settings control panel. From this tab, you can specify the Reference Level
for the signal analyzer's RF front end. Depending on which instrument is connected, you may also be
able to access the settings for the internal attenuator, and enable/disable the optional internal preamp. The
following image shows the tab as it appears when an RSA500A Series instrument is connected.

Ref Level

The reference level can be set for the RF Input of the connected instrument.
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Internal Attenuator

The Internal Attenuator setting can be set to Auto or Manual. When Auto mode is enabled, the attenuation
setting is displayed but is not adjustable. When Auto is disabled, the attenuator operates in manual mode,
allowing you to set the internal attenuation. The internal attenuation setting range varies depending on
the instrument in use.

Internal Preamp

Use this setting to switch the preamp on or off.

NOTE. To ensure the best accuracy, thermally stabilize before taking critical measurements.

External Gain/Loss Correction Tab

The External Gain/Loss Correction tab allows you to apply a correction to a signal to compensate for the
use of external equipment, such as an amplifier or attenuator. You can specify whether the corrections on
this tab apply to all acquired data or only to a set group of displays.

External Gain Value

Use the External Gain Value setting to apply a flat gain/loss correction to the signal. Positive values
represent a gain and negative values represent a loss. The range is –50 to +30 dB. Resolution is 0.1 dB.

NOTE. Selecting Preset clears the check box, but it does not change the value.

Apply External Corrections To

Use the two selections to specify whether the enabled external loss tables are applied to all acquired data
or only to traces in the Spectrum, Spectrogram, Spurious, and Amplitude vs Time displays.

When choosing whether to correct sample data or traces, keep the following in mind:
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If sample data is acquired while data correction is enabled, that data record is permanently corrected.
If the acquisition is saved and recalled, the recalled acquisition includes corrections. Corrections
are not saved separately from the raw data; they are used during the acquisition process to adjust
the data values.

Trace corrections can be applied at any time, as they are part of the measurement's computations.
Using Replay will apply trace corrections to a trace if this control is enabled (and an external loss
table is specified and enabled).

Be aware that if you recall acquisition data that was saved with data corrections and you use Replay
with trace corrections selected and an external loss table enabled, the trace will be calculated using
corrected data and also corrected with trace corrections. This probably creates incorrect traces.

When only Traces are being corrected, triggering operates on uncorrected acquisition data. Frequency
masks and trigger level lines in the displays are also not corrected, so there is a visual discrepancy
between data traces and trigger indicators in the graphs under this condition.

When only Traces are being corrected, triggering operates on uncorrected acquisition data. Frequency
masks and trigger level lines in the displays are also not corrected, so there is a visual discrepancy
between data traces and trigger indicators in the graphs under this condition.

Trace Corrections Versus Data Corrections

Because of the real-time nature of the instrument and desire to frequently reanalyze stored acquisitions, it
is possible to apply amplitude corrections in real time. Applying real-time corrections to the incoming
data means that, the correction factors present during the acquisition are already part of the data when
the data is stored and then reanalyzed. This also allows the DPX display to maintain its update rate
while presenting an amplitude-corrected display.

Real-time gain/loss factors are applied by creating a correction filter that is applied by the same digital
signal processing hardware used to correct for calibration and alignment factors in the instrument. This
process does have limitations. In creating a digital filter to represent the gain/loss table, a limited number
of filter taps are be used in order for the filter to be practically realizable. If your amplitude corrections
contain discontinuities or extremely sharp transitions, the filter used will contains errors and ringing.

If the above is the case, we recommended that you use trace corrections. These are very similar to a
conventional spectrum analyzer, and may be applied to the spectrum, spectrogram, spurious search and
amplitude vs. time displays. These traces may contain transitions of any type within the maximum and
minimum correction values allowed in the tables.

External Loss Tables

Use an External Loss Table to apply a frequency dependent gain/loss correction to the signal. When an
External Loss Table is selected, the analyzer adjusts the signal according to the values in the table. An
external loss table allows you to compensate the signal level for variations in cable loss, antenna frequency
response or preamp frequency response.

You can create external loss tables from the analyzer application and save them as files. External loss tables
are saved as plain text files in CSV (Comma Separated Value) format. The tables have a CSV file extension.
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You can change the title for each table. However, note that the title is only a label. It is not tied to the file
name of any table you may have loaded or saved.

NOTE. If you are using an External Loss Table for antenna corrections, be sure to set the Amplitude units
(Setup > Analysis > Units) to dBuA/m or dBuV/m.

Creating an External Loss Table

You can create an external loss table with the analyzer application. No external application is required.

To create an external loss table:

1. Click Edit. to display the Table Editor.

2. Click New Table to create a table. This clears all entries in the existing table and loads the default table.

3. To edit values in the table:

a. To edit an existing value, double-click on the cell you want to edit.

b. To add a new point to the table, click on Add Point. Edit the values as required.

c. Click Apply if you want to test your table without closing the editor (the table must be enabled
with the check box in the control panel and measurements must already be running).

To specify a frequency multiplier, you can type K, M, or G.

4. To delete a point from the table, select the point to be removed, and click Delete.

5. Select the Frequency Interpolation method:

Select Linear when the frequency scale of the spectrum or spurious measurements are linear.

Select Log when the frequency scale of the spectrum is logarithmic.
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6. When you have entered all the necessary values, click Save As (to save the table in a file) or click OK.

7. From the Save As dialog, name the file and save it in the desired location.

External loss tables are saved in CSV (Comma Separated Value) format.

Loading an External Loss Table

To load an external loss table file:

1. Click Edit to display the Table Editor.

2. Click Load to display the Open dialog box.

3. Navigate to the location of the desired file, select it and click Open.

4. Click OK.
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Continuous Versus Single Sequence

Menu Bar: Run > Single Sequence / Continuous

NOTE. SignalVu-PC must be connected to an instrument to display the Run menu.

Selecting Single Sequence sets the acquisition mode so that when you press Run, a single acquisition
sequence is performed and the instrument stops once the acquisition sequence is completed. Selecting
Continuous sets the acquisition mode so that an acquisition sequence is started as soon as you select
Continuous and as one acquisition sequence completes, another begins.

Note that an acquisition sequence can require more than one acquisition. For example, in a spectrum view,
the trace function might be set to Average 100 acquisitions Thus, a complete acquisition sequence would
consist of 100 acquisitions that are averaged together to create the trace that is displayed.

Run

Menu Bar: Run > Run

Favorites Bar: Run

Selecting Run begins a new acquisition/measurement cycle.

NOTE. SignalVu-PC must be connected to an instrument to display the Run menu.

Resume

Favorites Bar: Run > Resume

Restarts data acquisition, but does not reset accumulated results, such as Average or MaxHold. This
allows you to stop acquisitions temporarily, then continue. If the accumulation is already complete, for
example, 10 acquisitions or 10 averages have already been completed, each subsequent Resume command
will cause one more acquisition to be taken, and its results added to the accumulation. Not available if
instrument settings have been changed.

NOTE. SignalVu-PC must be connected to an instrument to display the Run menu.
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Abort

Favorites Toolbar: Run > Abort

Selecting Abort immediately halts the current acquisition/measurement cycle. In-process measurements
and acquisitions are not allowed to complete. Visibility and accuracy of results is unspecified after an abort.

NOTE. SignalVu-PC must be connected to an instrument to display the Run menu.

Acquire

Main menu: Setup > Acquire

Favorites Toolbar:

Selecting Acquire displays the Acquire control panel. This panel enables you to change sampling
parameters, view sample rate, and view record length.

Signal Input. The Signal Input control can be used when an instrument is connected. The I & Q and Diff
I & Q inputs are only valid when an MDO4000B/C is connected.

Setting Description

IQ Sampling Parameters (see
page 629)

Enables you to set the controls for real-time acquisition.

Acquisition Data (see
page 630)

(Only available when an
instrument is not connected)

Displays the sample rate and record length reported by the analyzer.
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Setting Description

Advanced (see page 630)

(Only available when an
RSA7100A is connected)

Enables you to set the preselector state to control image suppression.

Frequency Reference (see
page 631)

(Only available when an
instrument is connected)

Specifies the source of the frequency reference.

xxx

IQ Sampling Parameters

The IQ Sampling Parameters tab enables you to set the controls for real-time acquisition. Normally, the
best results are achieved by leaving the Adjust control set to the recommended setting of All Auto. This
allows the settings to be automatically adjusted for selected measurements.

Depending on the setting chosen for Adjust, two additional parameters can be set.

Adjust User Sets Analyzer Calculates

All Auto N /A N /A All values based on the
selected measurement

Acq BW / Acq Samples Acq BW Acq Samples Acq Length

Acq BW / Acq Length Acq BW Acquisition Length Acq Samples

xxx

Acquisition Memory Usage

The center portion of the tab shows how the acquisition memory is used.

Readout Description

Samples/s, sec/Sample Readout of the acquisition sample rate and sample period.

Capacity The maximum period of time and number of samples that can be acquired with the
current sampling parameters.

Using The total amount of acquisition memory that will be used based on the current settings.

xxx
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Acquisition Data

The Acquisition Data tab lists the Sample Rate and Record length of the recalled acquisition data file.

This tab is only available when not connected to an instrument.

Advanced

The Advanced tab is available only when an RSA7100A is connected. It contains the preselector setting.
The preselector uses input filters for image suppression when the span of the instrument allows for their use.

Two methods of preselection are used in the RSA7100A: a fixed low-pass filter (LPF) and a tunable
bandpass filter (BPF). Due to the narrow-band nature of the tuned BPF, it is necessary to bypass this
filter for wideband analysis of signals with bandwidth >50 MHz. The tuned BPF preselector is enabled
depending on the acquisition mode (swept or real-time), frequency range, and user selection of preselector
state (Auto, On, Off). The LPF preselector is naturally wideband, so that filter is always present, even
when the preselector Off mode is manually selected.
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Preselector setting Description

Auto This setting balances maximizing acquisition bandwidth with image suppression.
The analyzer will operate up to its maximum acquisition bandwidth and may
turn off the uWave preselector to accommodate this. When the requested span
exceeds the acquisition bandwidth, the uWave preselector is engaged and the
step size used is 50 MHz/step.

This is the default setting.

On This setting sets the preselector to always be on, independent of span. When the
span exceeds 50 MHz, the instrument is stepped in frequency to create the display.

Off This setting bypasses the preselector filters (except for the LPF, which is always
present) when the span is greater than the allowed acquisition bandwidth. The
maximum available real time span is equal to the maximum available acquisition
bandwidth at the selected frequency. When the span of the analysis exceeds
the available acquisition bandwidth for the selected frequency, the step size of
the sweep is set to 320 MHz.

xxx

The following table shows the preselector state by acquisition mode.

Acquisition mode Auto On Off

Swept, 50 MHz steps On On CF ≤ 3.6 GHz: On

CF > 3.6 GHz: Off

Swept, 320 MHz steps Not applicable Not applicable CF ≤ 3.41 GHz: On

CF > 3.41 GHz: Off

Real time span ≤ 50 MHz On On CF ≤ 3.6 GHz: On

CF > 3.6 GHz: Off

Real time span > 50 MHz CF ≤ 3.41 GHz: On

CF > 3.41 GHz: Off

Not applicable CF ≤ 3.41 GHz: On

CF > 3.41 GHz: Off

xxx

Frequency Reference

This tab is only available when an RSA306B, RSA500A series, RSA600A series, or RSA7100A
instrument is connected. Available selections depend on which instrument is connected.
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Setting Description

Internal Uses the internal 10 MHz clock of the connected instrument as the reference
frequency.

External For the RSA306, RSA306B, and RSA7100A instruments, 10 MHz is the only
allowed reference.

For the RSA500A series and RSA600A series instruments, a broad selection of
external reference frequencies are allowed. If you select External, the instrument
will auto-detect the external reference and attempt to lock to this reference if it falls
within acceptable accuracy range of the "defined" frequencies. If no external signal
is detected, or the instrument cannot lock to the connected signal, it will revert
back to Internal reference after displaying a dialog box indicating it could not lock.

GNSS

(Only available when an RSA500A
series or RSA600A series instrument
is connected.)

Selectable when GNSS is enabled from Setup > GNSS/Antenna (see page 653).

When selected, the analyzer will use timing signals from the internal GNSS
receiver to align the internal 10 MHz clock frequency to GNSS reference. Clock
frequency adjustment status is shown as one of the following states:

- Acquiring: Waiting for GNSS receiver lock and performing initial clock
frequency adjustment.

- Tracking: Updating clock frequency adjustment while GNSS receiver is
locked.

- Holding: Maintaining last clock frequency adjustment when GNSS receiver
is unlocked.

If Frequency Reference is changed to another selection, the GNSS-derived
clock adjustment is discarded and will restart from the original value if GNSS
is reselected.

When the GNSS status is Tracking or Holding, click the Set User button to store
the current GNSS-derived clock adjustment information in the User setting. The
User setting can then be selected as the Frequency Reference source at any time.

In Tracking state, the status also includes the quality of the clock correction relative
to GNSS timing, as indicated by the following:

- Low: Clock error is greater than ±200 x 10-9

- Medium: Clock error is less than ±200 x 10-9

- High: Clock error is less than ±25 x 10-9

Once the status is Holding, a date/time stamp will show next to User (see following
setting) and that setting will become selectable.

User

(Only available when an RSA500A
series or RSA600A series instrument
is connected.)

Selectable when a GNSS frequency reference setting has been saved with the
Set User button. The date and time at which the setting was saved are displayed.
This setting is the default setting for this tab if a valid User setting has been saved.
The User setting information is stored on the PC and so will not be available if the
device is connected to a different PC.

Set User button

(Only available when an RSA500A
series or RSA600A series instrument
is connected.)

This button is available when a GNSS acquired frequency reference has been
acquired after selecting GNSS. Clicking this button saves the frequency reference
and enables the User setting.

xxx
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TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

The Recording Control Panel

Main menu: Setup > Recording

Favorites toolbar:

Selecting Recording displays the Recording control panel. This panel contains tabs that allow you to
access the functions in the following table. You can play back recorded files with an optional playback
feature. Playback can only play files that were recorded using the Formatted data structure, although you
can use other applications, such as MATLAB, to read files recorded as Formatted data or Raw data.

Playback of recorded files is available for the RSA7100A when using an external application. The
Playback feature described in this topic is not available for use with the RSA7100A. You can read more
about file formats used by the RSA7100Ahere.

You can purchase Option SV56-SVPC to enable the Playback tab when connected to the RSA306,
RSA306B, and RSA500A and RSA600A series instruments.

Tab Description

Record Setup (see page 634) Enables you to define the save location, base filename, and data structure of the
recording.

Record (see page 636) Records the acquisition data directly to a file.

Playback (see page 639)

(Requires Option SV56-SVPC)

(Not available on the
RSA7100A.)

Plays the saved files recorded with the Record feature.

Playback only plays .r3f file formats.

xxx
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TIP. See the Features by product (see page 13) topic for more information about which features are
available with which connected analyzers.

Record Setup

The above image shows the Record Setup tab when a RSA306B RSA500A Series, or RSA600A Series is connected.

The above image shows the Record Setup tab when a RSA7100A is connected.
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The Record Setup tab allows you to set the following:

Setting

Location Sets the destination folder or directory for the recorded file(s).

Base file name Enter a base name that will be used for all recorded files. This base name is
appended with additional information, creating unique file names.

Data structure

(RSA500A Series, RSA600A Series,
RSA306B only)

Choose the output data file structure.
Files created with the Recording feature: Raw recordings contain instrument
setting and other information in a separate file from the raw ADC samples.
Formatted recording files contain all information in a single file. Refer to the
RSA306, RSA306B, RSA500A series, and RSA600A series API programming
manual for more detailed information about the data files created with the
Recording feature.

Formatted Formatted files are created, ending with a .r3f suffix, and contain a single
Header info block, followed by blocks of data and status information.
Each data block is called a frame which is 16384 bytes (16 kB) in size.
Formatted files can only contain complete frames.

Raw Unformatted files are created. Raw recordings contain instrument setting and
other information in a separate file from the raw ADC samples.
Two files are created for each recording, a header file (.r3h) and the raw data
file (.r3a).
Raw data files contain only ADC samples. The samples are contiguous, with all
transport frame information removed before storage.
The header file, if available, contains the Config data which can be used to
interpret and scale the ADC data samples for further processing.

Acq BW Shows the current acquisition bandwidth. Check the Auto box to automatically
set this value. Uncheck the Auto box to set it manually.

Data packed at 12 bits/sample for 800
MHz BW

(RSA7100A only)

At 800 MHz acquisition bandwidth, data is packed at 12 bits/sample to avoid
gaps in the streamed recording. If you require 16-bit samples, uncheck the box.

You can also convert 12-bit data to 16 bits/sample using the unpacking utility.
Streaming unpacked data at 800 MHz bandwidth may result in occasional
small gaps in the recording.

xxx

NOTE. You can read about the formatted data structure (.xdat) for files recorded using the RSA7100A in
the Data Settings and Picture File Formats topic.

Unpacking saved .xdat files to RAID in the RSA7100A

You can convert 12 bits/sample data to 16 bits/sample using the unpacking utility.

1. Open a command prompt in Windows from the CTRL7100A.

2. Type the location of the file you want to unpack.

3. Type unpack after the command prompt. You will then see a usage command with arguments after it.
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4. After the next command prompt, type the following:

a. unpack

b. Input file name (the file you want to unpack). For example, packed.xdat.

c. Enter a space using the spacebar.

d. Output file name (the unpacked file you are saving). For example, unpacked.xdat. This must be
an .xdat file type. You can also specify a location to which the file is saved.

5. If desired, enter an output file size. If the output size is smaller than the input size, the output file will
contain the first portion of the input file up to the specified file size.

6. Press the Enter key to execute the command.

7. Navigate to the location to the unpacked file.

Record

The recording feature lets you record the acquisition data directly to a file. Selections on this tab vary
depending on the connected instrument.

NOTE. SignalVu-PC does not accept changes while recording is active. Stop the current recording session
to change settings.

The above image shows the Record tab when Record Time is selected (when the RSA500A series, RSA600A
series, or RSA306B is connected).
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The above image shows the Record tab when Record Time is not selected (when the RSA500A series, RSA600A
series, or RSA306B is connected).

The above image shows the Record tab when the RSA7100A is connected.
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The Record tab allows you to set the following:

Setting

Record to disk:

Record now Data recording starts immediately when the Start button is pressed. Data is
continuously recorded until either stopped by the Start (Stop) button or the
Record Time condition is met.
If Record Time is disabled, recording continues until the Stop button is pressed
(or the specified save location runs out of space).

Record on trigger Data recording starts when an appropriate trigger signal is received (Triggering
must be separately enabled in the Trigger control panel).

Start The Start button is enabled when the Record to disk is set to Record now or
when Triggering is enabled and Record to disk is set to Record on Trigger.
Pressing Start begins the data recording. The button changes to Stop and
recording continues until pressed or the Record Time condition is met.

Files per run This determines how many files are created of the specified Record Time.
If the Record Time is not enabled, then this setting is ignored and only 1 file
is recorded by Start.

Record Time: Record Time is enabled by default. This determines how much data (time in
milliseconds, seconds, or minutes) is recorded after recording starts.
Record Time uses the Files per run setting to determine how many data files
are captured for each recording session.
Disabling Record Time allows the recording to continue until the Stop button is
pressed (or the specified save location runs out of space).

File size Indicates the size of each recorded file. This item is only displayed when
Record Time is enabled.

Max Record Time Indicates the maximum length of the record time based on available disk space.

This setting indicates the longest Record Time possible with current acquisition
settings and Available Disk Space.
This item is only displayed when Record Time is disabled.

Available Disk Space Indicates the amount of disk space available for recording.

Status

(RSA7100A only)

Progress Indicates the current progress of the recording.

Files recorded Indicates how many of the selected number of files to record per run have
been recorded.

Dropped Frame Indicates a missed frame has been detected in the recording.

The Marker file (.xmrk) indicates the sample in which the Dropped Frame
is detected. If the recording is done using the unpack data format and the
acquisition bandwidth is equal to 800 MHz, you can select the packed data
format to reduce Dropped Frame.

Input Overload Indicates if an overload has been detected in the record.

The Marker file (.xmrk) indicates the sample in which the Input Overload is
detected. You can increase the reference level to avoid Input Overload.

xxx
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NOTE. The record feature is best suited for PCs using a solid-state drive (SSD) to achieve the read/write
speeds necessary for best performance. Recording performance will be degraded on PCs with slower
drives.

Playback

Playback lets you play acquisition files that were recorded with SignalVu-PC’s recording feature. Recorded
files for the RSA306, RSA306B, RSA500 series, and RSA600 series have a .r3f file extension and only
these file types can be played with the Playback feature (Option SV56-SVPC).

Playback of recorded files is available for the RSA7100A when using an external application. The
Playback feature described in this topic is not available for use with the RSA7100A. You can read more
about file formats used by the RSA7100Ahere.

NOTE. The playback feature is best suited for PCs using a solid-state drive (SSD) to achieve the read/write
speeds necessary for best playback performance. Playback performance will be degraded on PCs with
slower drives.

If an instrument is connected through the Connect feature, you must first click the Stop button on the
Playback tab to enable Playback. SignalVu-PC acquires and analyzes the data of a recorded file as if it were
obtaining data from an instrument. Therefore, once you enable Playback, SignalVu-PC disconnects the

currently connected instrument. However, the connection indicator will still display as green ( ) because
the analyzer treats the playback file as live data acquisition. The Run/Stop toolbar remains active, allowing
you to stop and start the playback of the selected file (like the Stop and Play button in the Playback screen).

NOTE. Most controls in the Playback tab are not active while acquiring live data from a connected
instrument. The only control available is the Stop button, which will halt the acquisition of data from the
connected instrument. Once acquisition has stopped, the Playback controls become active.
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Setting

Location: Navigate to the location of the recorded file(s).

NOTE. You can also use the File > Recall menu to navigate to recorded files. You must set
the file type (to search for) to ADC sample data (.r3f).

Skip: Defines the amount of time skipped between frames of the playback data.

For long recordings, this allows you to skip portions of the data, allowing you to perform a
coarser analysis, but much quicker.

The amount of skip cannot be less than the defined acquisition length. The resolution for
setting the skip is one USB frame (73 μs).

Units: Defines the units of the Skip setting (μsec, msec, seconds).

Live rate This setting forces SignalVu_PC to attempt to play the file at the same rate as when it was
acquired, making the playback operation appear to be identical to having the instrument
connected.

This setting is very useful when listening to audio.

Loop file When selected, the file selected for playback continues to loop until playback is stopped.

If only a portion of the file is selected for playback (with the Begin and End sliders) only that
portion is looped.

Playback fields

Progress Provides an indication of the current status of the file being played.

Begin Use the Begin slider to choose a starting point within the recorded file to begin playback.

End Use the End slider to choose an end point within the recorded file to stop the playback.

Stop/Play This button toggles between Stop and Play.

NOTE. The Run/Stop toolbar in the SignalVu-PC application also performs the same functions
as the Stop/Play button in the Playback screen.

Stop Stop is displayed while a recorded data file is being played. Pressing Stop halts the playback
operation.

Stop is also displayed if SignalVu-PC is currently connected to an instrument. Pressing Stop
stops the acquisition of data from the instrument.

No changes can be made to playback while Stop is displayed.

Play Pressing Play starts playout of the file defined in the Location field.

If SignalVu-PC is connected to an instrument, acquisition of data from the instrument is stopped
before the file starts to play.

Exit Playback Exits the playback mode, disconnecting the recorded file (and the connected status indicates
no connection.

After you exit playback, you can replay the currently selected file, choose another file to play, or
reestablish a connection to an instrument.

xxx

Triggering

Triggering is available in SignalVu-PC when connected to an RSA306, RSA306B, RSA500A series,
RSA600A series, and RSA7100A Spectrum Analyzers. The RSA analyzer has two triggering modes:
Free Run and Triggered.
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Free Run

In Free Run mode, the instrument initiates acquisitions without considering any trigger conditions. It is a
fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you
need to specify a particular time at which to collect the data record.

Triggered

In the Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source (RF Input or External). If
the RF input is the selected trigger source, you can select from several trigger types (depending on the
connected analyzer). If other inputs are selected as the trigger source, you can select the slope and level of
the trigger point.

Power triggering. Power triggering triggers the instrument on time-domain signal transitions. The
incoming data is compared to a user-selected level in dBm. You can select the time-domain bandwidth
and trigger on the rising or falling edge.

Frequency mask triggering. Frequency Mask Triggering allows you to trigger the instrument when a
signal in the frequency domain violates the mask. You can draw a mask to define the conditions within the
real-time bandwidth that will generate the trigger event. It allows you to trigger on weak signals in the
presence of strong signals. This triggering is also useful for capturing intermittent signals.

DPX Density triggering. DPX Density triggering uses characteristics of the DPX display to specify
trigger parameters. When using DPX Density triggering, the percentage of time the signal falls within
the measurement box is used to define a trigger event. The measurement box is defined by frequency
and amplitude values.

NOTE. DPX Density and Frequency Mask triggering are not available with the RSA7100A.

Save on Trigger

An additional feature of the triggering capability is to save acquisition data when a trigger event occurs.
When the analyzer is run in Triggered mode, you can configure the instrument to save acquisition data to a
file. You can also set the instrument to save a picture of the screen when the trigger event occurs. See
Action Tab (Triggering) (see page 652) for details on configuring Save on trigger.

Setting Up Triggering

To set up triggering, use the Trigger control panel. To display the Trigger control panel:
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Click on the Favorites toolbar or select Setup > Trigger to access the Trigger control panel.

Using Free Run

To set Triggering to Free Run:

Click the Free Run option button.

The signal analyzer will acquire a signal without regard to any triggering conditions.

Using Power Trigger

To trigger acquisitions based on the power of the signal:

1. Click the Triggered option button.

2. Select RF Input from the Source drop-down list.

3. Select Power from the Type drop-down list.

4. For further information on setting the power level parameters, see Event Tab (Triggering). (see
page 647)

Using Frequency Mask Triggering

To trigger acquisitions based on violations of a user-defined mask:

1. Click the Triggered option button.

2. Select RF Input from the Source drop-down list.

3. Select Frequency Mask from the Type drop-down list.

For further information on setting the frequency mask parameters, see Event Tab (Triggering) (see
page 647) and Mask Editor (see page 643). If Frequency Mask triggering is installed, you can change the
resolution bandwidth of the frequency transform used to compare to the trigger mask. The standard FMT
uses a fixed length FFT for frequency transforms.

Using DPX Density Triggering

To trigger acquisitions based on the density of the DPX Bitmap trace, do the following.
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NOTE. DPX Density triggering is not available with the RSA7100A.

1. Click the Triggered option button.

2. Select RF Input from the Source drop-down list.

3. Select DPX Density from the Type drop-down list.

4. Set the DPX Density parameters as appropriate. You can do this one of the following ways:

Check the Show measurement box in the Density tab of the DPX Settings control panel to view
the measurement box in the display. Enter the Frequency and Amplitude in the Density tab.

Check the Show measurement box in the Density tab of the DPX Settings control panel to view
the measurement box in the display. Use the mouse to move and size the measurement box that
appears on the display to set the values for Frequency and Amplitude.

NOTE. If the Amplitude units (Setup > Analysis > Units) is set to Watts or Volts, you cannot move
the measurement box using a mouse. Set the amplitude units to any unit other than Watts or Volts to
move or resize the measurement box.

For further information on setting the power level parameters, see Event Tab (Triggering) (see page 647).

Frequency Mask Trigger

The following topics describe the frequency mask trigger controls:

Event tab (see page 647): explains how to configure frequency mask triggering parameters.

Mask Editor (see page 643): explains how to create and edit frequency masks.

Triggering (see page 640): explains how to initiate frequency mask triggering.

Mask Editor (Frequency Mask Trigger)

The Mask Editor is used to create masks that are used by the Frequency Mask Trigger function. The
Frequency Mask Trigger ( FMT ) function is used to define trigger events to capture signal anomalies
based on their frequency and amplitude.

Displaying the Mask Editor

To display the Mask Editor:
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1. Click on the Favorites toolbar or select Setup > Trigger to access the Trigger control panel.

2. Select the Event tab.

3. Set Source to RF Input.

4. Set Type to Frequency Mask.

5. Select Mask Editor.

Creating a Mask

The simplest way to create a mask is to use the Auto draw function.

To create a new mask using Auto draw:

1. Select the trace on which to base the mask from the Reference trace drop-down list. (Only traces
that are shown can be selected from the drop-down list. To show a trace that isn't currently in the list,
open its display and enable the trace of interest.)

2. Specify the margins to be applied between the mask and the reference trace. Enter values for the X
Margin and the Y Margin.

3. Click Auto draw.

The following screen shows a mask created with Auto draw.

To create a new mask without using Auto draw:
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Click the New button.

Changing a Mask

A mask is a collection of points specified by their frequency (defined by their offset from the center
frequency) and their amplitude. You can change a mask by adding (or removing) points and editing points.

NOTE. When placing points in the frequency mask, keep in mind that in most cases, the Frequency Mask
Trigger has a range of 80 dB below Reference Level. However, for values of Reference Level lower than
-50 dBm, this range decreases as the RefLevel decreases. The FMT range is also reduced when the
Acquisition Bandwidth contains frequencies near 0 Hz. In both these situations, the underlying reason the
trigger range is reduced is because the instrument is using various amounts of "digital gain" in addition to
hardware gain. You are not prevented from placing mask points outside the usable range of the instrument,
but at the time the mask is applied, the instrument adjusts its range. When the mask is adjusted, you can
see this in the Spectrum display and the Mask Editor. The mask's shaded fill shows the usable vertical
range. Points outside this range are shown, but will not cause a trigger.

Adding Points

To add a point to a mask:

1. Click the Add points option button. (Alternatively, you can right-click on the desired point location
(or left-click and hold for about a second) and release.)

2. Click in the graph area where you want the new point added to the mask.

You can also add a point to the mask while it is in Edit Points mode:

Right-click in the graph area where you wish to add a point to the mask. You can also left-click and
hold the button down for one second.

If you add a point by accident, click Undo. You can click Undo until the Undo button is grayed out.

Editing Points

When you edit a point, you change its offset from the center frequency and/or its amplitude. There are
two ways to edit the offset and amplitude of a point on a mask. First, you can drag a point to the desired
position. Second, you can double-click on the offset or amplitude value in the table and enter a new value.

To edit a point on a mask:

1. Click the Edit Points option button.

2. Click on the point you wish to change.
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3. Change the position of the point using the following methods:

a. Dragging it with the mouse to the desired position.

b. Clicking the arrow keys in the Mask Editor window to move the point to the desired position.
Use the left/right keys to change the frequency offset. Use the up/down arrow keys to change
the amplitude.

4. To edit another point, click Next.

You can also edit a point by double-clicking on the value in the table that you want to change and typing
in a new value.

Deleting Points

To delete points from the mask:

1. Click the Edit Points option button.

2. Click on the point to be removed and click the X button to delete the point.

You can also delete a point by clicking on the point in the table that you want to delete and clicking
the X button.

If you delete a point by accident, click Undo. You can click Undo until the Undo button is grayed out.

Saving a Mask

To save a mask:

Click the Save button.

To save an edited mask under a new name:

Click the Save As button.

Opening an Existing Mask

To open an existing mask:

1. Click on Open. This displays the Open dialog box.

2. Navigate to the location of the mask file.

3. Select the desired file and click Open.
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Trigger Settings

Main menu bar: Setup > Trigger

Favorites toolbar:

The Trigger control panel allows you to set the parameters that define trigger events and how the analyzer
responds to them.

Trigger Modes

There are two trigger modes: Free Run and Triggered.

Mode Description

Free Run Acquires and displays the signal without triggering.

Triggered Acquires a data record after the defined trigger event is recognized.

xxx

Trigger Tabs

Use the Trigger tabs to access controls for setting the different trigger parameters.

Tab Description

Event (see page 647) Sets parameters that control triggering on the selected trigger source.

Advanced (see page 651) Sets controls for triggering in swept acquisitions.

Actions (see page 652) Sets parameters for Save on trigger function.

xxx

Event Tab

The Event tab is used to set the parameters that define trigger events. The parameters that appear on the
Event tab change depending on the selected Trigger source and type.
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Source

Source specifies the source of the signal to be monitored for a trigger event. The choices available are: RF
Input and External. The Source drop-down list is always visible on the Event tab.

Type

Type defines the trigger type as Power or Frequency Mask. The Type selection is only present when
Source is set to RF Input.

When Type is set to Power, a transition through an adjustable level of the selected source determines
a trigger event.

When Type is set to Frequency Mask, where and how the input signal crosses or fails to cross the edge
of the mask defines a trigger event.

Source = RF input.

The following table describes the settings for each triggering type available when Source is set to RF
Input. Type specifies what type of violation will define a trigger event.
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Table 10: Trigger types

Event Type Setting Description

Power For the Power setting, if the RF input signal crosses the specified
level (in the direction set by Slope), a trigger event occurs. A trigger
event does not occur if the power level of the signal simply exceeds
the level setting, there must be a power level transient that crosses
the specified level.

Slope The slope control determines whether the signal analyzer finds the
trigger point on the rising or falling edge of the RF input signal.

Level The Level setting determines the power level that will be recognized
as a trigger event. The Level is indicated in the Amplitude vs Time
and Time Overview displays with a dark cyan colored-line.

Trigger BW Time-domain BW is a filter used to process the trigger input signal
before the trigger system analyzes the signal. The frequency edge
trigger point must lie within the range of time domain bandwidth. This
makes the range of the frequency edge trigger =
Center Frequency ±(0.5 × Time Domain Bandwidth)

Frequency Mask

(RSA7100A only)

For the Frequency Mask setting, events where the trace crosses the
edge of the mask when it should not or when the trace does not cross
the edge of the mask when it should define the trigger event.

Violation Specifies the type of transition that defines a violation.

RBW Specifies the resolution bandwidth.

Auto Specifies whether the RBW is adjusted automatically or manually.

Mask Editor Displays the Mask Editor so that you can create and edit Frequency
Masks.

You can read more about using this tool in the Mask Editor
(Frequency Mask Trigger) topic.

Load from file Opens the Open dialog for selecting a previously saved frequency
mask file.

xxx

Violation. Violations are state changes (or a sequence of state changes) defined by whether a point on the
signal falls within the frequency mask or outside the frequency mask. A True violation occurs if even a
single point on the trace falls inside the mask (above the mask's lower edge). Conversely, a False violation
occurs if no points on a signal fall inside the mask (all trace points are below the mask's lower edge).
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A trigger event is initiated based on the type of violation that occurs and the sequence of violations
that occur.

Violation Description

T Only one state is required to initiate a trigger event. The signal has at least one data point
inside (above) the mask. The trigger event occurs when the instrument detects the first
signal with a point violating the mask. A trigger event could occur on the first acquisition.

F Only one state change is required to initiate a trigger event. The signal has all data points
outside (below) the mask. The trigger event occurs when the instrument has detected
the first spectral waveform that lies completely below (outside) the mask. A trigger event
could occur on the first acquisition.

T - F (Out) Two states are required to initiate a trigger event. The signal must be inside the mask
and then passes out of the mask. The trigger event occurs when the first non-violating
waveform is detected.

F - T (In) Two states are required to initiate a trigger event. The signal must be outside the mask
and then passes into the mask. The trigger event occurs when the first non-violating
waveform is detected.

T - F - T (Out & In) Three states are required to initiate a trigger event. The signal starts inside the mask and
then passes out of the mask. Next, the signal must pass into the mask. The trigger event
occurs at the second transition where the signal passes back into the mask.

F - T - F (In & Out) Three states are required to initiate a trigger event. The signal starts outside the mask and
then passes into the mask. Next, the signal must pass back outside the mask. The trigger
event occurs at the second transition where the signal passes back out of the mask.

xxx

Mask Editor. Launches the Mask Editor (see page 643) that enables you to create and edit Frequency
Masks.

Load from File. Enables you to load an existing frequency mask for use with Frequency Mask Trigger.
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Advanced Tab (Triggering)

Menu Bar: Setup > Trigger > Advanced

Favorites toolbar:

Allows you to set the following parameters.

Setting Description

Position Sets the point along the acquisition record the trigger event should occur.

Auto Enables the instrument to set the position of the trigger event. To manually specify the
position of the trigger event, unselect Auto.

Trigger each frequency
segment in Swept acquisition
mode

Sets the analyzer to wait for a trigger for each acquisition in a swept spectrum or other
measurement requiring multiple acquisitions worth of span.

xxx
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Actions Tab (Triggering)

The Actions tab sets parameters for the Save on trigger function. The Save on trigger function allows you
to save an acquisition data file and/or a screen capture when a trigger event occurs.

Trigger events are defined on the Event (see page 647) tab.

Action tab settings

Setting Description

Save acq data on Trigger Enables the Save on Trigger function. The list box to the right of the Save acq
data on Trigger check box specifies the format of the saved file. Acquisition
data files can be saved in TIQ (native) format, CSV format, and MAT (MATLAB)
format. For descriptions of these file formats, see Data, Settings and Picture
File Formats (see page 692).

When TIQ is the selected file type, a file is saved after a complete acquisition,
which can include multiple frames. When CSV or MAT is the selected file type, a
separate file is saved for each frame.

Files are saved in the last location a file was saved. If Automatically increments
filename/number is enabled (see Save and Export ), files will be saved without
user interaction. If Automatically increments filename/number is not enabled, you
will be prompted for a filename when a trigger event occurs.

Save picture on Trigger Enables saving a picture of the display when a trigger event occurs. Files can be
saved in PNG, JPG, and BMP format. For descriptions of these file formats, see
Data, Settings, and Picture File Formats (see page 692).

Max total files saved per Run Specifies the number of times a Save on Trigger action stores a file. After this
limit is reached, no more files are saved. The instrument will continue to run, but
no additional files are saved when a trigger event occurs.

Keep in mind when setting this number that picture files are counted as part of the
total number of files. For example, if you set Max total files to 100, the instrument
will save 100 acquisitions if only acquisitions are saved or only pictures are
saved. But, if both acquisitions and pictures are saved, then 50 acquisitions
and 50 pictures will be saved.

xxx
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How to set up GNSS

The combined use of the GNSS, Antenna, and Map It features allows you to capture and map location
coordinates when using an antenna and a GNSS receiver. The Map It feature requires that the optional
MAP application license be installed.

You can use the GNSS and Map It features to connect a Global Navigation Satellite System (GNSS)
receiver to a communication (COM) port on your PC to capture the timing and positioning data of the
receiver for a measurement from a satellite or constellation of satellites. The receiver must output
navigation messages using NMEA 0183 serial data format, and the messages must include at least one of
these sentence types: RMC, GGA or GNS.

The RSA500A series and RSA600A series instruments have an internal GNSS receiver.

How to access the GNSS/Antenna control panel

Click the icon or select Setup > GNSS/Antenna from the Main menu bar to view the GNSS/Antenna
control panel.

GNSS settings

The following images and table show the GNSS tab of the GNSS/Antenna control panel and its contents.

The above image shows the GNSS tab as it appears when the GNSS selection is External, None, or Simulator.

The above image shows the GNSS tab as it appears when the GNSS selection is RSA Device. This selection is only
available when an RSA500A series or RSA600A series instrument is connected.
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Setting Description

Source Select the GNSS source as None, RSA Device, or External.

None disables use of GNSS data.

RSA Device selects the internal GNSS receiver in the RSA500A series or RSA600A
series instrument if connected.

External selects a user-provided GNSS receiver in the PC with SignalVu-PC installed, or
it may be one you connect through USB or some other method.

Antenna Power This item appears when RSA Device is the GNSS selection. Check this box to supply power to
an attached antenna. Power is provided as a DC voltage on the connector center conductor.

Unchecking the box turns power to the antenna off. Changing the selection from RSA Device
to any other selection also turns the power to the antenna off.

COM Port This list is auto-populated with the COM ports on your PC, as well as a simulation port.

This selection is not available when RSA Device is selected.

NOTE. You must first select the COM port to which the antenna is connected before an
antenna connection can be established.

Baud rate Select a baud rate. Selection of this rate will depend on your GNSS receiver and COM port
specifications. Options are 4800, 9600, 19200, and 38400.

This selection does not apply when RSA Device is selected.

Satellite System Select a satellite system: GPS, GLONASS; GPS, BeiDou; GPS; GLONASS, BeiDou.

GNSS readout This readout shows the status of the GNSS connection and time, location, and satellite
information. Each item is described below.

GNSS Status GNSS receiver connection status: Off, Comm error, Unlocked, Locked.

Time Date (yyyy-mm-dd) and time (hh:mm:ss).

Longitude East-west position (shown in degrees), where the prime meridian is 0°. Positive numbers
indicate East and negative numbers indicate West.

Latitude North-south position between the poles (shown in degrees), where the equator is 0°. Positive
numbers indicate North and negative numbers indicate South.

Altitude Elevation from sea level (shown in meters).

Satellites Number of GNSS satellites currently tracked by the GNSS receiver.

HDOP Horizontal Dilution of Precision (HDOP). This value indicates the quality of the satellite signal
using the relative geometry of the satellite to receiver. An ideal value is <1. The lower the
value, the better the positional precision.

Speed Speed of receiver (shown in km/s).

Course Compass bearing (shown in degrees).

xxx

The icon appears in the right corner of the Status Bar. It is green when GNSS is locked, yellow if
unlocked, and red if there is a communication error.

How to set up the GNSS feature with an external GNSS receiver

1. Install a GNSS receiver to a COM port on your PC.

2. Select Setup > GNSS/Antenna from the Main menu bar to view the GNSS/Antenna control panel.

3. Select External from the drop-down menu in the GNSS tab.
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4. From the COM Port drop-down list, select the COM port to which the GNSS receiver is connected.

You can also select RSA Device as your GNSS source if you are using an RSA500A or RSA600A
series instrument.

NOTE. You can select Simulation Port to run a simulation when no GNSS receiver is present. Copy the file
GnssSimCom19 from C:/RSAMap Files/Example Files and place it in the Windows C:/Temp directory,
then select Simulation Port from the COM Port drop down menu.

5. Set the Baud Rate as appropriate for the connected GNSS receiver. The default is 4800, which is a
typical rate.

When the GNSS receiver is communicating with the analyzer, the readouts in the right portion of the
GNSS panel (status area) will update to display current location information and GNSS receiver status.
Lock times will vary depending on the receiver and receiving conditions.

See also:

How to use the Antenna feature

How to use Map It

Frequency Reference tab and GNSS settings (see page 631)

How to use the Antenna feature

The antenna feature allows you to connect to an Alaris DF-A0047 USB-connected antenna that reports
bearing/azimuth data over USB. In conjunction with a GNSS receiver, you can capture location and
azimuth data using the Map It feature. If you do not use an Alaris DF-A0047 antenna, you can use the
manual controls to enter an azimuth.

Explore the following topics in this section:

NOTE. A USB driver is installed for the Alaris antenna with SignalVu-PC. However, Windows will search
for new drivers if the PC is connected to the internet. The first time you plug an antenna into the port, it
may take several minutes for the driver to be installed (when connected to the internet).
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Antenna settings.

How to set up the Antenna feature with an antenna.

How to use the antenna Simulator.

How to use the Alaris function button

How to access the Antenna control panel

Click or select Setup > GNSS/Antenna from the Main menu bar to view the GNSS/Antenna control
panel. Then click on the Antenna tab in the control panel.

Antenna settings

Following is an image and a description of the Antenna tab of the GNSS/Antenna control panel.

Setting Description

Antenna Select the antenna. Choices are None, Alaris DF-A0047, and Simulator. The
Simulator simulates an antenna connection and readouts for demonstration
purposes.

Manual Azimuth Enter a value here to force the azimuth (compass direction in degrees) to be a specific
value. The azimuth is the angle measured clockwise between the reference meridian
(geographic north) and the current antenna direction. It can range from 0 to 360°.

Force Manual Azimuth Check this box to force the analyzer to read the azimuth at the entered value instead
of the antenna generated value.

Show Compass Check this box to view a visual, qualitative representation of the bearing (a virtual
compass). To remove the compass, uncheck the box. To adjust the compass size,
click and drag from the bottom right corner.

Configure... This button opens the Antenna Setup window. In this window you can enter the
antenna serial number and set the following antenna related parameters: baud rate,
data bits, stop bits, and parity.

Connect Click this button to connect to the antenna or to start the antenna simulator.

NOTE. You must first select the COM port to which the antenna is connected
before a connection can be established. Use the Windows Device Manager to find
the port used by your antenna.

Manual Declination Enter a value here to force the declination (angle in degrees between magnetic (true)
north and geographic north) to be a specific value.
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Setting Description

Force Manual Declination Check this box to force the analyzer to use the manually entered declination value.
Otherwise, the analyzer will assume that geographic north and magnetic north are
the same and use 0°.

Antenna readout This readout field will contain some or all of the following readings, depending on
your setup.

Amplifier Shows Off or On depending on whether or not you have enabled the amplifier on
the antenna.

Freq Band The current operating frequency band of the antenna. For the Alaris DF-A0047,
this value can be one of the following:

A (0.009 - 20 MHz)

B (20 - 50 MHz)

C (50 - 8500 MHz)

Uncorrected Compass Bearing Shows the azimuth reading from geographic north.

Declination Shows the declination.

True North Azimuth Shows the azimuth reading after declination is applied.

Elevation Shows the antenna elevation.

Roll Shows the antenna roll.

xxx

How to set up the Antenna feature with an antenna

1. Install the Alaris DF-A0047 driver. The driver can be copied from the SignalVu-PC Software and
Documentation USB stick supplied with the RSA306, RSA306B, RSA500A series, and RSA600A
series instruments. It can also be download from www.Tek.com\downloads.

2. Connect an Alaris DF-A0047 antenna to the PC.

NOTE. Connecting an RSA306, RSA306B, RSA500A series, or RSA600A series is not required, but
provides increased functionality of this feature.

NOTE. A USB driver is installed for the Alaris antenna with SignalVu-PC. However, Windows will search
for new drivers if the PC is connected to the internet. The first time you plug an antenna into the port, it
may take several minutes for the driver to be installed (when connected to the internet).

3. Select Setup > GNSS/Antenna to open the GNSS/Antenna control panel.

4. Select Alaris DF-A0047 from the Antenna drop-down menu. Selections also include None (default)
and Simulator.

5. Click the Configure... button to launch the Antenna Setup window.
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6. Do the following in the Antenna Setup window:

a. Enter the serial number of the antenna, if desired.

b. Select the COM port to which the antenna is connected. You can see a list of COM ports for your
PC in the Microsoft Windows Control Panel. Use the Windows Device Manager to find the
port used by your antenna.

c. You can change the following parameters; however, the default values are set for the Alaris
DF-A0047 antenna. If you change these parameters, you may lose communication with the Alaris
antenna: baud Rate, data bits, stop bits, and parity.

8. Click OK to save the changes and close the Antenna Setup window.

9. You can now choose to manually set the declination, if desired. To do this, check the box next to
Force Manual Declination in the Antenna tab of the GNSS/Antenna control panel and then enter the
desired value. Notice that the value you enter will appear in the antenna readout to the right of the
Connect button. The True North Azimuth reading is the sum of the Uncorrected Compass Bearing
and the Declination.

You can also check the box next to Force Manual Azimuth and enter a desired value if you want to
force the azimuth or are using an antenna that does not report azimuth.

When you select to manually force the declination and/or azimuth, those values will not change in the
readout, even if the antenna direction changes.

10. Check the Show Compass box to view a visual, qualitative representation of the bearing. As you
move the antenna, the compass needle will move.
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TIP: You can adjust the size of the compass by clicking on the right bottom corner and dragging it.

11. Click the Connect button to connect to the antenna. Connection may take about 10 seconds. Once
connected, the antenna readout will reflect the antenna direction and other readings.

How to use the antenna Simulator

1. Select Setup > GNSS/Antenna to open the GNSS/Antenna control panel.

2. Select Simulator from the Antenna drop-down menu. Selections also include None (default) and
Alaris DF-A0047.

3. Click the Connect button to launch the Smart Antenna Control Form.

4. Click on the various areas of the Smart Antenna window to adjust azimuth, roll, or elevation. You
can also enter the values directly in the Azimuth, Elevation, and Roll Angle fields. This Smart
Antenna window simulates a physical antenna, except that there is no amplification available (the
Passive/Active switch in non-functional).

5. Click the Button1 button to capture the GNSS information. (See the How to use Map It topic for
more information on capturing data.)
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6. You can now choose to manually set the declination, if desired. To do this, check the box next to
Force Manual Declination in the Antenna tab of the GNSS/Antenna control panel and then enter the
desired value. Notice that the value you enter will appear in the antenna readout to the right of the
Connect button. The True North Azimuth reading is the sum of the Uncorrected Compass Bearing
and the Declination.

You can also check the box next to Force Manual Azimuth and enter a desired value if you want to
force the azimuth or are using an antenna that does not report azimuth.

When you select to manually force the declination and/or azimuth, those values will not change in the
readout, even if the antenna direction changes.

7. Check the Show Compass box to view a visual, qualitative representation of the bearing. As you
move the antenna, the compass needle will move.

TIP: You can adjust the size of the compass by clicking on the right bottom corner and dragging it.

How to use the Alaris function button

The Alaris antenna has a function button that allows you to make Band and Mode selections. These can be
selected using the rotary encoder and push button located on the front of the Alaris antenna grip.

To select a frequency:

1. Turn the rotary switch either to the left or right.

2. Watch the LEDs on the back of the grip. The LEDs indicate which frequency band is selected.
Selections are:

Top LED, Band A: 9 kHz – 20 MHz

Middle LED, Band B: 20 MHz – 500 MHz

Bottom LED, Band C: 500 MHz – 8500 MHz
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To select an amplifier mode:

1. Push the button on the front of the antenna grip.

2. Watch the LED on the back of the grip. It indicates the mode status as:

LED on: Active mode (amplifier on)

LED off: Bypass mode (amplifier off)

To take a measurement using the button:

1. Hold the button down for two seconds.

2. Release the button. The measurement is transferred and stored via the Map It function of SignalVu-PC.

See also:

How to set up GNSS (see page 653)

How to use Map It (see page 661)

How to use Map It

Select View >Map It Toolbar from the Main menu bar to open the Map It toolbar.

Once you have set up the GNSS receiver as shown here, perform the following steps to capture the
data. A Map It file includes trace data, measurement data, time, and location information for use in
the RSA Map program.

NOTE. The Map It feature requires that the optional MAP application license be installed.

1. Check that at least one of the following displays is active: Spectrum, DPX, Spectrogram, Amplitude
vs Time, Channel Power, or Occupied Bandwidth.

2. If an RSA306, RSA306B, RSA500A series, and RSA600A series is not currently connected to the PC,
you can connect one now, if desired.

3. Select View >Map It Toolbar from the main menu bar to view the Map It toolbar. Notice that the
current GNSS location and time information are shown on the toolbar.

4. Click the Edit... button to open the Map It Editor window.
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5. In the Map It Editor window, click the Capture button to capture data. If you prefer, you can click
the Capture button on the Map It toolbar first, and then click Edit... to open the Map It Editor
window to view the result.

6. You can now import, export, or recall captured data using the related buttons at the bottom of the
Map It Editor window. If you export a file, you can then open it using the RSAMap application
(open from the Tools menu).

Importing and exporting Map It files

The information you capture can be zipped and stored as a single file with multiple captures. Recalling
results will recall the trace data and settings stored with Map It. Make sure to uncheck the Show box in the
traces menu of the selected display when you have completed examination of the Map It data.

The Map It zip file is structured as follows:
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Viewing live updates after viewing an imported file

When you want to view live updates again in a Spectrum, DPX, or Spectrogram display, you must go
into the Traces tab of the Settings control panel and uncheck the Show recalled trace box. If you are
using a DPX display, do this twice, once each for Bitmap and Trace 1.

See also:

How to use the Antenna feature

How to set up GNSS
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How to use the Signal Database

Select Tools > Signal Database to open the Signal Database window. Here you can select which signal
standards and types are listed (and selectable) in the Channel Navigation toolbar and/or the Define
Survey control panel.

Signal standards and signal types defined

The analyzer uses the following definitions of signal standards and signal types to populate the Signal
Database.

Signal standard: A group of channels that adheres to the parameters and characteristics of a given
signal type. These channels could include both uplink and downlink frequencies.

Signal type: Parameters and characteristics (bandwidth, spectral shape) common to a given signal. A
signal type can be shared by multiple signal standards.

How to select signal standards in the database window

The following image is of the Signal Database window with the Signal Standards tab selected. The
table describes the fields and buttons of the tab. The standards selected here show in the Define Survey
control panel and the Channel Navigation toolbar.

Setting Description

Signal Standards
Supported

List of all available signal standards. Click a standard to select it or click and drag to select a
contiguous range of standards.

Add > > Adds (moves) selected items from the Signal Standards Supported list to the Signal Standards
selected list.
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Setting Description

< < Delete Deletes (moves) selected items from the Signal Standards selected list to the Signal Standards
Supported list.

Signal Standards
selected

List of selected signal standards that will be made available in the Channel Navigation toolbar and
the Region tab of Define Survey control panel. To delete items, select one or more signal standards
and click the Delete button.

Factory Reset Sets the supported and selected fields to the factory-specified signal standards.

Channel Nav
Toolbar check box

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You
can read more about the Channel Navigation toolbar here.

Signal Survey
Toolbar check box

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can
read more about the Signal Survey toolbar here.

xxx

How to merge the H500 signal database with SignalVu-PC default database

You can merge all user-defined signal types and signal standards from the Tektronix H500 instrument
into the default SignalVu-PC signal database. This provides the advantages the new items introduced in
SignalVu-PC without losing your user-defined additions. Merge databases as follows:

1. Close SignalVu-PC.

2. Make a copy of \BuiltInDisk\NetTekApps\Database\sst_db file to a USB memory stick from the
H500 instrument.

3. Rename the copy of the sst_db file to SignalDatabase.rsadb.

4. On the PC with SignalVu-PC installed, overwrite the C:\SignalVu-PC Files\SignalDatabase\Signal-
Database.rsadb file with that you made in step 3.

5. Start SignalVu-PC.

6. Verify all H500 user-defined signal standards and signal types are now available in SignalVu-PC.

How to select signal types in the database window

The following image is of the Signal Database window with the Signal Types tab selected. The table
describes the fields and buttons of the tab. The types selected here show in the Define Survey control panel.
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Item Description

Signal Types
supported

List of all available signal types. Click a type to select it or click and drag to select a contiguous
range of types.

Add > > Adds (moves) selected items from the Signal Types Supported list to the Signal Types selected
list.

< < Delete Deletes (moves) selected items from the Signal Types selected list to the Signal Types
Supported list.

Signal Types
selected

List of selected signal types made available in the Region tab of the Define Survey control panel.
To delete items, select one or more signal types and tap the Delete button.

Factory Reset Sets the supported and selected fields to the factory-specified signal types.

Channel Nav
Toolbar check box

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You
can read more about the Channel Navigation toolbar here.

Signal Survey
Toolbar check box

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can
read more about the Signal Survey toolbar here.

xxx

How to select channels in the database window

The following image is of the Signal Database window with the Channel Table tab selected. The table
describes the fields and buttons of the tab. The channels selected here are included in the Signal Channel
Selection window. (See the Channel Navigation toolbar section for information about channel selection.)
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Item Description

Selected Signal
Standard

Drop down list allows you to select the signal standard, the channels of which will populate the
channel table. This list is taken from the enabled standards in the Signal Standards tab.

Enabled column
checkboxes

Enables/disables the channel in the row.

Mark All Selects all channels in the table to enable them.

Unmark All Deselects all channels in the table to disable them.

Hide unmarked
checkbox

Hides any deselected channels so that you can view only the enabled channels in the table.

Factory Reset Sets each channel to the factory-specified enabled/disabled state.

Channel Nav
Toolbar checkbox

Check box to open the Channel Navigation toolbar. The Signal Database window stays open. You
can read more about the Channel Navigation toolbar here.

Signal Survey
Toolbar checkbox

Check box to open the Signal Survey toolbar. The Signal Database window stays open. You can
read more about the Signal Survey toolbar here.

xxx

Channel Navigation toolbar

Select View > Chan Nav Toolbar to view the Channel Navigation toolbar. This toolbar allows you to
navigate easily from channel to channel in any measurement display. It provides the following capabilities:

Select a channel for enabled standards (only standards selected in the Signal Database).

Select the channel direction, if applicable (uplink or downlink).

Access the Signal Channel Selection window, which allows you to select from a list of enabled
channels.

The following image shows the toolbar and the following table describes how it functions.
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Item Description

Signal Standard Drop down list allows you to select the signal standard, the channels of which will populate the
Channel field to the right . This list is taken from the enabled standards in the Signal Standards
tab of the Signal Database.

Channel This field shows the channel number of the currently selected signal standard that the instrument is
currently tuned to. An entry of "--" indicates that the current instrument frequency does not match
that of any of the currently enabled channels.

Clicking in this field allows for direct channel number entry. To select the next or previous channel,
you can use the up and down arrow keys on your keyboard or the arrows in the Numeric Keypad (in
the View menu, check the Numeric Keypad box). Note that this applies to enabled channels only.

If you see a ≈ in front of the channel number, it means that the current instrument frequency
is close to, but not exactly equal to, the currently selected channel. It means that the current
instrument frequency does not exactly match the currently selected channel frequency, but that it is
within the current channel bandwidth.

You cannot directly enter or use the arrow keys to select non-numeric channel names for signal
standards You must use the Select Channel button.

Select Channel Opens the Signal Channel Selection window. This window shows a table of enabled channels for
the selected standard. Click on the channel you want to view in the plot and then click the OK
button. This window also allows you to access the Signal Database window (using the Enabled
Channels button) so that you can enable different channels or change standards or types, if desired.

Uplink Click to select the uplink channels for the currently selected signal standard.

Downlink Click to select the downlink channels for the currently selected signal standard.

xxx

See also:

How to use the Signal Database. (see page 665)
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Signal Classification

With the SV54 optional application license for SignalVu-PC installed, you can use the signal classification
toolset to help you classify signals. You will first define areas of interest as regions anywhere on a
Spectrum or DPX waveform. You can then use our Signal Database tool to compare the spectral shape
of the selected signal area to known signal types, and the center frequency of the selected signal area to
known signal standard channels. Finally, you can assign classification labels to regions, record related
notes, and save all defined regions to a region survey file. This toolset also allows you to import and export
survey files. The following information and procedures are available to help you find, navigate through,
and use the signal classification tools to classify a signal.

Step by step procedures for classifying a signal. These procedures walk you through the classification
process from start to finish using the analyzer’s signal classification tools. Examples are included.

How to use the Signal Survey toolbar. (see page 679) Once launched, this toolbar allows you to access
the Create/Edit, Define, and Classify tools. These tools allow you to create a new survey/region,
import and export surveys, define region signal standards and types, navigate quickly through regions
in a survey, and classify a signal in a region.

How to use the Signal Survey Editor window. (see page 680) This window is accessed through a
Signal Survey toolbar button. It allows you to create and edit regions or import or export a survey.

How to use the Define Survey control panel. (see page 681) This panel is accessed through a Signal
Survey toolbar button. It allows you to select signal standards and types from the Standards Database;
see bandwidth, frequency, and channel information; view all regions and related information in a
survey in a table; and select and view a spectral profile (most signal types have an available profile).

How to classify a signal

The following procedure shows you how to use the signal classification tools to classify a signal. It is
divided into four main tasks.

NOTE. Before you proceed, you will need to select a list of enabled signal standards, signal types, and
channels in the Signal Database. You do not need to perform this setup each time you classify a signal.
Once set up, this list does not change unless you reset to default or change the selections.

1. Create areas of interest as regions (center frequency and frequency span) anywhere on the signal.

2. Define a survey (a region or collection of regions) by comparing the bandwidth of the unknown
signal to that of known signal types, and the center frequency of the unknown signal to that of known
signal standard channel frequencies.

3. Classify the signal by assigning classification labels and notes to a defined region.

4. Export or import a region survey file.
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Create a region

The first step in classifying a signal is to create a region that defines the portion of the signal you want
to use.

1. Open a Spectrum or DPX display to view the signal you want to classify.

2. Select View from the analyzer menu bar and select (check) Signal Survey Toolbar. The toolbar will
appear near the bottom of the screen.

3. Click the Create/Edit... button in the Signal Survey tool bar to open the Signal Survey Editor window.

4. Check that the selected reference trace is correct in the Reference dropdown list which is located to
the right of the Export As... button. Note that for a trace to be in the list, it must be enabled in the
Spectrum or DPX display.

5. Click the Add Region button.

6. By default, Click and drag on plot is selected for the add region method. Click and drag on the plot
around the signal area of interest to define the width (span) of the region. The analyzer will draw a
box on the plot that is outlined in gray, indicating that the region is as yet undefined. Click on the

icon at the bottom of the region to change the CF. You can also click and drag on the left or
right edge of the region rectangle to change its span. The amplitude of the signal does not need to
be totally enclosed in the region box.

7. If you want to manually enter the center frequency and span parameters to create a region, select
Manual entry, enter the values in the New Region Location fields, and then click the Add Region
button.

8. Create more than one region, if needed.

NOTE. A maximum of two regions can overlap at any given frequency. If you try to create a new region
that contains any frequency point that is already shared by two other regions, an error message is
displayed stating that too many regions overlap.
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9. If you want to edit a region, then you can use the same tools as when you first created the region (click,
drag, ). If you want to delete a region, select the desired region and then click the Delete Region
button. You can also click Delete All Regions to delete all regions in the display.

When Manual entry is selected in the On Add area, you can manually edit the Frequency and Span.

10. Click the OK button when you are finished creating and editing regions. Clicking the Cancel button
will result in all additions/changes made during the current edit session (as long as the Signal Survey
Editor dialog has been open) being discarded.

See also:

How to use the Signal Survey Editor window.

How to use the Signal Survey toolbar.

How to use the Define Survey control panel.

What region color codes mean.

Using the Signal Database.

Define a region using known standards

The next step after creating a region is to define it by comparing the unknown signal’s bandwidth and
frequency to the known signal standards and signal types. Doing this allows you to potentially find a
match and classify the unknown signal. You can also use known signal standard channel frequencies to
match against a region’s center frequency.

NOTE. You can also define a region using a known signal standard channel frequency and match it
against the center frequency of a region.

1. Click the Define button to open the Define Survey panel.

2. Do one of the following to select a region:

Click on a region (shown as a horizontal bar along the top edge of the plot) in the Spectrum or
DPX display. When selected, the region will expand to a rectangular box around the signal.

Click on a row in the Survey Summary tab table of the Define Survey panel. This table is
scrollable and contains summary information about all of the regions in the current display (called
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a survey). Clicking on a row in the table selects the region in the display. Information in the
rows is not editable.

Use the left or right arrows on the Signal Survey toolbar to navigate to the desired region. Notice
that this will highlight the row number in the Survey Summary tab table of the associated region,
and thus select the region in the display.

NOTE. Only one region can be active at a time. Inactive regions are shown as horizontal bars along the
top edge of the signal. An active region is shown as a box drawn around the signal.

3. In the Define Signal panel, select the Region tab and click to view the drop-down list under the Signal
Type Bandwidth. In the below image, you can see that in the list, the Bluetooth signal type has a star
next to it. The degree and darkness of the shading of a star indicates how close of a bandwidth match
the given signal type is to the unknown signal. (You can read about how the star indicator works in
The Define Survey control panel (see page 681) topic.)

4. You now want to select from this list of known signal types and associated bandwidths. Once selected,
a spectral profile (shown as a green waveform in the example image) will be overlaid on the portion of
the signal in the region. The spectral profile is used to compare against the signal in the region. If the
profile and the signal match, then there is a good chance the signal is that given signal type.
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NOTE. Most, but not all, signal database signal types have spectral profiles.

5. Click on the Prefs tab in the Define Survey panel to set the spectral profile to do one of the following:

Snap to Channel Frequency: Use this option if you want to verify the frequency of the signal
is aligned with the selected signal standard channel frequency. If the selected signal standard
channel frequency is within the selected region, then the spectral profile will center on that channel
frequency. If the channel frequency is outside of the selected region, then the spectral profile
will revert to being centered within the region.

Snap to Center of Region: Use this option if you know that the frequency you are viewing has no
defined signal standard channels in the database.

Off: Use this option if you want to view the signal in the region without the spectral profile
overlayed on the signal.

See also:

How to use the Signal Survey Editor window

How to use the Signal Survey toolbar

How to use the Define Survey control panel.

What region color codes mean

Signal Database

Classify a region

After you have created a region, you can classify it by assigning classification labels and notes to it.
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1. Select a region.

2. Click the Classify button in the Signal Survey toolbar to view the Declare Region window.

3. Select a Classification state from the drop-down list and enter a Description and Comments for the
region.

Classification state and region color coding. Each region’s outline is colored according to it’s
classification state:

Gray = None

Yellow = Unknown

Orange = Unauthorized

Blue = Permitted

4. Click OK to save the classification information as a survey and close the window. Once a region has
been classified, the signal type and signal standard used for classification are locked. To apply different
signal types and standards to the region, set the classification to None.

The following example survey is of a portion of the TV broadcast band. Seven regions have been declared
as either Permitted, Unknown, or Unauthorized, as indicated by the color bars for each region.
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The illustration below shows a detailed portion of one of the declared regions. Since we have declared
this to be an ATSC video signal, the spectral profile for the ATSC signal is shown overlaid in the region.
The signal is a close match to the spectral profile, including the vestigial carrier at the lower side of the
signal, characteristic of ATSC broadcasts.

See also:

How to use the Signal Survey Editor window

How to use the Signal Survey toolbar

How to use the Define Survey control panel.

How to use the Declare Region window

Signal Database

Export or import a survey file

The application does not enforce a hard limit on the total number of regions you can create. However,
as the number or regions increase, system performance decreases. A good rule of thumb is to keep the
total number of regions under 500. If more than that are required, create and save separate surveys,
each with no more than 500 regions.

Export a file. To export a region or set of regions in a file, do the following:

1. Click the Create/Edit... button in the Signal Survey toolbar to open the Signal Survey Editor window.

2. Click the Export As... button in the Signal Survey Editor window.

3. Navigate to the location you want to save the file.
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4. From the Save as type drop down list in the Save As window, select one of the following:

*.Survey – survey in an internal format

*.txt – survey in a tab separated format

*.csv – survey in a comma separated format

5. Enter the file name and click Save to save the file.

Survey Import/Export file format notes.

All lines starting with a "#" character are treated as a comment line.

All blank lines are ignored.

Lines starting with "Signal Classification: Number of Regions" are ignored (in order to be compatible
with H500/SA2500 survey import/export files).

The only required fields are the region center frequency and region bandwidth all other fields can be
left blank.

Survey file field definitions. You can create your own .txt and .csv Survey files using software applications
such as Excel or Notepad, and then import them. The following information will help you do this. You can
also refer to the SurveyImportFileExample.txt sample import/export file installed with SignalVu-PC in the
C:\SignalVu-PC Files\Example Files\SignalClassification directory.

# - Region number. Note that the value specified is not used during import (regions are renumbered as
necessary)

Freq (Hz) - Center frequency of the region

Span (Hz) - Bandwidth of the region

Description - Short description of the region

Classification - Declared region classification (None, Unknown, Permitted, or Unauthorized)

Type - Declared region signal type ("Not Set", "Unknown" or any currently defined signal type name)

Standard - Declared region signal standard ("Not Set", "Unknown" or any currently defined signal
standard name)

Channel - Declared region channel number (channel number from the specified signal standard; "----"
can be used to denote no channel number specified)

Ch Freq (Hz) - Declared region channel frequency (for the specified channel number; "----" can be
used to denote no channel frequency specified)

Comments - Declared region comments
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Import a file. To import a region or survey file, do the following:

NOTE. If a problem is found with the format of the file being imported, a dialog will be displayed indicating
the file line number where the problem was found and a short description of the problem. For example,
“Survey Import failed: Syntax Error near line 10: Invalid span value”.

2. Click the Create/Edit... button in the Signal Survey toolbar to open the Signal Survey Editor window.

3. Click the Import... button in the Signal Survey Editor window.

4. Navigate to the location of the saved file and select to import one of the following file types:

*.Survey – survey in an internal format

*.txt – survey in a tab separated format

*.csv – survey in a comma separated format

5. Click Open to open the selected file.

Importing guidelines. If you try to import a survey when regions are already defined, an Import Regions
dialog will appear and prompt you to select one of the following import options:

1. Delete all existing regions prior to import.

2. Attempt to merge the imported regions with the existing regions.

3. Cancel the import.

If an import and merge action does not successfully merge all regions, the "Warning: not all regions
were successfully merged" message will be displayed in the informational area of the Signal Survey
Editor dialog.

Signal Survey toolbar

Select View > Signal Survey Toolbar to view the Signal Survey toolbar. It allows you to create, edit,
define, and classify a signal. It also allows you to navigate from one region to another in the DPX or
Spectrum display and to delete the selected region. This topic describes the toolbar and all of its related
windows and functions.

Item Description

Create/Edit... Opens the Signal Survey Editor window that allows you to create and edit regions and import and
export region survey files.

Define Opens the Define Survey control panel. This panel allows you to view a survey summary, select how
to view spectral profiles, and to specify a signal type and signal standard channel for each region.

Classify Opens theThe Declare Region window (classify) (see page 683) that allows you to classify a region.
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Item Description

Selected Region Click the arrows to navigate from region to region.

Delete Click to delete a selected region.

xxx

The Signal Survey Editor

Click the Create/Edit... button on the Signal Survey toolbar to access the Signal Survey Editor window.
Following is an image of the window and a table describing it.

NOTE. If you change which waveforms are enabled in the DPX or Spectrum display after the Signal
Survey Editor window is open, the Reference list in the Editor will no longer be accurate. You must
close and then reopen the Editor to refresh the list.

Item Description

Import Click this button to import a survey from a file.

Export Click this button to save changes made to a previously saved survey file. This button is only
available for previously saved surveys. This function is like the common Save function.

Export As... Click this button to export all of the region information to a survey file. This function is like the
common Save As function.

Reference This drop down list shows all active traces from the currently displayed Spectrum and/or DPX
measurement displays. When you first open the Editor, the displayed reference trace will be the
trace in the currently selected Spectrum or DPX measurement display.

Delete All Regions Click this button to delete all regions on the plot.

Add Region Click the Add Region button to enable the plot to allow you to add a region by clicking and dragging
or entering the values manually, depending on the selected On Add setting.

On Add: Select to add a region manually or by clicking and dragging on the plot.
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Item Description

New Region
Location

When Manual entry is selected in the On Add area, the New Region Location area appears. Here
you can manually enter the Frequency and Span.

Status message
area

Shows informational and error messages.

Region table Shows regions and the related frequency and span. These are editable in the table for regions that
have not yet been classified.

Measurement
display

Interactive view of the active measurement plot (DPX or Spectrum). You can click and drag on
the plot to create a region and left-click in the display area to select the current click/drag mode.
Allowable modes are Select, Span Zoom, and CF Pan. You can also adjust the area of the signal
within the region using the following:

dB/div Shows the dB per division on the y-axis of the plot.

CF Shows the current region center frequency. Click on the field to enter a new value.

Span Shows the current region span. Click on the field to enter a new value.

Classification Shows the classification label of the selected region: Unknown, Unauthorized, or Permitted. If it
has not been classified, this field reads None.

Signal Type Shows the signal type of the selected region, if the signal in the region has been classified. If it has
not been classified, this field reads Not Set.

Signal Standard Shows the signal standard of the selected region, if the signal in the region has been classified. If it
has not been classified, this field reads Not Set.

Delete Region Click this button to delete the selected region.

xxx

See also:

The Create a region (see page 672) topic to see how the Signal Survey Editor works when creating/editing
a region.

The Define Survey control panel

Click the Define button on the Signal Survey toolbar to access the Define Survey control panel. The
following images and tables describe the Define Survey control panel and its tabs.

Region tab
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Item Description

Signal Type For classified regions, this field is not editable. For unclassified regions, this field is a drop-down list
of all enabled signal types (set in the Signal Database). The types that best match the signal are
starred in this list. See here for star rating definitions.

Bandwidth Shows the bandwidth of the selected signal type.

Notification area Notes may appear between the Signal Type and Signal Standard fields.

Signal Standard For classified regions, this field is not editable. For unclassified regions, this field is a drop-down list
of all enabled signal standards (set in the Signal Database) and standards for which channels are
enabled. The standards and their channels that best match the center frequency of the region are
starred in this list. See here for star rating definitions.

Frequency Shows the channel frequency of the selected signal standard.

Channel Shows the channel number for the selected signal standard. .

xxx

Criteria for signal standard and type star ratings.

Criteria

Star Signal standards Signal types

The region center frequency matches the selected
signal standard channel frequency and the
selected signal standards database signal type
matches that of the selected signal type.

The region bandwidth exactly matches the selected
signal type bandwidth.

The region center frequency matches the selected
signal standard channel frequency.

The region bandwidth is within ±5% of the selected signal
type bandwidth and does not exceed the defined min/max
matching bandwidth range of the selected signal type.

A large portion of the region start/stop frequency
overlaps the selected signal standard channel
frequency.

The region bandwidth is within the defined min/max
matching bandwidth range of the selected signal type.

A small portion of the region start/stop frequency
overlaps the selected signal standard channel
frequency.

Not applicable.

No star No portion of the region start/stop frequency
overlaps the selected signal standard channel
frequency.

The region bandwidth is outside the defined min/max
matching bandwidth range of the selected signal type.

xxx

Survey Summary tab

682 SignalVu-PC Printable Help



Signal Classification Signal Survey toolbar

Item Description

Each region is identified by a number.

The center frequency of the region.

The span of the region.

The classification of the signal in the region.

The signal type of the signal in the region, if it has been set. Otherwise, this field reads Not Set.

Summary table of all
of the regions in the
active plot

The signal standard and channel of the signal in the signal in the region, if it has been set.
Otherwise, this field reads Not Set.

xxx

Preferences tab

Item Description

Off turns the spectral profile off so that it does not appear on the plot. Use this option if you want to
view the signal in the region without the spectral profile overlayed on the signal.

Snap to Center of Region aligns the spectral profile to the center of the region. Use this option if
you know that the frequency you are viewing has no defined signal standard channels in the
database.

Spectral Profile

Snap to Channel Frequency aligns the spectral profile with the specified signal standard channel
frequency of the signal. Use this option if you want to check that the channel frequency of the
spectral profile matches the signal frequency you are looking at. If the selected signal standard
channel frequency is within the selected region, then the spectral profile will center on that channel
frequency. If the channel frequency is outside of the selected region, then the spectral profile
will snap to the center of the region.

xxx

See also:

Define a region using known standards.

The Declare Region window (classify)

Click the Classify... button on the Signal Survey toolbar to access the Declare Region window. Once a
region is classified, you can no longer change the signal type or signal standard in the Region tab of the
Define Survey control panel. The following image and table describe the Declare Region window.
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Item Description

Classification Lists classification types to assign to the current region. Each classification has a
unique color that is assigned to the region box:

None: Gray

Unknown: Yellow

Unauthorized: Orange

Permitted: Blue

Description Enter a brief description to identify the region.

Comment/Notes Enter additional comments to provide needed information regarding the region.

Signal Lists the selected signal type and signal standard of the selected region.

Region Lists the span and center frequency of the selected region.

xxx

NOTE. If a region is classified, you need to change the classification to "None" before you can make
any changes to that region.
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Saving and Recalling Data, Settings, and Pictures

You can save different types of data for later recall and analysis.

Data type Description Save as type

Setup files Saves all of the setup information for
all displays, except those settings that
are not part of Preset.

Setup (.Setup)

Picture of Selected Display
(PNG/JPG/BMP)

Saves a capture of the screen in the
specified format. This option is useful
for including the graphic in reports or
other applications. Marker readouts
and other information are included.

Picture (.BMP, .PNG, .JPG)

Results Export files Saves the trace and numeric data for
the selected display. The trace and
numeric data are saved as CSV files.

Results export (various)

Measurement Settings Saves a list of settings relevant to the
selected measurement to a text file.
This option is useful for including the
measurement settings in reports.

Measurement settings export (TXT)

Trace Saves a trace for later recall into the
display from which it was saved.

Selected trace (various)

Data Saves data for reanalysis later or as
data to use with external software
(either CSV (comma-separated
value) or MAT (MATLAB format).

Acquisition data with setup (TIQ); or
Acquisition data export (CSV or MAT)

xxx

Saving Files

Saving files follows the same procedure regardless of the type of data being saved. To save setups
(including application presets), pictures, results, or acquisition data:

1. Select Save As from the File menu to open the Save As dialog box.

2. Navigate to the folder where you want to save the setups, or use the default location.

To save setups so that they appear in the Application Presets window, save your setup in the folder
C:\SignalVu-PC Files\User Presets. The saved setup will appear in the Application Presets
window with the name you give the file.

3. Enter a file name.

4. Select the type of file to save from the Save as type drop-down list.

5. Click Save.
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Recalling Files

You can recall three types of files: Setup files, Selected Trace, and Acquisition data with setup. Recalling
data follows the same procedure regardless of the type of data being recalled.

1. Select Recall from the File menu to open the Open dialog box.

2. Navigate to the folder containing the file you want to recall.

3. Select the type of file to recall from the Files of type drop-down list. This selection determines the
files that appear in the Open dialog box.

4. Select the file to recall.

5. Click Open.

Recalling Waveforms with SignalVu-PC

SignalVu-PC can recall waveform files saved by Tektronix oscilloscopes and spectrum analyzers. It can
also read files saved in MATLAB Level 5 format. Waveform files can be recalled two ways: as Data and
setup, and as Data only. When recalled as Data and setup, only the .tiq file format opens with all settings
and measurements recalled. Because only the .tiq file is recalled with all settings and measurements, you
should save any non-tiq file as a .tiq file once you have recalled the file with SignalVu-PC.

The following tables lists the supported file formats and includes notes about using the files.

Table 11: RSA5000/RSA6000/SPECMON file formats supported by SignalVu-PC

Generated by RSA5000/RSA6000/SPECMON

File type .tiq .mat

File
description

Contains corrected I and Q
time-domain data, all settings
and measurement setup

Contains I and Q
time-domain data,
center frequency,
sample rate

All Settings and
Measurements are
Recalled

Open
with
settings

Automatically
Sets Span, Center
Frequency

What
SignalVu-PC
can do with
this format

Open as
data only

Uses settings from
SignalVu-PC when
opened

Notes This is the native format for
SignalVu-PC. It contains all
information needed to open and
analyze all displays available

Recommend saving as
.tiq file after opening

xxx
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Table 12: RSA3000 and WCA200 file formats supported by SignalVu-PC

Generated by RSA3000, WCA200

File type .iqt .mat

File
description

Contains I and Q time-domain
data, center frequency, sample
rate, amplitude and phase
corrections

Contains I and Q
time-domain data, center
frequency, sample rate

All Settings and
Measurements are
Recalled

Open
with
settings

Automatically
Sets Span, Center
Frequency

What
SignalVu-PC
can do with
this format

Open as
data only

Uses settings from
SignalVu-PC when
opened

Notes Recommend saving as .tiq file
after opening

Recommend saving as
.tiq file after opening

xxx

Table 13: WCA300 file formats supported by SignalVu-PC

Generated by WCA300

File type .iqt

File description Contains I and Q time-domain data,
center frequency, sample rate, amplitude
and phase corrections

All Settings and
Measurements are Recalled

Open with
settings

Automatically Sets Span,
Center Frequency

What SignalVu-PC
can do with this
format

Open as data
only

Uses settings from
SignalVu-PC when opened

Notes Recommend saving as .tiq file after
opening

xxx

Table 14: SignalVu on oscilloscopes file formats supported by SignalVu-PC

Generated by SignalVu on oscilloscopes

File type .tiq .mat

File
description

.tiq format as used by SignalVu,
all versions, includes I and Q
time domain data, all settings
and measurement setup

Contains I and Q
time-domain data,
center frequency,
sample rate
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Table 14: SignalVu on oscilloscopes file formats supported by SignalVu-PC (cont.)

All Settings and
Measurements are
Recalled

Open
with
settings

Automatically
Sets Span, Center
Frequency

What
SignalVu-PC
can do with
this format

Open as
data only

Uses settings from
SignalVu-PC when
opened

Notes This is the native format for
SignalVu-PC. It contains all
information needed to open
and analyze all displays
available

Recommend saving as
.tiq file after opening

xxx

Table 15: Performance Oscilloscope (without SignalVu) file formats supported by SignalVu-PC

Generated by MSO/DPO/DSA5000/7000/70000

File type .wfm

File description Amplitude vs. Time, includes sample
rate information

All Settings and
Measurements are Recalled

Open with
settings

Automatically Sets Span,
Center Frequency

What SignalVu-PC
can do with this
format

Open as data
only

Uses settings from
SignalVu-PC when opened

Notes Prior to opening: Preset SignalVu-PC.
Set span and center frequency. After
opening, save as .tiq file. Reopen
the .tiq file for further changes to the
measurement settings and opening
additional displays

xxx

Table 16: Bench Oscilloscope file formats supported by SignalVu-PC

Generated by MSO/DPO 2000, 3000, 4000

File type .isf

File description Amplitude vs. Time, includes sample
rate information
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Table 16: Bench Oscilloscope file formats supported by SignalVu-PC (cont.)

All Settings and
Measurements are Recalled

Open with
settings

Automatically Sets Span,
Center Frequency

What SignalVu-PC
can do with this
format

Open as data
only

Uses settings from
SignalVu-PC when opened

Notes Prior to opening: Preset SignalVu-PC.
Set span and center frequency. After
opening, save as .tiq file. Reopen
the .tiq file for further changes to the
measurement settings and opening
additional displays

xxx

Table 17: MDO4000B/C mixed domain oscilloscope file formats supported by SignalVu-PC

Generated by MDO4000B/C, RF channel

File type .tiq

File description Contains I and Q time domain data.
Opens with spectrum analyzer and time
overview.

All Settings and
Measurements are Recalled

Open with
settings

Automatically Sets Span,
Center Frequency

What SignalVu-PC
can do with this
format

Open as data
only

Uses settings from
SignalVu-PC when opened

Notes Native format for SignalVu-PC. Opens
with Time Overview and Spectrum
Display active

xxx

Table 18: H500 and SA2500 file formats supported by SignalVu-PC

Generated by RF Hawk

File type .iqt .mat

File
description

Contains I and Q
time-domain data, center
frequency, sample rate

Contains I and Q time-domain
data, center frequency,
sample rate
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Table 18: H500 and SA2500 file formats supported by SignalVu-PC (cont.)

All Settings and
Measurements are
Recalled

Open with
settings

Automatically
Sets Span, Center
Frequency

What
SignalVu-PC
can do with
this format

Open as
data only

Uses settings from
SignalVu-PC when
opened

Notes Recommend saving as .tiq
file after opening

Recommend saving as .tiq
file after opening

xxx

Table 19: User generated (including Agilent 89601 software) file formats supported by SignalVu-PC

Generated by User generated (including Agilent 89601
software)

File type .mat

File description MATLAB Level 5 format, must contain
at least InputCenter, InputZoom, Xdelta,
and Y

All Settings and
Measurements are Recalled

Open with
settings

Automatically Sets Span,
Center Frequency

What SignalVu-PC
can do with this
format

Open as data
only

Uses settings from
SignalVu-PC when opened

Notes Recommend saving as .tiq file after
opening

xxx

To recall a acquisition data file, see Recalling Files (see page 686) above.

Opening .iqt files saved by RSA3000 and WCA300 analyzers. To open a .iqt file:

1. Select File > Preset (Main).

2. Select File> Recall and select Acq Data with Settings (IQT) (*.iqt) in the Open dialog. Select
the desired file and click OK to open the file.

3. Save the file by selecting File > Save As and set the file type to Acq data with setup (TIQ) (*.tiq).
Save the file by clicking OK.

Saving the file in .tiq format preserves all of the settings in the analyzer and associates them with the
data set. After saving the file in .tiq format, recall the saved .tiq file and add measurements and
change settings.

The .iqt file format contains I and Q waveforms plus instrument amplitude/phase correction data,
analysis bandwidth and center frequency. When SignalVu-PC opens an .iqt file, the amplitude and phase
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corrections are applied to the IQ data to produce a corrected data set. The span and center frequency
information present in the .iqt file are used to set the SignalVu-PC span and center frequency. However, no
information about analysis length, offset or type is preserved in the .iqt file.

Opening .mat files saved by RSA5000/6000/SPECMON series and third party waveforms. To open a .mat
file from these instruments:

1. Select File > Preset (Main).

2. Select File> Recall and select Acq Data with Setup (MAT) (*.mat) in the Open dialog. Select
the desired file and click OK to open the file

3. Save the file by selecting File > Save As and set the file type to Acq data with setup (TIQ) (*.tiq)
and click OK. Saving the file in .tiq format preserves all of the settings in the analyzer and associates
them with the data set.

4. Recall the saved .tiq file and add measurements and change settings.

If you choose to save the file in .mat format, SignalVu-PC automatically adds all of the SignalVu-PC
settings needed for your analysis into the stored .mat file.

Opening files saved with oscilloscopes. Oscilloscopes acquire and store data in an amplitude vs. time
format that must be converted by SignalVu-PC into an IQ format for further processing. Sample-rate and
amplitude information is available in these files, but no other information is available to SignalVu-PC.

To open files stored in either .ISF or .WFM format saved by Tektronix oscilloscopes, use the following
procedure:

1. Preset SignalVu-PC. This resets the analysis so that only the spectrum analyzer display is present, with
a center frequency of 250 MHz and a span of 200 MHz.

2. Set the Span of SignalVu-PC to 0.2 × Sample Rate of the acquisition.

How to determine the maximum available span for your .ISF or .WFM file: The maximum span is
calculated to be 0.4 × Sample Rate. For example, a waveform sampled at 1 GSample/second will have
a maximum span of 0.4 × (109) = 400 MHz. This represents the Nyquist bandwidth of the sampling
system plus an allowance for filter bandwidth. Note that this span may exceed the bandwidth of the
oscilloscope used, and results at frequencies higher than the oscilloscope bandwidth will be attenuated.

When processing the waveform, SignalVu-PC automatically sets the bandwidth to twice the entered
span to allow for increasing the span in later analysis. Set the span of the spectrum analyzer to ½ the
calculated maximum span. In the case of the example of above, this is ½ × 400 MHz, or 200 MHz.

3. Set the center frequency to ½ of the span. This puts the analysis frequency within the first Nyquist
zone to prevent aliasing of the signal.

4. Open the .ISF or .WFM file with the settings above.

5. Set the span to the calculated maximum (in the example above, 0.4 × Sample Rate = 400 MHz) and
reanalyze.

6. Save the results as a .TIQ file. This preserves all of the settings in the analyzer and associates them
with the data set.
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Setup Files

You can set up the instrument as desired and then save the settings in a setup file. This enables you to
quickly setup the instrument by recalling previously saved setups.

Exporting Results

Save for further analysis of results in other programs, such as MATLAB or Excel.

Pictures of the Selected Display

You can save pictures of the instrument display for documentation purposes. When saving pictures of
the display, you can select from three file types: BMP, JPG, or PNG.

Measurement Settings

You can save a list of settings relevant to the selected display to a file for documentation purposes. The
exported file uses tab characters to separate values. The settings included in the file depend on the selected
display. The contents of the file are the same as a Results export except it does not include the results.

Saving Acquisition Data with Setup

Save for later analysis with the analyzer. The setup is saved as part of the acquisition data file so you can
choose when recalling data whether or not to also recall the associated acquisition and analysis parameters.

Saving Acquisition Data Export in CSV Format

Save for examining results in other programs, such as MATLAB or Excel.

Data, Settings, and Picture File Formats

You can save different types of data for later recall and analysis.

Saved File Types

File type File extension Description

Setup files .setup Setup files enable you to save instrument settings for later recall. Using
these files saves setup time and ensures consistent measurements.

Picture .png/.jpg/.bmp Screen capture of SignalVu-PC application window. They are useful for
documenting results in test reports.
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File type File extension Description

Results Export .csv Results files contain the trace points and numeric values that were
produced by the selected measurement. The header of a Results file
includes key acquisition and analysis settings to aid in the interpretation
of the data. The file is saved as a plain text file, but the contents are
formatted as CSV (comma-separated values). Results files can be
opened from applications such as Microsoft Excel and MATLAB.

Measurement
Settings

.txt Measurement settings files contain a list of settings that describe how
the instrument is set up for the selected measurement. The list contains
measurement settings (for example, Span), trace settings (for example,
whether or not a trace is selected) and global settings (for example,
Frequency and Reference Level). The list of settings contained in the
file varies depending on which display is selected.

Selected Trace Varies with display Trace files contain the trace results data in binary format. These files
are only readable by the SignalVu-PC application. Several of the
instrument's measurements allow you to recall a Trace file for visually
comparing a saved trace to a live trace.

Acquisition Data
with Setup

.tiq These files contain the acquisition data record and complete instrument
setup (in binary format). Use these files to save data for later recall and
analysis. When you save an Acquisition Data file, the current Setup
is always saved with the file. At the time of recall, you will be asked
whether you want to restore only the acquisition data or both data and
setup. If the instrument is already set up for a specific measurement,
you will probably want to recall only the acquisition data. Recalling
both data and setup returns the instrument to the same state it was
in at the time you saved the file.

Acquisition Data .csv These files contain IQ sample data before it has been processed by
a measurement. The acquisition data points are saved as IQ pairs.
Use this format to import the acquisition data into Microsoft Excel for
further analysis.

Acquisition Data .mat These files contain IQ sample data before it has been processed by
a measurement. The acquisition data points are saved as IQ pairs.
Use this format to import the acquisition data into MATLAB for further
analysis.

Range file .csv These files contain a list of settings that describe how the instrument is
set up for the Spurious measurement. The file contains the number of
ranges enabled, the start and stop frequencies for each enabled range,
the limits for each enabled range, the mask type and more.

Recorded file

(RSA500A series,
RSA600A series,
and RSA306B
only)

.r3f These files contain acquisition data that was recorded directly to a
file from an RSA306B, RSA500A series, RSA600A series spectrum
analyzer.

These files can be played back using the Playback feature located in
the Acquisition control panel (with Option SV56-SVPC).

Recorded file

(RSA7100A only)

.xdat These files can be played back using an application.

xxx
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Results Export File Format

The Results Export format contains trace points and/or scalar results produced by the measurement. The
file contains general information about the measurement settings at the top of the file and the results data in
the second part of the file. Groups of settings or results are headed with [text], as described below.

At the top of the file is the measurement name and the date and time data was acquired.

The first group of settings is [Global Parameters]. These settings include the Measurement Frequency,
Acquisition Data, Reference Level and others.

The second group of settings is [Parameters]. These settings are specific parameters which vary depending
on the measurement.

The next group is [Trace Parameters], which may not be present, depending on the measurement. Within
this group, there are parameters specific to a trace. There will be a Trace Parameters group for each
trace shown on the display.

The next group is [Results]. These are scalar results for the measurement.

Next is [Traces]. The Traces group consists of one or more [Trace] groups. There is one Trace group for
each trace. Each [Trace] group contains background information about the trace (units, number of points, x
scaling, and others depending on the measurement) at the top of the group, followed by the trace points.

Acquisition Data with Setup File (.tiq) Format

The file consists of two parts - the header that is in XML and the data that is in binary format.

Header. The header consists entirely of the DataFile element. This element is broken down into
sub-elements.

1. DataSetsCollection

2. Setup

DataSetsCollection. The DataSetsCollection contains a DataDescription element, a DataSet element,
and a ProductSpecific element.

Binary data. Binary data is a sequence of Int32 values, which are IQ pairs (I,Q,I,Q, ...) in binary Little
Endian format.

To convert these values to volts, multiply the individual values by the Scaling value in the DataDescription.

The binary data starts at an offset into the file == the "offset" attribute in the DataFile element. This
offset number will always start at the 19th character into the file (starting with 1), and will always be 9
characters long.

NOTE. You should not casually modify the XML header, because this will change the offset to the start of
the binary data.
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Acquisition Data Files (.csv)

The acquisition data files have two sections. At the top of the file is the following information:

SamplingFrequency - The sampling frequency in Hertz.

NumberSamples - The number of IQ samples in the file.

DateTime - When the data was acquired.

Frequency - The center frequency in Hertz.

AcquisitionBandwidth - The acquisition bandwidth Hz.

Following the AcquisitionBandwidth are the data. The data are IQ pairs, in volts.

Groups of settings or results are headed with [some text].

The first thing in the file is the measurement name and the date/time when the acquisition was taken.

The first group [Parameters] are global parameters. Measurement Bandwidth in this group is the
measurement bandwidth used by the General Signal Viewing measurements (Spectrum, Amplitude vs.
Time, etc). It also includes some source settings, like Acq BW, Dither, Preamp, and RF Attenuation.

The second group [Parameters] are measurement-specific parameters.

Another group which can occur is [Trace Parameters]. Within this group, there will be a set of parameters,
one for each trace that is currently shown.

Another group is [Results]. These are scalar results for the measurement.

Another group is [Traces]. It has [Trace] groups under it, one for each trace. Each [Trace] group has
some background information about the trace (units, number of points, x scaling, etc), and the trace
points themselves.

Acquisition Data Files (.mat)

The acquisition data files saved in MATLAB format contain the following MATLAB variables:

InputCenter - The center frequency in Hertz.

XDelta - The sample period in seconds.

Y - A complex array containing IQ pairs.

InputZoom - The acquisition bandwidth in Hertz.

The MATLAB format used to save acquisition data has the following properties and limitations:

Files are stored in MATLAB Level 5 format.

MATLAB Level 5 file size is limited to 2 GB.
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The instrument acquisition memory limit is 1 GB (1.024 Gigabytes). Because of the way acquisition
data is processed, 1 GB of acquisition memory requires 2 GB of memory to store. When header
information (instrument settings) is added to the acquisition data, the resulting file size is >2 GB.

If acquisition memory is filled (1 GB), exporting the data to MATLAB format will result in a file that
exceeds 2 GB in MATLAB level 5 format. A PC with sufficient memory is required to open the file. If
memory is not sufficient, MATLAB will warn the user. To check how much acquisition memory is
filled, select Setup > Acquire > Sampling Parameters. When the instrument is stopped, or you are
analyzing a recalled data file, you can find the acquisition length under File > Acquisition Data Info.

Printing Screen Shots

You can print screen shots (screen captures) two ways: use File > Print or save a picture file and print the
file using a separate graphics program. Printing a screen capture is the same as printing with any windows
program. For details on the available file formats for saving a screen capture, refer to Data, Settings, and
Picture File Formats (see page 692). For details on saving a picture to a file, see Saving and Recalling
Data, Settings, and Pictures (see page 685).

To print a screen shot:

1. Select File > Print.

2. Select File > Print Preview if you wish to review the screen shot before sending it to the printer.

3. Select File > Print to print the file to a printer.
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Application Help

Menu Bar: Help > User Manual

This menu item displays this Help. It is a standard Windows help system. The Help menu item is the only
method available to display the help; there are no other links to the help within the software.

About the Vector Signal Analysis Software

This window displays information about the SignalVu-PC software.

Version

At the top of the window is a line that displays the version of the SignalVu-PC software.

Installed Options

This text box lists the software options installed.

Hardware Information

This text box lists the serial number of the software and information about connected instruments.
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Copy Info

The Copy Info button copies the information to the Windows clipboard, which you can then paste into a
document. This information may be useful if you need to contact Tektronix about the software.

Mapping Measurements

The RSA Map software lets you record measurements on a geo-referenced map or a bitmap map for
documentation purposes. If an external GPS receiver is connected to the analyzer, measurements can be
mapped at the GPS coordinates where the measurement was taken. Using an external GPS receiver, RSA
Map can perform repeat measurements using either time or distance to initiate measurements. RSA Map
software can also save results for future reference or analysis.

To map measurements:

Select Tools > RSA Map. This launches the RSAMap software in a separate window.

Full documentation on how to use RSA Map is provided in the RSA Map Help. In RSA Map, select
Help > User Manual.

Main menu overview

The main menus are:
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Menu Description

The display icon indicates which display is currently active in the application. Right click
on this icon to view the following drop-down menu. These options allow you to control
the individual measurement window view.

Favorites bar toggle This icon allows you to toggle to hide or show the Favorites bar. The Favorites bar is
located just below the Main Menu bar, is editable, and provides icons for quick and easy
access to functions and menus.

File (see page 700) Select measurements, open and save files, print documents, and preset.

View (see page 704) Change display size, display the Marker toolbar and Status bar.

Run (see page 708) Start, stop and abort acquisitions, select single or continuous acquisition mode.

Only available when connected to an RSA306, RSA306B, RSA500A series, and
RSA600A series spectrum analyzer or an MSO4000B/C oscilloscopes.

Replay (see page 615) Replay measurements; select which record(s) to play, Replay/Stop/Pause, or enable
continuous loop.

Markers (see page 708) Search for signal peaks, center the display to a marker, and access the Define Marker
panel.

Setup (see page 708) Change settings for acquisition, analysis, and measurements.

Presets (see page 21) Load and configure presets.

Tools (see page 709) Perform searches and configure user preferences.
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Menu Description

Connect (see page 710) Connect and disconnect from instruments.

Window (see page 711) Controls the size and layout of displays within the SignalVu-PC application.

xxx

File Menu
Command Description

Recall (see page 700) The Recall dialog enables you to recall saved data, setups and traces.

Save (see page 701) Saves a file without asking for a file parameters (based on most recent settings).

Save As (see page 701) Displays the Save dialog enabling you to specify the parameters of the save operation.

Save on trigger (see page 652) Displays the Actions tab of the Trigger control panel which allows you to configure
the Save on Trigger function. This is only available when connected to an RSA306,
RSA306B, RSA500A series, and RSA600A series or MDO4000B/C.

Acquisition save options (see
page 30)

Displays the Save and Export tab of the Options control panel which allows you to specify
how much data is saved in acquisition files.

Acquisition data info (see
page 615)

Displays the Acquisition Info tab (see page 615) of the Replay control panel. The info
on this tab describes such acquisition parameters as acquisition bandwidth, sampling
rate, RF attenuation, and acquisition length.

Measurement Data Info (see
page 703)

Displays the characteristics of the most recently analyzed record in the display.

Print (see page 704) Prints the selected display.

Print Preview (see page 704) Displays a preview of the print output.

Exit Closes the SignalVu-PC application.

xxx

Recall

Main menu bar: File > Recall

Favorites toolbar:

Use the Recall command to load previously saved acquisition data, setups or trace data.

To Recall Data or Setups

1. Select File > Recall. This displays the Open dialog box.
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2. Select the file type to be recalled and click Open.

Save / Save As

Menu Bar: File > Save / Save As

Use Save / Save As to store acquisition data, setups, and traces. Save is also used to export traces, results
and pictures of the display for use in other programs.

Difference Between Save and Save As

Use Save As to specify what kind of data you want to save and where the data should be saved. Use Save
to quickly save the same data as you saved the last time you executed a Save, without having to specify the
data type and location.

For example, suppose you want to save a picture of a spectrum trace each time you adjust a circuit to
document how the adjustments affect the output of the circuit. The first time you want to save a picture of
the display, you will need to select Save As. From the Save As dialog box, you specify the type of data you
want to save (Picture of Selected Display) and specify the location of the saved file. As long as the Save
and Export option is set to automatically name saved files, the next time you want to save a picture of
the display, you can just press Save on the front panel and a picture of the selected display will be saved
without requiring you to type a file name or the location of the file to be saved.
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What Data Types Can Be Saved

Data type Description

Acquisition Data Acquisition data previously recalled can be exported with different settings. Data is saved
in a format readable only by SignalVu-PC, oscilloscopes running SignalVu software, or
RSA6100/RSA5100/SPECMON Series instruments.

Setup Configuration information detailing instrument settings. Data can be saved in a
format readable only by SignalVu-PC, oscilloscopes running SignalVu software, or
RSA6100/RSA5100/SPECMON Series instruments.

Selected Trace Saves the selected trace for later analysis by the analyzer. Data is saved in a
format readable only by SignalVu-PC, oscilloscopes running SignalVu software, or
RSA6100/RSA5100/SPECMON Series instruments.

Exported Traces and Numeric
Results

Save traces and results in a file format that can be used by other programs.

Pictures of the Display Save screen images in graphic image file formats that can be used in other programs.

Exported Acquisition Data Save acquisition data records in a file format that can be used by other programs.
Acquisition data can be saved in either comma-separated-variable format or MATLAB
format.

xxx

Data, Settings, and Picture File Formats (see page 692).

Options for Saving Pictures of the Display

Option Setting Description

PNG Saves exported screen captures in Portable Network Graphics format.

JPG Saves exported screen captures in Joint Photographic Experts Group (JPEG)
format.

Image
Format

BMP Saves exported screen captures in Windows bitmap format.

xxx
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Measurement Data Info

The Measurement Data Info command in the File menu displays a listing of acquisition-related information
about the last data analyzed by the selected measurement. The last data can be from the current acquisition
or it could be from a recalled data file.

Acquisition Data

The Acquisition Data tab displays the sample rate and record length of the data received from the
oscilloscope or from a recalled oscilloscope waveform file.

SignalVu-PC Printable Help 703



Reference Print

Print

Menu Bar: File > Print

Print displays the Windows Print dialog box for printing a screen capture of the display. To save ink when
printing, use the Colors tab to set the color scheme. See Options Settings .

Print Preview

Menu Bar: File > Print Preview

Print Preview shows how a print out will appear when it is printed.

View Menu

The View menu enables you to control the display of views and toolbars in the application window.

Command Description

Full Screen (see page 705) Toggles all views between full-screen size and user-selected size.

Navigator View (see page 66) Selecting Navigator View adds the Time Overview display to the existing measurement
displays to provide a better perspective of the signal.

When the Navigator View is enabled, the Time Overview display is always located above
any other measurement displays and uses the maximum horizontal resolution of the
display area, regardless of the Window Tile setting.

Numeric Keypad When selected, any time you place the cursor within a control or setting that takes a
numeric value, you are presented with a dialog box to easily enter a value.

For instance, placing the cursor in the Frequency setting, displays the following dialog
screen.

Use the arrow buttons to change the value.

Press the calculator icon to display a keypad that allows you to enter values and suffixes.

Chan Nav Toolbar (see
page 668)

Check to view the Channel Navigation toolbar. Uncheck to hide it. Detailed information
about this toolbar is available in the Channel Navigation toolbar topic.
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Command Description

Signal Survey Toolbar (see
page 679)

Check to view the Signal Survey toolbar. Uncheck to hide it. Detailed information about
this toolbar is available in the Signal Survey toolbar topic.

Map It Toolbar (see page 661)

(Only available with optional
MAP application license.)

Check to view the Signal Survey toolbar. Uncheck to hide it. Detailed information about
this toolbar is available in the How to use Map It topic.

Replay Toolbar (see page 618) Check to view the Replay toolbar. Uncheck to hide it.

Traces Toolbar Check to view the Traces toolbar. Uncheck to hide it. This toolbar can also be accessed
from the Basic Controls Toolbar. It allows quick access to the trace controls of the
selected measurement display. This example is the Spectrum trace toolbar.

Markers Toolbar (see
page 596)

Check to view the Markers toolbar. Uncheck to hide it. This toolbar can also be accessed
from the Basic Controls Toolbar. It enables you to define Markers and perform Peak
searches. Click the Define button on the toolbar to define markers. See the Define
Markers menu topic for detailed information.

Basic Controls Toobar The Basic Controls toolbar is defaulted to on and is located just above the Status Bar. It
allows quick access to controls and settings of the selected measurement display. This
example is the Spectrum Basic Controls toolbar.

It contains the following:

Name of selected measurement window

Frequency: The center frequency in the active display. To change the value, click the
text and enter a value with a keyboard or the numeric keypad. For fine adjustments,
you can use the mouse wheel.

Reference: Reference level in the active display. To change the value, click the text
and enter a value with a keyboard or the numeric keypad.

Span: The span in the active display. To change the value, click the text and enter
a value with a keyboard or the numeric keypad. For fine adjustments, you can use
the mouse wheel.

Res BW: The resolution bandwidth (RBW) in the active display. To change the value,
click the text and enter a value with a keyboard or the numeric keypad. For fine
adjustments, you can use the mouse wheel.

Show or hide the Markers toolbar

Show or hide the Traces toolbar

Show or hide the Settings Control Panel

Status Bar (see page 707) The Status bar is defaulted to on and is located at the bottom of the application window.

xxx

Full Screen

Menu Bar: View > Full Screen
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When unchecked, clicking Full Screen resizes the application window to fill the screen. Full Screen mode
maximizes the application window, and turns off the application title bar.

When checked, clicking Full Screen restores the application window to its previous size. The application
title bar is restored.
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Status Bar

The Status Bar displays information on specific instrument settings. It contains only status information; it
does not display any error information. The Status bar has no controls. It can not be hidden.

Elements of the Status Bar

Area within Bar Description

Run Status Displays the running state. For example, some run states are Arm, Ready, Triggered,
Analyzing, or Stopped.

Status message area Displays status messages (for example, ADC Overrange). When there no status
messages to report, displays current acquisition parameters (for example, Acq Length:
22.320 us).

Acquisition mode Displays either Real Time or Swept. Indicates how the next acquisition will be acquired.

Trigger Settings Displays Trigger settings. For example, you will see Free Run, Power, Trig In (front),
Frequency Mask and others.

Frequency Reference Setting Indicates whether the internal or external reference source is selected. Displays Ref:
Int or Ref: Ext.

Connection status
indicates a GNSS connection status (a green, yellow, or red icon indicates locked,

unlocked, or COM error, respectively).

indicates the application is connected to an instrument; indicates the application
is not connected to an instrument.

xxx

Run Status Indicators

Indicator Description

Acquiring SignalVu-PC is capturing the signal from a connected MDO4000B/C series oscilloscope
or RSA306, RSA306B, RSA500A series, and RSA600A series spectrum analyzer.

Analyzing SignalVu-PC is processing the signal record from a connected MDO4000B/C series
oscilloscope or an RSA306, RSA306B, RSA500A series, and RSA600A series spectrum
analyzer.

Replaying SignalVu-PC is analyzing recalled waveform or acquisition records.

Stopped If Stopped is displayed, no analysis being performed. This can occur because the Stop
button has been pressed (when Replay is set to Loop) or because the software has just
been launched and no analysis has been performed yet.

xxx
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Run Menu

(The Run menu is available only when connected to an RSA306, RSA306B, RSA500A series, and
RSA600A series Spectrum Analyzer or an MDO4000B/C instrument.)

The Run menu provides access to commands that control the signal acquisition.

Command Description

Run Single Sets the acquisition mode to Single and runs one measurement/acquisition cycle.

If acquisition mode is already Single, selecting Run Single begins a new
measurement/acquisition cycle. If acquisition mode is Continuous, selecting Run Single
halts the current measurement/acquisition cycle after it completes.

Run Continuous Sets the acquisition mode to Continuous and starts the measurement/acquisition cycle.

If acquisition mode is already Continuous, selecting Run Continuous toggles the
measurement/acquisition cycle between Run and Stop.

Resume Restarts data acquisition, but does not reset accumulated results, such as Average
or MaxHold. This allows you to stop acquisitions temporarily, then continue. If the
accumulation is already complete, for example, 10 acquisitions or 10 averages have
already been completed, each subsequent Resume command will cause one more
acquisition to be taken, and its results added to the accumulation. Resume is not
available if instrument settings have been changed.

Abort (see page 628) Immediately halts the current measurement/acquisition cycle.

xxx

Replay Menu

The Replay Menu (see page 615) allows you to run measurements using the data in a recalled acquisition
data file. You can use this to compute new results for old data after you change settings or measurements.

Markers Menu

The Markers menu provides to settings that define and control the location of markers.

Setting Description

Peak (see page 594) Moves the selected marker to the highest peak on the trace.

Next Peak > Moves the selected marker to next peak depending on the setting chosen.

Marker to Center Frequency Sets center frequency to the frequency of the selected marker.

Define Markers (see page 594) Displays the Define Marker control panel.

xxx

Setup Menu

The Setup menu provides access to control panels that specify parameters for numerous signal analyzer
functions.
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Command Description

Displays (see page 37) Displays the Displays control panel.

Settings (see page 721) Displays the Settings control panel for the selected display.

Trigger (see page 647)
(Available when connected
to an RSA306, RSA306B,
RSA500A series, RSA600A
series, RSA7100A, or
MDO4000B/C)

Displays the Trigger control panel.

Acquire (see page 628) Displays the Acquire control panel.

Analysis (see page 607) Displays the Analysis control panel.

Amplitude (see page 621) Displays the Amplitude control panel.

GNSS/Antenna (see page 653) Displays the GNSS/Antenna control panel.

Audio (see page 535)
(Available when connected
to an RSA306, RSA306B,
RSA500A series, or RSA600A
series)

Displays the Audio demodulation panel.

Recording (see page 633) Displays the Recording control panel, providing access to record file and playback file
functions.

xxx

Presets Menu

The Presets menu provides you access to instrument presets and preset options.

Command Description

Main (see page 21) Resets the instrument to factory defaults. Acquisition data and settings that have not
been saved will be lost.

DPX Recalls the DPX presets.

Standards Presets Recalls the Standards presets.

Application (see page 26) Recalls the Application presets.

User (Favorites) (see page 23) Recalls the User (Favorites) presets.

Preset Options (see page 21) Displays a control panel where you can configure options for Presets.

xxx

Tools Menu

Provides access to several utilities for controlling instrument functions.
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Command Description

Mask Test (see page 601) Enables you to locate and highlight specified signal levels in specified displays.

Licenses (see page 7) Used to activate SignalVu-PC optional application licenses (options).

Licenses > Legacy > Manage... Used to activate a demo license or deactivate a license (used to move the license
between PCs).

Options Displays the Options control panel.

Signal Database (see
page 665)

Allows you to select which signal standards and types are listed (and selectable) in the
Channel Navigation toolbar and/or the Define Survey control panel.

RSAMap Launches the optional MAP application.

xxx

Connect menu

Connect allows you to connect your PC (with SignalVu-PC installed) to the following instruments:

MDO4000B/C Series instruments using USB, wireless, or LAN (SignalVu-PC with option CON
required)

RSA306, RSA306B, RSA500A series, and RSA600A series using USB

By connecting to one of these instruments, you are able to view and analyze waveforms in real time
using the SignalVu-PC software.

You can find instructions for connecting to an instrument here (see page 31).
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Elements of the Connect Menu

Menu item Description

Search for instruments An RSA306, RSA306B, RSA500A series, and RSA600A series connected via
USB is automatically recognized by the software and automatically establishes a
connection, so you do not need to search for the instrument.

When connecting to an MDO4000B/C series instrument, use this menu to activate
TekVISA to search for MDO4000B/C instruments that are connected by USB or
through a LAN network.

This menu is disabled if a connection to an instrument has been established.

Connect to instrument Select to view a list of currently connected instruments or to manually look for an
instrument.

This menu is disabled if a connection to an instrument has been established.

Manually look for LAN
instrument

(Available with option CON.) Select to open a dialog window that allows you to enter
the IP address of an instrument to connect to.

Disconnect from instrument Select to disconnect from the currently connected instrument. This is only available
when you are connected to an instrument.

xxx

Window Menu

Use the Window menu to arrange how windows are displayed. Displays can be set to appear full screen
(one display at a time) or with all (selected) displays visible at once. When all displays are visible at
once, you can rearrange the displays by dragging the title bar of a window (deselect Window > Lock
Windows to move displays around).

Command Description

Close View Closes the selected view.

Cascade Positions windows in a cascade view (not available when Lock Windows is selected).

Tile Horizontally Positions widows in a horizontal orientation (top to bottom).

Tile Vertically Positions widows in a vertical orientation (side by side).

Lock Windows Locks the windows into their current position, preventing them from being moved. If the
windows are locked, the Cascade arrangement is not selectable.

(List of windows) A numbered list of open windows.

xxx

Help Menu

The Help menu provides access to the Help and version information about SignalVu-PC.
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Command Description

User Manual Displays a navigable, searchable Help tool.

User Manual (PDF) Displays a PDF version of the Help.

Application Reference (PDF) Displays a PDF version of the RSA Application Manual.

Quick Start Manual (PDF) Displays a PDF version of the SignalVu-PC Quick Start User Manual.

PI Command Search (see
page 712)

Displays a navigable, searchable PI command search tool.

About Tektronix Real Time
Signal Analyzer Software

Displays information about the SignalVu-PC software and installed options.

xxx

PI Command Search tool

The PI Command search tool allows you to search for programming commands by typing the syntax
or key words into the search text box.

For a quick search, do the following:

1. Select the Search tab from the dialog box.

2. Type in the syntax or key word you are looking for in the text box.

3. Click on List Topics.

TO obtain an updated version of the PI commands manual, do the following:

1. Download the latest PI manual .CHM file from www.Tek.com/downloads.

2. Copy the downloaded PICommandSearch.chm file into the installer path C:\Program
Files\Tektronix\SignalVu-PC\RSA.

CAUTION. Do not change the file name PICommandSearch.chm or the file will not be found by the
application.

Favorites bar menus

Menu Description

Icons The icons on the Favorites bar are detailed in the Specific areas of the application window
(see page 17) topic.

Preset Recalls the Main preset.

Replay (see page 615) Replay measurements; select which record(s) to play, Replay/Stop/Pause, or enable
continuous loop.
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Menu Description

Run (see page 708) Start, stop and abort acquisitions, select single or continuous acquisition mode.

Only available when connected to an RSA306, RSA306B, RSA500A series, RSA600A
series, RSA7100A spectrum analyzer or an MSO4000B/C oscilloscope.

Click this icon to view the Edit Favorites menu:

(Audio demodulation icon is not available when connected to the RSA7100A.)

xxx

Error and Information Messages

The following list describes some of the common error and information messages that might appear
during instrument operation. Messages that apply specifically to one or more measurements appear in the
displays. Messages that pertain globally, such as those about hardware status, are shown in the Status Bar
at the bottom of the analyzer application window.

Acq BW too small for current setup

The display needs a wider acquisition bandwidth than what the current data record contains. This can be
due to any of the following reasons:

The sampling parameters are being manually controlled.

In the Acquire control panel > Sampling Parameters tab, set the Adjust control to All Auto to allow the
software to pick the sample rate and record length that it needs.

A display other than the one you intended has been selected. The selected display has requested
a smaller acquisition bandwidth to achieve a better accuracy or dynamic range for its particular
measurement.
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Select the display that contains the message. Click Run if the instrument is not already acquiring data.

Acquisitions are not running and the measurement now requests a wider bandwidth than the last
acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

The data is from a recalled TIQ file.

There is no way to increase the acquisition bandwidth for saved IQ data. You must adjust the
measurement settings so that less bandwidth is required.

Analysis failure: <description of error>

The instrument is unable to complete a measurement due to difficulty in characterizing the signal. For
example, due to either the signal or settings, the instrument may not be able to recognize a pulse so it
can compute the pulse measurements.

Try changing settings to improve analysis. For example, when Pulse Trace is displayed, try changing
the settings on the Settings > Params.

Analysis failure: Carrier detection failed

The instrument was unable to locate a carrier signal. Try adjusting the Carrier Threshold or Integration
BW values, if the measurement has these controls.

Analysis Length was limited

This message appears if the "Results Length", the time over which the measurement computed its results,
is less than the Actual Analysis Length reported in the Analysis Time control panel tab and the Time
Overview display. The Results Length is indicated by the magenta line below the Time Overview graph.
This can occur because the acquisition contained more data samples than a measurement can process (for
example, digital demodulation is limited to 80,000 samples) or the measurement had to use some of the
first and last samples for pre-measurement processes.

Analysis length too small for current setup

Increase the Analysis Length or decrease the RBW (Spectrum, ACPR, MCPR).

Avg Tx not available in Volts units

The Average Transmitted Power measurement is not defined for Volts.

Can't get acquisition data record

No acquisition record currently exists in memory (run an acquisition or recall a file), or an error has
occurred. Repeat the acquisition.

Can't replay data from swept acq

The measurement could not produce results because it is a real-time only measurement but was asked to
reanalyze (Replay) an acquisition taken in swept mode.

Can't replay. Live data needed for swept settings

The measurement could not produce results because it was asked to reanalyze (Replay) the acquisition but
it is in Swept acquisition mode. Swept-mode measurements cannot analyze recalled data.
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CISPR accuracy limited by acq memory. Adjust RBW or freq range

The CISPR function was applied, but the available data did not represent a long enough time to satisfy
CISPR requirements. Increasing RBW reduces the amount of time needed for analysis. Reducing
frequency range (for example, by reducing Span), decreases sample rate, allowing the available memory
to cover a longer time period.

If this data is from a saved file, the error cannot be cleared.

If this data is from a saved file, this error cannot be cleared.

This data was acquired when the input signal contained peaks greater than 6 dB above the Reference
Level setting.

If the data is from a file, this error cannot be cleared.

Data from unaligned instrument

The acquisition data was captured when the instrument was not aligned. This message refers to the
acquisition data currently being analyzed, but not necessarily to the current status of the instrument.
Measurements made on this data might not be accurate.

Disabled: data is from swept acquisition

The display needs to run in real-time mode. The display associated with this message cannot run now
because it is not the selected display, and the selected display is performing multiple acquisitions (it is
in swept mode).

Change the settings of the selected display so it is performing real-time acquisitions.

Select the associated display to make it the selected display. When it is selected, it will force the
acquisition parameters to change to meet its own needs.

Frequency exceeds preamp range

This is a warning that signals below the minimum preamp operating frequency are likely to be severely
attenuated (this is 100 kHz for option 51, 1 MHz for option 50).

Needs swept acq or larger AcqBW - Acquire data while display is selected

The display is not running because it needs to perform multiple acquisitions (it must be in swept mode) but
it is not the selected display. Only the selected display can perform multiple acquisitions.

Select the display showing this message to give it control of acquisitions parameters.

Sometimes, only one display can work and the others will be blank and show errors. This happens when
different displays have conflicting demands on the acquisition data record.

Export failure: file not saved

An error occurred while exporting Results. The file was not created.

Export the results again.

Export failure: unable to open results file for export. File not saved.

The Export Results file could not be opened for writing, so the export of results was not completed.

Verify that there is sufficient free space on hard disk.
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Insufficient data for CISPR. Acquire while display is selected

This message appears when a measurement is not the selected measurement and CISPR filters are selected.
Set the measurement to be the selected measurement and reacquire the signal.

IQ Processing Error: 8012

This message occurs in GP Digital Modulation displays. The most likely cause for this message is that
there are not enough symbols to analyze. This can happen if:

The Analysis Length is set too short. Increase the Analysis Length on the Analysis Time tab.

The Analysis Offset has pushed the Analysis Time so far out that the actual Analysis Length is too
short, even though the user-requested Analysis Length would have been long enough without the
excessive offset. Decrease the Analysis Offset on the Analysis Time tab.

The input signal is bursted, and the burst does not contain enough symbols.

Needs swept acq or larger Acq BW - Acquire data while display is selected

The display has one of two problems: It is not the selected display, which prevents it from controlling
the hardware acquisition parameters, and setting the acquisition mode to Swept; or its settings require a
wider data bandwidth.

Select the display that you are interested in and it will change the acquisition to meet its own needs.

Increase the acquisition bandwidth manually or by changing the selected display's settings to cause
the wider bandwidth.

No Math trace: unmatched trace lengths

A math trace could not produced because the traces selected to generate the math trace do not have
the same number of points. This can easily happen if both traces are recalled, but were saved under
different “Points” settings. This can also occur if one of the selected traces is a live trace and the other
trace is a recalled trace.

In a Spectrum display, as long as one trace is live, you can change the “Points” setting (Setup >
Settings > Freq & Span tab) to match the recalled trace.

If you are using two recalled traces to generate the Math trace. You must recreate at least one of
the traces.

No burst detected

The Burst Detection Mode (see page 576) is On, but no burst was detected in the signal.

Check that the Threshold setting is properly set.

Not enough samples for current setup

The measurement was not able to run because the combination of analysis length, offset, and measurement
bandwidth relative to acquisition bandwidth, were such that not enough samples were available for the
measurement to analyze. This can occur when two or more displays are shown and one display requires
a wide acquisition bandwidth and another display requires a much narrower bandwidth. The display
requiring the much narrower bandwidth must decimate and filter the acquisition record which can result in
too few samples left for the measurement.
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Increase the Analysis Length to provide more samples.

Close any displays you don't currently need.

Not enough samples – try increasing MeasBW

The measurement was not able to run because there are not enough samples available for the measurement
to analyze. The Settling Time measurement requires at least 256 samples. This can occur when two or
more displays are shown and one display requires a wide acquisition bandwidth and another display
requires a much narrower bandwidth. The display requiring the much narrower bandwidth must decimate
and filter the acquisition record which can result in too few samples left for the measurement.

Increase the Analysis Length to provide more samples.

Close any displays you don't currently need.

No FFT (not all pulses have results)

If a pulse cannot be measured (because its shape is too indistinct or it does not meet the parameters that
define a pulse (see page 370)), its results will be “- -" for every measurement on that pulse. The instrument
cannot compute an FFT.

No pulses found

The instrument was unable to find any complete pulses in the signal.

Make sure the analysis length (see page 607) includes at least one complete pulse cycle, from before
one rising edge until after the next rising edge.

Pulse Detection Error

The instrument was unable to detect a pulse.

The pulse Measurement Filter (see page 370) needs to be smaller. Try reducing the bandwidth and/or
selecting the Gaussian filter.

Detection threshold is not set to the proper level for the signal. Adjust the Power threshold to detect
pulses (see page 370).

The pulse interval is too long for the current settings. Try decreasing the filter bandwidth (see
page 370), as this may reduce the number of data points to a manageable quantity.

RBW conflict. Increase Span or Analysis Length

The measurement is not running because the actual RBW used by the measurement is too large for the
current acquisition span. Typically, the analysis length is too short as well.

Either increase the span or increase the Analysis Length.

RBW decreased

The current span or acquisition bandwidth is too small to allow a wider RBW filter.

Increase the span or acquisition bandwidth if the decreased RBW is not acceptable.

RBW increased

The current Spectrum Length (or Analysis Length if Spectrum Length is not Independent) is too small
to allow the requested RBW.
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Reference Error and Information Messages

Increase the Spectrum Length (or Analysis Length) if the increased RBW is not acceptable.

RBW limited by AcqBW to: XX Hz

The requested RBW is too close to the acquisition BW. Increase the frequency range of the measurement
(for example, Span).

RBW too small/large for current Acq BW

If the RBW is set manually, it is possible for the acquisition bandwidth to be incompatible with the
RBW setting.

Change the RBW setting.

Adjust the Acq BW setting, either directly (Setup > Acquire > Sampling Params: select on of the
manual modes) or by adjusting the measurement bandwidth of the selected display (Setup > Acquire >
Sampling Params: All Auto).

Recall error: Setup not completely restored

An error occurred while recalling a Setup file. Thus, the current setup may be a combination of settings
from the Setup file and the previous Setup.

Recall the setup again.

Recall failure: problem with file or file contents

An error occurred while recalling a Setup, Trace or Data file. This can occur because of a problem opening
the file (operating system error) or because of a problem with the contents of the file.

Recall the file again.

Restoring acquisition data

This is a status message displayed while data is being restored from a file.

Save failure: file not saved

An error occurred while saving a Setup or Data file.

Save the file again.

Saving acquisition data

This is a status message displayed while data is being saved to a file.

Selected VBW does not use full Spectrum Length

This message can occur when the Spectrum Length is greater than required for the VBW filter. If you
look at the Time Overview display, the Magenta line for Results Length indicates the part of the Spectrum
Length that was actually used. The measurement results are correct, but don't include some of the data in
the selected Spectrum Length. To clear this message, you can set the Spectrum Length to Auto.

Setup error: <description of error>
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Reference Displaying the Windows Event Viewer

When this message appears, it includes text that explains the problem. For example, the ACPR display
might show: “Setup error: channels can’t overlap”. Setup errors are the result of conflicts in instrument
settings. These types of errors occur when a user makes manual changes to settings. In the example
above, the channel settings in the Channel Power and ACPR display have been set so that the channels
overlap in frequency.

Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Integration BW exceeds Measurement BW

When this message appears, it includes text that explains the problem. Setup errors are the result of
conflicts in instrument settings. These types of errors occur when a user makes manual changes to settings.

Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Measurement time for Freq & Phase results

The Measurement time for Freq & Phase results (see page 372) specifies how far across the pulse top the
instrument should wait before measuring the Phase Difference and Frequency Difference for each pulse.
If this value is set too large for any of the pulses in the signal, the measurement point ends up on the
falling edge or during the pulse off time.

Decrease the Measurement time for Freq & Phase results setting (Settings > Define tab).

Unexpected software error. Please cycle power and try again. If the problem persists, contact
your Tektronix Service Center.

An unrecoverable error has occurred, and the instrument application software will shut down.

Relaunch the SignalVu-PC application.

VBW not applied - Acq BW too small

Increase VBW or measurement bandwidth. Make sure Sampling Parameters are set to Auto.

VBW not applied - Spectrum Length too short

This message occurs when the requested VBW can't be produced because the Spectrum Length is too short.

To clear this problem, set the Spectrum Length to Auto or manually increase the Spectrum Length (see
Setup > Analysis > Spectrum Time tab). If Spectrum Length is coupled to Analysis Length, set Analysis
Length to Auto or manually increase it (see Setup > Analysis > Analysis Time tab).

Displaying the Windows Event Viewer

When the analyzer generates an error message, information about the error is logged to the Windows
Event Viewer.

To display the Windows Event Viewer:

1. Select Start > Control Panel.

2. Select Administrative Tools. (If your instrument displays control panels in Category View, select
System and Security, and then select Administrative Tools.)
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3. Double-click Event Viewer.

4. From the Event Viewer window, selectWindows Logs, then select Application. This displays a list of
all errors that have been reported to the operating system from applications.

Errors reported to the Event Viewer from the analyzer application appear under Source as TekRSA.

5. Double-click the last error reported for TekRSA to see details on the most recently reported error.
Please note that many items reported as “errors” are simply informational and do not mean that your
instrument is impaired. Contact the Tektronix Customer Support Center or Service Center if you
are concerned about an error shown in the Event Viewer. Do not send an instrument out for repair
based solely on these event reports.

How to Find Out if Software Upgrades are Available

Software upgrades might be available can be downloaded from the Tektronix Web site. To see if a
software upgrade is available for your product, use your browser to go to www.tektronix.com/software.
Search by the product model number.
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Reference Settings

To add additional software options or features, you will need an option key from Tektronix. In some
instances, you may need to upgrade the product software before adding the new option key. Follow the
installation instructions provided with your software option.

Settings

Main menu bar: Setup > Settings

Favorites toolbar:

The Settings menu item enables access to control panels that allow you to change settings for the selected
display. The control panel that appears when you select Settings depends on the selected display. The
Settings control panel for the Spectrum display is shown in the following figure.

The control panel for the CCDF display is shown in the following figure.

Settings Control Panels

ACPR Settings (see page 124)

Acquire (see page 628)

AM Settings (see page 98)

Amplitude vs Time Settings (see page 80)

Analysis Settings (see page 607)

Audio Spectrum Settings (see page 522)

Audio Summary Settings (see page 524)

Bluetooth 20dB BW settings (see page 504)

Bluetooth CF Offset and Drift Settings (see page 489)
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Bluetooth Constellation Settings (see page 483)

Bluetooth Eye Diagram Settings (see page 486)

Bluetooth Frequency Dev Vs Time Settings (see page 502)

Bluetooth Summary Settings (see page 494)

Bluetooth Symbol Table Settings (see page 497)

CCDF Settings (see page 161)

Channel Power and ACPR Settings (see page 124)

Constellation Settings (see page 539)

DPX Spectrum Settings (see page 55)

EVM vs Time Settings (see page 543)

Eye Diagram Settings (see page 546)

FM Settings (see page 105)

Frequency Deviation vs Time Settings (see page 548)

Frequency vs Time Settings (see page 82)

LTE ACLR Settings (see page 446)

LTE Channel Spectrum Settings (see page 449)

LTE Constellation Settings (see page 451)

LTE Power vs Time Settings (see page 453)

Magnitude Error Settings (see page 550)

MCPR Settings (see page 138)

Occupied Bandwidth Settings (see page 148)

OFDM Channel Response Settings (OFDM (see page 325)) (WLAN (see page 138))

OFDM Constellation Settings (see page 327)

OFDM EVM Settings (see page 329)

OFDM Magnitude Error Settings (see page 331)

OFDM Phase Error Settings (see page 335)

OFDM Power Settings (see page 337)

OFDM Summary Settings (see page 339)

OFDM Symbol Table Settings (see page 341)

Phase Error vs Time Settings (see page 552)

Phase vs Time Settings (see page 84)
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PM Settings (see page 113)

Pulse Statistics Settings (see page 367)

Pulse Table Settings (see page 362)

Pulse Trace Settings (see page 364)

RF I Q vs Time Settings (see page 86)

Mask Test Limits Settings (see page 601)

Settling Time Settings (see page 175)

Signal Quality Settings (see page 558)

Spectrogram Settings (see page 75)

Spectrum Settings (see page 71)

Symbol Table Settings (see page 560)

Time Overview Settings (see page 64)

Trellis Diagram Settings (see page 563)
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Glossary Accuracy

Accuracy

The closeness of the indicated value to the true value.

ACLR

Adjacent Channel Leakage power Ratio is the ratio of the RRC (Root Raised Cosine) filtered mean power
centered on the assigned channel frequency to the RRC filtered mean power centered on an adjacent
frequency (defined in 3GPP).

ACPR Measurement

Adjacent Channel Power Ratio (ACPR) is the ratio of the mean power centered on the assigned channel
frequency to the mean power centered on an adjacent channel frequency. In the 3GPP specification, it
is called ACLR (Adjacent Channel Level Ratio) and both the main channel and adjacent channels are
required to be filtered with RRC (Root Raised Cosine) filters.

Acquisition

A series of time-contiguous frames. This is also called a Block.

Analysis Length

The length of time in the Analysis Time.

Analysis Time

The portion of the acquisition record over which one or more measurements are calculated.
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Glossary ASK

ASK

Acronym for Amplitude Shift Keying. The process, or result of a process, in which the amplitude of the
carrier is varied in accordance with the state of a digital input signal.

Block

An integer number of time-contiguous frames. See also: Acquisition.

Calibrator

A signal generator producing a specified output used for calibration purposes.

Carrier

The RF signal upon which modulation resides.

Carrier Frequency

The frequency of the CW component of the carrier signal.

Carrier Signal

The electrical signal, typically a sine wave, upon which modulation is impressed.

Carrier-to-Noise Ratio (C/N)

The ratio of carrier signal power to average noise power in a given bandwidth surrounding the carrier;
usually expressed in decibels.
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Glossary CCDF - Complimentary Cumulative Distribution Function

CCDF - Complimentary Cumulative Distribution Function

The Complementary Cumulative Distribution Function (CCDF) represents the probability that the peak
power above average power of a measured signal exceeds a threshold.

CCDF is a plot of the percent of time that a signal's power value exceeds it average value versus the
amount by which it exceeds the average. The CCDF plot has a log of probability on the Y-axis (100% at
the top) and dB above average amplitude on the X-axis (0 at the left).

CDMA

Acronym for Code Division Multiple Access.

Center Frequency

The frequency corresponding to the center of a frequency span of the analyzer display.

Check Mark Indicator

The check mark indicator in the upper-left corner of the display indicates the display for which the
acquisition hardware is optimized. When you have more than one display open, the display with the
check mark indicator has control over the acquisition hardware. To give a display priority over any
others, click its title bar.

When Best for multiple windows is selected in the Amplitude control panel's RF & IF Optimization control,
none of the measurement displays shows a checkmark, as there is not a single optimized measurement.

CISPR

International special committee on radio interference. (Comité international spécial des perturbations
radioélectriques)

CW

Acronym for Continuous Wave.
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Glossary CW Signal

CW Signal

Continuous wave signal - a sine wave.

DANL

Acronym for Displayed Average Noise Level. See Sensitivity (see page 738).

dBfs

A unit to express power level in decibels referenced to full scale. Depending on the context, this is either
the full scale of the display screen or the full scale of the analog-to-digital converter (ADC).

dBm

A unit of expressed power level in decibels referenced to 1 milliwatt.

dBmV

A unit to express voltage levels in decibels referenced to 1 millivolt.

dBuV

A unit to express voltage levels in decibels referenced to 1 microvolt.

Decibel

Ten times the logarithm of the ratio of one electrical power to another.
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Glossary Detection

Detection

The process by which a long waveform is decimated (reduced) down to the desired number of trace points,
by dividing the waveform into intervals and choosing a single value to represent each interval in the trace.

Display Reference Level

A designated vertical position representing a specified input level. The level may be expressed in dBm,
volts, or any other units.

Distortion

Degradation of a signal, often a result of nonlinear operations, resulting in unwanted signal components.
Harmonic and intermodulation distortion are common types.

Dynamic Range

The maximum ratio of the levels of two signals simultaneously present at the input which can be measured
to a specified accuracy.

EVM

Acronym for Error Vector Magnitude.

Export

Save data to a file in a format other than application-native.

FastFrame

FastFrame segments the acquisition record into a series of frames and then captures acquisitions as single
frames. You can then view and measure each frame individually.
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Glossary FFT

FFT

Fast Fourier Transform - a mathematical process to calculate the frequency spectrum of a discrete number
of time domain sample points.

Filter

A circuit that separates electrical signals or signal components based on their frequencies.

FM

Acronym for Frequency Modulation.

Frame

A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce
a spectrum view of a specified span and RBW.

Frequency

A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce
a spectrum view of a specified span and RBW.

Frequency Band

The continuous range of frequencies extending between two limiting frequencies, expressed in hertz.

Frequency Domain View

The representation of the power of the spectral components of a signal as a function frequency; the
spectrum of the signal.
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Glossary Frequency Drift

Frequency Drift

Gradual shift or change in displayed frequency over the specified time due to internal changes in the
analyzer, where other conditions remain constant. Expressed in hertz per second.

Frequency Range

The range of frequencies over which the performance of the instrument is specified.

Frequency Span

A continuous range of frequencies extending between two frequency limits.

Frequency Settling Time

The time measured from a reference point to when the signal of interest settles to within user-defined
tolerance.

GPIB

Acronym for General Purpose Interface Bus, the common name for the communications interface system
defined in IEEE Std. 488.

Graticule

The calibrated grid overlaying the display screen of analyzers, oscilloscopes, and other test instruments.

Grayed Out

An on-screen control is “Grayed Out” if it is not adjustable.
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I/Q

Acronym for In-phase / Quadrature.

IF

Acronym for Intermediate Frequency.

Import

Bring data into the application from a file of some format other than application-native.

Impulse Response

The Impulse Response trace display shows normalized power on the vertical axis and time on the
horizontal axis.

Input Impedance

The impedance at the desired input terminal. Usually expressed in terms of VSWR, return loss, or other
related terms for low impedance devices and resistance-capacitance parameters for high impedance
devices.

LISN

Acronym for Line Impedance Stabilization Network.

Local Oscillator (LO)

An oscillator which produces the internal signal that is mixed with an incoming signal to produce the IF
signal.
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Marker

A visually identifiable point on a waveform trace, used to extract a readout of domain and range values
represented by that point.

Max Hold

Digitally stored display mode which, at each frequency address, compares the incoming signal level to
the stored level and retains the greater level. In this mode, the display indicates the peak level at each
frequency after several successive acquisitions.

MCPR (Multiple Carrier Power Ratio)

The ratio of the signal power in the reference channel or group of channel to the power in adjacent channels.

Min Hold

Digitally stored display mode which, at each frequency address, compares the incoming signal level to
the stored level and retains the lower level. In this mode, the display indicates the minimum level at
each frequency after several successive sweeps.

Modulate

To regulate or vary a characteristic of a signal, typically in order to transmit information.

Modulating Signal

The signal which modulates a carrier. The signal which varies or regulates some characteristic of another
signal.
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Modulation

The process of varying some characteristic of a signal with a second signal.

Noise

Unwanted random disturbances superimposed on a signal which tend to obscure it.

Noise Bandwidth (NBW)

The exact bandwidth of a filter that is used to calculate the absolute power in dBm/Hz.

Noise Floor

The noise intrinsic to a system that represents the minimum limit at which input signals can be observed;
ultimately limited by thermal noise (kTB). The analyzer noise floor appears as a “grassy” baseline in the
display, even when no signal is present.

Open (Recall)

Bring data into the application from a file of application-native format.

OQPSK

Acronym for Offset QPSK (Quadrature Phase Shift Keying).

Phase Settling Time

The time measured from a reference point to when the signal of interest settles to within user-defined
tolerance.
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Glossary PM

PM

Acronym for Phase Modulation.

Primary Marker

The marker displayed in the Single Marker mode whose frequency and/or position is changed when
tuning with the general purpose knob.

PSK

Acronym for Phase Shift Keying. The process, or result of a process, in which the carrier phase is varied
discretely in accordance with a digital code.

QAM

Acronym for Quadrature Amplitude Modulation. The process, or result of a process, in which the amplitude
and phase of the carrier are varied concurrently by synthesizing two orthogonal ASK waves (see ASK).

Real-Time Analysis

Measurement technique based on triggering on an RF signal, seamlessly capturing it into memory, and
analyzing it in the frequency, time, and modulation domains.

Real-Time Bandwidth

The frequency span over which real-time seamless capture can be performed, which is a function of the
digitizer and the IF bandwidth of a Real-Time Signal Analyzer.

SignalVu-PC Printable Help 735



Glossary Real-Time Seamless Capture

Real-Time Seamless Capture

The ability to acquire and store an uninterrupted series of time domain samples that represent the behavior
of an RF signal over a long period of time.

Reference Level

The signal level represented by the uppermost graticule line of the analyzer display.

Residual FM (Incidental FM)

Short term displayed frequency instability or jitter due to instability in the analyzer local oscillators. Given
in terms of peak-to-peak frequency deviation and expressed in hertz or percent of the displayed frequency.

Residual Response

A spurious response in the absence of an input signal. (Noise and zero pip are excluded.)

RBW

The RBW determines how well the analyzer can resolve or separate two or more closely spaced signal
components.

Ripple

The Ripple measurement result is displayed in either Watts or Volts. The amplitude units selected on
the Setup > Analysis > Units tab determine whether the measurement is presented in Watts or Volts.
Volts are shown for linear units (for example, volts or amps); Watts are shown for non-linear units (for
example, watts or dBm).
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Glossary Secondary Marker

The Ripple measurement, in Watts, is calculated as follows:

Where:

DelPos = Delta Positive in Volts

RefPos = Reference Positive in Volts

DelNeg = Delta Negative in Volts (this is a positive value)

RefNeg = Reference Negative in Volts

The Ripple measurement, in Volts, is calculated as follows:

Where:

RatioPosV = DelPos/RefPos

RatioNegV = DelNeg/RefNeg

Secondary Marker

The “second” marker displayed only in the Delta Marker mode.
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Glossary Sensitivity

Sensitivity

Measure of a analyzer’s ability to display minimum level signals, usually expressed as displayed average
noise level (DANL (see page 728)).

Shape Factor (Skirt Selectivity)

The ratio of the frequency separation of the two (60 dB/3 dB) down points on the response curve to the
static resolution bandwidth.

Signal

As used in this help, the signal refers to the input signal before it is processed. The signal is an input.

Signal Strength

Signal Strength locates the direction of a signal using a directional antenna and an audio tone and a
visual display.

Span

Span is the range of frequencies displayed in a spectrum window. Span, start frequency and stop frequency
are related by the following equation: Span = (stop frequency) - (start frequency). The settings for center,
start and stop frequencies are related to the setting for span; when one parameter is changed, the others are
changed automatically.

Span Per Division (Span/Div)

Frequency difference represented by each major horizontal division of the graticule.
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Glossary Spectrogram

Spectrogram

Frequency vs. time vs. amplitude display where the frequency is represented on the x-axis and time on the
y-axis. The power level is indicated by variations in color.

Spectrum

The frequency domain representation of a signal showing the power distribution of its spectral component
versus frequency.

Spectrum Analysis

The technique or process of determining the frequency content of an RF signal.

Spectrum Analyzer

A device for determining the frequency components of a signal.

Spectrum Time

Analysis Time for spectrum analysis views. Spectrum time can be the same as Analysis Time, but it
can be different.

Spur

A spur is a signal peak that exceeds a user-definable threshold (See Spurious > Settings > Ranges) and
excursion setting. A spur that also exceeds a limit (either Absolute or Relative) specified on the Settings
> Limits tab is considered a violation.

Spurious Response

A response to a analyzer wherein the displayed frequency is not related to the input frequency.
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Glossary Time Measurement

Time Measurement

This is the time in seconds relative to the time reference point in the first acquisition record in the data set.

Time Reference

The point in time during the acquisition record used as the zero point for counting time. The time reference
can be set to either the start of the acquisition record or the trigger point.

Trace

As used in this help, trace refers to the displayed signal. The displayed signal can be a processed version of
the input signal (for example, it may be averaged.) The trace is a result or output.

Vector Signal Analyzer

Like a spectrum analyzer, a device for determining the frequency components of a signal. However, unlike
a standard spectrum analyzer, the vector signal analyzer is optimized for analyzing digitally modulated
RF signals.

Vertical Scale Factor, Vertical Display Factor

The number of dB, volts, etc., represented by one vertical division of a spectrum analyzer display screen.

Violation

A violation is a spur that exceeds either an Absolute or Relative limit (depending on the selected mask)
specified on the Settings > Limits tab. A spur is a signal peak that exceeds a user-definable threshold (See
Spurious > Settings > Ranges) and excursion setting.
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Index

Symbols and Numbers
-6dB RBW (MIL) Filter shape

Spectrum display BW tab, 92
20 dB bandwidth

Bluetooth, 46
20dB Bandwidth display

Bluetooth, 502
3-D Spectrogram display, 72
3-D Waterfall

Spectrogram/DPXogram, 77
802.11ad Constellation

display, 301
802.11ad displays, 301
802.11ad EVM vs Time

display, 305
802.11ad measurements, 300
802.11ad Standards presets, 297
802.11ad Summary display, 309
802.11ad Symbol Table

display, 307

A
Abort acquisition, 628
About the Software, 697
Abs

Ranges and Limits table, 158
Abs & Rel

Ranges and Limits table, 158
Abs OR Rel

Ranges and Limits table, 158
Abs Same

Ranges and Limits table, 158
Abs Start (dBm)

Ranges and Limits table, 158
Abs Stop (dBm)

Ranges and Limits table, 158
Absolute Frequency, 351
accuracy, 725
ACLR, 725

LTE, 46
ACLR measurement, 124
ACPR measurement, 725

Acq Data
Replay menu, 615

Acq Data/DPX Spectra, 613
Acquire control panel, 628

Playback, 639
acquisition, 725
acquisition data

saving, 685
Acquisition data files, 30
Acquisition Data tab, 703
Acquisition Info tab, 615
Acquisition memory usage, 629
Actions tab

Search, 606
Triggering, 652

Activate
option key, 7
optional legacy application

licenses, 7
adaptive equalizer, 570
Adjacent Channel Power

measurement, 124
Adjacent Channel Power

Ratio, 39
Advanced Params tab

OFDM Analysis
displays, 343

Advanced Params Tab
GP Digital Modulation

displays, 572
Advanced tab

Triggering, 651
Alaris

antenna function button, 660
+AM, 44

AM display, 44
-AM

AM display, 44
AM display, 97
AM measurements, 44
Amplitude control panel, 621
Amplitude vs. Time display, 79
Amplitude vs. Time display

Settings, 80

Analysis
802.11ad, 300

Analysis control panel, 607
analysis length, 725
Analysis Params tab

Bluetooth, 510
LTE, 467
P25 Analysis displays, 423
WLAN Analysis

displays, 288
Analysis tab

Pulse-Ogram display, 379
analysis time, 725
Analysis Time tab

Bluetooth, 511
GP Digital Modulation

displays, 576
LTE, 468
OFDM Analysis

displays, 344
Options control panel, 30
P25 Analysis displays, 423
WLAN Analysis

displays, 291
Analysis Time tab (Analysis

control panel), 607
Antenna, 655

Alaris function button, 660
control panel, 656
how to set up, 657
settings, 656

Antenna Power, 654
APCO P25 measurements, 45
Application

moving a license, 6
Application Help, 697
Application preset

modulation analysis, 26
pulse analysis, 26
spectrum analysis, 27
Time-Frequency analysis, 28

application presets
saving, 685

Application presets, 21
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Applications
how to purchase, 3
install, 4
list of available options, 10
uninstall, 5

Apply ampl corrections, 373
APSK, 567
APSK parameters, 574
APSK Parameters, 574
Arm trigger status light, 641
arranging windows, 711
ASK, 726
Attenuator settings, 621
Audio BW, 526

setting, 526
Audio Demod tab, 535
audio filters

custom, 530
Audio Filters tab

Audio Analysis displays, 528
Audio Freq

Audio Summary display, 524
Audio Spectrum display, 521
Audio Spectrum settings, 522
Audio Summary settings, 524
Auto

Ranges and Limits table, 158
automatically generate

filenames, 29
Automatically increment

filename/number, 30
Autosave acquisition on

Trigger, 651
Average Channel Power

measurement, 124
Average ON Power, 46
Average Transmitted Power, 349
Averaging

Audio Analysis displays, 528
Params2 tab, 528

B
Base software, 3
Basic Controls Toolbar, 705
black text

settling time
measurements, 170

Blackman-Harris 4B Filter Shape
Spectrum display BW tab, 92

Blizzard color scheme, 30
block, 726
Blue background (cells), 149
Bluetooth

Analysis Params tab, 510
Analysis Time tab, 511
BT 20dB Bandwidth

display, 502
BT InBand Emission, 505
Freq & RBW tab, 519
Frequency Dev vs Time (BT)

display, 498
Limits tab, 512
Measurement Params

tab, 520
Parameters tab, 517
Power class, 509
Prefs tab, 516
Scale tab, 513
Trace tab, 514

Bluetooth measurements, 45
BT 20dB BW Settings, 504
BT CF Offset and Drift

display, 487
settings, 453

BT Constellation
display, 481
settings, 484

BT Eye Diagram
display, 484
settings, 486

BT limits, 490
BT Summary

display, 489
settings, 494

BT Symbol Table
display, 494
settings, 497

Burst detect threshold, 114
BW (Hz)

Ranges and Limits table, 158
BW Tab

Amplitude vs. Time
display, 81

DPXOgram display, 92
Spectrum display, 92

C
C4FM modulation type

measurements, 44
C4FM signal quality

measurements, 558
Cable loss, 40
Cable Loss display settings, 228
calibrator, 726
Carr Freq Err

Audio Summary display, 523
carrier, 726
carrier frequency, 726
Carrier frequency detection, 114
Carrier Frequency Error, 44
Carrier frequency offset and drift

Bluetooth, 45
Carrier Power

Audio Summary display, 523
carrier signal, 726
carrier-to-noise ratio (C/N), 726
CCDF, 39
CCDF - Complimentary

Cumulative Distribution
Function, 727

CCDF display, 160
CDMA, 727
Cell ID detection

LTE, 46
center frequency, 727
Channel direction, 669
Channel Navigation toolbar, 668
Channel Power, 39

LTE, 46
Channel Power and ACPR

(Adjacent Channel Power
Ratio) display, 121

Channel Power and ACPR
Settings control panel, 124

Channel Power measure-
ment, 124

Channel Response
OFDM, 40
WLAN, 41

Channels
how to enable, 669
in signal database, 667
tune to, 668
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Channels tab
Channel Power & ACPR

display, 125
LTE Analysis displays, 454
Signal Strength display, 132

Channels tab (MCPR), 143
check mark indicator, 727
Check mark indicator, 17
CISPR, 727
CISPR Filter shape

Spectrum display BW tab, 92
Classic color scheme, 30
Classify a signal, 683
Connect, 710
Connect to instruments

LAN, USB, 710
Connect to MDO

Connect, 710
Connect to RSA306

Connect, 710
Connection

to an MDO4000B/C, 32
to an RSA306, RSA306B,

RSA500A series, and
RSA600A series, 31

Connectivity, 31
Connect, 710

Constellation
OFDM, 40
WLAN, 41

Constellation display, 538
displaying a second trace, 579

Constellation display
settings, 539

Convergence
Equalizer tab, 571

correction tables, 622
Create a region (Signal

Classification), 672
creating a mask, 644
Creating presets, 21
Cumulative Histogram display

settings, 353
Cumulative Statistics Table

display, 355
Cumulative Statistics Table

settings, 358
CW, 727

CW signal, 728

D
DANL, 728
Data file formats, 692
Data properties

File menu, 703
Data Range tab

OFDM Analysis
displays, 344

WLAN Analysis
displays, 290

Database
how to select channels, 667
how to set up signal

types, 666
how to set up standards, 665
of signal standards, 665

dBfs, 728
dBm, 728
dBmV, 728
dBuV, 728
De-emphasis

Audio Filters tab, 530
deactivating options, 10
decibel, 728
Declare a signal, 683
Default

BT limits table, 490
P25 limits table, 409

default settings, restore, 21
Define a region (Signal

Classification), 672
Define Markers, 594
Define Peaks tab, 595
Define tab, 601

Pulsed RF displays, 372
Settling Time displays, 176

Delay
Triggering, 651

Delta Markers, 594
Demod I&Q vs Time display

settings, 542
Demodulation

audio, 535
Density tab, 62
detect

AM display, 101

FM display, 108
General Signal Viewing

displays, 256
Time Overview, 67

Detect
PM display, 116

detection, 729
AM display, 101
FM display, 108
General Signal Viewing

displays, 256
Time Overview, 67

Detection
DPX display, 58
PM display, 116

detector
AM display, 101
FM display, 108
General Signal Viewing

displays, 256
Time Overview, 67

Detector
PM display, 116
Ranges and Limits table, 158

Deviation, 44
Diff

Audio Summary display, 524
Digital Phosphor Spectrum, 49
Disconnect from instruments

Connect, 710
Display

Pulse Statistics, 364
display reference level, 729
Displays

802.11ad, 301
802.11ad Constellation, 301
802.11ad EVM vs Time, 305
802.11ad Summary, 309
802.11ad Symbol Table, 307
arranging, 37
BT CF Offset and Drift, 487
BT Constellation, 481
BT Eye Diagram, 484
BT Summary, 489
BT Symbol Table, 494
Cumulative Histogram, 351
Cumulative Statistics

Table, 355

SignalVu-PC Printable Help 743



Index

Frequency Settling Time, 167
interactions between, 37
LTE ACLR, 444
LTE Channel Spectrum, 447
LTE Constellation, 449
OFDM Channel

Response, 323
OFDM Constellation, 326
OFDM EVM, 327
OFDM Mag Error, 331
OFDM Phase Error, 333
OFDM Power, 335
OFDM Spectral Flatness, 329
OFDM Summary, 337
OFDM Symbol Table, 340
P25 Constellation, 401
P25 Eye Diagram, 404
P25 Power, 407
P25 Summary, 409
P25 Symbol Table, 412
Phase Settling Time, 167
selecting, 37
SEM (Spectrum Emission

Mask), 183
WLAN Channel

Response, 263
WLAN Constellation, 266
WLAN EVM, 268
WLAN Mag Error, 270
WLAN Phase Error, 272
WLAN Power, 274
WLANSpectral Flatness, 277
WLAN Summary, 279
WLAN Symbol Table, 284

Distance to fault (DTF), 40
distortion, 729
Documentation, 13
Done

Ranges and Limits table, 158
Dot Persistence, 55
Downlink, 669
DPX

Bitmap settings, 55
DPXogram Settings, 55

DPX Density, 62
DPX Density Trigger, 647
DPX display

DPXogram, 49

Frequency, 49
Phase, 49
Spectrum, 49
Zero Span, 49

DPX Spectra
Replay menu, 615

DPX Spectra/Acq Data, 613
DPX Spectrum settings, 55
DPXogram

DPX display, 49
Droop, 350
Droop dB, 47
DTF/Return Loss display

settings, 240
Duty Factor (%) measure-

ment, 349
Duty Factor (Ratio)

measurement, 47
dynamic range, 729

E
Elements of the display, 17
Enable EQ Export

Equalizer tab, 571
Enable Equalization

Equalizer tab, 571
Equalizer tab

GP Digital Modulation
displays, 570

error message
Windows Event Viewer, 719

Error messages, 713
Evaluation mode

for options, 9
Event tab (Triggering), 647
Event Viewer, 719
EVM, 339

OFDM, 40
WLAN, 41

EVM tab
WLAN Analysis

displays, 295
EVM vs. Time display, 542
EVM vs. Time Settings, 543
Excrsn (dB)

Ranges and Limits table, 158
Expand

Ranges and Limits Tab, 157

export, 729
External Gain value, 622
External Gain/Loss Correction

tab, 622
External Loss Tables, 622
Eye Diagram display settings, 546

F
Fall Time, 47
FastFrame, 729
FFT, 730
File formats, 692
file formats supported

waveform, 686
File Menu, 700
File types, 692
filter, 730
Filter Parameter

GP Digital Modulation
displays, 565

Filter Shape
Ranges and Limits table, 158
Spectrum display BW tab, 92

Find tab
GP Digital Modulation

displays, 576
finding bursts in data

GP Digital Modulation
displays, 576

Flatness
OFDM, 40
WLAN, 41

FlatTop (CW ampl) Filter Shape
Spectrum display BW tab, 92

FM, 730
FM display, 103
FM measurements, 44
FMT (Frequency Mask

Trigger), 643
Formatted data structure, 634
frame, 730
Free trial

for options, 9
Freq & BW tab

RF I & Q vs Time display, 87
Freq & BW Tab

GP Digital Modulation
displays, 569
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Freq & RBW tab
Bluetooth, 519

Freq & Span tab
General Signal Viewing

displays, 88
Freq and RBW tab

LTE, 465
Freq Deviation, 350
Freq Diff, Phase Diff, Freq Abs

settings, 374
Freq Error, 44
Freq Estimation tab

Pulsed RF displays, 378
Freq, Span & RBW tab

Channel Power & ACPR
display, MCPR
display, 140

RF Measurements
displays, 195

Signal Strength display, 130
Freq-domain Linearity

setting, 372
frequency, 730
Frequency

DPX display, 49
frequency band, 730
Frequency Dev vs Time (BT)

display
Bluetooth, 498

Frequency Dev vs Time (P25)
display, 416

Frequency Dev vs. Time (BT)
Settings, 502

Frequency Dev vs. Time (P25)
Settings, 418

Frequency deviation
P25, 45

Frequency Deviation vs. Time
settings, 548

frequency domain view, 730
frequency drift, 731
Frequency Edge triggering, 649
Frequency Error, 42

GP Digital Modulation
displays, 569

Frequency Mask Trigger
(FMT), 640

Frequency Offset
GP Digital Modulation

displays, 569
frequency range, 731
Frequency range

Bluetooth, 46
Frequency Reference, 631
frequency settling time, 731

measuring, 172
Frequency Settling Time

display, 167
Frequency Settling Time

settings, 175
frequency span, 731
Frequency tab, 609
Frequency vs. Time display, 81
Frequency vs. Time Settings, 82
Full Screen, 705

G
Gain Imbalance, 556
GNSS, 653

control panel, 653
how to set up, 654
RSA source, 655
Simulation, 655

GPIB, 731
graticule, 731
Graticule On/Off

RF Measurements
displays, 200

Signal Strength display, 134
grayed out, 731

H
H500 signal database, 666
Hanning Filter Shape

Spectrum display BW tab, 92
HCPM transmitter logical channel

time alignment
P25, 45

Help Menu, 711
Hide sensitive readouts, 29
Hide Sensitive readouts, 29
Histogram readout

Pulsed RF displays, 384

Holdoff
Triggering, 651

HPF
Audio Filters tab, 529

Hum & Noise
Audio Summary display, 533

hysteresis, 649

I
I/Q, 732
IF, 732
Ignore Region

Params2 tab, 528
import, 732
Impulse Response Ampli-

tude, 350
Impulse Response setting, 373
Impulse Response Time, 48
In-band emission / ACPR

Bluetooth, 46
InBand Emission

Bluetooth, 505
Information messages, 713
input impedance, 732
Install SignalVu-PC, 3
Internal Attenuator

Internal Settings tab, 621
Internal attenuator (Internal

Settings tab), 621
Internal Preamp

Internal Settings tab, 622
Internal Settings tab, 621
IQ Origin Offset, 42
IQ Sampling Parameters tab, 629
IQ vs. time view, 85
is greater than (Test), 602
is greater than mask, 601
is inside mask, 601
is inside mask (Test), 603
is less than (Test), 602
is less than mask, 601
is outside mask, 601
is outside mask (Test), 603

K
Kaiser (RBW) Filter Shape

Spectrum display BW tab, 92
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Keep-out time, 373
Keypad, 704

L
LAN connection

Connect, 710
Length, 44

Equalizer tab, 571
Levels tab

Pulsed RF displays, 377
license

deactivating, 10
License

activating legacy, 7
install, 4
moving an application, 6
return, 5
trial, 4
uninstall, 5

Licensed software, 3
Licenses, 3

available application
options, 10

how to view, 3
Limit lines, 601
Limits

BT default, 490
P25 default, 409
Spurious display, 159

Limits tab
Bluetooth, 512
P25 Analysis displays, 430

Link to Span, 87
LISN, 732
Load

Ranges and Limits Tab, 157
Ranges and Limits table, 158

local oscillator (LO), 732
Lock Center Frequency of

Spectrum displays, 609
Lock Center Frequency of

Spectrum displays to
Measurement Frequency
Frequency tab, 610

Log
Audio Spectrum display, 532

Log (Horizontal)
Spectrum display, 72

Loop over all selected records
Replay menu, 616

LPF
Audio Filters tab, 529

LTE
Analysis Params tab, 467
Analysis Time tab, 468
Channels tab, 454
Freq and RBW tab, 465
Measurement Params

tab, 466
Modulation Params tab, 467
Offsets and Limits Table

tab, 459
Parameters tab, 456
Prefs tab, 462
Processing tab, 458
Scale tab, 460
Trace tab, 469
VBW (Channels tab), 455
VBW (Freq & RBW tab), 465

LTE ACLR
display, 444
settings, 447

LTE Channel Spectrum
display, 447
settings, 449

LTE Constellation
display, 451

LTE measurements, 46

M
Mag Error, 42

OFDM, 40
WLAN, 41

Magnitude Error vs. Time
display, 549

Magnitude Error vs. Time
settings, 550

Main
presets, 21

Manuals, 13
Map It, 653

how to use, 661
toolbar, 661

marker, 733
Marker noise mode, 597
Marker noise mode (dBc/Hz), 594

Marker Properties tab, 594
Marker to Center Frequency, 594
Markers, 596

in the BT Symbol Table, 497
Marker Toolbar, 596
Using Markers, 591
Using Markers in Noise

Mode, 597
Markers menu, 708
Markers Toolbar, 705
Mask

Ranges and Limits table, 158
Mask Editor, 643
Mask tab

Settling Time displays, 179
Mask Test, 601

is greater than mask, 601
is inside mask, 601
is less than mask, 601
is outside mask, 601

mask testing
settling time

measurement, 163
MATLAB file format, 692
Max Freq Error, 350
max hold, 733
Max number of pulses

Pulse Table display, 370
Max Number of Pulses

Params tab, 371
Max Phase Error, 350
Max total files saved per Run, 652
Max trace points, 83

Settling Time displays, 183
MCPR (multiple carrier power

ratio), 733
MCPR display, 134
MCPR settings, 138
Meas BW

Frequency Settling Time, 176
Meas Frequency

Frequency Settling Time, 176
Measurement BW, no filter, 87
Measurement Filter

GP Digital Modulation
displays, 565

Params tab, 370
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Measurement Frequency, 609
Frequency tab, 610

Measurement Length
Time Params tab, 178

Measurement Params tab
Bluetooth, 520
Channel Power & ACPR

display, MCPR
display, 140

LTE, 466
Signal Strength display, 130

Measurement point, 374
Measurement settings export, 685
Measurements, 39

802.11ad, 300
APCO P25, 45
Bluetooth, 45
LTE, 46

Measurements tab, 369
measuring settling time, 172
Menus, 698
MER (RMS), 557
min hold, 733
Min Settled Duration

Time Params tab, 178
Minimum off time between pulses

Params tab, 371
Mod Distor

Audio Summary display, 524
Mode

Equalizer tab, 571
modulate, 733
modulating signal, 733
modulation, 734
Modulation analysis

application presets, 26
Modulation characteristics

Bluetooth, 45
Modulation fidelity

P25, 45
modulation measurements, 537
Modulation measurements, 42
Modulation Params tab

GP Digital Modulation
displays, 565

LTE, 467
OFDM Analysis

displays, 342

P25 Analysis displays, 420
WLAN Analysis

displays, 287
Modulation types supported, 565
moving windows, 711
Multi-Carrier Power Ratio, 39
Multiple Carrier Power Ratio, 138

N
Navigator View, 704
nFSK modulation type

measurements, 44
nFSK signal quality

measurements, 557
No. of Harmonics

Params2 tab, 528
No. of Non-Harmonics

Params2 tab, 528
noise, 734
noise bandwidth (NBW), 734
noise floor, 734
Noise markers, 597
Non-Harmonic Excursion

Params2 tab, 528
Non-Harmonic Threshold

Params2 tab, 528
Numeric keypad, 704

O
OBW Level Left/Right, 145
OBW Ref Power, 145
Occupied bandwidth

LTE, 46
Occupied Bandwidth, 148
Occupied Bandwidth

settings, 148
Occupied BW display, 145
OFDM Channel Response

display, 323
settings, 325

OFDM Constellation
display, 326
settings, 327

OFDM EVM
display, 327
settings, 329

OFDM Mag Error
display, 331
settings, 333

OFDM Phase Error
display, 335

OFDM Power
display, 335
settings, 337

OFDM Spectral Flatness
display, 329
settings, 331

OFDM Summary
display, 337
settings, 339

OFDM Symbol Table
display, 340
settings, 341

Off
Ranges and Limits table, 158

Offset & Limits Table tab
SEM display, 190

Offset EVM, 557
Offsets and Limits Table tab

LTE, 459
On

Ranges and Limits table, 158
open (recall), 734
Operating band unwanted

emission
LTE, 46

Operating frequency accuracy
P25, 45

Optimization
Channel Power & ACPR

display, MCPR
display, 140

Signal Strength display, 130
option

activate with Internet, 7
activate without Internet, 7

Option key
activate, 7

Optional software, 3
options

deactivating, 10
deactivating legacy, 10
moving to another PC, 10
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Options
how to purchase, 3
list of available, 10
transferring an application

license, 6
Options control panel, 29
OQPSK, 734
OQPSK and SOQPSK modulation

type measurements, 43
Out-of-band spurious emission

Bluetooth, 46
Output power

Bluetooth, 46
Overlap, 75
Overshoot, 350

dB, 350
Overshoot dB, 350
Overshoot settings, 375

P
P25

presets, 25
P25 Constellation

display, 401
settings, 403

P25 Eye Diagram
display, 404
settings, 406

P25 limits, 409
P25 measurements, 45
P25 Power vs Time

display, 407
settings, 408

P25 Summary
display, 409
settings, 412

P25 Symbol Table
display, 412
settings, 415

Parameters tab
AM display, 99
Bluetooth, 517
CCDF display, 162
FM display, 107
LTE, 456
Occupied BW display, 149
PM display, 114
SEM display, 187

Spurious display, 154
Params tab

Pulsed RF displays, 370
Params1 tab

Audio Analysis displays, 525
Params2 tab

Audio Analysis displays, 528
Pass /Fail readout

SEM display, 185
Pass/Fail Limit Testing

Spurious display, 159
Pass/Fail tests, 602
Pause

Replay menu, 616
+Peak

Audio Summary display, 524
-Peak

Audio Summary display, 524
Peak Excursion, 594
Peak FSK err, 44
Peak Mag Err, 44
Peak Power, 46
Peak Threshold, 594
Peak/Avg Ratio, 39
Peak-Peak/2

Audio Summary display, 524
Phase

DPX display, 49
Phase Deviation, 350
Phase Difference, 350
Phase Error, 557

OFDM, 40
WLAN, 41

Phase Error vs. Time display, 551
Phase Error vs. Time settings, 552
phase settling time, 734

measuring, 172
Phase Settling Time display, 167
Phase Settling Time settings, 175
Phase vs. Time display, 83
Phase vs. Time settings, 84
pictures

saving, 685
+Pk

FM display, 44
PM display, 45

-Pk
FM display, 44

PM display, 45
Pk-Pk

FM display, 44
PM display, 45

Pk-Pk/2
FM display, 44

Playback, 639
Define skip, 640
Exit playback, 640
Live rate, 640
Location, 640
Loop file, 640
Progress bar, 640

PM, 735
PM measurements, 45
Position

Triggering, 651
Power

OFDM, 40
Power class

Bluetooth, 509
Power density

Bluetooth, 46
Power Markers, 594
power measurements, 121
Power measurements, 39
Power Threshold to Detect Pulses

Params tab, 370
Power vs Time

WLAN, 41
Pre-defined Filters

Audio Filters tab, 529
Prefs tab

AM display, 103
Bluetooth, 516
FM display, 111
General Signal Viewing

Displays, 95
GP Digital Modulation

displays, 581
LTE, 462
OFDM Analysis

displays, 348
Options control panel, 31
P25 Analysis displays, 429
PM display, 119
Pulsed RF displays, 384
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RF Measurements
displays, 200

Settling Time displays, 183
Signal Strength display, 134
WLAN Analysis

displays, 296
Presets, 685

802.11ad, 297
Application, 21
Main, 21
P25, 25
recalling, 23
Standards, 25
User, 21
WLAN, 21

Presets tab
Options control panel, 30

primary marker, 735
Print, 704
Print Preview, 704
Processing tab

LTE, 458
SEM display, 189

Product documentation, 13
PSK, 735
Pulse analysis

application presets, 26
Pulse measurements, 46
Pulse Statistics display, 364
Pulse Statistics display

settings, 367
Pulse Table display, 360
Pulse Table display settings, 362
Pulse Trace display, 362
Pulse Trace display settings, 364
Pulse Width, 47
Pulse-Ogram settings, 360
Pulse-Pulse Frequency

Difference, 48
Pulse-Pulse Phase Difference, 48
Pulse-ref Freq Difference, 350
Pulse-ref Phase Difference, 350
pulses

how many can be
analyzed, 371

Q
QAM, 735

Quadrature Error, 556

R
Range file, 692
Ranges and Limits Tab

Spurious display, 156
Raw data structure, 634
RBW, 736

Channel Power & ACPR
display, MCPR
display, 140

Signal Strength display, 130
Ready trigger status light, 641
real-time analysis, 735
real-time bandwidth, 735
real-time seamless capture, 736
Recalling Presets, 23
Record, 633
Record control panel

Record, 636
Record setup

formatted data structure, 634
raw data structure, 634

Record to disk, 638
Recording, 634
Recording control panel, 633
Red background (cells), 149
red text

settling time
measurements, 170

Ref
Audio Summary display, 524

Ref Channel tab
SEM display, 190

Ref level (Internal Settings
tab), 621

Reference Filter
GP Digital Modulation

displays, 565
reference level, 736
Reference tab

Spurious display, 154
Rel

Ranges and Limits table, 158
Rel Same

Ranges and Limits table, 158
Rel Start (dB)

Ranges and Limits table, 158

Rel Stop (dB)
Ranges and Limits table, 158

Relative power
Bluetooth, 46

Repeat, 627
Repetition Interval, 47
Repetition Rate, 47
Replay all selected records

Replay menu, 616
Replay control panel, 613
Replay current record

Replay menu, 616
Replay from selected

Replay menu, 616
Replay menu, 615
Replay Speed tab, 615
Replay toolbar, 618

Replay menu, 616
Reset Equalization

Equalizer tab, 571
Reset layout

Ranges and Limits Tab, 157
residual FM (incidental FM), 736
residual response, 736
results

saving, 685
Resume, 627
Return loss (RL), 40
Return loss measurements, 40
RF Channel Power

measurement, 123
RF I & Q vs. Time display, 85
RF I & Q vs. Time settings, 86
RF output power

P25, 45
Rho, 42
Ripple, 350
Ripple dB, 350
ripple measurement

calculation, 736
Ripple settings, 375
Rise Time, 47
RMS

Audio Summary display, 524
FM display, 44
PM display, 45

RMS Error Magnitude, 44
RMS Freq Error, 350
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RMS FSK Err, 44
RMS Mag Err, 44
RMS Phase Error, 350
RSA Device, 654
Run, 627
Run menu, 708

S
S/N

Audio Summary display, 524
Save

Ranges and Limits Tab, 157
Save acq data on Trigger, 652
Save and Export tab, 29

Options control panel, 30
Save As

Ranges and Limits table, 158
Save on trigger, 652
Save picture on Trigger, 652
saved file types, 685
saving

acquisition data, 685
pictures, 685
results, 685
setups, 685

Saving
presets, 21

Saving and Recalling Data, 685
Scale tab

AM display, 102
Audio Analysis displays, 531
Bluetooth, 513
DPX Spectrum display, 61
FM display, 110
General Signal Viewing

displays, 94
GP Digital Modulation

displays, 580
LTE, 460
OFDM Analysis

displays, 346
P25 Analysis displays, 426
PM display, 118
Pulsed RF displays, 382
RF Measurements

displays, 199
SEM display, 193
Settling Time displays, 182

Signal Strength display, 133
Spectrogram display, 77
Spectrum display, 72
WLAN Analysis

displays, 293
Search control panel, 606
Search for instruments

Connect, 710
Search In, 602
secondary marker, 737
Security tab, 29

Options control panel, 30
Select all

Replay menu, 616
Select data records tab, 613
Select records from history

Replay menu, 616
SEM display, 183
sensitivity, 738
Set to max BW, 87
Settings, 721

AM display, 98
Audio Spectrum display, 522
Audio Summary display, 524
BT 20dB BW, 504
BT CF Offset and Drift, 489
BT Constellation, 484
BT Eye Diagram, 486
BT Frequency Dev vs.

Time, 502
BT Summary, 494
BT Symbol Table, 497
Cable Loss display, 228
CCDF display, 161
Constellation display, 539
Cumulative Histogram

display, 353
Cumulative Statistics Table

display, 358
Demod I&Q vs Time

display, 542
DPX Spectrum, 55
DTF/Return Loss

display, 240
EVM vs. Time display, 543
Eye Diagram display, 546
FM display, 105

Frequency Deviation vs.
Time, 548

Frequency Settling Time, 175
Frequency vs. Time, 82
LTE ACLR, 447
LTE Channel Spectrum, 449
Magnitude Error vs.

Time, 550
MCPR, 138
Occupied Bandwidth, 148
OFDM Channel

Response, 323
OFDM Constellation, 327
OFDM EVM, 329
OFDM Flatness, 331
OFDM Mag Error, 333
OFDM Phase Error, 335
OFDM Power, 337
OFDM Summary, 339
OFDM Symbol Table, 341
Options control panel, 29
P25 Constellation, 403
P25 Eye Diagram, 406
P25 Frequency Dev vs.

Time, 418
P25 Power vs Time, 408
P25 Summary, 412
P25 Symbol Table, 415
Phase Error vs. Time, 552
Phase Settling Time, 171
Phase vs. Time, 84
Pulse Statistics display, 367
Pulse Table display, 362
Pulse Trace display, 364
Pulse-Ogram display, 360
restoring defaults, 21
RF I & Q vs. Time, 86
Signal Quality, 558
Spectrogram display, 75
Spectrum display, 71
Spectrum Emission

Mask, 187
Spurious display, 153
Symbol Table display, 560
Time Overview display, 64
Trellis Diagram display, 563
Trigger, 647
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WLAN Channel
Response, 263

WLAN Constellation, 267
WLAN EVM, 269
WLAN Mag Error, 271
WLAN Phase Error, 273
WLAN Power vs Time, 276
WLANSpectral Flatness, 278
WLAN Summary, 283
WLAN Symbol Table, 286

Settled Frequency
definition, 163

Settled Phase
definition, 163

settling time
measuring, 172

Settling Time, 163
definition, 163

Settling Time decimal places
Settling Time displays, 183

settling time measurement
text color, 170

Setup Menu, 708
setups

saving, 685
shape factor (skirt

selectivity), 738
Show graticule

General Signal Viewing
Displays, 95

Pulsed RF displays, 384
Settling Time displays, 183

Show Marker Readout in Graph
General Signal Viewing

Displays, 95
Pulsed RF displays, 384
RF Measurements

displays, 200
Settling Time displays, 183
Signal Strength display, 134

Show recalled trace, 89
AM display, 100
FM display, 108
PM display, 115
Time Overview display, 67

signal, 738
Signal Classification

create a region, 672

define a region, 672
Signal database, 665

merge the H500 database, 666
Signal Power

Audio Summary display, 523
Signal Quality display, 553
Signal quality measurements, 556
Signal Quality settings, 558
Signal standards, 665
signal strength, 738
Signal Strength display, 127
Signal Strength Settings control

panel, 128
Signal types, 665
Simulation

GNSS, 655
SINAD

Audio Summary display, 524
span, 738
span per division, 738
Span/RBW Ratio

Spectrum display BW tab, 92
spectrogram, 739
Spectrogram display, 72
Spectrogram display settings, 75
spectrum, 739
Spectrum

DPX display, 49
spectrum analysis, 739
Spectrum analysis

application presets, 27
spectrum analyzer, 739
Spectrum Center Frequency, 609

Frequency tab, 610
Spectrum display, 69
Spectrum display settings, 71
Spectrum Emission Mask

display, 183
settings, 187

Spectrum Monitor
Spectrogram, 78

spectrum time, 739
Spectrum Time tab, 609
Spectrums/line, 75
Split

DPX display, 49
spur, 739

Spur
defining, 159

Spurious, 149
Spurious display settings, 153
spurious response, 739
Standard

Audio Filters tab, 530
Standard Settings button, 564
Standard software, 3
Standards

802.11ad, 297
database, 665
how to set up database, 665
presets, 21

Standards presets
P25, 25
WLAN, 25

Start (Hz)
Ranges and Limits table, 158

Status bar, 705
Status Bar, 707
Stop

Replay menu, 616
Stop (Hz)

Ranges and Limits table, 158
Summary

WLAN, 41
supported file formats

waveform, 686
symbol maps, 581
Symbol Rate, 44
Symbol rate accuracy

P25, 45
Symbol Rate Error, 44
Symbol Table

WLAN, 41
Symbol Table display, 559
Symbol Table display

settings, 560

T
Taps

Equalizer tab, 571
Taps/Symbol

Equalizer tab, 571
Target Reference

Frequency Settling Time, 177
Test For, 602
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Test Patterns tab
P25 Analysis displays, 425

Test using a mask, 603
THD

Audio Summary display, 524
Thrshld (dBm)

Ranges and Limits table, 158
Thunderstorm color scheme, 30
Time, 350
Time & Freq Scale tab

Spectrogram display, 77
time measurement, 740
Time Overview, 63
Time Overview display

settings, 64
Time Params tab

Settling Time displays, 178
time reference, 740
time scale status readout, 75
Time-Frequency analysis

application presets, 28
TIQ acquisition data files, 30
TIQ acquisition data files

parameters, 29
TNHD

Audio Summary display, 524
TOFF

LTE, 46
Tolerance (+/-)

Frequency Settling Time, 177
Tools Menu, 709
Total AM

AM display, 44
Touch-screen Actions, 15
trace, 740
Trace 2

Constellation display, 579
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